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Safety

Your press and the recommended supplies have been designed and tested to meet strict safety requirements. 
Attention to the following information ensures the continued safe operation of your Xerox® Press.

PRODUCT SYMBOLS

SYMBOL DEFINITION 

CCaauuttiioonn 

This symbol indicates a mandatory action to take in order to avoid damage to these areas.

WWaarrnniinngg 

This symbol alerts users to areas where there is the possibility of personal injury.

HHoott WWaarrnniinngg 

This symbol alerts users to areas where there are heated surfaces which should not be 
touched.

LLaasseerr WWaarrnniinngg 

This symbol indicates a laser is being used and alerts the user to refer to the appropriate 
safety information.

PPiinncchh HHaazzaarrdd 

This warning symbol alerts users to areas where there is the possibility of personal injury.

LLoocckk 

UUnnlloocckk 

DDoo NNoott TToouucchh 

DDoo NNoott TToouucchh tthhee DDrruumm CCaarrttrriiddggee 

To avoid damage, do not touch the surface of the Drum Cartridge.

DDoo NNoott DDiissppoossee iinnttoo aann OOppeenn FFllaammee oorr IInncciinneerraattee 
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SYMBOL DEFINITION 

DDoo NNoott IInncciinneerraattee tthhee DDrryy IInnkk//TToonneerr CCaarrttrriiddggee 

Always refer to the recycling instructions for your region or marketplace for correct disposal 
information and procedures.

DDoo NNoott IInncciinneerraattee tthhee DDrryy IInnkk//TToonneerr WWaassttee BBoottttllee 

Always refer to the recycling instructions for your region or marketplace for correct disposal 
information and procedures.

DDoo NNoott IInncciinneerraattee tthhee DDrruumm CCaarrttrriiddggee 

Always refer to the recycling instructions for your region or marketplace for correct disposal 
information and procedures.

DDoo NNoott IInncciinneerraattee tthhee SSeeccoonndd BBiiaass TTrraannssffeerr RRoollll  

Always refer to the recycling instructions for your region or marketplace for correct disposal 
information and procedures.

GGrroouunndd,, CCoommmmoonn,, oorr EEaarrtthh TTeerrmmiinnaall 

LLAANN 

Local Area Network

UUSSBB 

Universal Serial Bus

KKeeeepp AArreeaa CClleeaarr 

Do not store any objects in this location.

KKeeeepp AArreeaa CClleeaarr 

Do not store any objects in this location.
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SYMBOL DEFINITION 

DDoo NNoott UUssee TTrraannssppaarreenncciieess wwiitthh aa WWhhiittee SSttrriipp oorr OOvveerrhheeaadd PPrroojjeeccttoorr SShheeeettss wwiitthh aa 
WWhhiittee SSttrriipp  

DDoo NNoott UUssee EEnnvveellooppeess wwiitthh OOppeenn FFllaappss 

DDoo NNoott UUssee FFoollddeedd,, CCrreeaasseedd,, CCuurrlleedd,, oorr WWrriinnkklleedd PPaappeerr 

DDoo NNoott UUssee IInnkk JJeett PPaappeerr 

DDoo NNoott LLooaadd PPoossttccaarrddss iinn tthhee IInnddiiccaatteedd DDiirreeccttiioonn 

DDoo NNoott UUssee MMeeddiiaa AAttttaacchheedd wwiitthh SSttaapplleess oorr PPaappeerr oorr MMeettaall CClliippss 

DDoo NNoott CCooppyy MMoonneeyy 

TTrraayy GGuuiiddeess MMuusstt TToouucchh MMeeddiiaa 

LLooaadd PPoossttccaarrddss iinn tthhee IInnddiiccaatteedd DDiirreeccttiioonn 

10 Xerox® Versant® 280 Press User Documentation 

Learning About



SYMBOL DEFINITION 

LLooaadd HHoollee--ppuunncchheedd PPaappeerr aass IInnddiiccaatteedd 

LLooaadd MMeeddiiaa aanndd DDooccuummeennttss FFaaccee DDoowwnn 

IICC CCaarrdd RReeaaddeerr 

Integrated Circuit Card Reader, Smart Card Reader and Chip Card Reader

OOnn 

This symbol indicates the main power switch is in the OONN position.

OOffff 

This symbol indicates the main power switch is in the OOFFFF position.

SSttaannddbbyy 

This symbol indicates the secondary power switch is in the SSttaannddbbyy position.

DDoo NNoott DDiissppoossee iinn NNoorrmmaall HHoouusseehhoolldd WWaassttee SSttrreeaamm 
• Application of this symbol is confirmation that you should not dispose of items, such as 

Customer Replaceable Units (CRUs), in the normal household waste stream. You must 
dispose of these items in compliance with agreed national procedures. 

• This symbol often accompanies batteries and indicates that used electrical and 
electronic products and batteries should not be mixed with general household waste. 

• For more information about collection and recycling, contact your local municipality, your 
waste disposal service, or the point of sale where you purchased the items. 

NOTICES AND SAFETY

Carefully read the following instructions before operating your press. Refer to these instructions to ensure the 
continued safe operation of your press.

Your Xerox® press and supplies are designed and tested to meet strict safety requirements. Safety requirements 
include safety agency evaluation and certification, and compliance with electromagnetic regulations and 
established environmental standards.

The safety and environment testing and performance of this product have been verified using Xerox® materials 
only.

Unauthorized alterations, which can include the addition of new functions or connection of external devices, can 
affect the product certification. For more information, contact your Xerox representative.
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ELECTRICAL SAFETY

General Guidelines

Warning: Read the following warnings.

• Do not push objects into slots or openings on the press. Touching a voltage point or shorting out a part could 
result in fire or electric shock.

• Do not remove the covers or guards that are fastened with screws unless you are installing optional equipment 
and are instructed to do so. Switch off the press when performing these installations. Disconnect the power cord 
when removing covers and guards for installing optional equipment. Except for user-installable options, there 
are no parts that you can maintain or service behind these covers.

Emergency Power Off

The following are hazards to your safety: 

• The power cord is damaged or frayed.

• Liquid is spilled into the press.

• The press is exposed to water.

• The press emits smoke, or the surface is unusually hot.

• The press emits unusual noise or odors.

• The press causes a circuit breaker, fuse, or other safety device to activate.

If any of these conditions occur, do the following: 

1. Turn off the printer immediately.

2. Disconnect the power cord from the electrical outlet.

3. Call an authorized service representative.

Power Cable and Electrical Supply

• Use the power cords that are supplied with your press.

• Do not remove or modify the power cord.

• The electrical outlet must be near the printer and must be easily accessible.

• Plug the power cable directly into a properly grounded electrical outlet. Ensure that each end of the cable is 
connected securely. If you do not know if an outlet is grounded, ask an electrician to check the outlet. 

Warning: To avoid risk of fire or electrical shock, do not use extension cords, power strips, or power 
plugs. Always adhere to national and local building, fire, and electrical codes regarding length of cord, 
conductor size, grounding, and protection.

• Do not use a ground adapter plug to connect the press to an electrical outlet that does not have a ground 
connection terminal.
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• The electrical supply for the press must meet the requirements stated on the data plate located on the rear of 
the press. If necessary, consult your local electricity provider or a licensed electrician.

• Do not place the press in an area where people can step on the power cable.

• Do not place objects on the power cable.

• Do not plug or unplug the power cable while the power switch is in the On position.

• If the power cable becomes frayed or worn, replace it.

• To avoid electrical shock and damage to the cable, grasp the plug when unplugging the power cable.

Disconnect Device

The power cable is the disconnect device for this equipment. To remove all electrical power from the machine, 
disconnect the power cable from the electrical outlet.

LASER SAFETY

North America Laser Safety

This product complies with safety standards and is certified as a Class 1 Laser product under the Center for Devices 
and Radiological Health (CDRH) of the United States Food and Drug Administration (FDA) implemented regulations 
for laser products. This product complies with FDA performance standards for Laser products except for deviations 
pursuant to Laser Notice No. 50 dated June 24, 2007. These regulations apply to laser products marketed in the 
United States. The label on the Production Press indicates compliance with CDRH regulations and must be attached 
to laser products marketed in the United States. This product does not emit hazardous laser radiation.

Laser Warning: Use of controls or adjustments or performance of procedures other than those specified 
herein may result in hazardous exposure of laser light.

Since radiation emitted inside this product is completely confined within the protective housing and external covers, 
the laser beam cannot escape from the Production Press during any phase of the user operation.

This product contains laser warning labels. These labels are intended for use by the Xerox Service Representative 
and are placed on or near panels or shields that require special tools for removal. Do not remove any of the panels. 
There are no operator serviceable areas in these covers. 

European Union (EU) Laser Safety

This product complies with IEC safety standard EN 60825-1: 2014.

The equipment complies with laser product performance standards set by governmental, national, and international 
agencies as a Class 1 Laser Product. It does not emit hazardous radiation as the beam is totally enclosed during all 
phases of customer operation and maintenance.

Warning: Use of controls or adjustments or performance of procedures other than those specified herein 
may result in hazardous radiation exposure.

If you need additional safety information about the product or Xerox supplied materials, you can email request to 
EHS-Europe@xerox.com.
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OPERATIONAL SAFETY

Your Xerox equipment and supplies were designed and tested to meet strict safety requirements. These include 
safety agency examination, approval, and compliance with established environmental standards.

Your attention to the following safety guidelines will help ensure the continued safe operation of your Press:

• Do not remove any trays when the Press is printing.

• Do not open the doors when the Press is printing.

• Keep hands, hair, neckties, and so on, away from the exit and feed rollers.

• Covers, which require tools for removal, protect the hazard areas within the Press. Do not remove the protective 
covers.

• Do not attempt to remove paper that is jammed deeply inside the Press. Switch off the Press promptly and 
contact your local Xerox representative.

• To avoid a tip hazard, do not push or move the device with all of the paper trays extended. 

• Do not place the Press in locations susceptible to vibrations.

• For optimum performance, use the Press at the Altitude specified in Environmental Specifications section of the 
User Documentation.

• Use the materials and supplies specifically designed for your Press. The use of unsuitable materials may result in 
poor performance of the Press and possibly a hazardous situation.

• Follow all warnings and instructions that are marked on or supplied with the Press.

• Place the Press in a room that provides adequate space for ventilation and servicing.

• Place the Press on a level, solid surface, not on a thick pile carpet, that has adequate strength to support the 
weight of the Press.

• Do not attempt to move the Press. A leveling device that was lowered when your Press was installed may 
damage the carpet or floor.

• Do not set up the Press near a heat source.

• Do not set up the Press in direct sunlight.

• Do not store or operate the Press in an extremely hot, cold, or humid environment.

• Do not set up the Press in line with the cold air flow from an air conditioning system.

• Do not place containers of coffee or other liquid on the Press.

• Do not block or cover the slots and openings on the Press.

• Do not attempt to override any electrical or mechanical interlock devices.

WARNING—HOT SURFACE: Be careful when working in areas identified with this warning symbol. 
These areas may be very hot and should not be touched.

If you need any additional safety information concerning the Press or materials, contact your Xerox representative.
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Ozone Information

This product produces ozone during normal operation. The ozone is heavier than air, and the quantity is dependent 
on print volume. Install the system in a well-ventilated room.

For more information, refer to Facts about ozone and Fact about ventilation at www.xerox.com/EHS or www.xerox. 
com/EHS-eu.

MAINTENANCE INFORMATION

Do not carry out any maintenance on this product which is not described in the customer documentation.

Warning: Do not use aerosol cleaners. Aerosol cleaners can be explosive or flammable when used on 
electromechanical equipment.

Use supplies and cleaning materials only as directed.

Do not remove the covers or guards that are fastened with screws. Customer service items are not located behind 
these covers.

Note: Your Xerox Production Press is equipped with an power saving device to conserve power when the 
Production Press is not in use. The Production Press can be left on continuously.

WARNING—HOT SURFACE: The metallic surfaces in the fuser area are hot. Use caution when you 
remove paper jams from this area and avoid touching any metallic surfaces.

Vacuum Cleaner Use for Dry Ink/Toner Spills

Use a broom or a wet cloth to wipe off spilled dry ink/toner. Sweep slowly to minimize generation of dust during 
clean up. Avoid using a vacuum. If a vacuum must be used, the unit should be designed for combustible dusts (for 
example, explosion rated motor and non-conductive hose).

CONSUMABLE INFORMATION

Warning: When handling cartridges such as ink or fuser, avoid skin or eye contact. Eye contact can cause 
irritation and inflammation. Do not attempt to disassemble the cartridge. This can increase the risk of skin 
or eye contact.

Caution: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service Agreement, and 
Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of performance caused 
by use of non-Xerox supplies, or the use of Xerox supplies not specified for this Production Press. The Total 
Satisfaction Guarantee is available in the United States and Canada. Coverage can vary outside these 
areas. For more details, contact your Xerox representative.

Store all consumables in accordance with the instructions given on the package or container.

Keep all consumables away from the reach of children.

Never throw dry ink/toner, print cartridges, or dry ink/toner containers into an open flame.

For information on Xerox® supplies recycling programs, go to:
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• For the United States or Canada: www.xerox.com/recycling

• For Europe and other markets: www.xerox.com/recycling-eu

BATTERY SAFETY

One or more circuit boards in this printer contain a lithium battery.

Do not attempt to repair or replace the lithium battery. If there is a problem with the battery, contact an 
authorized service representative to correct the problem.

The lithium battery in this printer contains Perchlorate material. For information about the special handling 
procedures associated with Perchlorate material, refer to www.dtsc.ca.gov/hazardouswaste/perchlorate.

Warning: If the battery on a circuit board is installed incorrectly, there is a risk of explosion.

ENVIRONMENTAL,  HEALTH,  AND SAFETY CONTACT INFORMATION

For more information on Environment, Health, and Safety in relation to this Xerox® product and supplies, contact 
the following:

• United States and Canada: 1-800-ASK-XEROX (1-800-275-9376)

• Email request to Europe: EHS-Europe@xerox.com.

• Web address: www.xerox.com/environment or www.xerox.com/environment_europe.
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Press Overview

The press is a full color or black and white, auto-duplex copier and printer that operates at a speed of 80 prints per 
minute when printing on 8.5 x 11 inch or A4 paper.

PRESS COMPONENTS

1. User Interface

2. Document Feeder

3. Document Glass

4. Press Power Switch

5. Dry Ink/Toner Front Cover

6. Press Front Door

7. Trays 1-3

8. Bottom Left Door

9. Casters

10. Tray 5 (Bypass)

11. Tray 5 (Bypass) Top Cover

12. USB Memory Port

13. Offset Catch Tray (OCT)
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Press with Full System Configuration

This is an example of a full system configuration of the press with optional devices attached. 

1. Dual Advanced Oversized High-Capacity Feeder (Trays 8 and 9) (Optional)

2. Advanced Oversized High-Capacity Feeder (Trays 6 and 7) (Optional)

3. Press

4. Interface Decurler Module (IDM) (Optional)

5. Inserter Module (Optional)

6. High-Capacity Stacker (Optional)

7. Two-sided Trimmer (Optional)

8. C/Z Folder (Optional)

9. Production Ready (PR) Finisher (Optional)

10. SquareFold® Trimmer (Optional)

Note: Full system configurations vary depending on which optional devices are attached to the press. For 
detailed information about an optional device, refer to the appropriate section in this guide.

PPrreessss CCoonnffiigguurraattiioonn wwiitthh OOtthheerr OOppttiioonnaall DDeevviicceess AAttttaacchheedd

This is another example of a full system configuration with optional devices attached, such as Dual High-Capacity 
XLS Vacuum Feeder and Plockmatic MPS XL.

1. Dual High-Capacity XLS Vacuum Feeder (Trays 8 and 9) (Optional)

2. High-Capacity Vacuum Feeder (Trays 6 and 7) (Optional)
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3. Press

4. Interface Decurler Module (IDM) (Optional)

5. Inserter Module (Optional)

6. High-Capacity Stacker (Optional)

7. Two-sided Trimmer (Optional)

8. C/Z Folder (Optional)

9. Production Ready (PR) Finisher Plus (Optional)

10. Plockmatic MPS XL (Multi-Purpose Stacker) (Optional)

Locating the Press Serial Number

The press serial number can be accessed from the User Interface (UI) or from the serial number plate which is 
located on the inside frame of Tray 1.

1. Press the Machine Status button on the UI.

2. From the Machine Status screen, ensure that the Device Information tab is displayed. 

The press serial number is displayed under Device Serial Number near the bottom of the screen.

3. If there is a loss of power and it is not possible to access the Machine Status screen, the press serial number 
can also be found on the inside frame of the press near the Paper Tray 1 drawer: 

a. At the press, fully open Tray 1.

b. At the left of the tray, on the press frame, locate the plate with the serial number (SSEERR##). 
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User Interface (UI)

ITEM 
NUMBER NAME DESCRIPTION 

1 Touch Screen Directly touch the screen to select and set features. 
Displays instructional and informational messages, fault 
clearance procedures and general press information. 

2 Services Home button Press this button to display the main window. Provides 
access to features such as Copy, E-Mail, and Network 
Scanning, just to name a few features. Other features can 
be available depending on your marketplace. 

3 Services button This button lights when the main power is on. 

4 Job Status button Use to check the progress of active jobs and detailed 
information about completed jobs or pending jobs. This 
area also allows you to delete a job (cancel printing or 
copying) and pause jobs. 

5 Machine Status button Use this button to access the Device Information, Faults, 
Supplies, Billing Information, and Tools feature which 
include the press configuration, the software version, the 
press billing meters and counter information, and print job 
history or error reports.  

6 Log In / Out button Use to log in and out of Administrator mode or 
Authentication mode with user ID and password. 

7 Power Saver button Use this button if the press is inactive and the touch 
screen is dark, or the press is in Power Saver mode. This 
button manually exits the press from Power Saver mode; it 
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ITEM 
NUMBER NAME DESCRIPTION 

does not place the press in Power Saver mode. 

8 Clear All button Use this button to return all selections to the same state 
as when the press was powered on. Press once to clear a 
current entry. Press twice to return to default settings. 

9 Stop button Press to stop and pause the print or copy job in progress. 

10 Start button Use this button to perform certain functions, such as 
scanning and copying a document or printing a selected 
report from the print engine. This button is also used by 
the Customer Service Engineer (CSE) during diagnostic 
routine procedures. 

11 Interrupt button Use this button to suspend a copy or print job in progress 
and have the press stop to process another job. During the 
Interrupt mode, the Interrupt button lights. Pressing the 
Interrupt button again exits the Interrupt mode and 
resumes the suspended job. 

12 Numeric Keypad Use to enter alphanumeric characters. The C (Cancel) 
Entry cancels the previous entry made on the numeric 
keypad.  

13 Language button Use to select a different language for the touch screen 
options. 

14 Help button Displays the Help System, this feature may not be 
available in all marketplaces. 

Features

Login

There are two login levels:

• Guest/Operator: This is the default login user. You are automatically logged on as Guest.

• Administrator: This login level is required to customize the system and network defaults for your press and to 
customize print jobs by setting or changing the parameters for certain features. Press the Guest button (or the 
Log in button on the User Interface) to access the Login screen.

Xerox® Versant® 280 Press User Documentation 21

Learning About



Note: Refer to the System Administrator Guide for more information on the Administrator features.

Language 

Note: The number of languages available on your system depends on what was installed during the initial 
installation process.

Selecting a particular language immediately changes the language on the User Interface. No confirmation is 
required.

CChhaannggiinngg tthhee LLaanngguuaaggee

1. Press the Language button on the User Interface. 

The Language window displays on the touch screen.

2. Choose one of the following: 

• Select the desired language from the list, then select Save. The language on the screen changes to the new 
language and closes the Language window.

• Select the Cancel button to return to the main screen.
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Press Performance Customization

There are three different performance customization configurations available with the press: 

• Xerox® Versant® 280 Press with basic print engine configuration performance

• Xerox® Versant® 280 Press with All Stock Rated Speed (ASRS) configuration performance (optional)

• Xerox® Versant® 280 Press with Performance Package (PP) configuration performance (optional)

PRESS WITH BASIC PRINT ENGINE CONFIGURATION PERFORMANCE

The press is a full color or black and white, automatic 2-sided copier and printer that operates at a speed of 80 
prints per minute when printing on 8.5 x 11 in. or A4 paper. The press uses CMYK to create full color.

PRESS WITH OPTIONAL ALL STOCK RATED SPEED (ASRS)  CONFIGURATION PERFORMANCE

The All Stock Rated Speed (ASRS) performance option is ordered before the initial installation of the system. It is 
not possible to upgrade an existing press with the All Stock Rated Speed (ASRS) performance after the system is 
ordered and installed.

The All Stocks Rated Speed (ASRS) feature eliminates the slower speeds created by heavier weight stocks. With 
ASRS, only the size of the stock, and not its weight, governs the speed of the press. Therefore, all stock weights up to 
400 g/m2 for a given sheet size run at the rated speed, that is the top speed, for that stock size.

With the Xerox® Versant® 280 Press with All Stock Rated Speed (ASRS) performance option, the user experiences a 
25% increase in handling heavyweight stock. 

Note: If you purchase the optional All Stocks Rated Speed (ASRS) package, the Interface Decurler Module for 
All Stocks Rated Speed (ASRS) is required, regardless of any additional finishing devices.

PRESS WITH OPTIONAL PERFORMANCE PACKAGE

Important: The Performance Package is ordered prior to initial installation of the system. It is not possible to 
upgrade an existing press with the Performance Package after the press is ordered and installed.

The optional Performance Package is a suite of technologies and tools that enhances the capabilities of the base 
press in three areas: operational speed, color management automation, and print shop productivity.

The Performance Package is comprised of the following technologies and tools:

• All Stocks Rated Speed (ASRS) software

• Automated Color Quality System (ACQS) software

• Inline Spectrophotometer (ILS), which is included with the Interface Decurler Module

• Xerox EX 280 Print Server

AAllll SSttoocckkss RRaatteedd SSppeeeedd ((AASSRRSS))

The All Stocks Rated Speed (ASRS) feature eliminates the slower speeds created by heavier weight stocks. With 
ASRS, only the size of the stock, and not its weight, governs the speed of the press. Therefore, all stock weights up to 
400 g/m2 for a given sheet size run at the rated speed, that is the top speed, for that stock size.
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AAuuttoommaatteedd CCoolloorr QQuuaalliittyy SSyysstteemm ((AACCQQSS))

The Automated Color Quality System (ACQS) is an advanced color management technology that transfers the 
complex decisions about color maintenance from operators to an automated system. ACQS automates the printing 
and measuring of calibration charts and then calculates and makes precise adjustments to color tables based on 
the results.

Note: The ACQS suite is available only with the external Xerox® EX 280 Print Server, Powered by Fiery®. It is 
not available with the Xerox® EX-i 280 Print Server, Powered by Fiery®.

ACQS takes the variability out of the color equation by incorporating standardized color measurements. The 
standardized color measurements use the Inline Spectrophotometer on the Interface Decurler Module. The Inline 
Spectrophotometer calibrates color on the press and generates accurate destination profiles for different stocks.

Procedures are automated in that they eliminate the need for an operator to scan target sheets manually using an 
external spectrophotometer. The operator initiates the procedure at the print server, but all target sheets are 
generated and scanned automatically, and all measurements, calculations, and corrections are performed 
automatically.

IInnlliinnee SSppeeccttrroopphhoottoommeetteerr ((IILLSS))

The Inline Spectrophotometer (ILS) is housed in the Interface Decurler Module. The ILS enables the Automated 
Color Quality Suite (ACQS). ACQS automates the process of ensuring stable and accurate color from job to job. This 
automation eliminates the need for operators to use a hand-held spectrophotometer during print server calibration. 
It also facilitates the creation of custom destination profiles for each stock on which the press prints.

With the ILS placed strategically within the paper path, automated processes are quick to perform and require less 
downtime for the press. Automated processes include measurements for calibration and destination profiling. Over 
time, the ACQS software and the ILS hardware work together to provide accurate and more stable color.

In addition to the Inline Spectrophotometer (ILS), the Interface Decurler Module provides cooling for the press 
when the press is running at higher speeds. Also, the Interface Decurler Module provides a decurler to ensure flat 
sheets for finishing.

CCoonnffiigguurraattiioonn IInnffoorrmmaattiioonn RReeggaarrddiinngg tthhee PPeerrffoorrmmaannccee PPaacckkaaggee

1. The Performance Package must be ordered when the press is ordered. Once the press has been configured 
without the Performance Package option, it cannot be upgraded later to include the package.

2. The Performance Package is not available with the Xerox EX-i 280 Print Server. Customers are required to order 
the external Xerox EX 280 Print Server.

3. If customers configure the press with the Business Ready (BR) Finisher, the Business Ready Finisher with Booklet 
Maker, or the Offset Catch Tray, the Performance Package option is not available for the configuration.

4. The Performance Package requires the Interface Decurler Module with ILS.

5. Finishing options that are enabled when the Interface Decurler Module with ILS is installed include these 
finishers and their options: 

• Inserter device

• GBC® AdvancedPunch® Pro

• High Capacity Stacker (HCS)

• Crease and Two-Sided Trimmer
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• C/Z Folder

• Production Ready (PR) Finisher

• PR Booklet Maker Finisher

• PR Finisher Plus

• SquareFold® Trimmer device. This device requires the PR Booklet Maker Finisher

• Plockmatic® Pro 35 and Plockmatic® Pro 50. This device requires the PR Finisher Plus
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Print Server Overview

The print server networked with your press accepts, processes, and manages document files for job submission to 
the press.

One of the following print servers can be used with your press:

• Xerox® EX 280 Print Server, Powered by Fiery®

• Xerox® EX-i 280 Print Server, Powered by Fiery®

Fiery® Print Servers version 3.0 include Fiery System version FS600 and have unique features that are not available 
on older Fiery® Print Servers. To find your print server version or Fiery System version, on the Command WorkStation 
window, go to Server > Device Center > GENERAL > General Info, then refer to Fiery Server or Fiery System. 
This information is accessible also on the Fiery configuration page, printed through Fiery® Print Server.

Note: For detailed information on your specific print server, refer to the customer documentation that was 
delivered with it. Documentation can also be downloaded from www.xerox.com by searching for the press 
and selecting the Support link or go to Fiery - Xerox Versant 280 Press.
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Specifications

RRaatteedd SSppeeeedd

Full color or black only: 80 pages per minute of Letter (8.5 x 11 in.), A4 paper size

PPrriinntt MMooddeess

Two print modes are supported and are specified at the print server:

• 4 Color Mode (CMYK)

• Black and White Mode (Grayscale)

MMaaxxiimmuumm PPrriinnttaabbllee AArreeaa

• Default Border: 4 mm on the leading edge and 2 mm on the remaining sides

• For Trays 1–3, 6, 7, and Tray 5 (Bypass): 

– 323 x 482 mm (12.72 x 18.98 in.) before adjustment 

– 326 x 482 mm (12.83 x 18.98 in.) after adjustment 

• For Tray 5 (Bypass), Extra Long Sheet: 

– 323 x 654 mm (12.72 x 25.75 in.) before adjustment, when connected to the optional Oversized High 
Capacity Feeder 

– 326 x 654 mm (12.83 x 25.75 in.) after adjustment, when connected to the optional Oversized High 
Capacity Feeder 

• Image Quality Assurance Area: 

– Print: 317 x 482 mm (12.48 x 18.98 in.) 

– Copy: 293 x 426 mm (11.54 x 16.77 in.) 

PPaappeerr SSiizzee RRaannggeess

• Minimum: 

– Trays 1–3: 140 x 182 mm (5.51 x 7.17 in.) 

– Tray 5 (Bypass): 96 x 146 mm (3.78 x 5.75 in.) 

– Trays 6, 7 (optional Advanced Oversized High Capacity Feeder without Envelope Support Kit): 182 x 182 
mm (7.17 x 7.17 in.) 

– Trays 6, 7 (optional Advanced Oversized High Capacity Feeder with Envelope Support Kit): 98 x 182 mm 
(3.86 x 7.17 in.) 

– Tray 6 (optional Oversized High Capacity Feeder with Envelope Support Kit): 100 x 182 mm (3.94 x 7.17 in.) 

• Maximum:  

– Trays 1–3: 330.2 x 488 mm (13 x 19.2 in.) 

– Tray 5 (Bypass): 330.2 x 488 mm (13 x 19.2 in.) 
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– Tray 5 (Bypass) Extra Long Sheet, 1-sided: 330.2 x 660 mm (13.0 x 26.0 in.) 

– Trays 6, 7 (optional Advanced Oversized High Capacity Feeder): 330.2 x 488 mm (13.0 x 19.2 in.) 

PPrriinnttiinngg RReessoolluuttiioonn

• Print Engine Imaging Resolution: 2400 x 2400 dpi 

• Print Server RIP Resolution (print server to print engine): 1200 x 1200 dpi

FIRST-PRINT-OUT TIME

First Print-Out Time is measured from the time that the printer starts to the time the trailing edge of the sheet exits 
the Offset Catch Tray.

Note: If the system is equipped with various types of finishing devices, the First-Print-Out Time varies 
depending on the length of the paper path required to transport that paper.

• From a cold start (power on or power saver), the system takes less than 5 minutes to start printing.

• From standby mode, the system usually takes less than 1 minute to start printing.

• In Ready Mode, on average, the First-Print-Out Time is less than 8 seconds for color and less than 10 seconds for 
black and white.

• When you copy or print during initial power on, the system requires 30–45 seconds to produce the first print.

• Switching from a color mode job to a black and white job or the reverse requires on average 30–60 seconds.

• 60 seconds is needed after a paper jam. to ensure that the system is recovered from possible contamination, 
and to ensure that the image quality is optimized.

PRESS WARM-UP TIME

The press warm-up times vary depending on the current state or mode of the press. Warm-up times are listed as 
follows:

• From a cold start (power on or power saver mode), less than 5 minutes

• From Sleep Mode or Power Saver, less than 5 minutes

• From Standby Mode, less than 1 minute

• When switching print modes (such as from black only to full color), approximately 2 minutes
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DUPLEX AUTOMATIC DOCUMENT FEEDER (DADF)  SPECIFICATIONS

ITEM SPECIFICATION 

Document Size and Type SSiizzee: 

Maximum: A3, 297 x 432 mm (11 x 17 in.)

Minimum: A5, 148 x 210 mm (5.82 x 8.26 in.)

Weight: 38–200 g/m2, 10–53 lb., 2-sided: 50–200 g/m2

TTyyppee:

A5, A5, A4, A4, 8.5 × 11 in., 8.5 × 14 in. (SEF), 11 × 17 in. (SEF)

Paper Capacity 250 sheets 

When you use Xerox 75 g/m2, 20 lb. paper.

Document Productivity 

(8.5 x 11 in., A4 portrait, 1-sided)

A4 LEF or Letter LEF: 
• 1-sided to 1-sided, full color: 75 dpm* or more 
• 1-sided to 1-sided, black and white: 75 dpm or more 
• 2-sided to 2-sided, full color: 75 dpm or more 
• 2-sided to 2-sided, black and white: 75 dpm or more 

* Documents per minute (dpm)

COPY SPECIFICATIONS

ITEM SPECIFICATION 

Copier Type Console 

Scanning Resolution 600 x 600 dpi 

Output Resolution 600 x 600 dpi 

Gradation 256 gradation 

Warm-up Time 5 minutes or less, when the room temperature is 20° C (68° F) 

Copy Document The maximum size is 297 x 432 mm (11 x 17 in.), A3 for both sheets and books 

Copy Paper Size Maximum: 320 x 488 mm (12.6 x 19.2 in.), 330 x 483 mm (13 x 19 in.) 

Minimum: A5, 5.75 x 8.25 in. (Postcard for Tray 5 (Bypass))

Image loss:

• Leading edge and trailing edge: 4 mm (0.157 in.) or less 
• Front and back: 4 mm (0.157 in.) or less. 

PPaappeerr TTrraayyss 11––33 

A5, A4 LEF, A4 SEF, A3, B5, B4
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ITEM SPECIFICATION 

8.5 x 11 in. LEF, 8.5 x 11 in. SEF, 8.5 x 13 in., 8.5 x 14 in., 11 x 17 in., 12.6 x 19.2 
in. (320 x 488 mm)

8K, 16K, tab paper (8.5 x 11 in., A4)

Non-standard size: X direction from 140–330 mm (5.5–13 in.), Y direction from 
182–488 mm (7–19 in.)

TTrraayy 55 ((BByyppaassss))

A6, A5, A4 LEF, A4 SEF, B4

8.5 x 11 in. LEF, 8.5 x 11 in. SEF, 8.5 x 13 in., 8.5 x 14 in., 11 x 17 in., 12 x 18 in., 
12.6 x 19.2 in. (320 x 488 mm), 13 x 19 in. (330 x 483 mm)

8K, 16K

Non-standard size: X direction from 148–488 mm (5.8–19 in.), Y direction from 
100–330 mm (4–13 in.)

Copy Paper Trays 1–3: 52–256 g/m2 

Tray 5 (Bypass): 52–400 g/m2

Trays 6, 7 (optional Advanced OHCF): 52–400 g/m2

Use Xerox recommended papers for best results.

First Copy Output Time 

Values can differ depending 
on press configuration.

Trays 1–3: 
• Black and white: 5.2 seconds or less 
• Full color: 9 seconds or less 

These times apply when 100% Reduction/Enlargement and 8.5 x 11 in. or A4 
are used.

Copy Reduction and 
Enlargement Ratio 

100%: 1:1 ± 0.7% 

Preset%: 1:0.500,1:0.707,1:0.816,1:0.866, 1:1.154,1:1.225,1:1.414,1:1.632, 
1:2.000

Variable%: 1:0.25–1:4.00, in 1% increments

Continuous Copy Speed 

The speed may be reduced in 
order to adjust image quality.

The performance may be 
reduced depending on the 
paper type.

A4 LEF or Letter LEF: 
• 1-sided to 1-sided, full color: 80 ppm 
• 1-sided to 1-sided, black and white: 80 ppm 
• 2-sided to 2-sided, full color: 80 ppm 
• 2-sided to 2-sided, black and white: 80 ppm 
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ITEM SPECIFICATION 

Paper Feed Method and 
Capacity 

SSttaannddaarrdd: 
• Trays 1–3: 550 sheets 
• Tray 5 (Bypass): 250 sheets 
• Optional Trays 6, 7: 2000 sheets for each tray, total of 4000 sheets 
• Maximum paper capacity: 9900 pages, including Trays 8 and 9, optional 

Advanced Oversized High Capacity Feeder 

The maximum paper capacity, 9900, is based on 90 g/m2, 24 lb. Xerox Bond 
Digital Uncoated Paper.

Continuous Copy Pages 9999 sheets 

The press can pause temporarily to perform image stabilization.

SCAN SPECIFICATIONS

ITEM COLOR SCANNER 

Scan Size Maximum size: 297 x 432 mm (11 x 17 in.), A3 for both sheets and books 

Scan Resolution 600 x 600 dpi, 400 x 400 dpi, 300 x 300 dpi, 200 x 200 dpi 

Scan Graduation Color: 10-bit input or 8-bit output for each RGB color 

Monochrome: 

• 1-bit input, 1-bit output (2 tones), or 
• 8-bit Grayscale output (256 tones) 

Document Scan Speed For 8.5 x 11 in. or A4: 
• 200 dpi Black & White: 100 IPM (Images per minute) 
• 600 dpi Full Color: 80 IPM (Images per minute) 

Scanning speeds change depending on the original document type.

Interface Sharing with print controller 

Scan to Folder Supported protocol: TCP/IP (Salutation, HTTP) 

Output format:

• Monochrome (2 colors: TIFF) 
• Driver: TWAIN (Salutation) 
• Driver-supported Operating Systems: Windows 10, Windows 7, 

Windows Server 2008, Mac OS 10.6 
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ITEM COLOR SCANNER 

Scan to PC • Supported protocol: TCP/IP (SMB, FTP), NetBEUI (SMB) 
• Supported Operating Systems: Windows 10, Windows 7, Windows 

Server 2008, Mac OS 10.6 
• SMB protocol only is supported. 
• FTP protocol only is supported. 

Output format:

• Monochrome 2 colors: TIFF (compression type: MH and MMR) 
• DocuWorks 
• PDF 

E-mail Supported protocol: TCP/IP (SMTP) 

Output format

• Monochrome 2 colors: TIFF (compression type: MH and MMR) 
• DocuWorks 
• PDF 

ENVIRONMENTAL SPECIFICATIONS

For the press system to operate, the temperature and relative humidity of the room where the press is located 
needs to be within the minimum and maximum allowable temperature and relative humidity limits.

AAmmbbiieenntt tteemmppeerraattuurree

• The operating temperature range is 10–32° C (50–90° F)

• Ambient temperature for optimal image quality and paper handling performance is achieved at 20–24° C (68– 
76° F)

Note: The press can operate outside of this range, but the performance cannot be guaranteed.

RReellaattiivvee hhuummiiddiittyy

• The required humidity range is 15–85% (relative humidity) - (RH) J zone (Dew condensation is inhibited)

• Relative humidity for optimal image quality and paper handling performance is achieved at 45% RH

Note: The press can operate outside of this range, but the performance cannot be guaranteed.

AAllttiittuuddee

The press functions at the elevation of 0–2500 meters (0–8200 feet)
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Getting Help

HELP ON THE XEROX WEB SITE

For technical product support, Xerox supplies, customer documentation, and answers to frequently-asked questions, 
go to www.xerox.com. You will find the latest documentation and the knowledge base under Support & Drivers. 
Use the Contact link for specific contact information/telephone numbers in your area.

Note: Be sure to periodically check this website for the latest information on your product.

It may be helpful to know your press serial number before calling for support. The press serial number is shown on 
the Device Information tab: Machine Status > Device Information.

PRINT SERVER CUSTOMER DOCUMENTATION

The Fiery Print Server Help menu on the Command WorkStation window is designed to provide information on 
specific work flows when using the Command WorkStation. Additional user documentation supplied by Fiery is 
available to you from www.xerox.com under the Customer Support > Support and Drivers link.

XXeerrooxx EEaassyy VViittaallss

Fiery® Print Servers version 3.0, FS600, introduces a new feature called Easy Vitals. It is a dashboard available in 
the printer server, showing graphical and numeric indicators of key elements of the digital press. The dashboard 
also shows warning messages associated with the press. The key elements in the Easy Vitals dashboard include: 

• Temperature and Humidity

• Toner levels

• Waste toner bottle status

• High Frequency Service Items (HFSI) status

You can access Easy Vitals dashboard from Fiery Command WorkStation. From the print server menu, click Easy 
Vitals. Data on the Easy Vitals dashboard is updated shortly after the print engine has cycled down. Temperature 
and Humidity data are from sensors inside the print engine and can vary from the operating environment of the 
press.

For more information, refer to Fiery - Xerox Versant 280 Press.

XXeerrooxx®® FFrreeeeFFllooww®® VViissiioonn CCoonnnneecctt

Xerox® FreeFlow® Vision Connect is a Web-based software solution that offers real-time, at-a-glance visibility and 
control of production operations. The dashboard screen monitors, tracks, and benchmarks performance across 
printers and sites. To access FreeFlow® Vision Connect web application, install the Vision Connect Printer Agent on 
your Fiery Print Server. For more information, refer to Xerox® FreeFlow® Vision Connect Web Application User Guide 
available at Workplace and Digital Printing Solutions | Xerox. 

Note: Xerox® FreeFlow® Vision Connect web application is not available for the integrated print server, 
Xerox® EX-i 280 Print Server, Powered by Fiery®.
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MORE INFORMATION

Refer to the following sources for more information about your press and its capabilities.

RESOURCE LOCATION 

Other documentation for your printer Print Server Documentation: For more information, refer to the 
Fiery documentation that shipped with the print server. After 
installation is complete, it is recommended that you or your 
System Administrator get additional print server documentation 
for later reference from www.xerox.com/VERSANT_280docs or 
Fiery - Xerox Versant 280 Press. 

Recommended Media List United States: www.xerox.com/rmlna

Europe: www.xerox.com/rmleu

Technical support information for your 
printer; including online technical support, 
Online Support Assistant, and print driver 
downloads. 

Go to www.xerox.com/VERSANT_280support. 

Information Pages To print from the control panel, press the Machine Status 
button, then touch Device Information. 

To print from the CentreWare® Internet Services, click Support, 
then on the Online Support, click Connect.

Order supplies for your printer Go to www.xerox.com/VERSANT_280supplies

Local sales and Technical Customer Support Go to www.xerox.com/office/worldcontacts

Printer registration Go to www.xerox.com/register

It is recommended that you print all customer documentation and keep it close to the machine.

Note: For the latest documentation updates for your Xerox Digital Press, go to www.xerox.com/VERSANT_ 
280docs or www.xerox.com/VERSANT_280support.

Before you contact Xerox for support, ensure that you have the serial number of your Xerox press. To locate the 
press serial number, refer to Locating the Press Serial Number.
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Regulatory Information

BASIC REGULATIONS

Xerox® has tested this printer to electromagnetic emission and immunity standards. These standards are designed 
to mitigate interference caused or received by this printer in a typical office environment.

Changes or modifications to this device not specifically approved by the Xerox® Corporation may void the user's 
authority to operate this equipment.

FCC Regulations in the USA

This product has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of 
the Federal Communications Commission (FCC) Rules. These limits are designed to provide reasonable protection 
against harmful interference when the equipment is operated in a commercial environment. This equipment 
generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the 
instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a 
residential area is likely to cause harmful interference in which case the user will be required to correct the 
interference at his or her own expense.

Changes or modifications to this equipment not specifically approved by the Xerox® Corporation may void the 
user’s authority to operate this equipment.

To maintain compliance with FCC regulations, shielded cables must be used with this equipment. Operation with 
non-approved equipment or unshielded cables is likely to result in interference to radio and TV reception. 

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: 

1. This device may not cause harmful interference, and

2. This device must accept any interference received, including interference that may cause undesired operation.

Responsible Party: Xerox® Corporation

Address: 800 Phillips Road, Webster, NY 14580

Web address: www.xerox.com/environment

Canada

This Class A digital apparatus complies with Canadian ICES-003 and ICES-001.

Cet appareil numérique de la classe A est conforme à la norme NMB-003 et NMB-001 du Canada.

This device complies with Industry Canada’s license-exempt RSSs. Operation is the subject to the following two 
conditions: 

1. This device may not cause interference, and

2. This device must accept any interference, including interference that may cause undesired operation of the 
device.

Le présent appareil est conforme aux CNR d’Industrie Canada applicables aux appareils radio exempts de licence. 
L’exploitation est autorisée aux deux conditions suivantes: 
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1. l’appareil ne doit pas produire de brouillage, et

2. l’utilisateur de l’appareil doit accepter tout brouillage radioélectrique subi, même si le brouillage est susceptible 
d’en compromettre le fonctionnement.

European Union and European Economic Area Compliance

The CE mark applied to this product indicates compliance to applicable EU Directives. You 
can find the full text of the EU Declaration of Conformity in www.xerox.com/environment_ 
europe.

European Union Lot 4 Imaging Equipment Agreement

Xerox® has agreed to design criteria for energy efficiency and environmental performance of our products that are 
in scope of the European Union (EU) Energy Related Products Directive, specifically the Lot 4 - Imaging Equipment.

In scope products include Household and Office equipment that meet the following criteria: 

• Standard monochrome format products with a maximum speed less than 66 A4 images per minute.

• Standard color format products with a maximum speed less than 51 A4 images per minute.

TO LEARN MORE ABOUT GO TO 

• Power Consumption and Activation Times 
• Default Power Saver Settings 

User Documentation or Systems Administrators Guide 

www.xerox.com/VERSANT_280docs

• Benefits of purchasing ENERGY STAR® 

qualified products 
www.energystar.gov

• Environmental Benefits of Duplex Printing 
• Benefits of using lighter paper weights (60 

g/m2) and Recyclability 
• Cartridge disposal and treatment 
• Xerox participation in sustainability 

initiatives 

www.xerox.com/environment or www.xerox.com/environment_ 
europe

European Union Lot 19 Ecodesign Directive

Per European Commission Ecodesign Directive, the light source contained within this product or its components is 
intended to be used for Image Capture or Image Projection only, and is not intended for use in other applications.

EPEAT

This device is registered in the EPEAT directory for meeting the ecolabel properties. Included is the factory defaulted 
Sleep mode enablement. In Sleep mode the printer uses less than 1 Watt of power.

To learn more about Xerox participation in sustainability initiatives, go to: www.xerox.com/about-xerox/ 
environment/enus.html or www.xerox.co.uk/about-xerox/environment/engb.html.
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Environmental Benefits of Duplex Printing

Most Xerox® products have duplex printing, also known as 2-sided printing, capability. This enables you to print on 
both sides of the paper automatically, and therefore helps to reduce the use of valuable resources by reducing your 
paper consumption. The Lot 4 Imaging Equipment agreement requires that on models greater than or equal to 40 
ppm color or greater than or equal to 45 ppm monochrome the duplex function has been auto-enabled, during the 
setup and driver installation. Some Xerox models below these speed bands may also be enabled with 2-sided 
printing settings defaulted on at the time of install. Use of the duplex function will reduce the environmental impact 
of your work. However, you must require simplex or 1-sided printing, you can change the print settings in the print 
driver.

Paper Types

You can use this product to print on both recycled and virgin paper, approved to an environmental stewardship 
scheme, which complies with EN12281 or a similar quality standard. Lighter weight paper (60 g/m2), which contains 
less raw material and thus saves resources per print, can be used in certain applications. We recommend you to 
check if this is suitable for your printing needs.

ENERGY STAR

The ENERGY STAR program is a voluntary scheme to promote the development and purchase of 
energy-efficient models, which help to reduce environmental impact. Details on the ENERGY STAR 
program and models qualified to ENERGY STAR can be found at the following website: www. 
energystar.gov.

The ENERGY STAR and ENERGY STAR mark are registered United States trademarks.

The ENERGY STAR Imaging Equipment Program is a team effort between United States, European 
Union, Japanese governments, and the office equipment industry to promote energy-efficient 
copiers, printers, fax, multifunction printers, personal computers, and monitors. Reducing product 
energy consumption helps combat smog, acid rain, and long-term changes to the climate by 
decreasing the emissions that result from generating electricity.

For more information on energy or other related topics, go to:

• www.xerox.com/environment or

• www.xerox.com/environment_europe

Power Consumption and Activation Time

The amount of electricity that a device consumes depends on the way the device is used. This device is designed 
and configured to enable you to reduce your electricity usage.

Power Saver modes are enabled on your device to reduce energy consumption. After the last print, the device goes 
to Ready mode. In this mode, the device can print again immediately. If the device is not used for a specified 
period, the device goes to Low Power mode, then to Sleep mode. In these modes, to enable reduced-power 
consumption, only essential functions remain active. The device takes longer to produce the first print after it exits 
the Power Saver modes than it takes to print in Ready mode. This delay is the result of the system waking up and is 
typical of most imaging devices on the market.

To save power, you can enable Auto Power Off mode on your device. If Auto Power Off mode is enabled, you can 
configure the mode as follows:
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• AAllwwaayyss AAlllloowweedd: The device powers off automatically after the specified time, and the cumulative Low Power 
mode and Sleep mode time outs have elapsed.

• AAlllloowweedd OONNLLYY WWhheenn tthhee CCoonnddiittiioonnss aarree MMeett: The device automatically powers off only after time outs have 
elapsed. The device also powers off if USB Drive, and Wired and Non-Wired Network are not activated.

To change the Power Saver settings, refer to the User Documentation at www.xerox.com/VERSANT_280docs. For 
more details, contact your System Administrator or refer to the System Administrator Guide.

To enable Auto Power Off mode, contact your System Administrator. For details, refer to the System Administrator 
Guide at www.xerox.com/VERSANT_280docs.

To learn more about Xerox participation in sustainability initiatives, go to:

• www.xerox.com/environment or

• www.xerox.com/environment_europe

Default Power Saver Settings

This device is ENERGY STAR® qualified under the ENERGY STAR Program Requirements for Imaging Equipment. The 
Low-Power mode time can be configured up to 30 minutes. The default value is 1 minute. The Sleep mode time can 
be configured up to 30 minutes. The default value is 1 minute. Sleep mode begins after the configured time of 
inactivity rather than time after Low-Power mode.

To change the Default Power Saver settings, contact your System Administrator, or refer to the System 
Administrator Guide at www.xerox.com/VERSANT_280docs.

Note: Changing the default Power Saver activation times can result in an overall higher energy consumption 
of the device. Before you turn off Power Saver modes or set a long activation time, consider the increase in 
device power consumption.

Eurasian Economic Union Compliance

The EAC mark applied to this product indicates certification for use on the markets of the Member 
States of the Customs Union.

Turkey RoHS Regulation

In compliance with Article 7(d), we hereby certify “it is in compliance with the EEE regulation EEE yönetmeliğine 
uygundur.” (Compliant with EEE Regulations).

Ukraine RoHS Compliance

Обладнання відповідаєвимогам Технічного регламенту щодо обмеження

використання деяких небезпечних речовин в електричному та електронному

обладнані, затвердженого постановою Кабінету Міністрів України від 3 грудня 2008 № 1057

(The equipment complies with requirements of the Technical Regulation, approved by the Resolution of Cabinet of 
Ministry of Ukraine as of December 3, 2008, in terms of restrictions for the use of certain dangerous substances in 
electrical and electronic equipment.)
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COPY REGULATIONS

United States

Congress, by statute, has forbidden the reproduction of the following subjects under certain circumstances. Penalties 
of fine or imprisonment can be imposed on those guilty of making such reproductions.

1. Obligations or Securities of the United States Government, such as: 

• Certificates of Indebtedness

• National Bank Currency

• Coupons from Bonds

• Federal Reserve Bank Notes

• Silver Certificates

• Gold Certificates

• United States Bonds

• Treasury Notes

• Federal Reserve Notes

• Fractional Notes

• Certificates of Deposit

• Paper Money

• Bonds and Obligations of certain agencies of the government, such as FHA and so on

• Bonds. United States Savings Bonds can be photographed only for publicity purposes for the campaign of 
the sale of such bonds

• Internal Revenue Stamps. If it is necessary to reproduce a legal document on which there is a canceled 
revenue stamp, this can be done provided the reproduction of the document is performed for lawful 
purposes

• Postage Stamps, canceled or uncanceled. For philatelic purposes, Postage Stamps can be photographed, 
provided the reproduction is in black and white and is less than 75% or more than 150% of the linear 
dimensions of the original document

• Postal Money Orders

• Bills, Checks, or Drafts of money drawn by or upon authorized officers of the United States

• Stamps and other representatives of value, of whatever denomination, which have been or can be issued 
under any Act of Congress

• Adjusted Compensation Certificates for Veterans of the World Wars

2. Obligations or Securities of any Foreign Government, Bank, or Corporation

3. Copyrighted materials, unless permission of the copyright owner has been obtained or the reproduction falls 
within the fair use or library reproduction rights provisions of the copyright law. Further information of these 
provisions can be obtained from the Copyright Office, Library of Congress, Washington, D.C. 20559. Ask for 
Circular R21.
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4. Certificate of Citizenship or Naturalization. Foreign Naturalization Certificates can be photographed.

5. Passports. Foreign Passports can be photographed.

6. Immigration papers

7. Draft Registration Cards

8. Selective Service Induction papers that bear any of the following Registrant information: 

• Earnings or Income

• Court Record

• Physical or mental condition

• Dependency status

• Previous military service

• Exception: United States military discharge certificates can be photographed

9. Badges, Identification Cards, Passes, or Insignia carried by military personnel, or by members of the various 
Federal Departments, such as FBI, Treasury, and so on, unless the head of such department or bureau orders a 
photograph.

Reproducing the following items is prohibited in certain states: 

• Automobile Licenses

• Driver Licenses

• Automobile Certificates of Title

The above list is not all-inclusive, and no liability is assumed for its completeness or accuracy. If there is doubt, 
consult your attorney.

For more information about these provisions, contact the Copyright Office, Library of Congress, Washington, D.C. 
20559. Ask for Circular R21.

Canada

Parliament, by statute, has forbidden the reproduction of the following subjects under certain circumstances. 
Penalties of fine or imprisonment may be imposed on those guilty of making such reproductions: 

• Current bank notes or current paper money

• Obligations or securities of a government or bank

• Exchequer bill paper or revenue paper

• The public seal of Canada or of a province, or the seal of a public body or authority in Canada, or of a court of 
law

• Proclamations, orders, regulations or appointments, or notices thereof (with intent to falsely cause same to 
purport to have been printed by the Queen’s Printer for Canada, or the equivalent printer for a province)

• Marks, brands, seals, wrappers or designs used by or on behalf of the Government of Canada or of a province, 
the government of a state other than Canada or a department, board, Commission or agency established by 
the Government of Canada or of a province or of a government of a state other than Canada
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• Impressed or adhesive stamps used for the purpose of revenue by the Government of Canada or of a province 
or by the government of a state other than Canada

• Documents, registers or records kept by public officials charged with the duty of making or issuing certified 
copies thereof, where the reproduction falsely purports to be a certified copy thereof

• Copyrighted material or trademarks of any manner or kind without the consent of the copyright or trademark 
owner

This list is provided for your convenience and assistance, but it is not all-inclusive, and no liability is assumed for its 
completeness or accuracy. In case of doubt, consult your solicitor.

Other Countries

Copying certain documents may be illegal in your country. Penalties of fine or imprisonment may be imposed on 
those found guilty of making such reproductions.

• Currency notes

• Bank notes and checks

• Bank and government bonds and securities

• Passports and identification cards

• Copyright material or trademarks without the consent of the owner

• Postage stamps and other negotiable instruments

This list is not inclusive and no liability is assumed for either its completeness or accuracy. In case of doubt, contact 
your legal counsel.

SAFETY CERTIFICATION

This device is compliant with IEC and EN product safety standards certified by a National Regulatory Test 
Laboratory (NRTL).

SAFETY DATA SHEETS

For Material Safety Data information regarding your printer, go to: 

• Web address: www.xerox.com/sds or www.xerox.co.uk/sds_eu

• United States and Canada: 1-800-ASK-XEROX (1-800-275-9376)

• For other markets, send email request to: EHS-Europe@xerox.com
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Recycling and Disposal

ALL COUNTRIES

If you dispose your Xerox product, note that the printer may contain lead, mercury, perchlorate, and other materials 
whose disposal may be regulated due to environmental considerations. The presence of these materials is fully 
consistent with global regulations applicable at the time that the product was placed on the market. For recycling 
and disposal information, contact your local authorities.

Perchlorate Material: This product may contain one or more perchlorate-containing devices, such as batteries. 
Special handling may apply. For more information, go to www.dtsc.ca.gov/hazardouswaste/perchlorate.

Battery Removal

Only a manufacturer approved service facility can replace the batteries.

NORTH AMERICA

Xerox operates an equipment take-back and reuse or recycle program. Contact your Xerox representative (1-800- 
ASK-XEROX) to ensure that this Xerox product is part of the program. For more information about Xerox 
environmental programs, go to www.xerox.com/environment.

For recycling and disposal information, contact your local authorities.
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EUROPEAN UNION

These symbols indicate that this product is not to be disposed of with your household waste, 
according to the Waste Electrical and Electronic Equipment (WEEE) Directive (2012/19/EU), 
the Battery Directive (2006/66/EC) and national legislation implementing those Directives.

If a chemical symbol is printed beneath the symbol shown above, in accordance with the 
Battery Directive, this indicates that a heavy metal (Hg = Mercury, Cd = Cadmium, Pb = Lead) 
is present in this battery or accumulator at a concentration above an applicable threshold 
specified in the Battery Directive.

Some equipment can be used in both a domestic or household and a professional or 
business application. Private households within European Union can return used electrical 
and electronic equipment to designated collection facilities free of charge. For more 
information about collection and recycling of old products and batteries, contact your local 
municipality, your waste disposal service or the point of sale where you purchased the items. 
In some member states, when you purchase new equipment, your local retailer may be 
required to take back your old equipment free of charge. For more information, contact your 
retailer.

Business Users in the European Union, in accordance with European legislation, end of life 
electrical and electronic equipment subject to disposal must be managed within agreed 
procedures. If you discard electrical and electronic equipment, contact your dealer or 
supplier, local reseller or Xerox representative for end of life take-back information prior to 
disposal.

Improper handling of this type of waste can have a possible impact on the environment and 
human health due to potentially hazardous substances that are generally associated with 
EEE. Your cooperation in the correct disposal of this product will contribute to the effective 
usage of natural resources.

Disposal Outside of the European Union

These symbols are only valid in the European Union. If you want to discard these items, contact your local 
authorities or dealer and ask for the correct method of disposal

OTHER COUNTRIES

Contact your local waste management authority to request a disposal guidance.
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Power On or Off the Press

THE POWER SWITCHES

There are three power switches on the press:

• The Breaker switch located at the rear of the press. Initially check to ensure that this switch is set to On when 
the press is shipped. 

• The Main Power switch located inside the Front Door. This switch is used mainly by the Xerox Service 
Representative when servicing the press. In rare problem-solving cases, you are directed to power off the press 
with this switch. 

• The Power On/Off button located on the top of the press near the Document Feeder. This button is the primary 
way for you to power on or off the press. It is used by the operator as the workflow requires. 
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Use the Power On/Off button to power on or power off the press.

Important: To power off, always press the power button first. Wait until the lights on the user interface stop 
blinking, to allow the fuser to finish cooling. Move the main power switch to the off position.

POWER ON OR OFF THE PRESS

Power On the Press

1. Check that the Main Power switch behind the Front Door is On.

2. Press the Power button on top of the press to the ON position. 

The Services button glows blue. 

A screen message advises of a short wait while the fuser warms up and the press runs a system check. You can 
set features for a job during this time and the printing process will start automatically when the press is ready.

Power Off the Press

Important: Always power off the power button first, and then power off the main power switch.

1. Press the Power On/Off button on the top of the press to Off. 
Wait until the lights on UI stop blinking, as this allows the fuser to begin cooling.

2. Switch Off the Main Power switch behind the Front Door. 

Note: Allow the press to remain off for a minimum of 10 seconds before switching on the power again.

POWER SAVER

The Power Saver feature allows the press to enter a reduced power consumption mode when all print jobs have 
completed and there are no jobs currently processing. There are two power saving modes: Low Power and Sleep.

By default, the press automatically enters the Low Power mode after 1 minute of inactivity. After 1 minute of 
inactivity, the press then enters Sleep mode. These time intervals for both modes can be changed by the system 
administrator.

Refer to the following example:

• Low Power Mode is set to 1 minute. 

• Sleep Mode is set to 10 minutes.

• Sleep Mode activates after 10 minutes of total inactivity and not 10 minutes after the Low Power Mode begins.

Low Power Mode

In this mode, the power to the User Interface (UI) and fuser unit is lowered to save power. The display goes out 
and the Power Saver button on the UI lights. To use the press, press the Power Saver button. The Power Saver 
button is no longer lit, indicating that the Power Saver feature is canceled.
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Sleep Mode

In this mode, the power is lowered more than in the Low Power mode. The display goes out and the Power Saver 
button on the UI lights. To use the press, press the Power Saver button. The Power Saver button is no longer lit, 
indicating that the Power Saver feature is canceled.

Exiting Power Saver

The press exits Power Saver mode by doing one of the following:

• Pressing the Power Saver button on the press UI

• Receiving print data for an incoming job to be printed

• Programming and performing a copy or scan job
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Press Apps

PRINT

Print Job Submission

There are several ways in which to submit your job for printing:

• From your computer workstation (PC or Mac), using print drivers such as PostScript and Printer Command 
Language (PCL), you can submit a document file to the print server queue. From the print server, you would 
then submit the job to the press.  

Note: Make sure the appropriate print drivers have been installed on your computer. Refer to your print 
driver documentation or the Xerox web site for more information on how to download or install print 
drivers.

• At any remote workstation, using a Hot Folders application to submit the document file to the print server.

• At the print server, importing/adding a document file to a print queue. Manage the job settings of the 
document and then submit to the press for printing.

Printing from a Computer

The system supports Xerox® EX print drivers, Powered by Fiery®. Through print drivers installed on your computer or 
Mac, you can send a document file from your desktop to the print server, which can then be submitted to the press 
for printing.

Note: You can also use a drag and drop Hot Folders feature by which to send your files to the print server for 
printing to the press.

1. From your computer, select the file you want to print and open it in its application.

2. Select File > Print.

3. Select the desired print server queue.

4. Select the Properties button for the queue.

5. Select the desired output options such as quantity or 1–sided/2–sided printing.

6. Select OK to close the Properties window.

7. Select Print to send the job to the print server queue.

Printing a Job from the Print Server

The following is a basic workflow for setting up a job and submitting it from the print server:

1. At the press, load the appropriate paper to be used for the job.

2. From the press UI, ensure that the Paper Tray settings/Tray Properties window matches the stock properties for 
the paper you will use and that it is assigned to the same feeder tray where the paper is loaded.
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3. At the print server main window, customize your job such as inserting special pages and tabs and create your 
print queue that defines the attributes of those jobs sent to the queue.

4. Submit the job file from the print server to the networked press for printing.

Printing from the EX Print Server

From your computer, you can submit your document files (select Print) to a directory on the print server using 
installed print drivers. You could also copy the document files onto a USB flash drive or CD/DVD and then connect 
those devices to the print server for importing.

1. From the EX Print Server, select File > Import Job.

2. Select Add.

3. Locate your storage device or other directory containing the document files.

4. Select and highlight one of the document files. Select Open.

5. Select Import.

6. Select the desired queue such as Process and Hold or Print and Hold. 

The job is sent to the selected queue or to the press for immediate printing.

Printing on Tabs from the Print Server

Basic Procedure for Printing on Tabs from a Print Server

There are many types of tab stock and tab sequences available. Precut tabs are commonly used and have two 
different orientations: the single straight collated tab stock or the single reverse collated tab stock.

When programming tab jobs and loading tab stock, consider the following:

• Precut tabs can only print 1-sided

• There are specific job settings that you need to define such as tab order or sequence, number of bank sets, 
stock weight, paper size, and insertion before or after body pages. Refer to your print server documentation for 
more detailed setting information.

• Always load tab stock LEF into the tray where the straight edge of the stock is the lead edge and the tabs are 
oriented at the trail edge.

• Always use a complete set or bank or tabs in the paper tray.

• If staple or punch finishing, use tray 5 or, if available, trays 6 or 7.

The following are the basic steps for printing tabs on your press.

1. From the print server, create and define the Tab stock for the paper tray you will be using.

2. Load the Tab stock in Trays 1, 2, 3, 5, 6 or 7.

3. From the print server window, access the Held queue that contains your document. Select the document you 
want to configure with tabs. Double click to open the file properties.

4. Once all settings are made, select Print. 

The press prints the complete set of tabs with the body pages defined. Any extra tabs not used in the job are 
sent to the output tray.
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Tips for Printing on Tabs from the EX Print Server

Use the following tips for printing on tabs from the EX Print Server:

• The EX Print Server allows for setting up your job to print on tabs. Otherwise, you can set up your job to insert 
preprinted tabs into your document. Use one tray for the body pages, another tray for the preprinted tab stock, 
and another tray for cover or back pages.

• While you can print tab stock from any of the paper trays on the system (Trays 1, 2, 3, 5, 6 or 7), Trays 6 and 7 
should be used for best results. If you plan to apply staple or punch finishing, use Trays 5, 6 or 7 only.

• Loading orientation depends on what tray you are using.

COPY

Document Feeder and Glass

Document Feeder Tips

Tips for using the Duplex Automatic Document Feeder (DADF):

• For best output, ensure that the documents are in good condition.

• A maximum of 250 documents can be scanned at one time by using the document feeder.

• Mixed-size original documents can be used; however, the top left corners of the original documents must be 
aligned in the document handler.

• Remove any staples and paper clips from the documents before loading them in the document feeder.

Document Glass

Use the Document Glass for scanning and copying various types documents, such as bound originals (books), odd 
size documents, or poor-quality originals. Documents should be placed face down on the glass and aligned with the 
tip of the registration arrow in the top left corner.

The document glass accommodates document sizes up to a maximum of 11 x 17 in., A3.

Basic Copying Steps

Basic Copying with the Document Feeder (DADF)

1. Adjust the movable document guides to their widest position. 
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2. Load the documents face up with the first page on top and with the headings toward the back or left of the 
press. 

The confirmation indicator lights to show that the documents are loaded correctly. 

3. Press the Home button on the press UI.

4. Select Copy on theHome window.

5. Select the desired Copy features/options: 

• Paper Supply

• Reduce/Enlarge

• Output Color

• 2-Sided Copying

• Original Type

• Lighten/Darken
The features displayed on the main Copy window vary depending on how it is configured by the administrator.

6. Enter the quantity.

7. Press Start.

Basic Copying with the Document Glass

1. Open the document feeder. 

2. Place the document face down by aligning it as shown in the illustration. 

3. Press the Home button on the press UI.
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4. Select Copy on the Home window.

5. Select the desired Copy features or options: 

• Paper Supply

• Reduce or Enlarge

• Output Color

• 2-Sided Copying

• Original Type

• Lighten/Darken
The features displayed on the main Copy window vary depending on how it is configured by the administrator.

6. Enter the quantity.

7. Press Start.

Selecting Copy Options for a Third-Party Finishing Device

Read the following list before performing the procedure:

• If your press has an optional, third-party, Document Finishing Architecture (DFA) device attached, then this 
profile feature is available and specific copy options may be selected for a job.

• Prior to physically attaching the DFA device to the press, device profiles are created. The profiles represent the 
characteristics of your finishing device. 

• Refer to the third-party customer documentation for information on setting the profile values for the specific 
DFA device attached to the press.

• A profile for the job can be selected from the print server, the print driver on your computer, or the User 
Interface (UI). Depending on the DFA device, a maximum of twelve profiles are available. 

1. Place your original documents in the document feeder or on the document glass.

2. Press the Home button on the UI.

3. Select Copy on the Home window.

4. Select the Output Format tab. 

a. Select the DFA Finisher. 

The DFA Finisher Profile screen displays.

b. From the displayed list, select the profile for the job. 
If the device is an e-binder, select the binding position.

c. Select Save.

d. Select the desired Face Up/Down Output option.

5. Select the desired Copy features/options. 
The features displayed on the main Copy window vary depending on how it is configured by the administrator.

6. Enter the quantity.
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7. Press Start. 
If prompted on the UI, follow the instructions provided to correct any job submission errors. If there is a DFA 
problem, refer to your DFA documentation.

Copy Feature

Copy Feature Overview

Tip: Depending on how the Copy tab is configured by the administrator, this tab may contain different features 
than the ones listed here.

The Copy feature includes the following options:

• Reduce/Enlarge (R/E)

• Paper Supply (Auto Select)

• Output Color

• Copy Output

• 2 Sided Copying

• Original Type

• Darken/Lighten

Reduce/Enlarge

RReedduuccee aanndd EEnnllaarrggee

The reduce/enlarge (R/E) feature provides a variety of reduction and enlargement options to adjust the size of the 
output image. Originals can be enlarged or reduced from 25-400%. Various automatic and preset selections are 
available to help you choose the most common reductions or enlargements, while a custom setting enables you to 
select the ratio that suits your requirements. Basic reduction/enlargement options include:

110000%% oorr RR//EE eennttrryy bbooxx

The default setting in the R/E entry box is 100%. This selection produces an image on your copy exactly the 
same size as the image on your original document.
You can also set the R/E ratio by using the plus or minus buttons. In this case, the ratio is displayed in the R/E 
entry box.

AAuuttoo%%

This selection proportionally reduces or enlarges the image so that it will fit onto your chosen paper. If this 
option is selected, you must also select a specific paper tray.

PPrreesseett RR//EE bbuuttttoonnss

Depending on what the System Administrator has selected, you see several percentage options for reduction or 
enlargement. These buttons can be customized by the Administrator to display the reduction/enlargement 
ratios that you frequently use.

MMoorree

When the Reduce/Enlarge (R/E) More button is selected, a new window opens and displays additional R/E 
options.
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MMoorree RReedduuccee aanndd EEnnllaarrggee OOppttiioonnss

The Reduce/Enlarge (R/E) More options include:

PPrrooppoorrttiioonnaall %%

All of the options will reduce or enlarge the image by the same ratio in both directions so that the image gets 
bigger or smaller, but the proportion remain the same.

AAuuttoo %%

Proportionally reduces or enlarges the image so that it will fit onto your chosen paper. If this option is selected, 
you must also select a specific paper tray.

IInnddeeppeennddeenntt XX--YY %%

This option allows you to specify different height and width ratios to scale the height and width independently.
Auto X-Y % ensures copies are made with the height and width ratios set automatically to match the paper 
size.

AAuuttoo CCeenntteerr

This option allows you to specify individually the height and width values.

PPrreesseett ppeerrcceennttaaggee bbuuttttoonnss

The percentage buttons are preset for specific magnification levels by the administrator to reflect the 
percentages used most frequently.

Paper Supply

Select the desired tray to be used for your job; options include:

AAuuttoo SSeelleecctt

This option automatically detects the size of the original document and selects the proper tray for output.

TTrraayy bbuuttttoonnss

Allows you to select a specific tray containing the desired media for your job.

MMoorree bbuuttttoonn

Displays the Paper Supply screen showing all available trays for the machine and their media content.

Output Color

Select the desired Output Color option which best applies to the job. The options include:

AAuuttoo DDeetteecctt

This option allows the press to automatically detect if the original document is in color or black and white.

CCoolloorr

This option generates copies with full color output, using all four printing colors - cyan, magenta, yellow, and 
black.

BBllaacckk aanndd WWhhiittee

This option copies in black and white only. Colors in the original are converted to shades of gray.
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DDuuaall CCoolloorr

This option allows you to separate the colors of the original into two groups of colors for copying. The source 
color is extracted from the original and replaced by the target area color. The rest of the colors are replaced by 
the non-target area color that you select.

SSiinnggllee CCoolloorr

This option allows you to copy in one of the preset or custom colors.

MMoorree

This option allows you to customize the color for the copied output.

Copy Output

Important: Copy Output options vary depending on the finishing devices attached to your press.

Note: Copy Output may be accessed from the Copy tab or from the Output Format tab.

Use the Copy Output feature to select the desired options for your output; options include:

• Auto

• Collated

• Uncollated

• Uncollated with Separators

• Original Orientation

• Optional finishing features, including: 

– Output Destination/Offset 

– Stapling 

– Hole Punching 

– C/Z Folding 

2-Sided Copying

Note: The 2-Sided Copying option may be accessed either from the main Copy screen or from the Output 
Format tab.

Make one or two-sided copies from one or two-sided originals using the document feeder or the document glass. 
The two-sided option enables you to select your output in book or calendar orientation. Options include:

11--11 SSiiddeedd

Use this option if your originals are printed on one side and you want single-sided copies.

11--22 SSiiddeedd

Use this option if your originals are printed on one side and you want two-sided copies.

22--22 SSiiddeedd

Use this option if you want to make two sided copies from two-sided originals.
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22--11 SSiiddeedd

This option will make one-sided copies from two-sided originals.

OOrriiggiinnaallss aanndd CCooppiieess

Select the orientation of both your original documents and the output copies. Options include Head to Head 
andHead to Toe.

HHeeaadd ttoo HHeeaadd

This option is sometimes called Top-to-Top. For your original documents, select this option when all the pages of 
your original documents have the same orientation. For copy output, select this option to copy or print the 
reverse side of a page so that the finished document opens like a book.

HHeeaadd ttoo TTooee

This option is sometimes called Top-to-Bottom. For your original documents, select this option when the pages 
of your original documents have the opposite orientation such as on a calendar. For copy output, select this 
option to copy or print the reverse side of a page so that the finished document opens like a calendar.

OOrriiggiinnaall OOrriieennttaattiioonn

UUpprriigghhtt IImmaaggeess

Select this option when placing the top edge of the document against the top side of the document glass or 
document feeder.

SSiiddeewwaayyss IImmaaggeess

Select this option when placing the top edge of the document against the left side of the document glass or 
document feeder.

Original Type

Note: The Original Type option may be accessed from the main Copy screen or from the Image Quality tab.

The Original Type feature provides a convenient way to enhance the quality of your output based on the type of 
original images you are copying. Select the Original Type button on the Image Quality tab, then select the desired 
option.

AAuuttoo

This option sets the output color according to the document type preset in the System Administration mode.

PPhhoottoo aanndd TTeexxtt

Use this option if your original is from a magazine or other source that contains high quality photographs with 
text. This setting produces better pictures, but slightly reduces sharpness for text and line art.

TTeexxtt

Use this option if your original contains only text or line art. The result is sharper edges for the text and line art.

PPhhoottoo

This option is specifically designed to copy photographs or magazine pictures without any text or line drawings. 
This option prevents faint reproduction of colors.
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MMaapp

Use this option for making copies of documents that have text on colored backgrounds such as maps.

Darken or Lighten

Note: The Darken/Lighten option may be accessed from the main Copy screen or from the Image Quality 
tab and then by selecting Image Options.

The Darken/Lighten option provides manual control to adjust the lightness or darkness of the scanned images. 

• Select the Left scroll button to darken the scanned image from light originals such as pencil images.

• Select the Right scroll button to lighten the scanned image from dark originals such as half tones or originals 
with colored backgrounds.

Image Quality Feature

Original Type Option for Image Quality

Note: The Original Type option may be accessed from the main Copy screen or from the Image Quality tab.

The Original Type feature provides a convenient way to enhance the quality of your output based on the type of 
original images you are copying. Select the Original Type button on the Image Quality tab, then select the desired 
option.

AAuuttoo

This option sets the output color according to the document type preset in the System Administration mode.

PPhhoottoo aanndd TTeexxtt

Use this option if your original is from a magazine or other source that contains high quality photographs with 
text. This setting produces better pictures, but slightly reduces sharpness for text and line art.

TTeexxtt

Use this option if your original contains only text or line art. The result is sharper edges for the text and line art.

PPhhoottoo

This option is specifically designed to copy photographs or magazine pictures without any text or line drawings. 
This option prevents faint reproduction of colors.

MMaapp

Use this option for making copies of documents that have text on colored backgrounds such as maps.

Image Quality Feature Overview

The Image Quality feature includes the following options:

• Original Type

• Image Options

• Image Enhancement

• Color Effects
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• Color Balance

• Color Shift

Selecting Image Quality Options

1. Load the document or documents onto the Document Glass or into the Document Feeder.

2. Press the Home button on the press UI.

3. Select Copy on theHome window.

4. Select the Image Quality tab.

5. From the Image Quality window, select the desire options: 

• Original Type

• Image Options

• Image Enhancement

• Color Effects

• Color Balance

• Color Shift

6. Select the Copy tab.

7. Select the desired Copy options including: 

• Paper Supply

• Reduce/Enlarge

• 2-Sided Copying

8. Select any other desired Copy features/options (such as Layout Adjustment, Output Format).

9. Enter the quantity.

10. Press Start on the UI.

Image Options

Use the Image Options feature to make adjustments to the following options:

LLiigghhtteenn//DDaarrkkeenn

This option provides manual control to adjust the lightness or darkness of the scanned images.  

• Select the Down scroll button to darken the scanned image from light originals such as pencil images. 

• Select the Up scroll button to lighten the scanned image from dark originals such as half tones or originals 
with colored backgrounds. 

SShhaarrppnneessss

This option controls the balance between sharp text and moiré (patterns within the image). Move the slider 
control down (Soften) to produce an image with a smooth, uniform appearance ideally suited for photographic 
scanned images. Move the slider control up (Sharpen) to produce an image with better quality text or line art.

SSaattuurraattiioonn

This option allows colors to become more or less vivid. To make the colors on your output more vivid, move the 
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slide bar up. To create a less vivid output or a pastel effect, move the slide bar down. To keep the output normal, 
do not adjust the saturation.

Image Enhancement

Use the Image Enhancement settings when your scanned image requires more than the basic image quality. There 
are two features associated with Image Enhancement:

SSuupppprreessss BBaacckkggrroouunndd

This option prevents reproduction of unwanted shading from originals where the opposite side printing shows 
through.
Off
Auto Suppression: This option automatically reduces or eliminates any background on the copies caused by 
colored paper or newspaper originals.

CCoonnttrraasstt

Selections are Auto Contrast or Manual Constrast. The Constrast feature controls the difference between the 
image densities within the scanned image. Lower contrast settings reproduce more detail in light and dark areas 
of the original. Higher contrast settings produce vivid blacks and whites for sharper text and lines, but produce 
less detail in pictures. Auto Correction automatically chooses the best settings for your job.

Color Effects

This feature produces balanced image tones on your output. Options include:

LLiivveellyy

This option uses the highest color saturation to produce rich, vivid output colors. The option increases the color 
saturation of the most vivid setting in order to produce fresher images.

BBrriigghhtt

This option produces images that have a brighter appearance and enhanced contrast.

WWaarrmm

This option produces a soft image on the output and adding a warm, reddish tint to low density colors. Use this 
setting to apply a light pink tone to skin colors and to give a soft tone to dark, warm colors.

CCooooll

This option produces a strong, clear blue tone on the output. This setting makes blue color stronger and makes 
dark, cold colors clearer.

SShhaaddooww SSuupppprreessssiioonn

This option reduces or eliminates any background shadow caused by colored paper or newspaper originals.

Color Balance

This feature allows you to adjust the balance between colors and the overall amount of color on the output copies. 
You can adjust the levels of all four process colors (Yellow, Magenta, Cyan, and Black) for their low, medium, and 
high density ranges.

• The default option is Normal. 

• Basic Color adjusts the density. 
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• Advanced Color adjusts the Highlights, Midtones, and Shadows.

Color Shift

This feature allows you to shift all hues in an image simultaneously in order to make the overall character of the 
output image warmer or cooler. For example, if you select one of the:

NNoorrmmaall

This is the default option.

PPlluuss bbuuttttoonnss

The red colors shift toward the yellow hue, the green colors shift toward the cyan hue, and the blue colors shift 
toward the magenta hue. All colors between these original colors also shift in the same direction.

MMiinnuuss bbuuttttoonnss

The red colors shift toward the magenta hue, the blue colors shift toward the cyan hue, and the green colors 
shift toward the yellow hue. Again, all colors between these original colors also shift in the same direction.

Layout Adjustment Feature

Layout Adjustment Feature Overview

The Layout Adjustment feature includes the following options:

• Book Copying

• 2 Sided Book Copying

• Original Size

• Edge Erase

• Image Shift

• Image Rotation

• Invert Image

• Original Orientation

Selecting Layout Adjustment Options

1. Load the document or documents onto the Document Glass or into the Document Feeder.

2. Press the Home button on the press UI.

3. Select Copy on theHome window.

4. Select the Layout Adjustment tab.
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5. From the Layout Adjustment window, select the desire options: 

• Book Copying

• 2 Sided Book Copying

• Original Size

• Edge Erase

• Image Shift

• Image Rotation

• Invert Image

• Original Orientation

6. Select the Copy tab.

7. Select the desired Copy options including: 

• Paper Supply

• Reduce/Enlarge

• Darken/Lighten

8. Select any other desired Copy features/options (such as Image Quality, Output Format).

9. Enter the quantity.

10. Press Start on the UI.

Book Copying

Bound originals (such as books) can be placed on the document glass to make 1-sided or 2-sided copies. The bound 
original should be placed face down and registered to the rear left corner of the document glass. Align the top of 
the bound original against the rear edge of the document glass.

Book Copying options include:

BBootthh PPaaggeess

Copies both pages in page order.
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LLeefftt PPaaggee OOnnllyy

Copies the left page only.

RRiigghhtt PPaaggee OOnnllyy

Copies the right page only.

BBiinnddiinngg EEddggee EErraassee

This option erases or deletes the shadow from your copies that is caused by the center binding of the bound 
original.

2-Sided Book Copying

You can make 2-sided copies from two pages of a bound original. This feature allows you to assign pages when 
making copies of a bound original so that the copied pages face each other in the same way as the bound original. 
2-Sided Book Copying options include:

• Select a starting and ending page

• Select Starting Page (Left Page or Right Page)

• Selecting Ending Page (Left Page or Right Page)

Original Size

The press can detect the size of the document if it is a standard size. If the document is not a standard size, the 
machine does not know what size it is. This does not matter if you select a specific reduction/enlargement option 
and also select a specific paper tray. However, you can tell the press the size of the document if you want to use the 
Auto features. Original Size options include:

AAuuttoo DDeetteecctt

This option automatically detects the size of the scanned pages. The document sizes that can be detected 
automatically include all standard sizes.

MMaannuuaall SSiizzee IInnppuutt

This option allows you to select a standard paper size from the options shown or to input a non-standard 
(custom) size. When you have selected the size of your document, you can use the auto reduce/enlarge or the 
auto paper supply features.

MMiixxeedd SSiizzee OOrriiggiinnaallss

With this option the press automatically detects the size of each document.

Edge Erase

This option allows you to erase images around the border of a document. Edge Erase also deletes center streaks 
caused by a gap between the spine of a bound document and the document glass. Options include:

AAllll EEddggeess

This option causes a preset amount to be erased from the top/bottom and left/right edges and from the center 
of the output image.

PPrriinntt ttoo EEddggee

This option does not perform any edge deletions.
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IInnddiivviidduuaall EEddggeess

This option allows you to independently set the amount to be erased for each of the four edges and the center 
of your output. The default is 0.1 in. (2.54 mm) and each edge can be adjusted in 0.1 in. (2.54 mm) increments 
up to 2.0 in (50.8 mm).

PPrreesseettss

With this option you choose pre-programmed erase amounts that were previously created and saved by the 
system administrator.

Image Shift

Image Shift allows you to move the position of the image on the output page. Options include:

OOffff

This is the default setting. The image on the copy will be in the same place as the image on the original.

AAuuttoo CCeenntteerr

This option automatically centers the scanned image on the output paper. To work effectively, the original 
should be smaller than the selected output stock or the image should be reduced.

CCoorrnneerr SShhiifftt

This option enables you to move the image to each of the four corners of the paper or to the center of each of 
the four sides of the paper (eight positions total).

MMaarrggiinn SShhiifftt

This option creates a margin for binding one edge of a document by shifting the image away from that edge. 
The Margin Shift option enables you to center a document image, shift the image to one edge slightly, or move 
the image to a specified edge (0-50.8 mm (0-2.0 in.), Left and Right or Top and Bottom) of the output.

PPrreesseettss

With this option you choose pre-programmed shift amounts that were previously created and saved by the 
system administrator.

Image Rotation

If the orientation of the paper loaded in the selected paper tray differs from that of the document that is scanned, 
the Image Rotation option automatically rotates the document image to match the orientation of the paper 
loaded in the paper tray. You can also select which edge of the original document to use as a reference for image 
rotation if documents are of mixed orientations. Options include:

OOffff

This option causes copies to be made as they are loaded, even if they are oriented differently from the paper in 
the selected paper tray.

AAllwwaayyss OOnn

This option causes copies to be made with the document image automatically rotated so that the orientation 
of the document matches that of the paper in the selected paper tray.

OOnn dduurriinngg AAuuttoo

This option provides automatic rotation of the image on your original to fit correctly on your selected copy 
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paper when Auto Select or Auto% is selected.

Invert Image

The Invert Image feature allows you to make copies with the left and right sides of the document image reversed 
or the colors reversed. Options include:

MMiirrrroorr IImmaaggee

This option reverses the original image creating a mirror of the original. This feature can be used when you 
want to change the apparent direction of an image or where the original is inked on the reverse of the paper 
(for example engineering drawings).

NNeeggaattiivvee IImmaaggee

This option converts the black image areas in the original to white, the white image areas to black, and any dark 
gray image areas to light gray. This feature is useful for documents that have a substantial amount of dark 
background and/or light text and images, saving on dry ink/toner usage.

Original Orientation

This feature is used to inform the system of orientation of your original document when it is placed in the 
document feeder or on the document glass. The orientation must be specified in order to identify the top of the 
document set. This information is used by the system to make a decision about how to accurately place images on 
paper when using features such as Image Shift, Edge Erase, Multiple-Up, Repeat Image, Annotation, and Booklet 
Creation. Original Orientation options include:

• Upright Images: Select this option when placing the top edge of the document against the top side of the 
document glass or document feeder.

• Sideways Images: Select this option when placing the top edge of the document against the left side of the 
document glass or document feeder.

Output Format Feature

Output Format Feature Overview

The Output Format feature includes the following options:

• Booklet Creation

• Covers

• Transparency Options

• Page Layout

• Poster

• Annotations

• Watermark

• Tab Margin Shift

• Face Up/Down Output

• ID Card Copying

• Transparency Options
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• Folding (optional)

Selecting Output Format Options

1. Load the document or documents onto the Document Glass or into the Document Feeder.

2. Press the Home button on the press UI.

3. Select Copy on theHome window.

4. Select the Output Format tab.

5. From the Output Format window, select the desire options: 

• Booklet Creation

• Covers

• Transparency Options

• Page Layout

• Poster

• Annotations

• Watermark

• Tab Margin Shift

• Face Up/Down Output

• ID Card Copying

• Transparency Options

• Folding (optional)

6. Select the Copy tab.

7. Select the desired Copy options including: 

• Paper Supply

• Reduce/Enlarge

• Darken/Lighten

8. Select any other desired Copy features/options (such as Image Quality, Layout Adjustment, Output 
Format).

9. Enter the quantity.

10. Press Start on the UI.

Booklet Creation

Booklet Creation allows you to create multi-page booklets from an ordered set of 1-Sided or 2-Sided originals. 

Refer to the following tips when using the Booklet Creation feature:

• When Auto% is selected, the press reduces or enlarges the image as required. 

• Any other Reduce/Enlarge selection could result in image loss. 

• When Booklet Creation is selected, the output is automatically set to 1-2 Sided.
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• Ensure that the Original Orientation setting reflects the same orientation as that of the original documents.

BBooookklleett CCrreeaattiioonn OOppttiioonnss

When On is selected, the following Booklet Creation options are available:

OOrriiggiinnaall IInnppuutt

• 1 Sided Originals

• 2 Sided Originals

• 2 Sided Rotated Originals

BBiinnddiinngg SShhiifftt

Use this option to set the booklet binding-shift value within the range from 0 to 1.9 in. (0 to 50 mm) in 0.1 in. or 
1 mm increments.

CCoovveerrss

This option allows you to attach covers to the booklet. The front and back covers can be output before the first 
page and after the last page of the document and on a different type of paper.

DDiivviiddee OOuuttppuutt

Use this option when you have a large number of original documents. The original documents are divided to 
create subsets in order to reduce the thickness of each booklet. The press folds copies in half and piles them up 
to form a booklet. The Light Production C Finisher with Booklet Maker allows you to specify the number of 
sheets within the range of 1-50 sheets in one-sheet increments.

OOuuttppuutt//OOffffsseett

This option is available only when specific optional finishers are attached, such as the Standard Finisher or 
Booklet Maker Finisher.

AAuuttoo IImmaaggee PPoossiittiioonniinngg

This option adjusts the image position so that the printing position from the edge of each page remains 
consistent between the inner and outer pages of the booklet. Auto Image Positioning is available for selection if 
you have already selected Create Left/Top Bound Booklet or Create Right Bound Booklet.

FFoolldd aanndd SSttaappllee ((ooppttiioonnaall))

Folding and stapling are optional features. These features are available only with finishing devices that provide 
these capabilities.
When available, select the desired Fold and Staple option: 

• No Fold and Staple: This option produces booklets without folding or stapling.

• Fold Only: This option produces booklets that are folded in half.

• Fold and Staple: This option produces booklets that are folded in half and stapled in the center.

BBooookklleett TTrriimmmmiinngg aanndd PPrreessssiinngg ((ooppttiioonnaall))

Booklet trimming and pressing are available only if the optional SquareFold Trimmer Module is attached to the 
Booklet Maker Finisher. 
Booklet Trimming and Pressing options include the following: 
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• Booklet Trimming: This option trims (cuts) away the face (edge) of the booklet, resulting in a neat finished 
edge.

• Book Pressing: Book Pressing, also known as square folding, flattens the booklet spine, thereby reducing the 
booklet thickness and giving it the appearance of a perfect bound book.

Covers

This feature allows you to automatically add covers to your copied sets using stock from a different tray. For 
example, you can add colored stock, card or transparencies to your copied sets to add a professional finish to your 
copy job.

The Covers feature includes the following options:

FFrroonntt CCoovveerr aanndd BBaacckk CCoovveerr

Select an option for a front cover only, back cover only, or select options for both front and back covers:  

• Off

• Blank Cover: Uses blank sheets of paper as the cover.

• Print on Side 1

• Print on Side 2

• Print on Both

PPaappeerr SSuuppppllyy

Select the tray or trays from which front and/or back cover media is supplied. If Blank Covers is selected, enter 
the number of blank sheets that will be used for the covers.  

Note: If Blank Cover is used for both the front and back covers, verify that the correct quantity is selected 
for both the covers.

Page Layout

The Page Layout options are ideal for handouts, storyboards, or for archival purposes.

PPaaggeess ppeerr SSiiddee

The Pages per Side feature is ideal for handouts, storyboards or for archival purposes. It allows the scanning of 
up to eight independent images to fit onto one sheet of paper. Your press reduces or enlarges the images as 
needed in order to display them in either portrait (upright) or landscape (sideways) orientation on one page; 
this is based on the paper supply selected.

RReeppeeaatt IImmaaggee

This option allows you to copy a single image up to eight times onto one page.
Variable Repeat: This option specifies the number of times to repeatedly copy the image along each of the 
long and short sides of the paper. You can specify from 1 to 23 repeats along the short side (Y) and from 1 to 
33 repeats along the long side (X). The examples shown are a typical output that can be produced when using 
the Repeat Image feature.

Poster

This feature allows you to create a large poster by pasting together copies spread over multiple sheets. Copies are 
provided with a paste margin so that they can be pasted together. Options include:
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OOuuttppuutt SSiizzee

This option allows you to choose from a list of preset output poster sizes.

EEnnllaarrggeemmeenntt %%

This option allows you to enter specific height and width percentage values (from 100% to 400%) for your 
final poster size.

Annotations

This option allows you to add a stamp to your copied output. Options include:

CCoommmmeenntt

This option allows you to add comment stamps that are stored on the press to the output copies. Select one of 
eight existing stamped messages to be printed on the first page or all pages of your copied sets. Stored 
comments include Confidential, Urgent, and Draft. You can also create new or edit existing comments. These 
can also be stored to the press memory. You can also change the position and appearance of the comment 
using the Position and Font Size buttons. 

DDaattee

This option allows you to place the current date in the margins of your output. The date can be printed on only 
the first page of the output or it can be printed on all pages. You can also change the position and appearance 
of the date using the Position buttons.

PPaaggee NNuummbbeerrss

This option allows you to add an independent page number to one or many copied pages. You can also change 
the position and appearance of the page numbers using the Position andFont Size buttons. 

BBaatteess SSttaammpp

This option allows you to place an alphanumeric prefix, followed by a sequential page number in the margins of 
the output. You can specify an existing Bates Stamp or you can create a new or edit an existing Bates Stamp. 
You can also change the position and appearance of the stamp using the Position and Font Size buttons. 

Watermark

This option to add a lightly printed sequential control-number, stored watermark, date and time, or serial number 
on the background of each copy set. This feature can be used to help track confidential documents. For example, 
you can use sequential numbering to associate distribution copies with specific recipients. Options include:

CCoonnttrrooll NNuummbbeerr

This option allows you to input a start number that will be printed on each document set. For example, if you 
select 1 for the start number, the number 1 will be printed on the first set of documents, the number 2 will be 
printed on the second set, and so on. 

SSttoorreedd WWaatteerrmmaarrkkss

This option allows you to select an existing watermark to be printed on one page or many pages. Existing 
watermarks include Copy Prohibited, Copy, and Duplicate.

DDaattee aanndd TTiimmee

This option prints the current date and time on the output (each page).
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SSeerriiaall NNuummbbeerr

This option allows you to make copies with the press serial number printed on each page. This feature is useful if 
you want to track the copies coming from a certain machine.

WWaatteerrmmaarrkk EEffffeecctt

This option allows you choose an embossed or outline style for the watermark text you print.

Tab Margin Shift

The Tab Margin Shift option allows you to copy images from a document onto tabbed stock. You have the option 
to copy the entire original document onto the tabbed stock or you can choose to copy only the edge of the original 
document onto the tabbed stock. Options include:

SShhiifftt ttoo TTaabb

This option prints the edge of the original document image onto the tab of the tabbed stock. You can change 
the amount of shift required by using the Shift Value buttons on the touch screen.

SShhiifftt AAllll

This option copies the whole image of the document onto tab stock. Use the Shift Value button when you want 
to adjust the position of the image on the tab area.

SShhiifftt VVaalluuee bbuuttttoonnss

These buttons allow you to specify a shift value in the range of 0-15 mm (0-0.59 in.) in 1 mm (0.039 in.) 
increments.

AAdddd TTaabb SSttoocckk

Use this option to select a specific number of tab stock sheets to use.

PPaappeerr SSuuppppllyy

Use this option to select the tray containing the tab stock.

Face Up or Face Down Output

The Face Up/Down Output option allows you to select whether copies are output facing up or facing down. Options 
include:

AAuuttoo

Selecting the Auto button automatically determines whether the copies should be output face up or face down.

FFaaccee UUpp

Selecting the Face Up button causes all output to be delivered face up, with the first page on top of the output 
stack.

FFaaccee DDoowwnn

Selecting the Face Down button causes all output to be delivered face down, with the first page on the bottom 
of the output stack.

FFaaccee UUpp ((RReevveerrssee OOrrddeerr))

Selecting the Face Up (Reverse Order) button causes all output to be delivered face up, with the last page on 
the top of the output stack. This setting may not be available, depending on how your system administrator 
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configures the press.

ID Card Copy

Whether needing to copy insurance cards, a driver license, or any other form of identification, the ID Card Copying 
feature offers a simple and efficient way to save time. Information on both sides of an ID card can be copied onto 
one side of a sheet of paper into the paper or bypass tray.

1. Open the document feeder and place the ID card on the top, left corner of the document glass.

2. Close the document feeder.

3. Press the Home button on the press UI.

4. Select Copy on the Home window.

5. Select Output Format > ID Card Copying.

6. Select On.

7. Select Save.

8. Enter the quantity.

9. Press Start to begin scanning side 1.

10. Open the document feeder and turn the ID card over to copy side 2.

11. Close the document feeder.

12. Press Start to begin scanning side 2. 

Printing begins and copies are delivered to the output area.

Transparency Options

When making a set of transparencies you can insert a divider between each transparency in order to make it easier 
to manage your presentation slides. You can also produce paper copies of the transparencies in order to distribute 
them to people. Transparency options include:

BBllaannkk TTrraannssppaarreennccyy SSeeppaarraattoorrss

This option delivers your transparencies to the output destination with a blank sheet of paper separating each 
transparency.

BBllaannkk SSeeppaarraattoorrss aanndd HHaannddoouuttss

This option inserts a blank sheet of paper between each printed transparency. In addition, a distribution set of 
copies is also printed on the stock you specify using the Paper Supply Settings button. Handouts can be 1- or 2- 
sided and stapled (if available).

TTrraannssppaarreennccyy SSeett aanndd HHaannddoouuttss

This option delivers the transparencies without separators. However, a distribution set of copies will be printed 
on the stock you specify using the Paper Supply button. Handouts can be 1- or 2-sided and stapled (if available).

TTrraannssppaarreennccyy TTrraayy

Select the tray containing the transparencies. 
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SSeeppaarraattoorr TTrraayy // SSeeppaarraattoorr aanndd HHaannddoouutt TTrraayy // HHaannddoouutt TTrraayy

This option varies depending on the selected transparency option. Select the desired tray that contains the 
separator and/or handout stock.

Optional Folding

Note: This feature is available only if the appropriate, optional finishing device is attached to your press.

Review the following information before using the Folding option.

• If your press is equipped with an optional Folder, you can make copies or prints using the Folding feature.

• Depending on the finishing device, the Folding option can fold your output in half (single or bi-fold) or in thirds 
(C-fold or Z-fold types).

• The Folding option can be selected for both your copy and network print jobs.

• Depending on the copy/print job, the Folding option can be selected from the press UI or from the print driver 
on your workstation.

• The Folding option can also be selected at the print server for the selected job.

• In order to use the folding option, the orientation of documents must be short-edge feed (SEF). You must select 
a paper tray that contains SEF stock.

Folding options include:

• Single Fold (Bi-Fold): Select this option to fold the output copies in half.

• C-Fold: Select this option to fold the output copies in thirds.

• Z-Fold: Select this option to fold the output copies with two folds that are folded in opposite directions, resulting 
in a type of fan fold.

• Z-Fold Half Sheet: This option has two folds that are folded in opposite directions, with two unequal folds. The 
two unequal folds allow one edge of the sheet to have a longer edge which allows for stapling or hole punching.

• Image Inside Fold: Folds copies so that the image is printed on the inside.

• Images Outside Fold: Folds copies so that the image is printed on the outside.

Job Assembly Feature

Job Assembly Feature Overview

Janet Webster

Job Assembly includes the following features:

• Build Job

• Sample Job

• Combine Original Sets

• Delete Outside / Delete Inside
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Build Job

This feature allows you to change and save settings individually for each document page or stack. You can then 
make copies of documents with different settings as one job.

1. Split the hard-copy document into sections for individual programming.

2. On the Home window, select Copy.

3. Select the Job Assembly tab.

4. Select Build Job.

5. Select On.

6. Select Save.

7. Select Build Job again.

8. Program the job requirements for the first segment of the job by selecting and saving the applicable features 
from the features shown at the bottom of the Build Job window. After making selections for each category, 
select Save. Then on the Build Job window, select Save. 

• Copy Output

• Booklet Creation

• Covers

• Annotations

• Segment Separators

• Watermark

• Face Up/Down Orientation

9. Load only the first segment into the document feeder or place the segment on the document glass one page 
at a time.

10. Press Start. 

When the first segment has finished scanning, the Copy Status screen will appear.

11. Remove the originals from the document feeder or document glass.

12. Select Change Settings.

13. Program the job requirements for the second segment.

14. Load the second segment into the document feeder or on the document glass.

15. Press Start.

16. Repeat the previous steps until all segments of your job have been programmed and scanned.

17. After the last segment has been scanned, select Last Original.  

The press will complete the quantity selected.

18. Retrieve the copies from the output area.
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Sample Job

When making multiple copies, you can continue making copies after making and examining a sample set. You can 
choose to continue or cancel the job after confirmation.

To print a sample of the job, perform the following:

1. Press the Home button on the User Interface (UI).

2. Select Copy on the Home window.

3. Select Job Assembly > Sample Job.

4. Select On.

5. Select Save.

6. Load the documents in the document feeder or on the document glass.

7. Program the job with the Copy desired features/options.

8. Enter the quantity.

9. Press Start. 

One copy set of the job (the sample set) is printed and the remainder of the job is placed on hold and the 
press is paused.

10. If desired, change any applicable setting and copy quantity.

11. Select Start to finish the job or Cancel to stop the job. 

Selecting Start continues the copy process and the programmed number of sets will be printed. Retrieve the 
copies from the output area.

12. Upon completion, press the Clear All button on the UI to return the settings to their default state.

Combine Original Sets

This feature allows you to copy sets of documents that cannot be loaded into the document feeder. This is useful 
when copying documents that may be damaged, ripped or torn, or too wrinkled to go through the document 
feeder. Combine Original Sets allows you to copy each original by placing it on the document glass and creating 
one copy job for the entire set. 

1. Press the Home button on the press UI.

2. Select Copy on the Home window.

3. Select the Job Assembly tab.

4. From the Job Assembly tab, select CCoommbbiinnee OOrriiggiinnaall SSeettss.

5. Select On or Off. 

• On: Select this option to have the Next Original option highlighted on the copy screen when scanning is in 
process.

• Off: Select this option to have the Last Original option highlighted on the copy screen the scanning process 
is in process.

6. Select Save to save your choice. 
This feature is available only when Collated is selected in the Copy Output window.
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7. Load your documents into the document feeder or individually place them on the document glass.

8. Program the job with the desired Copy features or options.

9. Enter the quantity.

10. Press Start.

11. When you are finished scanning all the documents, select Last Original to complete the job.

12. Retrieve the copies from the output area.

Delete Outside/Delete Inside

This feature allows you to specify the area for omission or deletion and then to copy that area. Keep the following 
in mind when you use this feature:

• When specifying multiple areas to delete, it is also possible to overlap and specify an area.

• When selecting Reduce or Enlarge, the areas are reduced or enlarged by interlocking magnification.

1. Press the Home button on the User Interface (UI).

2. Select Copy on the Home window.

3. Select the Job Assembly tab.

4. Select Delete Outside/Delete Inside. 

The Delete Outside/Delete Inside screen appears. By default, Off is selected.

5. Select Delete Outside or Delete Inside.

6. If the originals are 2-sided, select the applicable option: 

• Both Sides

• Side 1 Only

• Side 2 Only

7. Select the Area 1 button. 

The Delete Outside/Delete Inside Area 1 screen appears. Use this screen to define the first area for deletion 
(omission) from the copy output.

8. To define a specific area, enter the two X and Y coordinates within a range 0.0-17.0 inches (0.0-431.8 mm). 
Navigate from coordinate to coordinate by selecting each X or Y button: 

a. Select the Y1 box and use the numeric keypad on the UI to enter the value for Y1.

b. Select the Y2 box and use the numeric keypad on the UI to enter the value for Y2.

c. Select the X1 box and use the numeric keypad on the UI to enter the value for X1.

d. Select the X2 box and use the numeric keypad on the UI to enter the value for X2.

Clear a deletion area by selecting the Clear Area X (1, 2, or 3) button.

9. Select Save.

10. Select Save again.

11. Select any other desired copy features or options.
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12. Enter the quantity.

13. Press Start.

14. Retrieve the copies from the output area.

SCAN

Scan Overview

The Scan feature supports several methods for scanning and storing an original document. You can use the 
scanning functions while printing is in progress. This press supports the following scan capabilities:

• Email: Scans a document and sends the scanned data as an email attachment after converting the data to 
TIFF, JPEG, PDF, DocuWorks®, or XPS (XML Paper Specification).

• Network Scanning: Scans a document using a job template that was created using CentreWare® Internet 
Services (CWIS). When Scan to Home is enabled and the Remote Access feature is available, the scanned data 
can be transferred to a different destination according to an authenticated user.

• Scan to PC: Scans a document and sends the scanned data to a network computer using the FTP or SMB 
protocol.

• Store to Folder: Scans a document and saves the scanned data in a folder on the press.

• Store to USB: Scans a document and saves the scanned data to a USB memory device. (This is an optional 
feature.)

• Store & Send Link (Send to Folder): Scans a document and sends an e-mail notifying the user of two URLs: one 
is for the location where the scanned data can be retrieved and second is for the location from which the data 
can be deleted.

• Store to WSD (Web Services on Device): Scan a job at the press or by sending a command from a network 
computer to the press. The scanned data is sent to a specified network computer.

Basic Scanning

Basic Scanning Procedure

1. From the press UI, press the Clear All button.

2. Press the Home button.
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3. Select the desired scan method. 

• E-mail

• Network Scanning

• Scan to PC

• Store to Folder

• Send from Folder

• Store to USB

• Store & Send Link (Send to Folder)

• Store to WSD

4. Load your original documents in the document feeder or on the document glass.

5. Select the desired scan options. 

• Color Scanning

• 2 Sided Scanning

• Original Type

• Scan Presets

• Advanced Settings

• Layout Adjustments

• E-mail Options or Filing Options

6. Press Start. 
If using the document glass and multiple documents or multiple pages of a bound original/book need to be 
scanned, the perform the following substeps:

a. Select Next Original, place the original to be scanned and select the Start button.

b. Continue until you are scanning the last original, select Last Original then select the Start button.

7. Select Job Status on the UI to view the status of the scanned job.

8. Retrieve the original documents from the Document Feeder or Document Glass.

Previewing Scanned Images

1. Scan the images and select job features.

2. While scanning, select Preview to preview the last page that was scanned.

3. From the drop-down menu, specify the view size by selecting Whole Page or Enlarge View and set Current 
Page.

4. After the confirmation, select Close to close the preview screen.

Changing Scan Settings and Options

While your job is scanning, perform the following steps to change the settings to that job.

1. Select Next Original.
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2. Select Change Settings.

3. Select the appropriate section and make select features. The following features can be adjusted: 

• Color Scanning

• 2 Sided Scanning

• Original Type

• Image Options (Lighten/Darken)

• Image Enhancement

• Resolution

• Quality/File Size

• Shadow Suppression

• Original Orientation

• Original Size

• Edge Erase

• Book Scanning

• Reduce or Enlarge

4. After your changes are complete, select Start.

Canceling a Scan Job

1. From the User Interface (UI), touch Stop on the touch screen or press the Stop button.

2. On the UI, press Cancel to end scanning or Start to restart the scan.

3. Press the Job Status button on the UI.

4. Select the job to cancel, then press Stop.  

Note: When a scan is canceled, scan data already stored to the mailbox is deleted.

Stopping a Scan Job

1. To stop a scan job while the job is in process, press the Stop button on the User Interface (UI) or touch Delete 
on the UI.

2. Select Delete.

3. If Delete does not appear on the screen, press the Job Status button on the UI.

4. Select the job to cancel and select Delete.

Scan Options

Scan Options Overview

The following settings can be set for scan jobs.
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• Basic Scan Options (shown on the first tab of the selected scan method window)

• Advanced Settings

• Layout Adjustment

• Email Options or Filing Options (depends upon the selected scan method)

Basic Scan Options

The basic scan options are shown on the first tab of the selected scan method. These options include the following:

CCoolloorr SSccaannnniinngg

Color Scanning options include: 

• Auto Detect: The color of the document is determined automatically; the press scans in full color when the 
document is colored, otherwise, scans in monochrome.

• Color: Select this option to scan a color document.

• Black & White: Scans a document in monochrome two tones. You can select the document type in Original 
Type.

• Grayscale: Scans a document in grayscale. Adds shades to monochrome, creating intermediate tones that 
change gradually. Suited to documents containing gradations that cannot be reproduced with monochrome 
(2-color tone).

22 SSiiddeedd SSccaannnniinngg

2 Sided Scanning options include: 

• 1 Sided: Select this option to scan only one side of the document.

• 2 Sided: Select this option when both sides of the 2-sided document are in the same orientation.

• 2 Sided, Rotate Side 2: Select this option when both sides of the 2-sided document are in opposite 
orientations. 

OOrriiggiinnaall TTyyppee

Original Type options include: 

• Photo & Text: Select this option when scanning a document that contains both text and photos. The press 
automatically identifies the text and photo areas and scans each area with optimum quality.

• Text: Select this option when scanning text clearly.

• Photo: Select this option when scanning photos.

SSccaann PPrreesseettss

Scan Presets options include: 

• Sharing and Printing: This setting is best used for sharing files to be viewed on screen and for printing most 
of the standard business documents. This setting results in small file sizes and higher image quality.

• Archival Record: This setting is best used for standard business documents that are stored for record 
keeping purposes. This setting results in the smallest file size and normal image quality.

• Optical Character Recognition: This setting is best used for documents that are processed by OCR 
software. This setting results in large file sizes and the highest image quality.

• High Quality Printing: This setting is best used for documents that contain detailed graphics and photos. 
This setting results in large file sizes and the maximum image quality.
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• Simple Scan: This setting is best used for faster processing but may result in excessively large file sizes. Use 
this setting to apply the minimal amount of image processing and compression.

Advanced Settings

The options for Advanced Settings are shown on the second tab of the selected scan method; these options 
include the following:

IImmaaggee OOppttiioonnss

The Image Options include: 

• Lighten/Darken: This option provides manual control to adjust the lightness or darkness of the scanned 
images. Scroll down to darken the scanned image of light originals such as pencil images. Scroll up to lighten 
the scanned image of dark originals such as half tones or originals with colored backgrounds.

• Sharpness: This option controls the balance between sharp text and moiré (patterns within the image). 
Move the slider control down (Soften) to produce an image with a smooth, uniform appearance (ideally 
suited for photographic scanned images). Move the slider control up (Sharpen) to produce an image with 
better quality text or line art.

IImmaaggee EEnnhhaanncceemmeenntt

The Image Enhancement options include: 

• Background Suppression: This option prevents reproduction of unwanted shading from originals where the 
opposite side printing shows through (translucent). 

Off: This is the default setting. With background suppression off, originals are scanned without filtering the 
document backgrounds.

Auto Suppression: This option automatically reduces or eliminates any background on the output which 
may be caused by colored paper or newspaper originals. For example, when Color Scanning is set to Black 
& White, the background of a document printed on colored paper, such as newspaper, is suppressed. When 
Color Scanning is set to Color, the background of a document printed on white-color paper is suppressed.

• Contrast: This option controls the difference between the image densities within the scanned image. Lower 
contrast settings reproduce more detail in light and dark areas of the original. Higher contrast settings 
produce vivid blacks and whites for sharper text and lines, but produce less detail in pictures.

RReessoolluuttiioonn

Choose one of four resolution settings: 

• 200 dpi (dots per inch): This setting produces normal output quality and a small file size. Use this setting for 
office documents and photos.

• 300 dpi: This setting produces a higher output quality and larger file size. Use this setting for sharper 
scanning of office documents and photos.

• 400 dpi: This setting produces medium output quality and the largest file size. Use this setting for high 
quality printing; this setting is suitable for fine lines and small fonts that have been enlarged and for 
documents with low image definition.

• 600 dpi: This setting produces maximum output quality and the largest file size. Use this setting for high 
quality printing; this setting is suitable for fine lines and small fonts that have been enlarged and for 
documents with low image definition.

QQuuaalliittyy//FFiillee SSiizzee

This feature allows you to select the ratio of data compression for color and grayscale scanned images. Use the 
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slider to choose from good image quality with small file size, higher image quality with larger file size, or highest 
image quality with largest file size. 

Note: This feature is unavailable whenever Black and White (Color Scanning) is selected.

PPhhoottooggrraapphhss

This feature enhances the image for files that are scanned using photographic originals. Select Off (default 
setting) or Enhance Photographs. 

Note: In order to use this feature, Color Scanning must be set for Color. Furthermore, when Enhance 
Photographs is selected, Shadow Suppression and Background Suppression are not available.

SShhaaddooww SSuupppprreessssiioonn

Select Auto Suppression to hide background color and image bleed through for color scanning. This feature is 
not available when Black and White is selected for Color Scanning.

Layout Adjustment

The options for Layout Adjustment are shown on the third tab of the selected scan method; these options include 
the following:

OOrriiggiinnaall OOrriieennttaattiioonn

Select the direction that your original lays in the document feeder or on the document glass. Select Upright 
Images or Sideways Images.

OOrriiggiinnaall SSiizzee

Select one of three options that indicate the size of your originals. 

• Auto Detect: This option automatically detects the size of the scanned pages. All standard sizes are 
automatically detected.

• Manual Size Input: This option allows you to select a standard paper size from the options shown or to 
input a non-standard (custom) size. 

• Mixed Size Originals: With this option the press automatically detects the size of each document.

EEddggee EErraassee

This option erases images around the border (margins) of a document. 

• All Edges: This option erases a preset, equal amount from the top, bottom, left and right margins.

• Print to Edge: This option does not erase any of the margins of the document.

• Individual Edges: This option independently erases differing amounts from each of the four margins.

• Presets: This option erases preprogrammed amounts as set up by the System Administrator. This includes 
preset options for Header/Footer Erase and Hole Punch Erase.

BBooookk SSccaannnniinngg

Use this option to scan pages from bound originals. Options include: 

• Left Page then Right: Scans the left page first and the right page of the facing pages for the bound 
original.

• Right Page then Left: Scans the right page first and the left page of the facing pages for the bound 
original.
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• Top Page then Bottom: Scans the top page first and then the bottom page of the facing pages for the 
bound original.

The following sub-options are also available: 

• Both Pages: Scans both pages in page order.

• Left Page Only: Scans the left page only.

• Right Page Only: Scans the right page only.

• Top Page Only: Scans the top page only.

• Bottom Page Only: Scan the bottom page only.

• Binding Edge Erase: This option erases or deletes the shadow that is caused by the center binding of the 
bound original.

RReedduuccee//EEnnllaarrggee

Use this option to select a reduction or enlargement value for the scanned document.

E-Mail Options

E-mail Options is the fourth tab of the E-mail scan method and options include the following:

FFiillee NNaammee

Use this option to enter a file name. If no name is entered, the system automatically generates a file name.

RReeppllyy TToo

Use this option to enter a reply recipient email address.

RReeaadd RReecceeiippttss

This option requests an email with the delivery status from the recipient to the sender.

FFiillee FFoorrmmaatt

Select the desired file format for scanned data; options include: 

• PDF: Saves scanned data in PDF format.

• PDF/A: Saves scanned data in the PDF/A format. PDF/A is used primarily for archiving and long-term 
preservation.

• TIFF: Saves scanned data in TIFF format.

• JPEG: Saves scanned data in JPEG format. This option is selectable when Color or Grayscale is selected for 
Color Scanning.

• TIFF/JPEG Auto Select: Automatically selects JPEG or TIFF. The file format is determined for each page: 
JPEG for full-color and grayscale pages and TIFF for monochrome pages.

• XPS (XML Paper Specification): Saves multiple pages into a single file.

Note: Options may vary and some options may not be available for your press.

AAddddiittiioonnaall FFiillee FFoorrmmaatt ooppttiioonnss

Depending on the selected file format, the following sub-options also are available: 
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• Compression Method: Allows you to select a compression method for the scanned data.

• MRC High Compression: Allows you to save PDF and XPS files with high compression.

• Searchable Text: Allows you to select whether to perform character recognition in PDF files.

• PDF Security: Allows you to configure security for the PDF output in order to prevent unauthorized access.

• Optimize For Quick Web View: Optimizes the PDF file so that it is displayed faster on a web browser.

• Add Thumbnail: Allows you to attach thumbnails to XPS files when XPS is selected. A thumbnail is a 
reduced, small file size image that helps you check the file contents.

• Single File for Each Page: Saves each page as a single file in the specified format.

CCoommpprreessssiioonn MMeetthhoodd ooppttiioonnss

When Manual Select is chosen for the Compression Method, some or all of the following options are 
available. 

For black and white images and pages only, select one of the following options:

• Modified Modified Read (MMR): This setting is automatically selected when Photo and Text or Text is 
chosen for Original Type.

• Modified Huffman (MH): This setting is automatically selected when Photo is chosen for Original Type.

• JBIG2 Arithmetic Encoded: This process has better compression performance than the Huffman encoded 
process. However, the compression rate is slower than Huffman encoded and it uses more memory but 
yields better compression results. 

Note: JBIG stands for Joint Bi-level Image experts Group. JBIG compresses only black and white images.

• JBIG2 Huffman Encoded: Huffman coding takes less page memory and has faster compression and 
decompression than the arithmetic coding. Use this option if high-quality compression results do not matter 
and you want to use less page memory.

For grayscale or color images and pages, select one of the following options:

• JPEG: This is the default setting for grayscale and color pages.

• Flate: This option saves the image data at a higher compression rate than JPEG. Flate is lossless and does 
not remove data during the compression process.

PPDDFF SSeeccuurriittyy ooppttiioonnss

The following PDF Security options are available when selecting E-mail Options > File Format > PDF > PDF 
Security > Password: 

• Encryption Algorithm: Choose one of three encryption methods: 

– 128-bit RC4: Encrypts the file by using the 128-bit RC4 method. Files encrypted with this method can 
be opened with Adobe® Acrobat® 5.0 or later. 

– 128-bit AES: Encrypts the file by using the 128-bit AES method. Files encrypted with this method can 
be opened with Adobe® Acrobat® 7.0 or later. 

– 256-bit AES: Encrypts the file by using the 256-bit AES method. Files encrypted with this method can 
be opened with Adobe® Acrobat® 9.0 or later. 

• File Open Password: This option sets a password for opening the PDF. The recipient of the PDF file must 
know the password before it can be opened.
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• Permissions: This option adds restrictions to the PDF file which prevents unauthorized printing or editing of 
the file. The recipient of the PDF must know the permissions password in order to remove these restrictions.

Filing Options

Note: Filing Options is not available with the E-mail scan method.

Filing Options is the fourth tab of the selected scan method. Options include the following:

FFiillee NNaammee

Use this option to enter a file name. If no name is entered, the system automatically generates a file name.

FFiillee NNaammee CCoonnfflliicctt

Use this option to resolve file name conflicts. Choices include: 

• Do Not Save: Cancels the scan operation so that you can enter another file name.

• Rename New File: Attaches a 4-digit number (0000-9999) to the end of the duplicate file name and saves 
the file in the same directory.

• Overwrite Existing File: Deletes the existing file with the duplicate file name and saves the new file with 
the specified file name in the same directory.

• Add to Existing Folder: Adds the scanned file to the existing folder and overwrites any other file that has 
the same file name.

• Add Date Stamp to File Name: Adds the current date to the name of the new file.

FFiillee FFoorrmmaatt

Select the desired file format for scanned data; options include: 

• PDF: Saves scanned data in PDF format.

• PDF/A: Saves scanned data in the PDF/A format. PDF/A is used primarily for archiving and long-term 
preservation.

• TIFF: Saves scanned data in TIFF format.

• JPEG: Saves scanned data in JPEG format. This option is selectable when Color or Grayscale is selected for 
Color Scanning.

• TIFF/JPEG Auto Select: Automatically selects JPEG or TIFF. The file format is determined for each page: 
JPEG for full-color and grayscale pages and TIFF for monochrome pages.

• XPS (XML Paper Specification): Saves multiple pages into a single file.

Note: Options may vary and some options may not be available for your press.

AAddddiittiioonnaall FFiillee FFoorrmmaatt ooppttiioonnss

Depending on the selected file format, the following sub-options also are available: 

• Compression Method: Allows you to select a compression method for the scanned data.

• MRC High Compression: Allows you to save PDF and XPS files with high compression.

• Searchable Text: Allows you to select whether to perform character recognition in PDF files.

• Optimize For Quick Web View: Optimizes the PDF file so that it is displayed faster on a web browser.
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• Add Thumbnail: Allows you to attach thumbnails to XPS files when XPS is selected. A thumbnail is a 
reduced, small file size image that helps you check the file contents.

• Single File for Each Page: Saves each page as a single file in the specified format.

CCoommpprreessssiioonn MMeetthhoodd ooppttiioonnss

When Manual Select is chosen for the Compression Method, some or all of the following options are 
available. 

For black and white images/pages only, select one of the following options:

• Modified Modified Read (MMR): This setting is automatically selected when Photo and Text or Text is 
chosen for Original Type.

• Modified Huffman (MH): This setting is automatically selected when Photo is chosen for Original Type.

• JBIG2 Arithmetic Encoded: This process has better compression performance than the Huffman encoded 
process. However, the compression rate is slower than Huffman encoded and it uses more memory but 
yields better compression results. 

Note: JBIG stands for Joint Bi-level Image experts Group. JBIG compresses only black and white images.

• JBIG2 Huffman Encoded: Huffman coding takes less page memory and has faster compression and 
decompression than the arithmetic coding. Use this option if high-quality compression results do not matter 
and you want to use less page memory.

For grayscale or color images/pages, select one of the following options:

• JPEG: This is the default setting for grayscale/color pages.

• Flate: This option saves the image data at a higher compression rate than JPEG. Flate is lossless and does 
not remove data during the compression process.

Resolving a File Name Conflict

Note: This option is not available with some of the scan methods.

1. Select the Filing Options tab.

2. Select the File Name Conflict option.

3. Select the appropriate option: 

• Do Not Save: Cancels the scan operation so that you may enter another file name.

• Rename New File: Attaches a 4-digit number (0000-9999) to the end of the duplicate file name and saves 
the file in the same directory.

• Overwrite Existing File: Deletes the existing file with the duplicate file name and saves the new file with 
the specified file name in the same directory.

4. Select Save.
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E-mail

E-Mail Overview

The E-mail feature scans a document and sends the scanned data as an e-mail attachment to one or more 
recipients.

E-Mail Components

NNeeww RReecciippiieenntt

If the recipient of the e-mail cannot be found in the address book, select New Recipient option to add the 
address in the To, Cc, or Bcc field of the e-mail. A maximum of 128 characters may be entered for a single e- 
mail address.

AAddddrreessss BBooookk

Use the address book to find and add recipients in the To, Cc, or Bcc fields of the e-mail. 

• List all public entries: This option displays the local address list which resides on the press.

• Retrieve entries using index: This option displays a keyboard allowing you to enter characters and narrow the 
search to specific recipients.

• Search Public: This option searches for entries in the local address list.

Note: The address book displays only entries that were previously added by the system administrator. A 
maximum of 2,000 addresses may be stored in the address book.

AAdddd MMee aanndd FFrroomm ffiieellddss

By default, these fields are not available for use. The system administrator must change the settings for these 
fields before they can be used.
When these fields are available for use, enter the email address for the sender in the From field and send a copy 
of the e-mail to the sender by selecting Add Me. A maximum of 128 characters may be entered for the address 
for the sender in the From field.

RReecciippiieenntt((ss)) ffiieelldd

From this field, an e-mail address can be edited or removed by selecting a specific recipient.

SSuubbjjeecctt

Use this field to enter the subject of the e-mail. A maximum of 128 characters may be entered for the subject 
line.

MMeessssaaggee

Use this field to enter a message to the recipient. A maximum of 512 characters may be entered for the e-mail 
body text.

PPrreevviieeww

Select this check box in order to preview the scanned images or data. 

Note: Scanned images or data cannot be previewed with E-mail Options > File Format > MRC High 
Compression > On.
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Scanning to an E-Mail Address

1. From the UI, press the Clear All button. 

This clears all previous settings from the press.

2. Press the Home button.

3. Select E-mail.

4. Specify one or more recipients by choosing one of the following options: 

• New Recipient 

1. Use the keyboard to enter the entire address.

2. Select Add.

3. If sending to multiple recipients, repeat the previous sub-steps until finished.

4. Select Close.

• Address Book 

1. Select Address Book.

2. Select one of the choices from the pull-down menu (such as List all public entries).

3. Select the desired recipient.

4. Select one of the fields To,Cc, or Bcc.

5. If sending to multiple recipients, repeat the previous sub-steps until finished.

6. Select Close.

5. If applicable, perform the following: 

• Select From and add the sender e-mail address.

• To send a copy of the email to the sender, select Add Me.

• Edit or remove recipients from the Recipient(s) field.

• Select Subject to enter and save an e-mail subject.

• Select Message to enter and save the e-mail message.

6. Load your original documents in the document feeder or on the document glass.

7. Select the desired scan options.

8. Press Start to begin scanning.

9. Retrieve the original documents from the Document Feeder or the Document Glass.

Network Scanning

Network Scanning Overview

This feature scans documents after selecting a specific job template and choosing other scan options such as the 
forwarding destination server. Job templates are created by using CentreWare Internet Services. Scanned data is 
converted to the format specified in a job template and is automatically sent to a server. The press allows you to 
automatically retrieve the job templates that are stored in a server.
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When Scan to Home is enabled and the Remote Access feature is available, the scanned document can be 
transferred to a different destination according to an authenticated user.

Note: In order to use Network Scanning, job templates must be created and set up by the system 
administrator. The system administrator uses CentreWare Internet Services to create and set up Job 
templates. Refer to the System Administrator Guide for detailed information.

Network Scanning Components

JJoobb tteemmppllaatteess

On the Network Scanning tab, this is a list of available job templates. Select the desired template to use for your 
network scanning job. If a template is not listed, contact your system administrator.
DEFAULT: This is the default job template. When a new template is created from CentreWare Internet Services, 
it is based on the default template. This template cannot be deleted. It can be edited and returned to the 
factory-default template only by the system administrator.

GGoo TToo

Use the numeric keypad to enter a 3-digit job template number. The job template then appears at the top of 
the list.

TTeemmppllaattee DDeessccrriippttiioonn

This button displays the Template Description screen. This button is available for selection only when a 
description has been added to a job template.

UUppddaattee TTeemmppllaatteess

Select this button to refresh the information. If a created job template is not displayed, select Update Templates 
to display all the job templates.

Network Scanning Procedure

On the Network Scanning window, you can scan documents after specifying a file (job template) saving scanning 
conditions, information on the forwarding destination server, and others. This feature creates job templates on a 
computer using CentreWare Internet Services. Scanned data is converted to the format specified in a job template 
and is automatically sent to a server. The press allows you to automatically retrieve job templates stored in a server. 
When Scan to Home is enabled and the Remote Access feature is available, the scanned document can be 
transferred to a different destination according to an authenticated user.

1. From the UI, press the Clear All button.

2. Press the Home button.

3. Select Network Scanning.

4. Select a template.

5. Load your original documents in the document feeder or on the document glass.

6. Select Preview. 

a. From the drop-down menu, specify the view size by selecting Whole Page or Enlarge Viewand set 
Current Page.

b. After the confirmation, select Close to close the preview screen.

7. Select the desired scan options.
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8. Press Start to begin scanning.

9. Retrieve the original documents from the Document Feeder or the Document Glass.

Scan to PC

Scan to PC Overview

The Scan to PC service allows you to scan documents and send the scanned data to a network computer using the 
FTP or SMB protocol. 

Scan to PC Components

TTrraannssffeerr PPrroottooccooll

The Scan to PC service allows you to scan documents and send the scanned data to a network computer using 
the FTP or SMB protocol. Specify the protocol to use when selecting Transfer Protocol. Choices include: 

• FTP

• SMB

• SMB (UNC Format): UNC stands for Universal Naming Convention and its format is as follows: \\\\hhoosstt 
nnaammee\\sshhaarreedd nnaammee\\ddiirreeccttoorryy nnaammee

AAddddrreessss BBooookk

Specify the recipient from the Address Book.

BBrroowwssee NNeettwwoorrkk ffoorr PPCC

Specify a destination PC by browsing your network. Selecting browse displays a hierarchy consisting of available 
server names and folders.

SSppeecciiffyy DDeessttiinnaattiioonn

Use this option to specify a destination PC using the screen keyboard. Enter information in the fields provided 
for the selected protocol, to specify a forwarding destination.

How to Use the Scan to PC Feature

UUssiinngg tthhee SSccaann ttoo PPCC FFeeaattuurree

Before performing the following procedure, ensure that a shared folder is created on your computer; this folder is 
where the scanned data will be stored.

The Scan to PC service allows you to scan documents and send the scanned data to a network computer using the 
FTP or SMB protocol.

1. From the UI, press the Clear All button.

2. Press the Home button.

3. Select Scan to PC.

4. Select the desired Transfer Protocol.

5. Select Save.
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6. Choose the Save in destination where the data will be stored: 

• Address Book; for instructions, refer to Using the Address Book to Specify a Scan to PC Destination.

• Browse the network for a destination PC; for instructions, refer to Browsing the Network for a Scan to PC 
Destination.

• Use the UI screen keyboard; for instructions, refer to Specifying a Scan to PC Destination Using the UI 
Keyboard.

7. Load your original documents in the document feeder or on the document glass.

8. If desired, select Preview.

9. Select the desired scan options.

10. Press Start to begin scanning.

11. Retrieve the original documents from the Document Feeder or the Document Glass.

UUssiinngg tthhee AAddddrreessss BBooookk ttoo SSppeecciiffyy aa SSccaann ttoo PPCC DDeessttiinnaattiioonn

1. From the main Scan to PC tab window, select Address Book.

2. The Address Book was previously set up (contains address information)? 

• Yes: Continue to the next step.

• No: See your System Administrator. Only the administrator can set up entries in the Address Book.

3. Select a recipient from the Name/Protocol list.

4. Select Add. 

This adds the recipient to the Save in box.

5. Select Close to save and close the window.

Complete the steps in the procedure Using the Scan to PC Feature.

BBrroowwssiinngg tthhee NNeettwwoorrkk ffoorr aa SSccaann ttoo PPCC DDeessttiinnaattiioonn

1. From the main Scan to PC tab window, select Browse.

2. Select the destination for saving the data by locating a file: 

• Select Previous to move to an upper directory.

• Select Next to move to a lower directory.

3. To add the selected destination to the address book, perform the following substeps: 

a. Select Add to Address Book.

b. Select Save. 

The Browse window is displayed.

4. Select Save to save and close the Browse window.

Complete the steps in the procedure Using the Scan to PC Feature.
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SSppeecciiffyyiinngg aa SSccaann ttoo PPCC DDeessttiinnaattiioonn UUssiinngg tthhee UUII KKeeyybbooaarrdd

1. From the main Scan to PC tab window, select inside the Server field. 

The UI screen keyboard is displayed.

2. Enter information to identify the server using the keyboard. 
For the Server name, enter a server name or IP address. When the save location is in the DFS namespace on 
Windows, enter a domain name or server name. Up to 64 characters are allowed.

3. Select Save. 

4. Select inside the Shared Name field and enter a shared name. 
When the save location is in the DFS namespace on Windows, enter a root name. Up to 64 characters. This 
option is only available when you select SMB in Transfer Protocol.

5. Select Save. 

6. Select inside the Save In field and enter a directory path.  
When the save location is in the DFS namespace on Windows, enter a folder name. Up to 128 characters. This 
option is only available when you select FTP or SMB in Transfer Protocol.

7. Select Save to save and return to the main Scan to PC tab window. 

8. Select inside the User Name field then enter the user name of the computer to which you are forwarding the 
data.  
When a user name is not required for the destination, this field can be skipped.

9. Select Save. 

10. Select inside the Password field and enter the password for the user name.  
Up to 32 characters are allowed.

11. Select Save. 

Complete the steps in the procedure Using the Scan to PC Feature.

Store to Folder

Store to Folder Overview

Use the Store to Folder option to scan documents and save the scanned data in a folder of the press.

Note: Folders must be created before using the Store to Folder feature. Refer to the System Administrator 
Guide for detailed information and instruction on creating folders.

Store to Folder Components

Use the Scan to Folder option to scan documents and save the scanned data in a folder of the press.

FFoollddeerr

Select a folder to save the scanned data in. Select the up arrow to return to the previous screen or select the 
down arrow to move to the next screen.

GGoo ttoo

Use the numeric keypad to enter a 3-digit folder number. The folder then appears at the top of the list.
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FFiillee LLiisstt

Select a folder and then select this button to display the File List screen. You can confirm or delete files stored in 
the folder.

Using the Store to Folder Feature

Note: Folders must be created before using the win feature. Refer to the System Administrator Guide for 
detailed information and instruction on creating folders.

1. From the User Interface, press the Clear All button.

2. Press the Home button.

3. Select Store to Folder.

4. Select the desired destination folder.

5. Load your original documents in the document feeder or on the document glass.

6. Select the desired scan options.

7. Press Start to begin scanning.

8. Retrieve the original documents from the Document Feeder or the Document Glass.

Store to USB

Store to USB Overview

The Store to USB feature allows you to scan documents and save the scanned data to a USB memory device.

Use the following USB memory devices:

• A formatted USB memory device

• A USB 2.0 compliant memory device (USB 1.1 is not supported.)

• A USB memory device with a storage capacity of up to 128 GB

Before using the Store to USB feature, review the following information:

• A USB memory device encrypted with software is not supported.

• A commercially available Memory Card Reader with a single slot can be used for this feature, but the safe 
performance of this reader is not guaranteed. When a Memory Card Reader with multiple slots is used, only one 
particular slot is available.

• When a USB memory device is inserted into the USB memory slot during the Power Saver mode, the UI touch 
screen does not light. After exiting the Power Saver mode by pressing the Power Saver button, insert the USB 
memory device again or select Store to USB on the Home window.

• Before removing the USB memory device, make sure that a window indicating that data is being transferred is 
not displayed. If you remove the USB memory device while the data is being stored, the data in the device may 
be damaged. You can also view Job Status to confirm if the data has been stored to the USB memory device.

Using the Store to USB Feature

1. Load your original documents in the document feeder or on the document glass.
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2. Insert the USB memory device into the USB memory slot on the front of the press (near the User Interface). 

One of the following happens: 

• The USB Device Detected window displays.

• The Store to USB window displays.

• The UI touch screen does not change.

3. Choose one of the following options:  

• If the USB Device Detected window displays, perform the following: 

1. On the press UI, select Store to USB.

2. Go to Step 4.

• If the Store to USB window displays, go to Step 4.

4. From the main Store to USB window, select Save in.

5. Select a folder in which to save the scanned data. 
This will be a folder location on the USB memory device.

6. Select Save. 

The main Store to USB window displays.

7. Select the desired scan options.

8. If desired, select Preview.

9. Press Start to begin the scanning process.

10. Retrieve the original documents from the Document Feeder or the Document Glass.

Store and Send Link Feature (Send to Folder)

Store and Send Link (Send to Folder) Overview

Tip: This feature may not be available in all marketplaces.

Note: The Store & Send Link feature is also referred to as the Send to Folder feature.

If an authenticated user scans a document, the press temporarily saves the scanned data and automatically 
obtains the e-mail address for the user that was registered in advance. The press then sends an e-mail notifying the 
user of two URLs: 

• One URL is for the location where the scanned data can be retrieved.

• The second URL is for the location from which the data can be deleted.

Tip: Only the authenticated user who logs into the press can be the recipient of an e-mail transmission. The press 
cannot send e-mail to multiple recipients.

After receiving the e-mail on a computer, the user can retrieve the scanned data using a web browser. 

Review the following information before using the Store & Send Link (Send to Folder) feature:
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• Scan files stored in the press will be automatically deleted when the retention period expires. 

• This retention period can be specified in URL File Expiration option by the System Administrator in the range 
of 1 to 168 hours. The default value is 3 hours. 

• The files will always be deleted automatically.

• To strengthen security, after retrieving the scanned data, access the second URL to delete the scanned data 
stored in the press.

• The Store & Send Link feature does not provide the following document management features:  

– Backing up and/or restoring files 

– Deleting all the data at one time 

– Listing files 

– Displaying available storage space 

• The Store & Send Link feature allows you to retrieve scanned data without specifying an e-mail address from 
the Address Book or from a folder for each scan job. However, the size of the data and its retention period are 
restricted on the press. If you want to avoid these restrictions, use the Scan to PC or E-mail service.

• For more information, refer to the System Administrator Guide.

• You can customize the layout of the features displayed on the Store and Send Link feature. For more 
information, refer to System Administrator Guide.

Storing and Sending a Link (Sending to Folder)

1. Press the Log In/Out button on the UI or select the login information field on the UI touch screen.

2. Enter the user ID.

3. Select Store & Send Link on the UI Home window. 

The system automatically obtains the preregistered e-mail addresses of the authenticated users and displays 
them in the Scan To and From fields.

4. Select inside the Subject and Message fields to enter the desired information. 
A maximum of 128 characters may be used for the Subject field and a maximum of 512 characters may be 
used for the Message field.

5. Load your original documents in the document feeder or on the document glass.

6. If desired, select Preview.

7. Select the desired scan options.

8. Press Start to begin scanning.

9. Retrieve the original documents from the Document Feeder or the Document Glass.

Store to Web Services for Devices (WSD)

Store to WSD Overview

Note: WSD stands for Web Services for Devices.

Use the Store to WSD feature to scan a job at the press or by sending a command from a network computer to 
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the press. The scanned data is then sent to a specified network computer.

The following options are available with Store to WSD:

• Computer: Select this option to start a scan job by sending a request from a network computer, then forward 
the scanned data to a network computer. The scan job will be operated from the network computer. 

– To operate the scan job from a network computer, use an application which supports image loading feature 
such as Windows Fax and Scan. 

– Windows Fax and Scan is not available for computers with Windows Vista Home Basic or Windows Vista 
Home Premium. To perform a scan from such a computer, use a different method, for example, using the 
Paint application and selecting the option From Scanner or Camera. 

• This Device: Select this option to start a scan job from the press UI, and then forward the scanned data to a 
network computer. When this option is selected, a list of available computers is displayed; from this list select 
the computer that will receive the scanned data. 

– When This Device is selected, a List of Components is displayed. 

– This list shows computer names and four processing methods including Scan to User PC (this is a specified 
network computer), Scan for Print to User PC, Scan for E-mail to User PC, and Scan for OCR to User PC. 

How to Use the Store to Web Services for Devices (WSD) Feature

UUssiinngg tthhee SSttoorree ttoo WWSSDD FFeeaattuurree

1. From the press UI, press the Clear All button.

2. Load your original documents in the document feeder or on the document glass.

3. Press the Home button.

4. Select Store to WSD.

5. From the Start Scan Job From window, choose one of the following options: 

• Computer; go to Starting a Scan Job from a Network Computer.

• This Device; go to Starting a Scan Job from This Device.

SSttaarrttiinngg aa SSccaann JJoobb ffrroomm aa NNeettwwoorrkk CCoommppuutteerr

Ensure that the original documents are loaded and that Computer is selected on the Start Scan Job From window.

Note: The following procedure describes the scan method using Windows Fax and Scan with Windows 7.

1. Select Operate from Computer. 

The UI displays a standby message stating that a scan job is waiting.

2. To exit the standby mode, select Delete. 

The UI displays a Remove Your Original message.

3. Remove your originals and select OK.

4. Reload your originals.

5. From the network computer, select Start > All Programs > Windows Fax and Scan.

6. At the bottom of the left pane, select Scan, then select New Scan from the toolbar.
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7. In the New Scan dialog box, select Change, then select the press. 
Ensure that the press model name is displayed; it will be shown to the right of Scanner.

If the press model name is not displayed, select Change, then select the press.

8. Select the Profile list, then select Document.

9. Select the desired scan options.

10. Select Scan. 

After the documents are scanned, the scanned data is forwarded to the specified computer.

11. The press UI displays a Remove Your Original message. 

a. Remove your original documents from the press Document Feeder or Document Glass.

b. Select OK on the press UI.

12. The UI displays a standby message stating that a scan job is waiting. 

• YYeess: The press cannot start another scan job even though the network computer recognizes the press. Clear 
the press; go to the next step.

• NNoo: The scan job is completed and the press is ready for other copy/print jobs.

13. From the UI, select Delete. 

The scan operation is stopped. The UI displays a Remove Your Original message.

14. Remove your originals and select OK. 

The scan job is completed and the press is ready for other copy/print jobs.

SSttaarrttiinngg aa SSccaann JJoobb ffrroomm TThhiiss DDeevviiccee

Ensure that the original documents are loaded and that This Device is selected on the Start Scan Job From 
window.

Note: This procedure is done from the press UI.

1. From the List of Components, select a destination.

2. Press the Start button. 

The scanned date will be forwarded to the specified destination.

3. Retrieve the original documents from the Document Feeder or the Document Glass.

4. Check the forwarded data on the destination computer.

SEND FROM FOLDER (FOLDER/FILE MANAGEMENT)

Send from Folder: Folder and File Management Overview

The Send from Folder feature allows you to access and manage folders and files that were saved on the press. 
Folder/file management includes the following functions:

• Access the saved files

• Review the details of the files

96 Xerox® Versant® 280 Press User Documentation 

Working With



• Print the files

• Rescan the files

• Send the files in an email

• Retrieve the email (with the file attachment) from a network computer

• Delete the files

• Create automatic routine tasks

• Register/create private folders and/or shared folders

File Options

The following options are available:

• Refresh: Displays the updated information.

• List: Lists the files stored in the folder, with their stored dates and pages.

• Thumbnail: Displays the images and names of the files stored in the folder.

• Number of Files: Displays the number of files stored in the selected folder.

• Select All: Allows you to select all the files in the folder. If you select Select All again, all the files are 
deselected.

• Delete: Allows you to delete the selected files in the folder.

• File Details: Previews the selected file to allow you to check its details and to copy or move it to another folder.

• Job Flow Settings: Allows you to create, link, and execute job flows.

• Print: Allows you to print selected files separately.

• Batch Print: Allows you to print multiple files as one file.

FFiillee DDeettaaiillss OOppttiioonn

For the File Details option, these additional selections are available:

• Whole Page: Allows you to select whether to display the whole page or to enlarge the image by 200%. You can 
select the view size from Whole Page and Enlarged View. A small-sized document cannot be enlarged even if 
you select Enlarged View. You can rotate or enlarge the image of the file in a folder in preview, but cannot save 
the file with the image rotated or enlarged.

• No Rotation: Allows you to select an angle to preview the image from Right 90 degrees, Left 90 degrees, and 
180 degrees. You can rotate or enlarge the image of the file in a folder in preview, but cannot save the file with 
the image rotated or enlarged.

• Change File Name: Allows you to change the file name. Use the displayed keyboard to enter a new name.

• Current Page: Allows you to specify a page to preview on the screen using + and - or the numeric keypad.

PPrriinntt OOppttiioonn

For the Print option, these additional selections are available:
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• Paper Supply: Select the desired paper tray.

• 2 Sided Printing: Select 2-sided printing.

• Output: Select the desired output options including stapling, hole punching, and which finishing tray to deliver 
the printed output.

• File Details: Displays a preview image of the selected file.

• Print Quantity: Select the number of print sets.

• Print: Prints the selected file.

BBaattcchh PPrriinntt OOppttiioonn

The Batch Print option allows you to select batch printing. You can print multiple files as one file. A maximum of 
100 files can be bound in the selected order. 

Note: For 2-sided printing, the last page becomes blank when the total number of printed pages is odd. For 
printing of multiple files, a blank page is inserted after the final page of each file. If a different size 
document is included in multiple files, it may be printed in improper orientation.

These additional options are available with Batch Print:

• Paper Supply: Select the desired paper tray.

• 2 Sided Printing: Select 2-sided printing.

• Output: Select the desired output options including stapling, hole punching, and which finishing tray to deliver 
the printed output.

• File Details: Displays a preview image of the selected file.

• Print Quantity: Select the number of print sets.

• Print: Prints the selected file.

Managing Folders and Scanned Files

1. From the UI, press the Clear All button.

2. Press the Home button.

3. Select Send from Folder.

4. Select a folder.

5. Select a file from the folder list.

6. From the drop-down menu, select how to display the file: 

• List

• Thumbnail
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7. Select one or more other options. 

• Refresh

• Select All

• Delete

• Review

• File Details

• Job Flow Settings

• Print

• Batch Print

How to Configure/Start a Job Flow

Configuring/Starting a Job Flow

The Send from Folder feature allows you to configure and/or start a job flow. Refer to the following information for 
the various job flow settings and options that are available in the Send from Folder feature.

JJoobb FFllooww SSeettttiinnggss

The options available with Job Flow Settings include the following:

• Auto Start: This sets auto start of the job flow for files stored in the folder. The job flow automatically starts 
when a file is stored.

• Start Current Job Flow: Select files in the folder, then select this button to start the job flow linked to this 
folder. After executing the job flow, confirm from Job Status or print a Job History Report to check the result. 

• Cut Link: Cancels the link between a folder and the linked job flow sheet.

• Create/Change Link: Displays the Link Job Flow Sheet to Folder window.

• Select Job Flow Sheet: Select this button while files are selected to display the Select Job Flow Sheet screen.

CCrreeaattee//CChhaannggee LLiinnkk

The settings available with the Create/Change Link option include the following:

• Refresh: Displays the updated file information.

• Create: Displays the Create New Job Flow Sheet window.

• Edit/Delete: Displays the Details window.

• Search by Name: Searches for job flows that partially match the entry. The press searches through job flow 
names that were registered upon each job flow creation. The entry can be up to 128 characters.

• Search by Keyword: Searches for job flows that fully match the entry. The press searches through keywords 
that were registered upon each job flow creation. The entry can be up to 12 characters. You can select from 
preset keywords if they have been registered in the System Administration mode.
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• Select by Keyword: Displays the Select Keyword window. Select a keyword registered in the System 
Administration mode to search for job flows. Job flows that fully match the entry are searched. The press 
searches through keywords that were registered upon each job flow creation.

• Sheet Filtering: Displays the Sheet Filtering window. Sheet Filtering allows you to filter the job flow sheets that 
are displayed. Displayed job flow sheets may vary depending on the Authentication feature.

SSeelleecctt JJoobb FFllooww SShheeeett

The settings available with the Select Job Flow Sheet option include the following:

• Start: Executes the selected job flow sheet.

• Refresh: Displays updated information.

• Details: Displays the Details window.

• Change Settings: If the selected job flow sheet setting is editable, the Change Settings window appears. You 
can temporarily change the settings.

• Search by Name: Searches for job flows that partially match the entry. The press searches through job flow 
names that were registered upon each job flow creation. The entry can be up to 128 characters.

• Search by Keyword: Searches for job flows that fully match the entry. The press searches through keywords 
that were registered upon each job flow creation. The entry can be up to 12 characters. You can select from 
preset keywords if they have been registered in the System Administration mode.

• Select by Keyword: Displays the Select Keyword window. Select a keyword registered in the System 
Administration mode to search for job flows. Job flows that fully match the entry are searched. The press 
searches through keywords that were registered upon each job flow creation.

• Sheet Filtering: Displays the Sheet Filtering window. Sheet Filtering allows you to filter the job flow sheets that 
are displayed. Displayed job flow sheets may vary depending on the Authentication feature.

SShheeeett FFiilltteerriinngg OOppttiioonnss

Sheet Filter options include the following:

• Owner: 

– System Administrator - If this box is checked, the only Job Flow Sheets available to the System 
Administrator are displayed. 

– Non-System Administrator - If this box is checked, Job Flow Sheets displayed do not include those available 
to the System Administrator. 

– No Filtering - When both the System Administrator and Non-System Administrator boxes are checked, all 
the Job Flow Sheets are displayed. 

• Target: Place a check in each job type you want displayed.

Using Send from Folder to Link a Job Flow Sheet to a Folder

1. From the UI, press the Clear All button.

2. Press the Home button.

3. Select Send from Folder.

4. Select a folder, if required.
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5. Select the files from the folder list.

6. Select the desired Job Flow option. 

• Auto Start

• Start Current Job Flow

• Cut Link

• Create/Change Link

• Select Job Flow Sheet

7. To link a specific job flow sheet, chooseSelect Job Flow Sheet. 

a. Select a desired job flow sheet.

b. Select Job Flow Settings.

c. Select Create/Change Link.

d. Select any option. 
If Sheet Filtering is selected, select the desired filtering conditions, then select Save.

e. From the Link Job Flow Sheet to Folder window, select Save.

8. Select Start to run the job flow.

JOB FLOW

Job Flow Introduction

Job Flow is a feature that allows you to register transfer settings of scanned data, such as a transfer method and 
destination; this simplifies data-transfer tasks. Job flow sheets are categorized into two types according to the 
target:

• Files stored in folders

• Scan files

AAuuttoommaattiicc//MMaannuuaall SSttaarrttiinngg aa JJoobb FFllooww

A Job Flow is started in the following ways:

• Automatically when a document or file is linked to a folder

• Manually selecting a Job Flow to act on the documents or files stored in the folder

To automatically start a job flow, you must create a link with a folder and a job flow sheet in advance. Files are 
automatically processed with the job flow sheet when they are stored in the linked folder.

AAcccceeppttaabbllee FFeeaattuurreess ttoo RReeggiisstteerr

You can register the following features:

• Forward: Multiple forwarding recipients can be configured for each forwarding method. 
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– FTP: Forwards via FTP. A maximum of two recipients can be specified. 

– SMB: Forwards via SMB. A maximum of two recipients can be specified. 

– Mail: Forwards via email. A maximum of 100 recipients can be specified. 

• Email Notification: Job results may be sent by email.

• Print: Files in a folder may be printed.

JJoobb FFllooww RReessttrriiccttiioonnss

A job flow sheet can be used by only one user, can be shared by multiple users, or can be used only for certain 
folders.

Only the Job Flow Sheets that you have permission to execute are displayed.

Job Flow Settings and Options

Overview of Job Flow Options

Note: Created Job Flow Sheets can be executed, modified, duplicated, or deleted only from the folder in 
which it was created.

Job Flow options include the following:

• Refresh: Displays updated information.

• Details: Displays the Details window. You can confirm the details of a job flow such as the name, last updated 
date, target, owner, and save location. When you select the information (i) button, the entire description of the 
job flow sheet is displayed.

• Change Settings: If available, this option allows you to change the job flow settings.

• Search by Name: Searches for job flows that partially match the entry. The press searches through job flow 
names that were registered upon each job flow creation. The entry can be up to 128 characters.

• Search by Keyword: Searches for job flows that fully match the entry. The press searches through keywords 
that were registered upon each job flow creation. The entry can be up to 12 characters. You can select from 
preset keywords if they have been registered in the System Administration mode.

• Select by Keyword: Displays the Select Keyword window. Select a keyword registered in the System 
Administration mode to search for job flows. Job flows that fully match the entry are searched. The press 
searches through keywords that were registered upon each job flow creation.

• Sheet Filtering: Displays the Sheet Filtering window. Sheet Filtering allows you to filter the job flow sheets that 
are displayed. Displayed job flow sheets may vary depending on the Authentication feature.

Additional Job Flow Options

Additional job flow options include the following:

• Name: Set the name for the job flow using a maximum of 128 characters.

• Description: Set the description of the job flow using a maximum of 256 characters.

• Keyword: Used to search for a Job Flow Sheet using a maximum of 12 characters. For example, enter 
Accounting as a keyword to access any Job Flow Sheets that contain Accounting in the Job Flow name.
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• Send as E-mail: Specify the recipients for the e-mail. You can specify a total of up to 100 addresses. Select 
from the address book numbers or by direct input by using the keypad.

• Transfer via FTP (1), Transfer via FTP (2): Specify the server where documents are sent using SMB protocols. 
When the server address is registered in the address book, you can specify the address from the address book. 
The specified address appears in the SMB Transfer window.

• Transfer via SMB (1), Transfer via SMB (2): Specify where SMB forwarding is to be stored.

• Print: Configure the print settings. When On is selected, you can configure the settings for the Print feature.

• E-mail Notification: You can receive an e-mail notification when a file is saved in a folder or a job flow ends.

• Edit/Delete: Review the content of the job flow sheet and edit, copy, or delete it. Additional options include: 
Edit, Delete, and Copy.

Sheet Filtering Options

Sheet Filter options include the following:

• Owner: 

– System Administrator: If this box is checked, only the Job Flow Sheets available to the System Administrator 
are displayed. 

– Non-System Administrator: If this box is checked, Job Flow Sheets displayed do not include those available 
to the System Administrator. 

– No Filtering: When both the System Administrator and Non-System Administrator boxes are checked, all the 
Job Flow Sheets are displayed. 

• Target: Place a check in each job type you want displayed.

Send as E-mail Options

The settings available with the Send as E-mail option include the following:

• Address Book: The recipients can be specified from address book. The specified recipient appears in Recipient 
Name/E-mail Address in the Send E-mail screen.

• New Recipient: Specify a new recipient. The specified recipient appears in Recipient Name/E-mail Address in 
the Send as E-mail screen.

• Name/E-mail Address: Displays the recipient name or e-mail address specified.

• Subject: If desired, set a specific subject.

• Delete Recipient: Deletes all the information for the selected recipient.

• Edit: Allows you to check or change the information for the selected recipient.

• File Format: Specify the output file format.

• Resend Attempts: Set the amount of times you want to resend an E-mail or to switch off the feature. If you 
select On, set the number of resend attempts and time interval: 

– Resend Attempts: Set the number of times to resend an email between 1-5. 

– Resend Interval: Set the transmission retry interval from 30-300 seconds. 
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Transfer via FTP (1)/Transfer via FTP (2) Options

The additional settings available with the Transfer via FTP (1) / Transfer via FTP (2) option include the following:

• Address Book

• File Format

• Resend Attempts

• Name, Server, Save, User Name, and Password: The maximum number of characters for each item is: 

– Name: Maximum 18 single-byte characters 

– Server: Maximum 64 single-byte characters 

– Save in: Maximum 128 single-byte characters 

– User Name: Maximum 97 single-byte characters 

– Password: Maximum 32 single-byte characters 

Transfer via SMB (1)/Transfer via SMB (2) Options

The additional settings available with the Transfer via SMB (1) / Transfer via SMB (2) option include the 
following:

• Address Book

• File Format

• Resend Attempts

• Name, Server, Save, User Name, and Password: The maximum number of characters for each item is: 

– Name: Maximum 18 single-byte characters 

– Server: Maximum 64 single-byte characters 

– Save in: Maximum 128 single-byte characters 

– User Name: Maximum 97 single-byte characters 

– Password: Maximum 32 single-byte characters 

Print Options

The additional settings available for Print option include the following:

• Print Quantity

• Paper Supply

• 2-Sided Printing

• Output

E-mail Notification Options

The additional settings available for E-mail Notification option include the following:

• Name/E-mail Address

• Message
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• When to Notify

• Delete Recipient

• Edit

• Close Menu

Job Flow Procedures

Creating a Job Flow Sheet

1. Press the Machine Status button.

2. Select the Tools tab on the UI.

3. Select Setup & Calibration > Setup > Create Job Flow Sheet.

4. Select Create.

5. Select one of the line items from the list (Name). 

a. Select Edit.

b. Enter the name information using the UI screen keypad.

c. Select Save.

6. Repeat the previous step for other line items (such as Description) until all desired information is entered and 
saved. 

7. If Send as E-mail is used, ensure all the required information is entered, including the recipient name and e- 
mail address.

8. If desired, select Print to set options to print the linked Job Flow Sheet. Select Off to disable this feature.

9. Select Save to keep your settings.

10. Review the newly created Job Flow Sheets and select Exit.

11. Press Clear All to return the press to its default values and settings.

Linking a Job Flow Sheet with a Folder

1. Log in as Administrator.

2. Press the Machine Status button.

3. Select the Tools tab on the press User Interface (UI).

4. Select Setup & Adjustment > Setup > Create Folder.

5. Select a folder that is not being used (Available). 

The New Folder window displays.
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6. On the New folder - Passcode window, choose one of the following:  

• Off: If you do not assign a passcode, all users will be allowed access to the folder.

• On: 

1. Enter a passcode with a maximum of 20 digits.

2. Select a Target Operation option: Always (All Operations), Save (Write), or Print/Delete (Read).

7. Select Save.

8. Enter the following information by selecting each line item and selecting Edit: 

• Folder Name (maximum of 20 characters)

• Check Folder Passcode

• Delete Documents After Retrieval

• Delete Expired Files

• Link Job Flow Sheet to Folder: Select and go to the next step.

9. At the Link Job Flow to Folder window, selectCreate/Change Link.

10. Select the Job Flow Sheet that you want to link and then select Save.

11. At the Link Job Flow to Folder window, choose one of the following: 

• Auto Start: Select this option if you want the Job Flow Sheet to be automatically executed when a new 
document is saved to the folder. If you do not select Auto Start, you will need to press theStart button on 
the UI to execute the linked Job Flow Sheet.

• Select Close. 

Note: Selecting Cut Link at any time will remove the link to the specified Job Flow Sheet.

The Job Flow Sheet is linked to the folder.

12. Select Close to exit to the Tools tab.

Starting a Job Flow Manually

1. Load the original document(s).

2. From the UI, press the Clear All button.

3. Press the Home button.

4. If enabled by the System Administrator, select Job Flow Sheets, then select OK.

5. Select a listed Job Flow Sheet.

6. Press the Start button. The job runs and is placed in a folder or on the appropriate server. 

Confirming and Changing a Job Flow

You can confirm a Job Flow and temporarily change its parameters. However, only fields that have change 
permission, assigned when the Job Flow was created, can be edited.

1. From the UI, press the Clear All button.

2. Press the Home button.
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3. If enabled by the System Administrator, select Job Flow Sheets, then select OK.

4. Select a listed Job Flow.

5. Select Change Settings.

6. Select the group to change from the Group of Items.

7. Select an item in the group that will be changed.

8. Select the options you want to change and make changes as instructed.

9. Close any open windows to keep your changes.

JOB STATUS

Job Status Overview

The Job Status feature allows the user to check active, pending, and completed jobs. The ability to cancel printing 
or pause jobs is also available fromJob Status.

Job Status Area

The Job Status button on the press UI displays the progress and status of any currently printing jobs and lists all 
completed jobs.

1. Select the Active Jobs tab to view the status of currently pending or in-progress print jobs on the system.

2. Select the Completed Jobs tab to view a list of all jobs that have completed successfully.

3. Select the Group Parent Jobs check box to list and display the jobs according to a parent and child relationship 
hierarchy.

Active Jobs Tab

1. Press the Job Status button on the UI.

2. Select the Active Jobs tab.

3. From the displayed list, select the applicable job to view. 

Use the up or down buttons to navigate the list.

4. If required, select Display Time to show the time required to process the job.

5. To delete a job or change the execution order, select a job from the list. 

6. Select Delete or Promote from the pop-up menu. 

• Delete: This option cancels the current or pending job.

• Promote: This option moves a job to the top of list and runs it after the job that is currently printing or 
copying. 

• Job Progress: This option shows the details of the selected document.

• Close Menu: This option closes the pop-up menu.
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Completed Jobs Tab

1. Press the Job Status button on the UI.

2. Select the Completed Jobs tab. 

A list of the completed or deleted jobs display. Use the scroll bar to navigate the list. 

3. To check the details of a job, select the job from the displayed list.

4. From this Status window, select one of the following to print a history of this job. 

a. To print the job details, select Print this Job Report button.

b. To print the history of parent and child jobs, select the Print this Job History Report button.

5. After checking the job details, select Close.

MACHINE STATUS

Machine Status Overview

Press the Machine Status button on the UI to access the Machine Status information, including maintenance and 
reporting features.

• Device Information 

• Faults

• Supplies

• Billing Information

• Tools

Device Information Tab

This tab provides general information about the press such as the currently installed software version and the press 
(device) serial number. This area also allows you to print reports and view details that apply to billing impressions.

DDeevviiccee SSeerriiaall NNuummbbeerr

The Device Serial Number is displayed under the General Information area on the Device Information tab. Use 
this number when calling Xerox for technical information or assistance.

CCuurrrreenntt SSyysstteemm SSooffttwwaarree

The version of the system software that is currently installed on the press is displayed under the Current System 
Software title.

IIPP AAddddrreessss aanndd HHoosstt NNaammee

The unique Internet Protocol Address and name identifies the press to the specific network to which it is 
connected.

PPaappeerr TTrraayy SSttaattuuss

Select the Paper Tray Status button to display tray status information including percentage amount of media 
installed in each tray.
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DDeevviiccee CCoonnffiigguurraattiioonn

Select the Device Configuration button to display a list of the various hardware components and options that 
are available on the press and their status. Hardware components and options include any optional feeding and 
finishing devices attached to the press.

SSooffttwwaarree VVeerrssiioonn

Select the Software Version button to display a list of the software versions for the various system 
components, including any optional feeding and finishing devices.

PPrriinntt RReeppoorrttss

This Print Reports button is enabled by the system administrator. From the various reports available, select a 
report on the touch screen and then select the Start button to print. Some reports are only available in the 
system administrator mode.
From the Print Reports screen, select: 

• Job Status

• Copy Reports

• Scan Reports

• Network Controller Job Report

• Job Counter Report (available in System Administrator mode only)

• Auditron Report / Meter Report (available in System Administrator mode only)

MMaaiinntteennaannccee AAssssiissttaanntt

Select the Maintenance Assistant button to send the Xerox Remote Print Services diagnostic information on 
the press to Xerox Support. Also, when logged in as an Administrator, Communication Test under Maintenance 
Assistant helps the press to upgrade software and NVM values through Xerox Remote Services. For more 
information, refer to System Administrator Guide.

OOtthheerrss

From the Others window, select the Overwrite Hard Disk button. This feature is a standard data security 
function on the system. It prevents the document image and registered data that is recorded on the press hard 
disk from being illegally retrieved or removed.
Job image data stored on the hard disk within the press can be deleted and overwritten after a number of 
overwrites or a period of time specified by the system administrator. The Standby status indicates the 
completion of the overwriting process. 

Faults Tab

The Faults tab provides access to a list of current faults affecting the press and some detailed information about 
the fault such as when it occurred. Access this tab by pressing the Machine Status button on the UI and selecting 
the Faults tab on the screen.

FFaauulltt HHiissttoorryy 

This column identifies the fault code number assigned to the fault message. 

DDaattee//TTiimmee

This column indicates the day and time the fault occurred.
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IImmaaggee CCoouunntt

This column indicates the total number of printed impressions.

From the Faults screen, select a fault to view instructions on how to fix the error.

Supplies Tab

The Supplies tab provides status information about the customer replaceable units (CRUs) that are used in the 
press.

To access supplies information, press the Machine Status button on the UI and then select the Supplies tab. Each 
Customer Replaceable Unit and status is displayed.

Billing Information Tab

Accessing Billing Information

1. Press the Machine Status button on the UI.

2. Select the Billing Information tab. 

The Billing Information screen displays.

Billing Impressions Information

The Billing Information screen allows you to view the total number of impressions (prints) recorded by the press, 
including a category of the number of color prints only, black prints only and large media prints. The screen displays 
specific usage counter information. The counters display the impression amount for all printed jobs.

All meters that can be used for billing purposes are displayed on the Billing Information screen:

• Color Impressions: This value represents the total number of color impressions that have been printed.

• Black Impressions: This value represents the total number of black-only impressions that have been printed.

• Total Impressions: This value represents the total number of all impressions. The value is the sum of the Color 
Impressions and the Black Impressions.

• Color Large Impressions: This value represents the total number of large color impressions. These impressions 
are one side of one sheet of large media, for example A3, 11 x17 in. Large impressions are any prints that are 
larger than 145 sq. in., 935 sq. cm. 

Note: This meter is NOT added to the Total Impressions meter since it is already added to the Color 
Impressions meter.

• Extra Long Impressions: For this impression type, the meter increases for any media with a length between 
491 mm (19.33 in.) and 661 mm (26 in.).

Usage Counters

Select the Usage Counters button (from Machine Status > Billing Information) to view even more detail on 
billing and counts being tracked on the press such as the number of 1-sided vs 2-sided print jobs.

From the Counters drop-down list you can select the desired counter to view:
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• Impression Counters

• Sheet Counters

• Images Sent Counters

• All Usage Counters

IImmpprreessssiioonn CCoouunntteerrss

This view displays the total impression amount. In other words, impression is the image on one side of one 
sheet of media. This counter shows the total impression amount for color and black-only impressions. 

• Total Impressions: This number represents the total number of impressions for all color and black-only print 
jobs.

• Black Impressions: This number represents the total number of impressions for all black/white print jobs; 
includes Black Copied Impressions and Black Printed Impressions.

• Black Large Impressions: These impressions are one side of one sheet of a large black-only document (such 
as 11 x17 in./A3). Large Impressions are any prints that are larger than 8.5 x14 in./B4.

• Color Impressions: This number represents the total number of impressions for all color print jobs; includes 
Color Copied Impressions and Color Printed Impressions.

• Color Large Impressions: These impressions are one side of one sheet of a large color document (such as 11 
x17 in./A3). Large Impressions are any prints that are larger than 8.5 x14 in./B4.

SShheeeett CCoouunntteerrss

This counter provides information on the total number of sheets the press feeds to the output area. Each sheet 
counts as one click on the counter (regardless of size or whether it is a one-sided or two-sided print job).

IImmaaggeess SSeenntt CCoouunntteerrss

This counter provides information on the total amounts for email images and network scanned images.

AAllll UUssaaggee CCoouunntteerrss

This view provides a complete total of all the counters, including the totals from the Impression Counters and 
Sheet Counters.

UUppddaattee BBuuttttoonn

Select this button to refresh and update the counts.

Tools Tab (Operator Mode)

Regular users have limited access to some of the features on theTools tab.

CCrreeaattee FFoollddeerr

Use this feature to create folders on the press for storing copied and scanned documents.

SSttoorreedd PPrrooggrraammmmiinngg

When available to the user, this feature enhances productivity by saving a series of programming steps and 
assigning them to a specified Stored Programming option. Stored programs save frequently used features and 
job settings which can be accessed using a shortcut button. Stored Programming not only remembers feature 
settings, but it can record a series of operations. This enables the user to record the hierarchy of displayed 
screens for each step. For example, Stored Programming can record the following actions for printing reports: 
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Press the Machine Status button and display the Print Reports screen. 

Note: This feature is available only if the system administrator has created and saved stored programs.

CCrreeaattee JJoobb FFllooww SShheeeett

Use this feature to create job flow sheets which contain transfer settings of scanned data, such as a transfer 
method and destination. These sheets simplify data-transfer tasks.

AAdddd AAddddrreessss BBooookk EEnnttrryy

Select this feature to add Address and Recipient Information. To add, select an available entry and enter the 
information. To view an entry, select the entry and the information will automatically display.

PPaappeerr TTrraayy AAttttrriibbuutteess

The Paper Tray Attributes feature allows the user to change the attributes of a paper tray, including size, type, 
and weight. 

Note: The Paper Tray Attributes feature appears on the Tools tab only if the system administrator has 
made it available to users.

BBiilllliinngg IImmpprreessssiioonn MMooddee

The Billing Impression Mode defines how the press tracks and records impressions made on large-size paper 
such as A3 or tabloid. The type of Billing Impression Modes used by your press is set during system installation. 
A Xerox Sales Representative can confirm the Billing Impression Modes applicable for your press. There are two 
types of Impression Mode: 

• AA33 IImmpprreessssiioonn MMooddee: For all media sizes (including oversized), counts all impressions equally. 

• AA44 IImmpprreessssiioonn MMooddee: Counts large impressions on media such as A3 and 11 x 17 inches (media that is 
larger than 8.5 x 14 inches), as their A4 equivalent.

To view the current Billing Impression Mode, press the Machine Status button on the UI, then selectTools > 
Billing Impression Mode.

Changing the Paper Tray Attributes

1. Press the Machine Status button on the UI.

2. Select the Tools tab.

3. Select Setup & Calibration > Setup > Paper Tray Attributes.

4. Select a tray.

5. If the settings are correct, select Confirm. Otherwise, select Change Settings.

6. If necessary, make the required changes to the tray settings (such as weight, type, and size).

7. Select Save.

8. Select Confirm.

9. Select Close. 

The main Tools screen is displayed.

10. Press the Home button on the UI to return to the main home screen.
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Paper and Media

Before loading paper, consider the following:

• The press supports the ability to pull different stock sizes and paper types from various trays and assemble them 
as part of a single job. To select multiple paper trays and insert different papers within one job, program this 
custom job at the print server using features such as special pages.

• The press supports Automatic Tray Switching, which allows a job to switch automatically from an empty tray to 
a full tray containing the same size paper, orientation, and stock type. Refer to the Paper and Media chapter for 
how to enable this feature and prioritize the order of trays to search on and use.

SUPPORTED PAPER

Paper Specifications

Note: Always refer to the Tested Substrate List (TSL) for a comprehensive list of supported media. The Tested 
Substrate List can be accessed from www.xerox.com.
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PAPER TYPE PAPER SIZE TRAYS WEIGHT (G/M2) 

Plain paper (coated and uncoated) 

Drilled paper (coated and uncoated)

B5 SEF and LEF 

A4 SEF and LEF

A4-Cover SEF and LEF

DT Special A4 SEF and LEF

B4 SEF

A3 SEF

SRA3 SEF

DT Special A3 SEF

4 x 6 in. SEF

7.25 x 10.5 in. SEF and LEF

8 x 10 in. SEF and LEF

8.46 x 12.4 in. SEF

8.5 x 11 in. SEF and LEF

8.5 x 13 in. SEF and LEF

8.5 x 14 in. SEF

9 x 11 in. SEF and LEF

11 x 15 in. SEF

11 x 17 in. SEF

12 x 18 in. SEF

12.6 x 19.2 in. SEF

13 x 18 in. SEF

16-kai (TFX) SEF and LEF

16-kai (GCO) SEF and LEF

Pa-kai (TFX) SEF

pa-kai (GCO) SEF

Trays 1–3 

Trays 5, 6 and 7

52–256 

52–400

Recycled paper (coated and 
uncoated)  

All Trays 64–105 

Embossed (coated and uncoated)  Trays 1–3 

Trays 5, 6 and 7

106–256 

106–400

Transparency 8.5 x 11 in. (A4) LEF All Trays — 

Postcard (coated and uncoated)  Trays 5, 6 and 7 106–400 
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PAPER TYPE PAPER SIZE TRAYS WEIGHT (G/M2) 

Government-Legal SEF/LEF 8.5 x 13 in. 215.9 x 330.2 — 

DT Special A4 SEF/LEF 8.90 12.20 in. 226.0 x 310.0 — 

DT Special A3 SEF 12.20 x 17.00 in. 310.0 x 432.0 — 

Envelopes For supported envelope 
sizes, refer to Customer 
Expectation and 
Installation Guide.    

Labels (coated and uncoated) 8.5 x 11 in., A4 LEF Trays 1–3 

Trays 5, 6 and 7

106–256 

106–400

Tabbed Inserts 9 x 11 in. LEF All Trays 163 

Paper Tray Information

PPrriinntt EEnnggiinnee TTrraayyss 11,, 22,, aanndd 33

When the press is installed, the tray size setting for Trays 1 and 3 are set to 8.5 x 11 in. or A4 (LEF). The tray size 
setting for Tray 2 is set to 11 x 17 in. or A3 (SEF). The specifications for each tray are:

• Maximum of 550 sheets of 90 g/m2 (24 lb.) uncoated paper

• Paper weight range of 64–256 g/m2 (18 lb. Bond–95 lb. Cover)

• Paper sizes from 182 x 182–330 x 488 mm (7.2 x 7.2–13 x 19.2 in.)

• Stock types include transparencies, heavyweight, coated and uncoated, predrilled, and tabs 

• Loading paper Long Edge Feed (LEF) or portrait or Short Edge Feed (SEF) or landscape (dependent on the actual 
paper size)

• Auto size detection capability

• Automatically adjusts the tray position in the front and back based on the paper size. The adjustment happens 
after the tray is closed.

BByyppaassss TTrraayy 55

• Maximum of 250 sheets of 90 g/m2 (24 lb.) uncoated paper

• Paper weight range of 52–400 g/m2

• Stock types include transparencies, heavyweight, coated and uncoated, predrilled, and tabs.

Throughput and Productivity Information

Process and print speed are based on simplex or duplex mode, paper type, paper weight, paper size, and feeding 
tray. Trays 1, 2, and 3 support 52–256 g/m2 paper only.
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TTaabbllee 22..11 TTrraayyss 11,, 22,, aanndd 33 iinn LLEEFF FFeeeedd DDiirreeccttiioonn

PAPER SIZE AND 
PAPER TYPE 

PAPER WEIGHT 

PRINTS PER MINUTE: 
BASIC PRINT ENGINE 
CONFIGURATION 

PRINTS PER MINUTE: ALL 
STOCKS RATED SPEED 
(ASRS) CONFIGURATION 

1–SIDED 2–SIDED 1–SIDED 2–SIDED 

8.5 x 11 in., A4  

Uncoated, Coated, 
and Matte Coated

52–220 g/m2 

221–256 g/m2

80 ppm 

60 ppm

40 ppm 

30 ppm

80 ppm 

80 ppm

40 ppm 

40 ppm

8.5 x 11 in., A4  

Labels, Cast Coated, 
Embossed or 
Textured Film

52–256 g/m2 40 ppm —  40 ppm —  

9 x 11 in., A4 Tab 
Stock 

Uncoated, Coated, 
and Matte Coated

52–220 g/m2 

221–256 g/m2

64 ppm 

48 ppm

32 ppm 

24 ppm

64 ppm 

64 ppm

32 ppm 

32 ppm

TTaabbllee 22..22 TTrraayyss 11,, 22,, aanndd 33 iinn SSEEFF FFeeeedd DDiirreeccttiioonn

PAPER SIZE AND 
PAPER TYPE 

PAPER WEIGHT 

PRINTS PER MINUTE: 
BASIC PRINT ENGINE 
CONFIGURATION 

PRINTS PER MINUTE: ALL 
STOCKS RATED SPEED 
(ASRS) CONFIGURATION 

1–SIDED 2–SIDED 1–SIDED 2–SIDED 

Postcard  

Uncoated, Coated, 
and Matte Coated

52–220 g/m2 

221–256 g/m2

80 ppm 

60 ppm

40 ppm 

30 ppm

80 ppm 

80 ppm

40 ppm 

40 ppm

8.5 x 11 in.  

Uncoated, Coated, 
and Matte Coated

52–220 g/m2 

221–256 g/m2

64 ppm 

48 ppm

32 ppm 

24 ppm

64 ppm 

64 ppm

32 ppm 

32 ppm

A4  

Uncoated, Coated, 
and Matte Coated

52–220 g/m2 

221–256 g/m2

51 ppm 

38 ppm

25.5 ppm 

19 ppm

51 ppm 

51 ppm

25.5 ppm 

25.5 ppm

8.5 x 14 in., B4  

Uncoated, Coated, 
and Matte Coated

52–220 g/m2 

221–256 g/m2

51 ppm 

38 ppm

25.5 ppm 

19 ppm

51 ppm 

51 ppm

25.5 ppm 

25.5 ppm

11 x 17 in., A3  

Uncoated, Coated, 
and Matte Coated

52–220 g/m2 

221–256 g/m2

44 ppm 

32 ppm

22 ppm 

16 ppm

44 ppm 

44 ppm

22 ppm 

22 ppm
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PAPER SIZE AND 
PAPER TYPE 

PAPER WEIGHT 

PRINTS PER MINUTE: 
BASIC PRINT ENGINE 
CONFIGURATION 

PRINTS PER MINUTE: ALL 
STOCKS RATED SPEED 
(ASRS) CONFIGURATION 

1–SIDED 2–SIDED 1–SIDED 2–SIDED 

12 x 18 in., SRA3  

Uncoated, Coated, 
and Matte Coated

52–220 g/m2 

221–256 g/m2

37 ppm 

29 ppm

18.5 ppm 

14.5 ppm

37 ppm 

37 ppm

18.5 ppm 

18.5 ppm

13 x 19 in., 330.2 x 
488 mm  

Uncoated, Coated, 
and Matte Coated

52–220 g/m2 

221–256 g/m2

37 ppm 

29 ppm

18.5 ppm 

14.5 ppm

37 ppm 

37 ppm

18.5 ppm 

18.5 ppm

8.5 x 11 in.  

Labels, Cast Coated, 
Embossed or 
Textured Film

52–256 g/m2 32 ppm —  32 ppm —  

8.5 x 14 in., B4, A4  

Labels, Cast Coated, 
Embossed or 
Textured Film

52–256 g/m2 25 ppm —  25 ppm —  

11 x 17 in., A3  

Labels, Cast Coated, 
Embossed or 
Textured Film

52–256 g/m2 22 ppm —  22 ppm —  

12 x 18 in., SRA3  

Labels, Cast Coated, 
Embossed or 
Textured Film

52–256 g/m2 20 ppm —  20 ppm —  

13 x 19 in., 330.2 x 
488 mm  

Labels, Cast Coated, 
Embossed or 
Textured Film

52–256 g/m2 19 ppm —  19 ppm —  
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TTaabbllee 22..33 TTrraayy 55 ((BByyppaassss TTrraayy))

PAPER SIZE AND 
PAPER TYPE 

PAPER 
FEED 
DIREC
TION 

PAPER WEIGHT 

PRINTS PER MINUTE: 
BASIC PRINT ENGINE 
CONFIGURATION 

PRINTS PER MINUTE: 
ALL STOCKS RATED 
SPEED (ASRS) 
CONFIGURATION 

1–SIDED 2–SIDED 1–SIDED 2–SIDED 

Postcard 

Uncoated, Coated, 
and Matte Coated

SEF 52–220 g/m2 

221–350 g/m2

351–400 g/m2

53 ppm 

48 ppm

48 ppm

26.5 ppm 

24 ppm

24 ppm

53 ppm 

53 ppm

53 ppm

26.5 ppm 

26.5 ppm

26.5 ppm

8.5 x 11 in., A4 

Uncoated, Coated, 
and Matte Coated

LEF 52–220 g/m2 

221–350 g/m2

351–400 g/m2

53 ppm 

48 ppm

48 ppm

26.5 ppm 

24 ppm

—

53 ppm 

53 ppm

53 ppm

26.5 ppm 

26.5 ppm

—

8.5 x 11 in. 

Uncoated, Coated, 
and Matte Coated

SEF 52–220 g/m2 

221–350 g/m2

351–400 g/m2

46 ppm 

40 ppm

40 ppm

23 ppm 

20 ppm

—

46 ppm 

46 ppm

46 ppm

23 ppm 

23 ppm

—

A4 

Uncoated, Coated, 
and Matte Coated

SEF 52–220 g/m2 

221–350 g/m2

351–400 g/m2

39 ppm 

33 ppm

33 ppm

19.5 ppm 

16.5 ppm

—

39 ppm 

39 ppm

39 ppm

19.5 ppm 

19.5 ppm

—

8.5 x 14 in., B4 

Uncoated, Coated, 
and Matte Coated

SEF 52–220 g/m2 

221–350 g/m2

351–400 g/m2

39 ppm 

33 ppm

33 ppm

19.5 ppm 

16.5 ppm

—

39 ppm 

39 ppm

39 ppm

19.5 ppm 

19.5 ppm

—

11 x 17 in., A3 

Uncoated, Coated, 
and Matte Coated

SEF 52–220 g/m2 

22 –350 g/m2

351–400 g/m2

34 ppm 

28 ppm

28 ppm

17 ppm 

14 ppm

—

34 ppm 

34 ppm

34 ppm

17 ppm 

17 ppm

—

12 x 18 in., SRA3 

Uncoated, Coated, 
and Matte Coated

SEF 52–220 g/m2 

221–350 g/m2

351–400 g/m2

32 ppm 

26 ppm

26 ppm

16 ppm 

13 ppm

—

32 ppm 

32 ppm

32 ppm

16 ppm 

16 ppm

—

13 x 19 in.,  

Uncoated, Coated, 
and Matte Coated

SEF 52–220 g/m2 

221–350 g/m2

351–400 g/m2

32 ppm 

26 ppm

26 ppm

16 ppm 

13 ppm

—

32 ppm 

32 ppm

32 ppm

16 ppm 

16 ppm

—

330.2 x 488 mm 

Uncoated, Coated, 
and Matte Coated

SEF 52–220 g/m2 

221–350 g/m2

31 ppm 

26 ppm

15.5 ppm 

13 ppm

—

31 ppm 

31 ppm

15.5 ppm 

15.5 ppm

—
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PAPER SIZE AND 
PAPER TYPE 

PAPER 
FEED 
DIREC-
TION 

PAPER WEIGHT 

PRINTS PER MINUTE: 
BASIC PRINT ENGINE 
CONFIGURATION 

PRINTS PER MINUTE: 
ALL STOCKS RATED 
SPEED (ASRS) 
CONFIGURATION 

1–SIDED 2–SIDED 1–SIDED 2–SIDED 

351–400 g/m2 26 ppm 31 ppm

8.5 x 11 in., A4 

Labels, Cast 
Coated, Embossed 
or Textured Film

LEF 52–300 g/m2 39 ppm —  39 ppm —  

8.5 x 11 in. 

Labels, Cast 
Coated, Embossed 
or Textured Film

SEF 52–300 g/m2 32 ppm —  32 ppm —  

8.5 x 14 in., B4, A4 

Labels, Cast 
Coated, Embossed 
or Textured Film

SEF 52–300 g/m2 25 ppm —  25 ppm —  

11 x 17 in., A3 

Labels, Cast 
Coated, Embossed 
or Textured Film

SEF 52–300 g/m2 21 ppm —  21 ppm —  

12 x 18 in., SRA3 

Labels, Cast 
Coated, Embossed 
or Textured Film

SEF 52–300 g/m2 19 ppm —  19 ppm —  

13 x 19 in., 330.2 x 
488 mm 

Labels, Cast 
Coated, Embossed 
or Textured Film

SEF 52–300 g/m2 19 ppm —  19 ppm —  

13 x 19 in., 330.2 x 
488 mm 

Labels, Cast 
Coated, Embossed 
or Textured Film

SEF 52–300 g/m2 19 ppm —  19 ppm —  

13 x 19 in., 330.2 x 
488 mm 

Labels, Cast 

SEF 52–300 g/m2 19 ppm —  19 ppm —  
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PAPER SIZE AND 
PAPER TYPE 

PAPER 
FEED 
DIREC-
TION 

PAPER WEIGHT 

PRINTS PER MINUTE: 
BASIC PRINT ENGINE 
CONFIGURATION 

PRINTS PER MINUTE: 
ALL STOCKS RATED 
SPEED (ASRS) 
CONFIGURATION 

1–SIDED 2–SIDED 1–SIDED 2–SIDED 

Coated, Embossed 
or Textured Film

13 x 19 in., 330.2 x 
488 mm 

Labels, Cast 
Coated, Embossed 
or Textured Film

SEF 52–300 g/m2 19 ppm —  19 ppm —  

Extra Long Sheets 
(XLS) 488–660 
mm 

Uncoated, Coated, 
and Matte Coated

SEF 52–220 g/m2 19 ppm —  19 ppm —  

Extra Long Sheets 
(XLS) 488–660 
mm 

Label Tacking 
paper, Cast paper, 
Film Embossed 
paper, OHP 
Transfer Paper

SEF 52–220 g/m2 9 ppm —  9 ppm —  

9 x 11 in., A4 Tab 
Stock 

Uncoated, Coated, 
and Matte Coated

LEF 52–220 g/m2 

221–350 g/m2

351–400 g/m2

46 ppm 

40 ppm

40 ppm

23 ppm 

20 ppm

20 ppm

46 ppm 

46 ppm

46 ppm

23 ppm 

23 ppm

23 ppm
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TTaabbllee 22..44 OOppttiioonnaall TTrraayyss 66,, 77,, 88,, aanndd 99

PAPER SIZE AND 
PAPER TYPE 

PAPER 
FEED 
DIREC
TION 

PAPER WEIGHT 

PRINTS PER MINUTE: 
BASIC PRINT ENGINE 
CONFIGURATION 

PRINTS PER MINUTE: 
ALL STOCKS RATED 
SPEED (ASRS) 
CONFIGURATION 

1–SIDED 2–SIDED 1–SIDED 2–SIDED 

Postcard 

Uncoated, Coated, 
and Matte Coated

SEF 52–220 g/m2 

221–350 g/m2

351–400 g/m2

80 ppm 

60 ppm

60 ppm

40 ppm 

30 ppm

30 ppm

80 ppm 

80 ppm

80 ppm

40 ppm 

40 ppm

40 ppm

8.5 x 11 in., A4 

Uncoated, Coated, 
and Matte Coated

LEF 52–220 g/m2 

221–350 g/m2

351–400 g/m2

80 ppm 

60 ppm

60 ppm

40 ppm 

30 ppm

—

80 ppm 

80 ppm

80 ppm

40 ppm 

40 ppm

—

8.5 x 11 in. 

Uncoated, Coated, 
and Matte Coated

SEF 52–220 g/m2 

221–350 g/m2

351–400 g/m2

64 ppm 

48 ppm

48 ppm

32 ppm 

24 ppm

—

64 ppm 

64 ppm

64 ppm

32 ppm 

32 ppm

—

A4 

Uncoated, Coated, 
and Matte Coated

SEF 52–220 g/m2 

221–350 g/m2

351–400 g/m2

51 ppm 

38 ppm

38 ppm

25.5 ppm 

19 ppm

—

51 ppm 

51 ppm

51 ppm

25.5 ppm 

25.5 ppm

—

8.5 x 14 in., B4 

Uncoated, Coated, 
and Matte Coated

SEF 52–220 g/m2 

221–350 g/m2

351–400 g/m2

51 ppm 

38 ppm

38 ppm

25.5 ppm 

19 ppm

—

51 ppm 

51 ppm

51 ppm

25.5 ppm 

25.5 ppm

—

11 x 17 in., A3 

Uncoated, Coated, 
and Matte Coated

SEF 52–220 g/m2 

221–350 g/m2

351–400 g/m2

44 ppm 

32 ppm

32 ppm

22 ppm 

16 ppm

—

44 ppm 

44 ppm

44 ppm

22 ppm 

22 ppm

—

12 x 18 in., SRA3 

Uncoated, Coated, 
and Matte Coated

SEF 52–220 g/m2 

221–350 g/m2

351–400 g/m2

37 ppm 

29 ppm

29 ppm

18.5 ppm 

14.5 ppm

—

37 ppm 

37 ppm

37 ppm

18.5 ppm 

18.5 ppm

—

13 x 19 in., 330.2 x 
488 mm 

Uncoated, Coated, 
and Matte Coated

SEF 52–220 g/m2 

221–350 g/m2

351–400 g/m2

37 ppm 

29 ppm

29 ppm

18.5 ppm 

14.5 ppm

—

37 ppm 

37 ppm

37 ppm

18.5 ppm 

18.5 ppm

—

8.5 x 11 in., A4 

Labels, Cast 
Coated, Embossed 

LEF 52–300 g/m2 40 ppm —  40 ppm —  
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PAPER SIZE AND 
PAPER TYPE 

PAPER 
FEED 
DIREC-
TION 

PAPER WEIGHT 

PRINTS PER MINUTE: 
BASIC PRINT ENGINE 
CONFIGURATION 

PRINTS PER MINUTE: 
ALL STOCKS RATED 
SPEED (ASRS) 
CONFIGURATION 

1–SIDED 2–SIDED 1–SIDED 2–SIDED 

or Textured Film

8.5 x 11 in. 

Labels, Cast 
Coated, Embossed 
or Textured Film

SEF 52–300 g/m2 32 ppm —  32 ppm —  

8.5 x 14 in., B4, A4 

Labels, Cast 
Coated, Embossed 
or Textured Film

SEF 52–300 g/m2 25 ppm —  25 ppm —  

11 x 17 in., A3 

Labels, Cast 
Coated, Embossed 
or Textured Film

SEF 52–300 g/m2 22 ppm —  22 ppm —  

12 x 18 in., SRA3 

Labels, Cast 
Coated, Embossed 
or Textured Film

SEF 52–300 g/m2 20 ppm —  20 ppm —  

13 x 19 in., 330.2 x 
488 mm 

Labels, Cast 
Coated, Embossed 
or Textured Film

SEF 52–300 g/m2 19 ppm —  19 ppm —  

9 x 11 in., A4 Tab 
Stock 

Uncoated, Coated, 
and Matte Coated

LEF 52–220 g/m2 

221–350 g/m2

351–400 g/m2

64 ppm 

48 ppm

48 ppm

32 ppm 

24 ppm

24 ppm

64 ppm 

64 ppm

64 ppm

32 ppm 

32 ppm

32 ppm

LOADING MEDIA IN TRAYS 1 ,  2 ,  AND 3

Information About Loading Media in Trays 1, 2, and 3

Trays 1, 2, and 3 are identical. Each tray has a capacity of 550 sheets of 20 lb./75 g/m2 paper. Stock can be Long 
Edge Feed (LEF) or Short Edge Feed (SEF), landscape or portrait.

Note: Each feeder tray has a stock loading label. When loading media into the tray, refer to the labels on the 
inside panel of the feeder tray for the correct orientation of that stock type.
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Loading Paper in Trays 1, 2, and 3

Note: A paper jam may occur if a tray is opened while it is being used to feed stock.

1. Select the appropriate paper stock for your print or copy job.

2. Pull out the tray slowly until it stops.

3. Open the ream of paper with the seam side facing up.

4. Fan the sheets before loading them into the tray.

5. Load and align the edge of the paper against the left edge of the tray. 

Paper can be loaded in either the LEF/portrait or SEF/landscape direction.

6. Adjust the paper guides by pressing in the guide release and carefully moving the Edge Guide until it lightly 
touches the edge of the material in the tray. 

Do not load materials above the MAX line located on the rear Edge Guide.

7. Gently push in the tray until it comes to a stop. 

If enabled by your System Administrator, the Paper Tray settings/Tray Properties window may be displayed on 
the UI. You can view and set stock attributes and verify trays are assigned with the correct stock.

8. From the Paper Tray settings/Tray Properties window, choose one of the following: 

• No changes were made to the paper tray; select Confirm to close the window.

• Changes were made to the paper tray; go to the next step.

9. Select the Change Settings button. 

a. Make the desired selections for Paper Type/Paper Weight, Paper Size, and Paper Color.

b. If necessary, make the desired changes to paper curl and alignment adjustment.

c. Select Save until you are returned to the Paper Tray settings/Tray Properties window.

d. Select Confirm or OK to save the information and close the Paper Tray settings/Tray Properties window.
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Loading Tab Stock in Trays 1, 2, and 3

Refer to the following tips before loading tab stock in the tray:

• You can load either single straight collated or single reverse collated tab stock.

• For network print jobs, refer to your print server customer documentation for instructions on loading tab stock 
into a tray.

• If a jam occurs while running tabbed sets, cancel the job and start again.

1. Pull out the tray slowly until it stops.

2. Fan the tab stock before loading into the tray.

3. Load the tab stock LEF (portrait) and align the straight edge of the tab stock against the left edge of the tray 
(tabs to the right or trailing edge). For single straight collated tabs, the first blank tab cutout in the stack will be 
toward the rear of the tray. For single reverse collated tabs, the first blank tab cutout in the stack will be toward 
the front of the tray. 

Note: Tab stock is loaded so the straight edge of the stock is in the feed direction. Also, you can only load 
the tab stock LEF.

4. Adjust the paper guides by pressing in the guide release and carefully moving the Edge Guide until it lightly 
touches the edge of the stock in the tray. 

Do not load materials above the MAX line located on the rear Edge Guide.

5. Gently push in the tray until it comes to a stop.

6. If the Paper Tray settings/Tray Properties window displays on the UI, confirm the correct tray to which it is 
printing and other information, including size, type (precut tab), and, if necessary, paper curl and/or alignment 
option.

7. Select Confirm or OK to save the information and close the Paper Tray settings/Tray Properties window.

Loading Transparencies in Trays 1, 2, and 3

Read these tips before using transparencies:

• Do not use transparencies with the white side strip (permanent or removable).

• Do not mix paper and transparencies in a tray. Jams may occur.

• Do not load more than 100 transparencies in a paper tray at one time.
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• Load 8.5 x 11 in (A4) transparencies long edge feed only (landscape).

1. Select the appropriate paper stock for your print job.

2. Pull out the tray slowly until it stops.

3. Fan the transparencies to stop them from sticking together before loading into the tray.

4. Load a small stack of paper into the tray first. The paper must be the same size as the transparencies. 

5. Load the transparencies LEF on top of this paper stack. Align the edge of the transparencies against the left 
edge of the tray, with the side to be printed on facing down. 

6. Adjust the paper guides by pressing in the guide release and carefully moving the Edge Guide until it lightly 
touches the edge of the material in the tray. 
Do not load materials above the MAX line located on the rear Edge Guide.

7. Gently push in the tray until it comes to a stop. 

If enabled by your System Administrator, the Paper Tray settings/Tray Properties window displays on the UI. 

8. From the Paper Tray settings/Tray Properties window, enter the correct paper information, including size, type, 
weight and, if necessary, paper curl and/or alignment option.

9. Select Confirm or OK to save the information and close the Paper Tray settings/Tray Properties window.

Loading Hole Punch Paper in Trays 1, 2, and 3

Pre-drilled paper is defined as having two or more holes along one edge for use in ring binders and notebooks. To 
prevent jams or damage, make sure that any plugs (pieces cut out of the paper to create the holes) do not remain 
in the stack.

1. Select the appropriate paper stock for your print job.

2. Pull out the tray slowly until it stops.

3. Open the ream of paper with the seam side facing up.

4. Fan the sheets before loading them into the tray.
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5. Load and align the edge of the pre-drilled paper with the holes against the left edge of the tray. 

Paper can be loaded in either the LEF or portrait, or SEF or landscape direction.

6. Adjust the paper guides by pressing in the guide release and carefully moving the Edge Guide until it lightly 
touches the edge of the material in the tray. 
Do not load materials above the MAX line located on the rear Edge Guide.

7. Gently push in the tray until it comes to a stop. 

If enabled by your System Administrator, the Paper Tray settings/Tray Properties window appears on the UI. 

8. From the Paper Tray settings/Tray Properties window, enter the correct paper information, including size, type, 
weight and, if necessary, paper curl and alignment option.

9. Select Confirm or OK to save the information and close the Paper Tray settings/Tray Properties window.

LOADING MEDIA IN THE BYPASS (TRAY 5)

Note: If any optional feeding devices are attached, the Bypass (Tray 5) is installed above or on top of that 
feeding device.

This tray is used primarily when using a small quantity and special media (such as envelopes). Review the following 
tips when using the Bypass (Tray 5):

• Verify the stock loaded in the tray with the Paper Tray settings/Tray Properties window on the UI

• Load a maximum of 250 sheets of 24 lb./90 g/m2 paper

• Do not load mixed-size paper into the Bypass Tray

• Do not load materials above the MAX line as indicated on the tray

Loading Paper in the Bypass (Tray 5)

Note: The following procedure shows the Bypass (Tray 5) located on top of the 2-Tray OHCF.
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1. Gently extend the Bypass tray (Tray 5) as necessary to accommodate the paper. 

2. Hold the center of the paper guides and slide them to the desired paper size. 

3. Select the appropriate paper stock for your print/copy job.

4. Open the ream of paper with the seam side facing up.

5. Fan the sheets before loading them into the tray.

6. Insert the paper or media into the tray until it stops.

7. Adjust the paper guides so that they touch the edges of the stack. 
If enabled by your System Administrator, the Paper Tray settings/Tray Properties window may be displayed on 
the UI.

8. If the Paper Tray settings/Tray Properties window displays on the UI, confirm the correct tray to which it is 
printing and other information, including size, type (precut tab), and, if necessary, paper curl and/or alignment 
option.

9. Select Confirm or OK to save the information and close the Paper Tray settings/Tray Properties window.

Xerox® Versant® 280 Press User Documentation 127

Working With



Loading Tab Stock in the Bypass (Tray 5)

Refer to the following tips before loading tab stock in the tray:

• You can load either single straight collated or single reverse collated tab stock.

• For network print jobs, refer to your print server customer documentation for instructions on loading tab stock 
into a tray.

• If a jam occurs while running tabbed sets, cancel the job and start again.

1. Gently extend the Bypass tray (Tray 5) as necessary to accommodate the tab stock.

2. Hold the center of the paper guides and slide them to the desired stock size.

3. Fan the tab paper before inserting into the tray.

4. Insert the tab stock into the tray so the straight edge of the stock is in the feed direction (lead edge) and the 
tabs are to the left (trail edge).

5. Continue to insert the tab stock into the tray until it stops.

6. Adjust the paper guides so that they touch the edges of the stack.

7. If the Paper Tray settings/Tray Properties window displays on the UI, confirm the correct tray to which it is 
printing and other information, including size, type (precut tab), and, if necessary, paper curl and/or alignment 
option.

8. Select Confirm or OK to save the information and close the Paper Tray settings/Tray Properties window.

Loading Transparencies in the Bypass (Tray 5)

Note: Do not use transparencies with a white side strip (permanent or removable).

1. Gently extend the Bypass tray (Tray 5) as necessary to accommodate the paper.

2. Hold the center of the paper guides and slide them to the desired paper size.

3. Select the appropriate paper stock for your print/copy job.

4. Fan the transparencies to stop them from sticking together before loading into the tray.

5. Insert the transparencies LEF into the tray with the side to be printed on face up and with the removable stripe 
to the right.

6. Continue to insert the paper or media into the tray until it stops.

7. Adjust the paper guides so that they touch the edges of the stack.

8. From the Paper Tray settings/Tray Properties window, enter the correct paper information, including size, type, 
weight and, if necessary, paper curl and/or alignment option.

9. Select Confirm or OK to save the information and close the Paper Tray settings/Tray Properties window.

Loading Hole Punch Paper in the Tray 5 (Bypass)

1. Gently extend the Bypass tray (Tray 5) as necessary to accommodate the paper.

2. Hold the center of the paper guides and slide them to the desired paper size.

3. Select the appropriate paper stock for your print or copy job.
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4. Fan the sheets before loading them into the tray.

5. Insert the pre-drilled stock into the tray in the LEF direction with the holes to the right.

6. Continue to insert the paper or media into the tray until it stops.

7. Adjust the paper guides so that they touch the edges of the stack.

8. From the Paper Tray settings/Tray Properties window, enter the correct paper information, including size, type, 
weight and, if necessary, paper curl and alignment option.

9. Select Confirm or OK to save the information and close the Paper Tray settings/Tray Properties window.

Loading Envelopes in Tray 5 (Bypass)

It is recommended that you print envelopes from the Bypass (Tray 5). If you are required to print envelopes from 
the optional Trays 6 and 7, use the Postcard Bracket.

Note: For information on supported envelope types and sizes, refer to the Customer Expectation and 
Installation Guide.

When setting up your print job, select from the following options:  

• Envelope Feeder: used for standard-sized envelopes

• Change Settings: used for custom-sized envelopes

Note: Store unused envelopes in their original packaging to avoid the excess moisture or dryness that can 
affect print quality and cause wrinkling. Excessive moisture can cause the envelopes to seal before or during 
printing.

Some wrinkling or embossing can occur when printing on envelopes. Successful envelope printing depends on the 
quality and construction of the envelopes. Try another envelope brand if problems occur.

When defining custom paper settings at the Paper Tray settings/Tray Properties window, assign the custom stock to 
the Bypass Tray (Tray 5) or an Advanced Oversized High Capacity Feeder (Tray 6 or 7). Select Auto Detect for 
automatic size-detection or measure the height and width of the envelope with the flap closed, then enter the 
dimensions. For more detailed information, refer to the following steps.

1. Always load envelopes with the flaps closed. 
Do not use padded envelopes.

2. When loading in the SEF direction, place the flaps facing the back of the press. When loading in the LEF 
direction, place the flaps facing the lead edge.

3. When submitting your network print file, select Custom Paper as the Paper Type. Enter the dimensions of the 
envelope. 
Measure the width from the lead edge to the trail edge of the envelope. For example, if you load SEF, enter the 
long dimension of the envelope as the width. If you load the envelope LEF, enter the short dimension of the 
envelope as the width.

4. Enter a heavy paper weight value, such as 220 g/m2 in the Paper Weight field.  
A paper weight of 220 is a good starting point. If the printing is blurred or smeared, enter a higher value. 

5. Select the Bypass Tray (Tray 5) as the Paper Source.
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Feeding Devices

HIGH CAPACITY FEEDER,  TRAY 6

The 1-tray High Capacity Feeder (HCF), otherwise known as Tray 6, provides a 2,000-sheet, letter-size (8.5 x 11 in., 
A4) paper source.

Note: This tray uses only letter-size, 8.5 x 11 in. or A4 (210 x 297 mm) paper, long-edge feed (LEF).

Loading Paper in Tray 6

Tips for the 1-tray HCF (Tray 6):

• This tray accommodates A4 (8.5 x 11 in.) long-edge feed (LEF) stock.

• Additionally, the tray can accommodate B5 and Executive (7.25 x 10.5 in.), but requires an NVM change for the 
default size settings. For changes to the NVM settings, contact Xerox Technical Customer Support.

• This tray supports stock weights 64–22 g/m2 (18 lb. Bond–80 lb. Cover).

• This tray holds a maximum of 2000 sheets of 75 g/m2 (20lb.) paper.

• Load stock in the LEF direction only.

• Do not load materials above the MAX line.

1. Select the appropriate paper for your job.

2. Pull out the tray slowly until it stops. 

3. Open the ream of paper with the seam side face up.

4. Before you load the paper into the tray, fan the sheets.

5. Load the paper in the tray. 
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a. Align the edge of the paper against the right edge of the tray.

b. Move the paper guides so that they just touch the edges of the paper stack.

Do not load materials above the MAX line.

6. Gently push in the tray until it stops. 

If enabled by your system administrator, the Paper Tray settings screen is displayed on the user interface.

7. If changes are made to the paper tray, select Change Settings, otherwise, proceed to the next step. 

a. Select the required settings for Paper Type/Paper Weight, Paper Size, andPaper Color.

b. If necessary, make the required changes to the paper curl and alignment adjustment settings. 

Note: Refer to the System Administrator Guide for detailed information on the paper curl and alignment 
adjustment options.

c. Select Save repeatedly, until you return to the tray settings window.

8. To close the window, select Confirm.

Tray 6 Specifications

ITEM SPECIFICATION 

Paper Capacity 2,000 sheets 

Sheet Size 8.5 x 11 in. or A4 

B5 and Executive (7.25 x 10.5 in.), but requires NVM change for default size settings.

Contact your customer support representative.

Paper Weight 64–220 g/m2 uncoated or coated paper 

ADVANCED OVERSIZED HIGH CAPACITY FEEDER,  TRAYS 6  AND 7

Trays 6 and 7 Overview

The Oversized High Capacity Feeder (OHCF) is available in a 1-tray or 2-tray option. The OHCF feeds a variety of 
stock sizes, including standard and oversized stock up to 13 x 19.2 in./330.2 x 488 mm. Each tray holds 2,000 
sheets.
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1. 2-Tray Advanced OHCF with Bypass (Trays 6 and 7)

2. 1-Tray OHCF with Bypass and storage cabinet above the tray (Tray 6)

Paper and Media in Trays 6 and 7

Note: Each feeder tray has a stock loading label. When loading media into the tray, refer to the labels on the 
inside panel of the feeder tray for the correct orientation of that stock type.

It is recommended that you use the Bypass Tray (Tray 5) to feed envelopes. However, if you use Trays 6 and 7, feed 
C5 and No. 10 envelopes SEF with the Postcard Bracket or Envelope Support Kit installed. Without the Envelope 
Support Kit, the maximum recommended stack height is 200 envelopes. The Envelope Support Kit increases the 
maximum recommended envelope capacity.

Note: The Envelope Support Kit is an additional kit to print envelops, that can be ordered separately.

If you are using the optional Postcard Bracket, minimum size is 101.6 x 152.4 mm (4 x 6 in.).

Note: For more information on the optional Postcard Bracket, refer to Paper and Media.

Loading Paper in Trays 6 and 7

1. Select the appropriate paper stock for your print/copy job.

2. Pull out the tray slowly until it stops.

3. Open the ream of paper with the seam side facing up.

4. Fan the sheets before loading them into the tray.

5. Load paper into the tray.

6. Adjust the paper guides by pressing in the guide release and carefully moving the Edge Guide until it lightly 
touches the edge of the material in the tray. 

Do not load materials above the MAX line located on the rear Edge Guide.

7. Gently push in the tray until it comes to a stop. 

The Paper Tray settings/Tray Properties window displays on the UI. You can view and set stock attributes and 
verify trays are assigned with the correct stock. 

8. From the Paper Tray settings/Tray Properties window, enter or verify the correct paper information, including 
size, type, weight and, if necessary, paper curl and/or alignment option. Select the stock and assign the stock to 
the tray to be used.
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9. Select Confirm or OK to save the information and close the Paper Tray settings/Tray Properties window.

Loading Tabs in Trays 6 and 7

Refer to the following tips before loading tab stock in the tray:

• You can load either single straight collated or single reverse collated tab stock.

• For network print jobs, refer to your print server customer documentation for instructions on loading tab stock 
into a tray.

• If a jam occurs while running tabbed sets, cancel the job and start again.

1. After programming your tab job at the print server, select the appropriate and matching tab stock for your print 
job.

2. Pull out the tray slowly until it stops.

3. Fan the tab paper before loading into the tray.

4. Load the tab stock LEF (portrait) and align the straight edge of the tab stock against the right edge of the tray 
(tabs to the left or trailing edge). For single straight collated tabs, the first blank tab cutout in the stack will be 
toward the front of the tray. For single reverse collated tabs, the first blank tab cutout in the stack will be 
toward the rear of the tray.  

Tab stock is loaded so the straight edge of the stock is in the feed direction. Also, you can only load the tab 
stock LEF.

5. Adjust the paper guides by pressing in the guide release and carefully moving the Edge Guide until it lightly 
touches the edge of the stock in the tray. 

Do not load materials above the MAX line located on the rear Edge Guide.

6. Gently push in the tray until it comes to a stop. 

The Paper Tray settings/Tray Properties window displays on the press UI. 

7. From the Paper Tray settings/Tray Properties window, confirm the correct tray to which it is printing and other 
information, including size (9 x 11 inches), type (precut tab), and, if necessary, paper curl and/or alignment 
option.

8. Select Confirm or OK to save the information and close the Paper Tray settings/Tray Properties window.
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Loading Transparencies in Trays 6 and 7

Read these tips before using transparencies:

• Do not use transparencies with the white side strip (permanent or removable).

• Do not mix paper and transparencies in a tray. Jams may occur.

• Do not load more than 100 transparencies in a paper tray at one time.

• Load 8.5 x 11 in (A4) transparencies long edge feed only (landscape).

1. Select the appropriate paper stock for your print job.

2. Pull out the tray slowly until it stops.

3. Fan the transparencies to stop them from sticking together before loading into the tray.

4. Load transparencies LEF on top of a small stack of same-size paper and align the strip edge of the transparency 
against the right edge of the paper tray, with the side to be printed on facing down.

5. Adjust the paper guides by pressing in the guide release and carefully moving the Edge Guide until it lightly 
touches the edge of the material in the tray. 

Do not load materials above the MAX line located on the rear Edge Guide.

6. Gently push in the tray until it comes to a stop. 

If enabled by your System Administrator, the Paper Tray settings/Tray Properties window displays on the UI. 

7. From the Paper Tray settings/Tray Properties window, enter the correct paper information, including size, type, 
weight and, if necessary, paper curl and/or alignment option.

8. Select Confirm or OK to save the information and close the Paper Tray settings/Tray Properties window.

Loading Hole Punch Paper in Trays 6 and 7

1. Select the appropriate paper stock for your print job.

2. Pull out the tray slowly until it stops.

3. Open the ream of paper with the seam side facing up.

4. Fan the sheets before loading them into the tray.
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5. Load and register the paper against the right side of the tray for LEF direction. 

6. Load and register the paper against the right side of the tray as depicted below for SEF direction. 

7. Adjust the paper guides by pressing in the guide release and carefully moving the Edge Guide until it lightly 
touches the edge of the stock in the tray. 

Do not load materials above the MAX line located on the rear Edge Guide.

8. Gently push in the tray until it comes to a stop. 

If enabled by your System Administrator, the Paper Tray settings/Tray Properties window displays on the UI. 

9. From the Paper Tray settings/Tray Properties window, enter the correct paper information, including size, type, 
weight and, if necessary, paper curl and/or alignment option.

10. Select Confirm or OK to save the information and close the Paper Tray settings/Tray Properties window.

Postcard Bracket

The Postcard bracket is delivered with the OHCF from manufacturing. The Postcard bracket allows you to print on 
smaller size media without requiring post-processing cutting or sorting. The Postcard bracket specifically 
accommodates 4 x 6 in. (101.6 x 152.4 mm) SEF media.
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UUssiinngg tthhee PPoossttccaarrdd BBrraacckkeett

Use the following procedure for installing and using the Postcard bracket when printing on smaller media (101.6 x 
152.4 mm (4 x 6 in.)).

With the Postcard Bracket installed, you can print envelopes from Trays 6 and 7.

1. Slowly open one of the paper trays until it stops, then remove the paper. 

2. Move the paper guides out to their largest position. 

3. To remove the postcard bracket, loosen the screw on the left side of the tray (1), then remove the bracket (2). 
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4. Install the Postcard bracket so that it sits on the locating pins on the upper frame and in the grooves on the 
bottom of the tray. 

5. Tighten the thumb screw so that it locks the Postcard bracket in place. 

6. Load the postcard stock and adjust the paper guides against the stock. 
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7. Close the paper tray, then confirm the new settings on the press user interface and if necessary at the print 
server.

8. Run your print job.

9. Upon completion of your print job, remove the postcard stock and the Postcard bracket from the tray.

10. Store the postcard bracket by inserting it into the storage area on the left side of the tray (1) and tightening 
the screw (2). 

Skew Adjustment Levers for Trays 6-9

The skew adjustment levers are found in all paper trays. These levers are used to improve paper feed accuracy and 
to reduce paper skew problems.

1. Rear Skew Adjustment Lever

2. Right Side Skew Adjustment Lever

Note: These levers should remain in their default position. The position of these levers should be changed 
only if there is a skew problem when running a specific print job and/or media type. Changing the levers 
may cause more skew problems when running certain media types such as coated, label, transparency and 
film.

Use the following procedure to set the skew adjustment levers:

1. Pull out the tray slowly until it stops. 

The Tray Properties / Settings automatically display at the press User Interface (UI).
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2. From the Tray Properties window, verify that the correct paper information is being used including size, type, 
weight and paper curl or alignment option for the tray. Select OK and close the Tray Properties window.

3. At the tray, slide the rear skew adjustment lever to the right.

4. Gently push in the tray until it comes to a stop.

5. Run your print job: 

• If the paper is fed accurately without skew and the printed output is satisfactory; your task is complete.

• If the paper is skewed and the printed output is unsatisfactory; proceed to the next step.

6. Pull out the tray slowly until it stops.

7. Verify the tray and paper settings at the print server.

8. Return the rear skew adjustment lever to its left, default position.

9. Slide the right-side skew adjustment lever toward the front of the paper tray.

10. Gently push in the tray until it comes to a stop.

11. Run your print job: 

• If the paper is fed accurately without skew and the printed output is satisfactory; your task is complete.

• If the paper is skewed and the printed output is unsatisfactory; proceed to the next step.

12. Pull out the tray slowly until it stops.

13. Return the right-side skew adjustment lever toward the rear of the paper tray; this is its default position.

14. Gently push in the tray until it comes to a stop.

Trays 6 and 7 Specifications

ITEM SPECIFICATION 

Paper Capacity 1 Tray: 2,000 sheets plus top Storage Cabinet 

2 Tray: 2,000 sheets per tray (total of 4000 sheets)

Important: When using up to Xerox 24 lb., 90 g/m2 bond 
paper.

Sheet Sizes 1 Tray: 182 x 250 mm (7.2 x 10 in.), B5 to 330 x 488 mm (13 x 19.2 
in.), SRA3 

1 Tray, with Postcard Bracket: 100 x 148 mm minimum

2 Tray: 102 x 152 mm (4 x 6 in.) to 330 x 488 mm (13 x 19.2 in.), 
SRA3

2 Tray, with Postcard Bracket: 98 x 148 mm minimum

Paper Weight 52–400 g/m2 
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DUAL ADVANCED OVERSIZED HIGH CAPACITY FEEDER,  TRAYS 8  AND 9

Trays 8 and 9 Overview

Important: The Dual Advanced Oversized High Capacity Feeder (OHCF), Trays 8 and 9, can be added only to 
a system which includes Trays 6 and 7.

Trays 8 and 9 can be added to the system to extend the paper capacities by providing two additional trays. Trays 8 
and 9 feed a variety of stock sizes, including standard, heavyweight, and oversized stocks up to 330 x 488 mm (13 x 
19.2 in.) in size and weighing between 52 g/m2 and 400 g/m2. Each tray holds 2000 sheets of coated and 
uncoated stock.

Note: The OHCF comes equipped from manufacturing with the Postcard bracket tray inserter.

If using the optional Postcard bracket, minimum size is 101.6 x 152.4 mm (4 x 6 in.)

Note: For more information on the optional Postcard Bracket, refer to Paper and Media.

Paper and Media for Trays 8 and 9

Loading Paper in Trays 8 and 9

1. Select the appropriate paper stock for your print/copy job.

2. Pull out the tray slowly until it stops.

3. Open the ream of paper with the seam side facing up.

4. Fan the sheets before loading them into the tray.

5. Load paper into the tray.

6. Adjust the paper guides by pressing in the guide release and carefully moving the Edge Guide until it lightly 
touches the edge of the material in the tray. 

Do not load materials above the MAX line located on the rear Edge Guide.
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7. Gently push in the tray until it comes to a stop. 

The Paper Tray settings/Tray Properties window displays on the UI. You can view and set stock attributes and 
verify trays are assigned with the correct stock. 

8. From the Paper Tray settings/Tray Properties window, enter or verify the correct paper information, including 
size, type, weight and, if necessary, paper curl and/or alignment option. Select the stock and assign the stock to 
the tray to be used.

9. Select Confirm or OK to save the information and close the Paper Tray settings/Tray Properties window.

Loading Tabs in Trays 8 and 9

Refer to the following tips before loading tab stock in the tray:

• You can load either single straight collated or single reverse collated tab stock.

• For network print jobs, refer to your print server customer documentation for instructions on loading tab stock 
into a tray.

• If a jam occurs while running tabbed sets, cancel the job and start again.

1. After programming your tab job at the print server, select the appropriate and matching tab stock for your print 
job.

2. Pull out the tray slowly until it stops.

3. Fan the tab paper before loading into the tray.

4. Load the tab stock LEF (portrait) and align the straight edge of the tab stock against the right edge of the tray 
(tabs to the left or trailing edge). For single straight collated tabs, the first blank tab cutout in the stack will be 
toward the front of the tray. For single reverse collated tabs, the first blank tab cutout in the stack will be 
toward the rear of the tray.  

Tab stock is loaded so the straight edge of the stock is in the feed direction. Also, you can only load the tab 
stock LEF.

5. Adjust the paper guides by pressing in the guide release and carefully moving the Edge Guide until it lightly 
touches the edge of the stock in the tray. 

Do not load materials above the MAX line located on the rear Edge Guide.

6. Gently push in the tray until it comes to a stop. 

The Paper Tray settings/Tray Properties window displays on the press UI. 
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7. From the Paper Tray settings/Tray Properties window, confirm the correct tray to which it is printing and other 
information, including size (9 x 11 inches), type (precut tab), and, if necessary, paper curl and/or alignment 
option.

8. Select Confirm or OK to save the information and close the Paper Tray settings/Tray Properties window.

Loading Transparencies in Trays 8 and 9

Read these tips before using transparencies:

• Do not use transparencies with the white side strip (permanent or removable).

• Do not mix paper and transparencies in a tray. Jams may occur.

• Do not load more than 100 transparencies in a paper tray at one time.

• Load 8.5 x 11 in (A4) transparencies long edge feed only (landscape).

1. Select the appropriate paper stock for your print job.

2. Pull out the tray slowly until it stops.

3. Fan the transparencies to stop them from sticking together before loading into the tray.

4. Load transparencies LEF on top of a small stack of same-size paper and align the strip edge of the transparency 
against the right edge of the paper tray, with the side to be printed on facing down.

5. Adjust the paper guides by pressing in the guide release and carefully moving the Edge Guide until it lightly 
touches the edge of the material in the tray. 

Do not load materials above the MAX line located on the rear Edge Guide.

6. Gently push in the tray until it comes to a stop. 

If enabled by your System Administrator, the Paper Tray settings/Tray Properties window displays on the UI. 

7. From the Paper Tray settings/Tray Properties window, enter the correct paper information, including size, type, 
weight and, if necessary, paper curl and/or alignment option.

8. Select Confirm or OK to save the information and close the Paper Tray settings/Tray Properties window.

Loading Hole Punch Paper in Trays 8 and 9

1. Select the appropriate paper stock for your print job.

2. Pull out the tray slowly until it stops.

3. Open the ream of paper with the seam side facing up.

4. Fan the sheets before loading them into the tray.
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5. Load and register the paper against the right side of the tray for LEF direction. 

6. Load and register the paper against the right side of the tray as depicted below for SEF direction. 

7. Adjust the paper guides by pressing in the guide release and carefully moving the Edge Guide until it lightly 
touches the edge of the stock in the tray. 

Do not load materials above the MAX line located on the rear Edge Guide.

8. Gently push in the tray until it comes to a stop. 

If enabled by your System Administrator, the Paper Tray settings/Tray Properties window displays on the UI.

9. From the Paper Tray settings/Tray Properties window, enter the correct paper information, including size, type, 
weight and, if necessary, paper curl and alignment option.

10. Select Confirm or OK to save the information and close the Paper Tray settings/Tray Properties window.

Skew Adjustment Levers for Trays 8 and 9

For information and instructions on using the skew adjustment levers for trays 8 and 9, refer to Skew Adjustment 
Levers for Trays 6-9.
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Trays 8 and 9 Specifications

ITEM SPECIFICATION 

Sheet size Short Edge Feed (SEF):  
• 8.5 x 11 in., A4 
• 8.5 x 13 in. 
• 8.5 x 14 in. 
• 10 x 14 in., B4 
• 11 x 17 in., A3 
• 12 x 18 in. 
• 12.6 x 17.7 in., SRA3 
• 13 x 18 in. 
• 13 x 19 in. 
• 12.6 x 19.2 in. 
• B5 
Long Edge Feed (LEF): 
• B5 
• 7.25 x 10.5 in. (executive) 
• A4 
• 8.5 x 11 in. 
• 8.0 x 10 in. 
Custom sizes: 182–330 mm (7.2–13 in.) Width and 182– 488 mm (7.2–19.2 in.) 
Length 

Paper weight 52–400 g/m2 

Paper capacity 2,000 sheets per tray 

Important: When using up to Xerox 24 lb., 90 g/m2 bond paper.
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Xerox® XLS Automatic Feeding Kit

Using the Xerox® XLS Automatic Feeding Kit

The optional Xerox® XLS Automatic Feeding Kit fluffs the media in the Multi-Sheet Inserter using blower fans. The 
Xerox® XLS Automatic Feeding Kit can improve sheet feed accuracy for long media and heavyweight media.

If the power switch for the Xerox® XLS Automatic Feeding Kit is in the On position, when you add media to the 
Multi-Sheet Inserter, the blower fans power on automatically.

XEROX® XLS AUTOMATIC FEEDING KIT COMPONENTS 

1. Power Switch 2. Blower Fans 

3. Speed Dial 

1. To power on the Xerox® XLS Automatic Feeding Kit, move the power switch to the On position. The power 
switch is located on the rear side of the Multi-Sheet Inserter tray.

2. Load media into the Multi-Sheet Inserter tray. The blower fans power on automatically.
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3. To adjust the blower fan speed, turn the dial to the appropriate speed for the weight of the media. 

BLOWER FAN SPEED MEDIA WEIGHT SUPPORTED 

Less than 100 g/m2 

100–200 g/m2 

More than 200 g/m2 

Note: When the Xerox® XLS Automatic Feeding Kit is not in use, to ensure that the blower fans power off, 
remove all material from the Multi-Sheet Inserter tray.

Note: Whenever you power off the press, Xerox recommends that you also power off the Xerox® XLS 
Automatic Feeding Kit using its power switch.

HIGH CAPACITY XLS VACUUM FEEDER AND DUAL HIGH CAPACITY XLS VACUUM FEEDER

High Capacity XLS Vacuum Feeder (HCVF) Components
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1. Error Indicator

2. Paper Level and Tray in Use Indicator

3. Tray 5, Bypass Tray

4. Extra Long Sheet (XLS) Feeder

5. Circuit Breaker Switch

6. Tray 6 of High Capacity XLS Vacuum Feeder

7. Tray 7 of High Capacity XLS Vacuum Feeder

8. Right Side Cover

The following information applies to the High Capacity XLS Vacuum Feeder:

• When a paper jam occurs, the error indicator illuminates.

• For the paper level indicator, when the corresponding tray is active, the top active indicator illuminates. The four 
center indicators, 1=25%, indicate the amount of remaining paper. When all four indicators are off, the tray is 
empty and the Empty Paper Indicator illuminates.

• In the event of fault current or a short circuit, the circuit breaker disconnects the electrical supply to the device 
automatically.

• To clear paper jams, open the right side cover.

Dual High Capacity XLS Vacuum Feeder Components

1. Paper Level and Tray in Use Indicator for Trays 6 and 7

2. Error Indicator for Trays 8 and 9

3. Paper Level and Tray in Use Indicator for Trays 8 and 9
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4. Tray 5, Bypass Tray

5. Extra Long Sheet (XLS) Feeder

6. Circuit Breaker Switch

7. Tray 8 of High Capacity XLS Vacuum Feeder

8. Tray 9 of High Capacity XLS Vacuum Feeder

9. Right Side Cover for Trays 8 and 9

10. Tray 6 of High Capacity XLS Vacuum Feeder

11. Tray 7 of High Capacity XLS Vacuum Feeder

12. Right Side Cover for Trays 6 and 7

13. Error Indicator for Trays 6 and 7

Circuit Breaker Switch

During normal operating conditions. the circuit breaker switch is in the up position. Before you move the HCVF, or if 
the HCVF is idle for an extended period of time, switch off the circuit breaker. To switch off the circuit breaker, move 
the switch to the down position.

1. Circuit Breaker Switch

2. Test Button

Note: When a fault is detected, the power to the circuit breaker is disconnected automatically. Do not touch 
the breakers under normal operating conditions.
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High Capacity XLS Vacuum Feeder Specifications

SSuuppppoorrtteedd PPaappeerr TTyyppeess aanndd WWeeiigghhttss

TRAYS PAPER SIZES WEIGHTS 

Tray 5, Bypass Tray* Standard:
• Maximum: SRA3 (320 x 450 

mm),  

320 x 488 mm (12.6 x 19.2 
in.)

• Minimum: Postcard, 100 x 
148 mm (3.9 x 5.8 in.) 

52–400 g/m2 

Custom: 
• Width: 98–330.2 mm (3.8– 

13 in.) 
• Length: 146–660 mm (5.7– 

26 in.) 

HCVF Tray 7 or  

Dual HCVF Trays 6, 7, and 9

Standard: 
• Maximum: SRA3 (320 x 450 

mm),  

320 x 488 mm (12.6 x 19.2 
in.)

• Minimum: Postcard, 100 x 
148 mm (3.9 x 5.8 in.) 

52–400 g/m2 

Custom: 
• Width: 98–330.2 mm (3.8– 

13 in.) 
• Length: 148–488 mm (5.8– 

19.2 in.) 
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TRAYS PAPER SIZES WEIGHTS 

Extra Long Sheet (XLS) Feeder Standard: 
• Maximum: SRA3 (320 x 450 

mm),  

320 x 488 mm (12.6 x 19.2 
in.)

• Minimum: A4 (210 x 297 
mm), 8.3 x 11.7 in. 

52–400 g/m2 

Custom: 
• Width: 210–330.2 mm (8.2– 

13 in.) 
• Length: 210–1200 mm (8.2– 

47.2 in.) 

* If the press is equipped with a Dual High Capacity XLS Vacuum Feeder, the Tray 5, bypass tray, is installed on 
the second HCVF. 

HHiigghh CCaappaacciittyy XXLLSS VVaaccuuuumm FFeeeeddeerr TTrraayy CCaappaacciittyy

• Tray 5, Bypass Tray: 250 sheets

• HCVF Tray 7 or Dual HCVF Trays 6, 7, and 9: 2100 sheets for each tray

• Extra Long Sheet (XLS) Feeder: 700 sheets

Note: The values are based on 90 g/m2 paper.

Paper and Media for High Capacity XLS Vacuum Feeder

Important: 

• Loading paper above the maximum fill line can cause paper jams or device malfunctions.

• Position the guides correctly to match the paper size. Incorrectly positioned guides can cause misfeeds and 
paper jams.

• When the power is reconnected while the bottom plate of the tray is rising, it is possible that the plate does not 
continue to move up. In this case, pull out the tray, ensure that the plate lowers fully, then push the tray into the 
machine slowly and firmly.

Note: When paper sheets are loaded or fed, the tray makes a sound of supplying air. This sound is caused by 
the Air Assist function and not an abnormal noise.

Loading Paper in the High Capacity XLS Vacuum Feeder (HCVF) Trays

Important: If fewer than 100 sheets of paper are loaded, the tray guides apply too much pressure to the 
paper, which causes the paper to be skewed. Skewed paper leads to paper jams.
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1. Pull out the tray toward you until it stops. 

2. Remove any paper remaining in the tray.

3. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface. This 
procedure separates any sheets that are stuck together and reduces the possibility of paper jams. 

4. Load 100–500 sheets of paper. For preprinted media, load the paper with the printed side facing up. 

a. Align the edges of the paper against the right edge of the tray (1). 
Paper can be loaded in the long-edge-feed (LEF) or portrait direction, or in the short-edge-feed (SEF) or 
landscape direction.

b. To adjust the paper guides, press in the guide release lever and move the guides carefully until they touch 
lightly the edges of the paper in the tray (2).
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5. Load the remaining sheets into the tray, then align the paper edges in the direction shown (1). To adjust the 
paper guides, press in the guide release lever and move the guides carefully until they touch lightly the edges of 
the paper (2). 

6. Gently push the tray into the press until it stops.

Special Media

HHoollee--PPuunncchheedd PPaappeerr

For hole-punched paper, place the paper with the holes to the right when you face the front side of the High 
Capacity Vacuum Feeder (HCVF).

PPrreeccuutt TTaabbss

For precut tabs, place the paper with the tabs to the left when you face the front side of the HCVF. After you load 
the paper, install the appropriate tab guide on the end guide, at the short edge of the paper.

Note: Ensure that the tabs of the precut tab fit the notch of the tab guides.
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Postcard Setting

To load paper size 98–181.9 mm portrait or smaller, attach the Postcard Kit to the High Capacity Vacuum Feeder 
(HCVF) tray. The Postcard Kit can be used in the HCVF trays only. You cannot use the Postcard Kit with Extra Long 
Sheet (XLS) Trays. 

The following procedure defines how to load paper using postcard guides.

1. Pull out the tray toward you until it stops. 

2. Remove any paper that remains in the tray.

3. To install the Postcard Kit, remove the postcard guides from their storage area.

4. Remove the shutters. 

a. Fold the shutters (1).

b. Lift the stack of shutters and remove them (2).
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5. Insert guide B into the slits on the side (1) and bottom (2) of the tray. Tighten the screw to secure the guide 
(3). 

Caution: If the screw is not tightened fully, it can come off and hit the transport device, which can result 
in breakage of the transport device.

6. Insert the guide A into the slit on the interior (1) and the bottom (2) of the tray. Tighten the screw to secure 
the guide (3). 
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7. Load 100–500 sheets of paper, then align the paper edges in the direction shown (1). For preprinted media, 
load the paper with the printed side facing up. Hold the side guides by its grip, then move them to touch the 
long edges of the paper lightly (2). 

Note: Ensure that you load the paper in the short-edge-feed (SEF) direction. The right side of the short edge 
of the postcard is the leading edge (1).

8. Load the remaining sheets in the tray. 

a. Align the paper edges in the direction shown (1).

b. Move the end guide to touch the short-edges of the paper lightly (2). 
Adjust the paper guides by pressing in the guide release lever and carefully moving the guides until they 
touch the edges of the paper lightly.

9. Gently push the tray into the press until it comes to a stop.

10. To remove and store the postcard guides, perform the following: 

a. Remove any paper from the tray.

b. Unfasten the screw from the postcard guide.
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11. After removing the postcard guides, place the shutters in their original positions, then expand them. 

Note: Hang the edges of the shutters on the beveled shutter retainers on both ends of the adjustable side 
guide. Confirm that they are fixed firmly.

12. Store the postcard guides in their storage area.

Note: Align the triangular marks so that the shutters can be mounted in the correct orientation. In the 
following image, the mark on the guide at the top edge of the paper is not visible, and the mark on the 
guide at the bottom edge of the paper is shown in the correct state.

Envelope Setting

Before you load envelopes in the paper tray, read and adhere to the following envelope guidelines:

• Curled or waving edges: If there are envelopes with curled or waving edges, replace the envelopes or straighten 
the edges.

• Adhered or glued to each other: If applicable, remove the glue and ensure bonding surfaces of the envelopes do 
not touch.

• Glue protruded: If applicable, wipe off the glue.

• Folded or non-flat surfaces: To flatten the top surface of the pile of envelopes, do the following: 

1. Place 100 envelopes on a level tabletop.

2. Press down the higher side of the top surface of the stack of envelopes.

3. When the higher side are not flattened, reduce the number of loaded envelopes until it becomes flat.

4. Repeat the process for another 100 envelopes. For example, if you are required to prepare 300 envelopes, 
then perform the process three times.
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• Ensure that the top surface of the loaded envelopes is flattened. The height difference between the front and 
back edge of the envelope can be no more than 1 cm., with the front edge of the envelope on the lower side. 
This guideline applies only when the Large Envelope Kit is not used. 

Within 1 cm.

LLooaaddiinngg aanndd OOrriieennttaattiioonn IInnffoorrmmaattiioonn

• Loading side: Load envelopes with the printable side face up.

• Load direction with the flap open: Place the envelope with the flap facing to the left, when you are at the front 
of the device. 

• Load direction with the flap closed: Place the envelope with the flap facing to the right, when you are at the 
front of the device. 

• When loading self-seal envelopes, fold the flaps.

• If the weight of each envelope is different, a multifeed is detected.

• If the printed output is not as expected, due to the image orientation or the flaps being open or closed, change 
the image orientation at the print server. While changing the image orientation at the print server, do not 
change the direction of loading paper. 

Caution: If envelopes are loaded above the maximum fill line or the top of the envelope stack is not 
level, a device malfunction can occur.

If any of the following fault codes appear, reduce the number of envelopes loaded: 

• Tray 6: 078-250

• Tray 7: 078-260

• Tray 8: 178-250

• Tray 9: 178-260
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EEnnvveellooppee SSppeecciiffiiccaattiioonn

• Type: Uncoated

• Weight: Specify the weight as twice that of the actual. For example, if 70 g/m2 is indicated, specify the weight 
as 140 g/m2.

• Size: 

– Standard size: If the envelope flaps are closed, use this size. 

– Custom size: If the envelope flaps are open, use this size. 

If the output is curled, decurling is required. If the cutting surfaces of envelopes have burrs, before you load the 
envelopes in the tray, flex the envelopes back and forth and fan them.

OOppttiioonnaall LLaarrggee EEnnvveellooppee KKiitt CCoommppoonneennttss

When you load the envelope size C4 (324 x 229 mm), C5 (229 x 162 mm), or DLX (235 x 120 mm), use the Large 
Envelope Kit. The Large Envelope Kit is an optional kit. Refer to the following Large Envelope Kit components for 
loading the envelopes with open flaps:

Based on the size of the envelope, ensure the correct combination of the Large Envelope Kit components. Refer to 
the following table to identify the correct components to be used.
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ENVELOPE SIZE 
POSTCARD 
KIT* LARGE ENVELOPE KIT 

C4   C D E F1  

C5 A B   E  F2 

DLX A B   E  F2 

Any other sizes, 181.9 mm (7.16 in.) or less 
on the long edge in the portrait orientation 

A B      

Any other sizes, 182.0 mm (7.16 in.) or more 
on the long edge in the portrait orientation   

C D    

* When you attach the Postcard Kit (A and B), remove the shutters. 
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OOppttiioonnaall LLaarrggee EEnnvveellooppee KKiitt IInnssttaallllaattiioonn IInnssttrruuccttiioonnss

1. To install the parts A and B, refer to Postcard Setting.

2. Fasten the screws to the side guide on the rear side to fix part C. 

Fasten the screws to the side guide on the front side to fix part D.

Caution: If the screw is not tightened fully, it can come off and hit the transport device, which can 
result in breakage of the transport device.

3. Attach part E to the end guide, at the short edge of the paper. Place part F1 or F2 along the wall on the leading 
edge of the paper. Verify that the parts are firmly fixed. 

LLooaaddiinngg EEnnvveellooppeess UUssiinngg tthhee OOppttiioonnaall LLaarrggee EEnnvveellooppee KKiitt

1. Pull out the tray toward you until it stops.

2. Remove any paper remaining in the tray.

3. Attach or remove the shutter from the Postcard Kit or Large Envelope Kit, depending on the size of the 
envelopes.
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4. Load one envelope with the paper edges aligned in the direction shown (1), to place it on parts E and F. For 
preprinted media, load the paper with the printed side facing up. Hold the end guide by its grip, then move it so 
that it touches the edges of the envelope lightly (2). Adjust the paper guides as needed. 

Note: Do not press the paper guide forcefully or leave a gap between the end guide and the envelope. 
These actions can cause a paper feeding error.

5. To fill the tray easily, load the stack of envelopes in small bundles. Bend the envelope stacks to provide 
additional clearance while loading. 

6. Load each stack of envelopes and align the envelopes edges in the direction shown (1). Hold the side guide by 
its grip, then move it to touch the edges of the envelopes lightly (2). 

7. When you load envelopes repeatedly, widen the side guide, then repeat the loading process for every bundle of 
about 100 envelopes. When you are using the Postcard Kit, align the envelopes by putting your hand between 
the side guide and the envelopes. 

Note: If the envelopes do not align, misalignment on prints or a paper feed error can occur.

LLooaaddiinngg EEnnvveellooppeess WWiitthhoouutt tthhee LLaarrggee EEnnvveellooppee KKiitt

1. Pull out the tray toward you until it stops.
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2. Remove any paper remaining in the tray.

3. Load a bundle of about 100 envelopes and align the envelope edges in the direction shown (1). For preprinted 
media, load the paper with the printed side facing up. Hold the side guide by its grip, then move it to touch the 
edges of the envelopes lightly (2). Adjust the paper guides as needed. 

4. When you load envelopes repeatedly, widen the side guide, then repeat the loading process for every bundle of 
about 100 envelopes. When using Postcard Kit, align the envelopes by putting your hand between the side 
guide and the envelopes. 

Note: If the envelopes do not align, misalignment on prints or a paper feeding error can occur.

5. Move the end guide to touch the edges of the envelopes lightly. To adjust the paper guides, press in the guide 
release lever and move the guides carefully until they touch the edges of the envelopes lightly.

Loading Paper in the Automatic Extra Long Sheet (XLS) Feeder

Caution: If fewer than 100 sheets are loaded in the Extra Long Sheet (XLS) Feeder tray, the paper guides 
apply more pressure to the paper. This pressure can distort the paper, which causes paper jams. For 
example, loading 10–20 sheets of 864 mm (34 in.) or longer paper can cause paper jams.

Note: The Postcard Kit for High Capacity XLS Vacuum Feeder (HCVF) cannot be used with the Extra Long 
Sheet (XLS) Feeder tray.

Loading 488 mm (19.21 in.) or Smaller Paper

1. Remove the paper from the bypass tray, then open the two covers. 
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2. On the left of the side guides at the long edge of the paper, lower the lever. Remove any paper remaining in 
the tray. 

3. If the end guide is stored, open the end guide shutter, then rotate the end guide to latch in the vertical 
position. 

a. Pinch the lever and open the shutter (1).

b. Hold the paper guide and pull it up (2). Pull the paper guide toward you until it clicks in place.

c. Pinch the lever (3) and close the shutter.

Caution: Do not hold the paper guide clip to pull up the paper guide. The guide clip can break.

4. Load 100–500 sheets of paper with the paper edges aligned in the direction shown (1). For preprinted media, 
load the paper with the printed side facing up. Hold the side guides by its grip, then move it to touch the edges 
of the paper lightly (2). 
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5. Load the remaining sheets into the tray, then align the paper edges in the direction shown (1). Move the end 
guide to touch the edges of the paper lightly (2). Adjust the paper guides by pressing in the guide release lever 
and carefully moving the guides until they touch the edges of the paper lightly. 

6. Close the two covers.

Loading 488.1–864 mm (19.21–34.0 in.) Paper

1. Remove the paper from the bypass tray, then open the two covers. 

2. Lift the lever on the left of the side guide. Remove any paper that remains in the tray. 

3. If the end guide is standing, store it: 
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a. Pinch the lever and open the shutter (1).

b. Hold the release lever and lay down the paper guide (2).

c. Pinch the lever (3) and close the shutter.

4. Load about 100 sheets of paper with the paper edges aligned in the direction shown (1). For preprinted media, 
load the paper with the printed side facing up. Hold the side guide by its grip, then move it to touch the edges 
of the paper lightly (2). 

5. Hold the XLS rear-side guide by its grip, then move it to touch the edges of the paper lightly (1). Place the XLS 
front side guide to fit the loaded paper (2). 
The XLS front side guide is removable. Install the front side guide in the direction that ensures that the metal 
surface touches the paper.

6. Load the remaining sheets in the tray, then align the paper edges in the direction shown. 
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7. Place the rear XLS end guide to fit the loaded paper. 
The rear end guide is removable. Install the rear end guide in the direction that ensures that the metal surface 
touches the paper.

8. Close the two covers.

Loading 864.1 mm (34.02 in.) or Larger Paper

You can load a maximum of 100 sheets of 864.1 mm (34.02 in.) or larger, 90 g/m2 paper.

1. Unfasten and remove the screws on the top of the left side cover. Remove the cover. 

2. Remove the paper from the bypass tray, then open the two covers. 

3. Attach the XLS extension tray and the extension plate. 
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a. Insert the XLS extension tray, then tighten the screws to secure it, as shown. 

b. Insert the XLS extension plate. 

c. When not in use, hang the parts on the holder of the lower part. 

4. Lift the lever on the left of the front side guide. Remove any paper that remains in the tray. 

5. If the end guide is standing, store it: 
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a. Pinch the lever and open the shutter (1).

b. Hold the release lever and lay down the paper guide (2).

c. Pinch the lever (3) and close the shutter.

6. Load 100 or less sheets of paper with the paper edges aligned in the direction shown (1). For preprinted media, 
load the paper with the printed side facing up. Hold the rear-side guide by its grip, then move it to touch the 
edges of the paper lightly (2). 

7. Hold the XLS rear-side guide by its grip, then move it to touch the edges of the paper lightly (1). Place the XLS 
front side guide to fit the loaded paper (2). 
The XLS front side guide is removable. Install the front side guide in the direction that ensures that the metal 
surface touches the paper.
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8. Close the two covers (1), then wait until the bottom plate rises. Place the XLS end guide to fit the loaded paper 
(2). 
The XLS end guide is removable. Install the end guide in the direction that ensures that the metal surface 
touches the paper.
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Finishing Devices

RReellaatteedd TTooppiiccss:: 
Business Ready (BR) Finisher and Optional Booklet Maker
Interface Decurler Module and Interface Decurler Module with Inline Spectrophotometer (ILS)
Inserter Device
GBC® AdvancedPunch® Pro
High Capacity Stacker (HCS)
Crease and Two-Sided Trimmer
C/Z Folder
Production Ready (PR) Finishers
Plockmatic MPS XL (Multi-Purpose Stacker)
SquareFold® Trimmer Device

BUSINESS READY (BR)  FINISHER AND OPTIONAL BOOKLET MAKER

Tip: The BR Finisher, with or without the Booklet Maker, attaches directly to the press and does not require an 
Interface Decurler Module or an Interface Decurler Module with Inline Spectrophotometer.

The Business Ready (BR) Finisher adds several professional-level finishing options to the press while requiring 
minimal additional space for the finisher. The finisher is available with or without an optional booklet maker.

BBuussiinneessss RReeaaddyy ((BBRR)) FFiinniisshheerr wwiitthhoouutt BBooookklleett MMaakkeerr

The BR Finisher supports hole punching and stapling. The Right Top Tray is used for stacked output and can 
receive up to 500 sheets of paper. The Stacker is used for offset and stapled output and can hold up to 3,000 
sheets.
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BBuussiinneessss RReeaaddyy ((BBRR)) FFiinniisshheerr wwiitthh tthhee ooppttiioonnaall BBooookklleett MMaakkeerr

The BR Finisher with the optional Booklet Maker supports hole punching, stapling, and booklet making. The 
Right Top Tray is used for stacked output and can receive up to 500 sheets of paper. The Right Center Tray is 
used for offset and stapled output and can hold up to 1,500 sheets. Both trays can be used for hole punched 
output (optional). The Bottom Finisher Tray is used for receiving saddle-stapled booklets.

Identifying the BR Finisher Components

1. Finisher Front Cover

2. Right Top Tray

3. Right Middle Tray

4. Staple Cartridge

5. Booklet Maker Tray (optional)

6. Booklet Staple Unit (optional)

7. Booklet Maker Unit (optional)
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BR Finisher Specifications

BBRR FFiinniisshheerr wwiitthhoouutt BBooookklleett MMaakkeerr

ITEM SPECIFICATION 

Tray Capacity • OOffffsseett ((TToopp)) TTrraayy: 500 sheets 
• SSttaacckkiinngg oorr SSttaapplliinngg TTrraayy: 

– 3,000 sheets unstapled 

– 100 sets (dual or 4-position staple), 11 x 17 in., 8.5 x 14 in., A4 

– 200 sets (single-position staple), A4, 8.5 x 11 in. 

Sizes • Stacking: A6–SRA3, 4 x 6–12 x 19 in. 
• Stapling: B5–A3, 7.25 x 10.5–11 x 17 in. 

Paper Weight Top Tray and Stacker Tray: 52–400 g/m2 uncoated and coated paper 

Stapling Single and multi-position stapling 
• Auto stapling, 50 sheets maximum, 90 g/m2, 24 lb. 
• Letter, Legal, Tabloid, A3, A4, B4, and B5 sizes supported 

Hole Punch NNoorrtthh AAmmeerriiccaa: 2–3 Hole Punch 

EEuurrooppee: 2–4 Hole Punch; 4 Hole Swedish Punch (Optional)

BBRR FFiinniisshheerr wwiitthh BBooookklleett MMaakkeerr

ITEM SPECIFICATION 

Tray Capacity • OOffffsseett ((TToopp)) TTrraayy: 500 sheets of 8.5 x 11 in., A4 unstapled 
• SSttaacckkiinngg oorr SSttaapplliinngg TTrraayy: 

– 1500 sheets of 8.5 x 11 in., A4, 11 x 17 in., A3, SRA3 unstapled 

– 200 stapled sets of 8.5 x 11 in., A4 (single-position stapling, or dual or 4- 
position stapling) 

– 100 stapled sets of 11 x 17 in., A3, SRA3 

Sizes • Stacking: A6–SRA3, 4 x 6–12 x 19 in. 
• Stapling: B5–A3, 7.25 x 10.5–11 x 17 in. 

Paper Weight 52–400 g/m2 uncoated and coated paper, for Top Tray and Stack Tray 

Stapling Single and multi-position stapling 
• Auto stapling, 50 sheets maximum, 90 g/m2, 24 lb. 
• Letter, Legal, Tabloid, A3, A4, B4, and B5 sizes supported 
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ITEM SPECIFICATION 

Hole Punch NNoorrtthh AAmmeerriiccaa: 2–3 Hole Punch 

EEuurrooppee: 2–4 Hole Punch; 4 Hole Swedish Punch (Optional)

Booklet Maker • Saddle stitch 2–16 sheets (7 sheets at 106–176 g/m2 uncoated, or 5 sheets at 
177–220 g/m2 coated) 

• Bi-fold up to 5 sheets 
• Letter, Legal, Tabloid, A3, A4, 12 x 18 in., SRA3 supported 

INTERFACE DECURLER MODULE AND INTERFACE DECURLER MODULE WITH INLINE 

SPECTROPHOTOMETER (ILS)

The Interface Decurler Modules (IDM) are optional finishing devices that are used in conjunction with other 
optional finishing devices. 

Two Interface Decurler Modules are available with the Xerox® Versant® 280 Press:

• Interface Decurler Module (IDM)

• Interface Decurler Module (IDM) with Inline Spectrophotometer (ILS)

The Interface Decurler Modules provide the following functions:

• Communication between the press and the attached finishing device

• An aligned paper path between the press and the attached finishing device

• Cooling and decurling of the paper as it exits the press

Optional Performance Customization and the Interface Decurler Module with Inline Spectrophotometer

There are three different performance customization configurations available with the press: 

• Xerox® Versant® 280 Press with basic print engine configuration performance

• Xerox® Versant® 280 Press with All Stock Rated Speed (ASRS) configuration performance (optional) 

Note: If you purchase the optional All Stocks Rated Speed (ASRS) package, the Interface Decurler 
Module for All Stocks Rated Speed (ASRS) is required, regardless of any additional finishing devices.

• Xerox® Versant® 280 Press with Performance Package (PP) configuration performance (optional) 
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Note: If the optional Performance Package is purchased, the Interface Decurler Module (IDM) with 
Inline Spectrophotometer (ILS) is required, regardless of any additional finishing devices.

Important: The All Stock Rated Speed (ASRS) configuration or the Performance Package can be ordered prior 
to initial installation of the system. It is not possible to upgrade an existing press with the ASRS or 
Performance Package after the press is ordered and installed.

With the Xerox® Versant® 280 Press with the All Stock Rated Speed (ASRS) performance option, the user 
experiences a 25% increase in handling heavyweight stock.

The optional Performance Package is a suite of technologies and tools that enhances the capabilities of the base 
press in three areas: operational speed, color management automation, and print shop productivity.

The Performance Package is comprised of the following technologies and tools:

• XXeerrooxx EEXX 228800 PPrriinntt SSeerrvveerr: The Performance Package is not available with other print servers.

• AAllll SSttoocckkss RRaatteedd SSppeeeedd ((AASSRRSS)) software: The All Stocks Rated Speed (ASRS) feature eliminates the slower 
speeds created by heavier weight stocks. With ASRS, the speed of the press is governed by the size of the stock 
only and not by its weight. This means that all stock weights up to 400 g/m2 for a given sheet size runs at the 
rated speed or the top speed for that stock size.

• AAuuttoommaatteedd CCoolloorr QQuuaalliittyy SSyysstteemm ((AACCQQSS)) software: The Automated Color Quality System (ACQS) is an 
advanced color management technology that transfers the complex decisions about color maintenance from 
operators to an automated system. ACQS automates the printing and measuring of calibration charts and then 
calculates and makes precise adjustments to color tables based on the results. 

Note: The ACQS suite is available only with the external Xerox® EX 280 Print Server, Powered by Fiery®; 
it is not available with the Xerox® EX-i 280 Print Server, Powered by Fiery®.

– ACQS takes the variability out of the color equation by incorporating standardized color measurements 
using the Inline Spectrophotometer to calibrate color on the press as well as generating accurate 
destination profiles for different stocks. 

– Procedures are automated in that they eliminate the need for an operator to manually scan target sheets 
using an external spectrophotometer. The operator must initiate the procedure at the print server, but all 
target sheets are then generated and scanned automatically and all measurements, calculations, and 
corrections are performed automatically. 

• IInnlliinnee SSppeeccttrroopphhoottoommeetteerr ((IILLSS)) - included with the IDM with ILS:  

– The Inline Spectrophotometer (ILS) is housed in the Interface Decurler Module. The ILS enables the 
Automated Color Quality Suite, which automates the process of ensuring stable and accurate color from job 
to job, by eliminating the need for operators to use a hand-held spectrophotometer during print server 
calibration. It also facilitates the creation of custom destination profiles for each stock on which the press 
prints. 

– With the ILS is strategically placed within the paper path, automated processes like measurements for 
calibration and destination profiling are quick to perform and require less down-time for the press. Working 
together, the ACQS software and the ILS hardware gives accurate color faster and provides more stable 
color over time. 

– Besides the Inline Spectrophotometer (ILS), the Interface Decurler Module contains additional cooling to 
support the higher speeds of the press when running at higher speeds and a decurler component to ensure 
flat sheets for finishing. 
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CCoonnffiigguurraattiioonn IInnffoorrmmaattiioonn RReeggaarrddiinngg tthhee PPeerrffoorrmmaannccee PPaacckkaaggee

1. The Performance Package must be ordered when the press is ordered. Once the press has been configured 
without the Performance Package option, it cannot be upgraded at a later time to include the package.

2. The Performance Package is not available with the Xerox EX-i 280 Print Server. Customers must order the 
external Xerox EX 280 Print Server.

3. If customers configure the press with the Business Ready (BR) Finisher, the Business Ready Finisher with Booklet 
Maker, or the Offset Catch Tray, then the Performance Package option is not available for the configuration.

4. When the Performance Package is ordered, the Interface Decurler Module with ILS must be used. The package 
cannot be used with other Interface Decurler Modules.

5. Various finishing options are enabled when the Interface Decurler Module or the Interface Decurler Module with 
Inline Spectrophotometer (ILS) is installed.

Finishing Devices that Require an Interface Decurler Module

The following finishing devices require the Interface Decurler Module or the Interface Decurler Module with Inline 
Spectrophotometer (ILS):

• Inserter device

• GBC® AdvancedPunch® Pro

• High Capacity Stacker (HCS)

• Two-Sided Trimmer

• C/Z Folder

• Production Ready (PR) Finisher

• PR Booklet Maker Finisher

• PR Finisher Plus

• Xerox® SquareFold® Trimmer device, this device requires the PR Booklet Maker Finisher

• Plockmatic® Pro 35 and Plockmatic® Pro 50, this device requires the PR Finisher Plus

Interface Decurler Module Components
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1. Paper Jam and Error Indicator Panel

2. Interface Decurler Module Front Cover

Control Panel on the Interface Decurler Module

1. Paper Jam and Error Indicator

2. Curl Up and Down Indicators

3. Manual Curl Up Button

4. Manual Curl Down Button

5. Auto Curl Button and Indicator

Curl Correction on the Interface Decurler Module

Tip: The purpose of this curl correction is to fix paper curl as it leaves the press but before it reaches the next inline- 
finishing device. Use the Interface Decurler Module (IDM) curl correction feature while the press is printing. 

176 Xerox® Versant® 280 Press User Documentation 

Working With



1. Printed Media from the Press

2. Interface Decurler Module paper path

3. Printed media from the Interface Decurler Module to inline finishing device

As media enters the module, it feeds into the IDM decurler for paper curl correction. The IDM decurler has both 
upper and lower decurler rolls that apply pressure to the media based on the following:

• System default, Auto on

• Manual selections made from the IDM control panel

If you want to adjust the paper curl on the printed output quickly, use the manual curl up or down buttons. After 
you use these buttons, if the printed output contains too much curl, refer to the System Administrator Guide, the 
section entitled Custom Paper Settings, Adjust Paper Curl.

From the decurler, the printed media is cooled and routed from the Interface Decurler Module to the next inline 
finishing device that is connected to the press.

Curl Correction Modes and Functions on the Interface Decurler Module

Note: When an Interface Decurler Module (IDM) curl correction mode is selected, the new mode is applied 
to the next sheet that is delivered to the IDM.
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INDICATOR MODE  FUNCTION 

Auto This is the default mode. 
• Automatically corrects the paper curl by 

selecting the curl direction and amount. 
This is based on the paper size and 
orientation and on the finishing device that 
is receiving the output. Automatic decurl 
mode flattens output sheet-by-sheet based 
on environment, paper weight, area 
coverage, and 1–sided or 2–sided printing. 

• When Auto is selected, the indicator to the 
right of the button is illuminated. 

• This mode has seven automated settings 
for controlling paper curl: three upcurl 
settings, three downcurl settings, and mid- 
range. 

• When Auto mode is in use, an indicator 
flashes momentarily on the control panel. 
The control panel shows the preselected 
curl direction and amount of decurl applied 
to the paper. 

Mid-range When this indicator is illuminated for either 
Auto mode or Manual mode, no curl correction 
is applied to the printed output. 
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INDICATOR MODE  FUNCTION 

Manual Upward Curling • When the printed output is curled upwards, 
select the curl-up button.  

• There are three upward curl correction 
values. 

• The top three indicators show which level 
of upward curl correction is selected. 

• The top indicator is the highest amount of 
upward curl correction that can be applied 
to a printed output. 
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INDICATOR MODE  FUNCTION 

Manual Downward 
Curling 

• When the printed output is curled 
downwards, select the curl-down button.  

• There are three downward curl correction 
values. 

• The bottom three indicators show which 
level of downward curl correction is 
selected. 

• The bottom indicator is the lowest amount 
of downward curl correction that can be 
applied to a printed output. 

Pressing the curl-up button changes the curl correction levels as shown:

Pressing the curl-down button changes the curl correction levels as shown:

INSERTER DEVICE

Note: This optional finishing device requires an Interface Decurler Module. 
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Use the Inserter device to load stock, such blank, preprinted, or special stock, which is inserted into the finished 
output. This stock serves as separators and covers for the finished output. Paper fed from the Inserter device is not 
printed on; however, the paper is placed into the printed output at selected locations. 

Note: The Inserter device sometimes is referred to as the post-process inserter or the 
interposer.

Inserter Components

1. Tray T1 or Inserter Tray

2. Inserter Control Panel

3. Inserter Front Cover

Inserter Control Panel

Xerox® Versant® 280 Press User Documentation 181

Working With



NUMBER COMPONENT DESCRIPTION 

1 Paper Jam Error Indicator This indicator lights when a paper 
jam occurs in the Inserter.  

2 Curl Up/Down Indicators Similar to the Interface Decurler 
Module (IDM), these indicators 
show the direction of the curl 
correction. However, there are only 
three curl correction options for the 
Inserter: 
• One upward curl correction; this 

is the top indicator. 
• One downward curl correction; 

this is the bottom indicator. 
• Off (no curl correction); this is 

the middle indicator. 

Important: Use one of the following buttons only if paper curl continues after setting the curl correction 
level to the highest or lowest setting on the Interface Decurler Module (IDM). 

3 Manual Curl Up Button When the printed output is curled 
upwards, select the curl-up button.  

4 Manual Curl Down Button When the printed output is curled 
downwards, select the curl-down 
button. 

5 Auto Curl Button Automatically corrects the paper 
curl by selecting the curl direction 
and amount.  

Paper and Media for Inserter Tray T1

Tip: Paper fed from the Inserter device is not printed on; however, the paper is placed into the printed output at 
selected locations. 

Supported Paper for the Inserter Tray T1

PAPER SIZE PAPER WEIGHT TRAY CAPACITY 

182 x 148– 30 x 488 mm (7.2 x 
5.8–13 x 19.2 in.), A3 

52–400 g/m2 coated and uncoated 250 sheets, based on Colotech+90 

Note: When the Inserter Tray is filled with 8.5 in. wide (SEF) media, its default size is 8.5 x 14 in. If you insert 
8.5 x 11 in. media, it is necessary to use Admin Mode Tools to adjust the default value of NVM 769-503. For 
more information, refer to the System Administrator Guide.

When you combine the following paper types with saddle stitch or bi-fold, use Tray 5 (Bypass): 
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• Coated paper that weighs 127 g/m2 or less

• Blank sheets or unprinted paper that weighs 80 g/m2 or less

Note: If a tray other than Tray 5 is used, the combination can cause misalignment of folding positions and 
wrinkle.

Loading Paper in Inserter Tray T1

Before using tray T1, review the following guidelines: 

• Remove any remaining paper from the tray.

• Load all the paper required for the job into the tray.

• To use saddle stitch / bi-fold options, ensure that the paper loaded in the main feeding tray (for example, tray 1) 
is the same size as the paper loaded in tray T1. 

• For supported paper information, refer to Supported Paper for the Inserter Tray T1. 

To insert separator sheets or cover sheets, such as blank or preprinted sheets, use the Inserter Tray T1. Paper loaded 
in tray T1 is inserted into the finished / printed output. A maximum of 250 sheets (Colotech+90) may be loaded in 
tray T1.

Tip: Paper fed from the Inserter device is not printed on; however, the paper is placed into the printed output at 
selected locations. 

1. Load the paper, aligning all edges.  

If the paper is preprinted, load the paper with the printed side facing up. 

Note: Do not load paper above the maximum fill line. It may cause paper jams or press malfunctions.

Xerox® Versant® 280 Press User Documentation 183

Working With



2. Hold the center of the paper guides and gently slide them to the desired paper size so that they are touching 
the edges of the paper. 

If the distance between the guides is too long or short relative to the paper, paper jams may occur.

If set by the system administrator, the Tray Properties window displays on press UI.

3. From the Tray Properties window, enter or verify the correct paper information.

4. Select OK to save the information and close the Tray Properties window.

Printing on Special Media

HHoollee--ppuunncchheedd PPaappeerr

Load hole-punched paper into tray T1 long-edge feed (LEF) with the holes on the right side as you face the front of 
the Inserter device.

TTaabb SSttoocckk

Load tab stock paper in tray T1 long-edge feed (LEF) with the tabs on the left side as you face the front of the 
Inserter device.
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Purge Function for Tray T1

If tray T1 runs out of paper, the press stops printing. When this happens, any printed output leaving the press is 
delivered to the inline finishing device output tray.

Tip: Do not reuse the output that is ejected by the purge function as this may cause paper jams.

To prevent the purge function from occurring when tray T1 runs out of paper, the function may be disabled or 
switched off from the press Tools mode. 

Important: Only a system administrator for the press can change the setting for the purge function for tray 
T1.

Tray T1 Purge Function Settings

The purge function allows you to specify how the press behaves when tray T1 is used. The purge function has two 
settings:

SSttaannddaarrdd

For each printed set that requires the inclusion of paper into the finished set, the press checks that paper Is 
loaded in tray T1 before it starts printing. 
This setting increases the wait time between sets, which causes decreased productivity. However, paper purging 
does not occur even if tray T1 runs out of paper.

SSppeeeedd FFiirrsstt

The printer starts printing regardless of the paper status of tray T1.
This setting maintains productivity based on press productivity. However, paper is purged from the press and 
the press stops printing when tray T1 runs out of paper. 

Note: Speed First is the default setting for the tray T1 purge function.

Changing the Purge Function Setting for Tray T1

Important: The following procedure must be performed by a system administrator with press administrator 
login authority.

1. Log in as the administrator.

2. On the control panel, press the Machine Status button.

3. Touch the Tools tab.

4. Select System Settings > Common Service Settings.
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5. Select Maintenance. 

The Maintenance screen displays.

6. Use the up/down arrows to scroll through the Maintenance screens until you see Print Action When Using 
Tray T1 (Inserter)

7. Select Print Action When Using Tray T1 (Inserter). 

The Tray T1 purge function screen displays.

8. Select the desired purge function option: 

• Standard: Select this option to switch off the purge function. It decreases productivity, but the press 
continues to run even when tray T1 runs out of paper. This may cause some printed output sets to be 
delivered to the designated finishing tray without inserts.

• Speed First: This setting maintains productivity. Select this option to have the press stop printing and 
purge paper when tray T1 runs out of paper. 

Note: Speed First is the default setting. 

9. Select Save or OK. 

The Maintenance screen displays.

10. Select Close. 

The main Tools tab screen displays.

11. Exit the administrator mode.

GBC ®  ADVANCEDPUNCH ®  PRO

The GBC® AdvancedPunch® Pro is an automatic hole punch module that integrates with the press to streamline the 
production of reports, directories, pricing guides and other bound books. It equals or betters traditional quality while 
saving time and increasing productivity by eliminating the labor-intensive steps of manual punching. The compact 
AdvancedPunch® Pro takes minimal space and accepts a variety of optional multiple hole punch die sets.

The AdvancedPunch® Pro can be connected to a variety of optional finishing devices and sits inline with these 
devices.

Note: This optional finishing device requires an Interface Decurler Module. 

The AdvancedPunch® Pro provides the following capabilities:
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• A bigger range of media sizes and types

• Trail edge, LEF and SEF punching

• Die set detection control panel shows die type and cycle count

• User Die set options include comb, wire, coil, and 3-7 hole varieties to enable most popular binding formats

• Operates at rated print engine speed for most paper sizes 

• Quick-change die sets that can be interchanged without any tools

• All die sets include an Identification Label providing the user with the hole pattern and name

• Convenient storage area for two extra Die Sets which is located above the sheet bypass on the device

For detailed information and instructions to use the AdvancedPunch® Pro, refer to the press User Documentation or 
go to www.xerox.com/gbc-advancedpunch-pro.

HIGH CAPACITY STACKER (HCS)

Note: This optional finishing device requires the Interface Decurler Module. 

The High Capacity Stacker (HCS) is an optional finishing device that provides large-capacity stacking and offsetting 
capabilities for production output to a stacker tray and cart. The HCS also provides a top tray convenient for short 
stack runs.
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High Capacity Stacker (HCS) Components

NUMBER COMPONENT DESCRIPTION 

1 Paper jam and error indicators These indicators light when a paper jam occurs in HCS 
areas E1-E8. 

2 Sample button Press this button to have the HCS deliver a sample sheet 
to the top tray.  

The indicator to the left of the button blinks until a 
sample sheet is delivered to the top tray.

3 Unload button Press this button to stop printing and remove paper. 

4 Top tray Receives the printed output. Sample sheets also are 
delivered here. 

Holds a maximum of 500 sheets (13 x 19.2 in., 330 x 488 
mm).

5 Circuit breaker switch The circuit breaker switch is located on the rear of the 
HCS. This switch automatically shuts off electricity in the 
event of electrical failure or a short circuit. 

6 Top cover Open this cover to clear paper jams. 
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NUMBER COMPONENT DESCRIPTION 

7 Stacker tray/cart Collated sets (up to a total of 5000 sheets) are 
transported to the stacker tray, which is located on a 
movable stacker cart. 

8 Front door Open this door to remove paper/printed output. 

HCS Circuit Breaker

The HCS circuit breaker is located on the rear of the HCS unit.

1. On or Off Switch

2. Test Button

The circuit breaker switch is normally in the ON position.

Note: When an electrical interruption is detected, the circuit breaker automatically switches off to 
discontinue the electrical flow to the HCS. For electrical information, refer to Safety.

Output Trays

The High Capacity Stacker (HCS) has two output trays.
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1. Top Tray

2. Stacker Tray or Cart

The Top Tray offers the following: 

• Convenience for short stack runs (up to 500 sheets) without offsetting

• Delivery of purged sheets

Control Buttons

1. Sample button: Press this button to output a sample sheet to the top tray.

2. Unload button: Press this button to stop printing and remove paper.

Unloading the Stacker Tray or Cart

Note: The HCS may be unloaded while it is running.

1. Press the Unload button on the HCS control panel.

2. After the Unload Indicator lights, open the HCS front door. 

3. Position the securing bar on top of the stacked paper.

4. Pull the Stacker Cart straight out of the HCS. 

5. Remove the securing bar.

6. Remove the paper from the stacker tray.

7. Push the empty Stacker Cart straight into the HCS.

8. Position the securing bar on the fixed area inside the HCS.

9. Close the front door; the tray will rise to the operate position.
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HCS Specifications

ITEM SPECIFICATION 

Tray capacity Top tray 500 sheets 

Stacker tray or cart 5,000 sheets 

Note: The values are based on paper less than 80 g/m2

Paper size Top tray Standard size Minimum Postcard  

4 x 6 in.

100 x 148 mm

Maximum 13 x 19 in. 

A3

Custom size Height 3.9–13 in.  

98.0–330.2 mm

Width 6-26 in.  

148.0–660.4 mm

Stacker tray or 
cart 

Standard size Minimum JIS BS 

Maximum 13 x 19 in. 

A3

Custom size Height 8–13 in.  

203.0–330.2 mm

Width 7.2–19.2 in.  

182.0–488.0 mm

Paper weight Top Tray 52–400 g/m2, coated and uncoated  

Stacker tray or 
cart 

52–400 g/m2, coated and uncoated 

HCS Media Guidelines

• Stacker tray/cart accepts 52–400 g/m2 coated or uncoated stock with the possibility of degraded stack quality 
and increased jam rate for stocks that are heavier than 300 g/m2.

• Transparencies can be run to the top tray or to the stacker tray/cart. Stack height should be limited to 100 
transparencies.

• Coated paper lighter than 100 g/m2 cannot run as reliably as coated paper heavier than 100 g/m2. 

• Non-standard papers longer than 305 mm (12 in.) in the feed direction require 210 mm (8.3 in.) minimum 
measurement across the feed direction.
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• Non-standard papers shorter than 254 mm (10 in.) in the cross-feed direction require 330 mm (13 in.) 
minimum measurement in the feed direction.

CREASE AND TWO-SIDED TRIMMER

Note: This optional finishing device requires the Interface Decurler Module. 

The Crease and Two-Sided Trimmer is an optional finishing device that provides trimming on two sides of the 
output.

• Trims 6–25 mm (0.24–0.99 in.) from the top and bottom of prints or booklets to produce an even edge.

• When paired with the SquareFold® Trimmer, all sides of booklets are trimmed except the binding, which enables 
full-bleed booklets. For more information, refer to SquareFold Trimmer Device.

• Trims paper sizes 182 x 257–330 x 488 mm (7.2 x 10.1–3 x 19.2 in.). If the trimmed output is for booklet 
making, the minimum paper size is 194 x 257 mm (7.6 x 10.1 in.).

• Handles uncoated and coated paper 52–350 g/m2.

Crease and Two-Sided Trimmer Components
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NUMBER COMPONENT DESCRIPTION 

1 Paper jam and error indicator This indicator lights when a paper jam occurs.If the indicator 
blinks, you must clear the paper jam before printing can 
resume. 

2 Trimmer Waste Container Full 
indicator 

This indicators lights when it is time to empty the Trimmer 
Waste Container and blinks when the container is full. 

3 Upper cover Open this cover to clear paper jams. 

4 Lower cover Open this cover to empty the Trimmer Waste Container. 

Crease and Two-Sided Trimmer Specifications

ITEM SPECIFICATION 

Two-sided Trim                Paper size Standard size Minimum  Letter (8.5 x 11 in.) 

A4

Maximum 13 x 19 in. 

A3

Custom size Height  7.7–13 in. 

194.0–330.2 mm 

Width  8.26–19.2 in. 

10.0–488.0 mm

Paper weight Uncoated 52–350 g/m2 

Coated 52–350 g/m2 

Trimming size 0.24–0.99 in. 

6–25 mm

Note: Setting a head-to-toe trimming area size of 7 mm 
(0.275 in.) or less can cause damage of the trimmed 
edges.

C/Z FOLDER

The C/Z Folder is available only with one of the optional Production Ready (PR) Finishers. For more information, 
refer to Production Ready (PR) Finishers.

Note: This optional finishing device requires the Interface Decurler Module.

The C/Z Folder is an optional finishing device that provides Envelope Folding (C-Fold and Z-Fold) for 8.5 x 11 in. and 
A4 media and large sheet folding (Half-Sheet Z-Fold) for 11 x 17 in. and A3 media.
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Folded output is produced by selecting the Fold feature.

• For network print jobs, select the Fold feature from the print drive. 

• For copy and scan jobs, select the Fold feature from the scanner.  

Note: Copy and scan jobs are applicable only if the press includes a scanner.

• To use the Fold feature, the orientation of documents must be short-edge feed (SEF). 

• Select a tray that contains SEF media.

• There are three types of folds available: C-Fold, Z-Fold, and Z-Fold Half-Sheet.

C/Z Fold Types

CC--FFoolldd

A C-Fold has two folds, which create a three-panel output. 

ZZ--FFoolldd

A Z-Fold has two folds that are folded in opposite directions, resulting in a type of fan fold. 

ZZ--FFoolldd HHaallff SShheeeett ((sshhoowwnn hheerree wwiitthh 33--hhoollee ppuunncchh))

As with a regular Z-Fold, the Z-Fold Half-Sheet has two folds that are folded in the opposite directions. The 
difference between a regular Z-Fold and a Z-Fold Half Sheet is that the Z-Fold Half Sheet is not folded in two 
equal folds. The two folds are unequal which allows one edge of the Z-Fold Half Sheet to have a longer edge. 
The longer edge allows for stapling or hole punching. 
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Note: Each Z-Fold Half Sheet added to a stapled set counts as 10 sheets. It reduces the total number of 
sheets for any given specified weight range.

C/Z Folder Components

Note: For detailed information about the folding feature, refer to the System Administrator Guide.

NUMBER COMPONENT DESCRIPTION 

1 C/Z fold output tray Receives output sheets. 

2 C/Z fold output tray button Press this button to open the output tray. 
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C/Z Fold Output

NUMBER COMPONENT DESCRIPTION 

1 C/Z fold output tray button When you press the button, the indicator flashes. 
When the output tray is unlocked and the indicator 
shows a steady light on (no blinking), pull out the 
output tray. 

2 C/Z fold output tray  C-Fold or Z-Fold jobs are delivered to this tray only.  

Note: C/Z Fold jobs cannot be delivered to 
any other tray.

C/Z Folder Specifications

ITEM SPECIFICATION 

Z-Fold Half Sheet Paper size 11 x 17 in. (Tabloid) 

A3

JIS B4

Paper weight 60–105 g/m2, uncoated 

Note: Each Z-Fold Half Sheet added to a stapled set counts as 10 sheets. It 
reduces the total number of sheets for any given specified weight range.

196 Xerox® Versant® 280 Press User Documentation 

Working With



ITEM SPECIFICATION 

Trifold (C or Z) Paper size 8.5 x 11 in. (Letter) 

A4

Paper weight 60–105 g/m2, uncoated 

Tray capacity 30 sheets 

Note: Values are based on Colotech+90.

PRODUCTION READY (PR)  FINISHERS

Note: These optional finishing devices require the Interface Decurler Module. 

Three Production Ready (PR) Finishers are available with your press.

• Product Ready (PR) Finisher

• Product Ready (PR) Booklet Maker Finisher

• Product Ready (PR) Finisher Plus

Note: Throughout this section, the three PR Finishers are referred to simply as the Finisher. Any 
differences between the finishers are distinguished by using the specific finisher name.

The Production Ready (PR) Finishers provide the following capabilities: 

• Handling media that is smaller than 5.83 x 8.27 in., A5.

• Stapling up to 100 sheets with one or two staples.

• Handling large-sized paper, maximum size of 13 x 19.2 in., 330.2 x 488 mm.

• For coated stocks, stapling a maximum of 35 pages.

• For the PR Finisher Plus only: Feeding the output media from the press and any inline finishing devices to a 
third-party DFA device.

Note: The optional C/Z Folder is available with all three Production Ready (PR) Finishers.

Xerox® Versant® 280 Press User Documentation 197

Working With



Production Ready (PR) Finisher

The PR Finisher consists of: 

• Two output trays: Top Tray and Stacker Tray

• Stapler

• Optional Basic Punch

Production Ready (PR) Booklet Maker Finisher

The Production Ready (PR) Booklet Maker Finisher provides all the same features as the PR Finisher plus it 
automatically creates saddle-stitched booklets of up to 30 sheets and bi-folding, also called single-folding.

The Production Ready (PR) Booklet Maker Finisher consists of: 

• Three output trays: Top Tray, Stacker Tray, Booklet Output Tray

• Booklet Maker Unit

• Stapler

• Optional Basic Punch

198 Xerox® Versant® 280 Press User Documentation 

Working With



Production Ready (PR) Finisher Plus

The Production Ready (PR) Finisher Plus consist of: 

• Two output trays: Top Tray and Stacker Tray

• Stapler

• Optional Basic Punch

The Production Ready (PR) Finisher Plus serves as an interface to transfer paper between the press and any third- 
party, Document Finishing Architecture (DFA) device attached to the press.

Finisher Components

1. Paper Jam and Error Indicator

2. Top Tray

3. Stacker Tray

4. Booklet Tray*

5. Booklet Output Button*

6. Front Cover
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7. Staple Waste Container

8. Basic Staple Cartridge for Side Stitch

9. Two Booklet Staple Cartridges for Saddle Stitch*

10. Hole Punch Waste Container

Note: * Available only with the PR Booklet Maker Finisher.

Finisher Output Trays

1. Top tray

2. Stacker tray

3. Booklet tray*

*Available only with the PR Booklet Maker Finisher.

TToopp TTrraayy

If output sheets are not fully ejected, this causes the press to detect a Paper Full condition. If this condition is 
detected frequently, change the angle of the top tray. 

Refer to the following guidelines for changing the top tray angle:

• For normal usage, keep the tray in its lower, default position. 

Important: Continual usage of the tray in the upper position, may cause paper jams or output 
sheets to fall from the tray upon delivery.

• When using the following paper types, change the angle of the tray to its upper position. These paper types 
may cause frequent Paper Full conditions: 

– Light-weight (106 g/m2 or lighter) coated paper 

– Coated paper whose edges are 364 mm or longer 

– Long paper 
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Note: If sheets are curled, changing the tray angle has no effect.

A B 

Default, lower angle  Raised, upper angle 

To change the angle of the tray:

1. Pull the top tray from the lower seating (A) by pulling it toward the right.

2. Insert the clutches at the lead edge of the tray into upper seating (B). 

SSttaacckkeerr TTrraayy

Side stitch jobs are delivered to this tray only.

Note: Delivering 2,000 or more sheets to this tray with excessive downward curl may cause the output stack 
to fall out of the tray. If this happens, set the curl correction level on the Interface Decurler Module to its 
lowest level and set curl correction on the Inserter setting to downward. For information, refer to Paper Curl 
Correction with the PR Finishers.

BBooookklleett TTrraayy

Note: The booklet tray is attached to PR Booklet Maker Finisher. However, if the SquareFold Trimmer is 
installed, the booklet tray is attached to SquareFold Trimmer.

Bi-Fold and Bi-Fold with Saddle Stitch jobs are delivered to this tray only.
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Top Tray Aligner Accessory

The Xerox Top Tray Aligner Accessory is an additional component for the top tray of the Production Ready Finishers. 
This accessory improves the stack quality of the Production Ready Finishers. The Top Tray Aligner Accessory aligns 
any small-size stock that goes on the top tray, such as small sheets, postcards, and envelopes. 

To install the Top Tray Aligner Accessory on a Production Ready Finisher, do the following:

1. Empty the top tray of the Production Ready Finisher. 

2. Place the Top Tray Aligner Accessory on the top tray of the PR Finisher. Adjust the alignment between the top 
tray and the Tray Aligner Accessory. 
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3. To achieve better stacking of the media, adjust the movable document guides on the Top Tray Aligner 
Accessory. To align the document guides with the media, put the media on the Top Tray Aligner Accessory, then 
adjust the guides. 

4. To align the document guides for envelopes or small stocks, put an envelope on the Top Tray Aligner Accessory, 
then adjust the document guides.

Paper Curl Correction with the PR Finishers

If sheets are curled when delivered any of the finisher trays, refer to the following information:

• Printing on 5.83 × 8.27 in., A5, LEF paper with upward curl may cause paper jams. If this occurs, set the curl 
correction level on the Interface Decurler Module to its highest setting and on the Inserter, set it to upward.

• Printing on heavyweight paper with downward curl may cause paper jams. If this occurs, set the curl correction 
level on the Interface Decurler Module to its lowest setting and on the Inserter, set it to downward.

• Printing on paper weighing 157 g/m2 or heavier with up curl may cause paper jams. If this occurs, set the curl 
correction level on the Interface Decurler Module to its highest setting and on the Inserter, set it to upward.

For more information about the paper curl correction features, refer to Curl Correction Modes and Functions on the 
Interface Decurler Module and Inserter Control Panel.

Bi-Fold Feature for the Production Ready Booklet Maker Finisher

Note: The Bi-Fold feature is available only with the Production Ready (PR) Booklet Maker Finisher. 

• To use the Bi-Fold feature, the orientation of documents must be short-edge feed (SEF). You must select a tray 
that contains SEF stock.

• The Bi-Fold feature is selected from the print driver (for network print jobs) or from the scanner (for copy and 
scan jobs; applicable only if the press is a combination copier and printer).

• Bi-Fold is sometimes referred to as Single Fold.

Important: The C-Fold and Z-Fold options are available only with the C/Z Folder; for more information, refer 
to C/Z Folder.

A Bi-Fold (Single Fold) has one fold which creates two panels to the output.
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There are three Bi-Fold options available:

• Bi-Fold Single Sheet

• Bi-Fold Multiple Sheets

• Bi-Fold Multiple Sheets Stapled

Note: For detailed information about fold types, refer to the Adjust Fold Positions in System Administrator 
Guide.

Booklet Output Button on the Production Ready Booklet Maker Finisher

Press this button to remove finished booklets from the finisher.

Note: If the SquareFold Trimmer is installed, pressing this button moves the booklets to the booklet tray 
installed on SquareFold Trimmer.

PR Finisher Specifications

ITEM SPECIFICATION 

Tray Top tray Collate and stack 
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ITEM SPECIFICATION 

Stacker tray Collate (offsetting supported) and stack (offsetting supported) 

Booklet tray Collate and stack 

Paper size Top tray Standard size Minimum Postcard (100 x 148 
mm) 

Maximum 13 x 19 in., A3 

Custom size Height 98–330.2 mm 

Width 148–660.4 mm 

Stacker tray Standard size Minimum 5.83 × 8.27 in., A5 

Maximum 13 x 19 in., A3 

Custom size Height 148.0–330.2 mm 

Width 148.0–488.0 mm 

Booklet tray Standard size Minimum JIS B5 

Maximum 13 x 19 in., A3 

Custom size Height 182–330.2 mm 

Width 257–488 mm 

Paper weight Top tray 52–400 g/m2 

Stacker tray 52–400 g/m2 

Booklet tray 60–350 g/m2 

Tray capacity Top tray 500 sheets 

Stacker tray 
(without staples) 

8.5 x 11 in., A4 PR Finisher: 3,000 sheets  

PR Booklet Maker Finisher: 2000 sheets

JIS B4 or larger 1500 sheets 

Mix stack 350 sheets

Stacker tray (with 
staples) 

8.5 x 11 in., A4 PR Finisher: 200 sets or 3000 sheets  

PR Booklet Maker Finisher: 2000 sheets

JIS B4 or larger 100 sets or 1500 sheets 

Booklet tray 20 sets 

Note: The values are based on Colotech+90. Mix stack means a set of paper sheets where larger sheets 
are placed over smaller ones. For example, A4 over JIS B5 or JIS B4 over A4. The booklet tray capacity is 
16 sets if one set consists of 17 or more sheets.
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ITEM SPECIFICATION 

Staple Capacity 100 sheets 

Note: The values are based on Colotech+90. Five sheets larger than A4 Letter (8.5 
x 11 in.)

Paper size Standard size Minimum 5.83 × 8.27 in., A5 

Maximum Tabloid (11 x 17 in.), 
A3 

Custom size Height 182–297 mm 

Width 148–432 mm 

Paper weight Uncoated 52–350 g/m2 

Coated 52–350 g/m2 

Stapling position 1 place, 2 places or 4 places 

ITEM SPECIFICATION 

Punch  

(with Punch 
Unit)

Paper size Standard size Maximum A3, Tabloid (11 x 17 in.) 

Minimum 2-hole or 3- 
hole 

JIS B5 

4-hole A4, 16K 

Custom size Height 203–297 mm 

Width 182–431.8 mm 

Paper weight Uncoated 52–220 g/m2  

Coated 72–200 g/m2 

Number of 
Holes 

2, 4-hole or US 2, 3-hole     

Note: The number of punch holes you can choose depends on the 
paper size.

Saddle Stitch / 
Bi-Fold 

Capacity Saddle Stitch 30 sheets 

PR Booklet 
Maker Finisher 

Bi-Fold 5 sheets 

Note: The values are based on Colotech+90.

Paper size Standard size Maximum 13 x 19 in., A3 

Minimum JIS B5 
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ITEM SPECIFICATION 

Custom size Height 182–330.2 mm 

Width 257–488 mm 

Paper weight Uncoated 52–300 g/m2 

Coated  52–300 g/m2 

Staple Output Capacity

PAPER WEIGHT 
(G/M2) 

SIDE STITCH SADDLE STITCH 

A4 OR SMALLER LARGER THAN A4 

UNCOATED COATED 
UN
COATED COATED UNCOATED COATED 

52–59 100 35* 65 35* 30* 25* 

60–71 30 

72–80 35 35 25 

81–90 

91–105 50 30 50 30 20 

106–128 45 15 

129–150 20 20 20 20 10 

151–176 

177–220 5 

221–256 4 

257–300 10 10 10 10 3 

301–350 

* Can be stapled; however, binding accuracy or paper feed performance cannot be guaranteed. 

Values in the table indicating the maximum number of sheets that can be stapled have been evaluated using the 
following paper types: 82 g/m2, Colotech+ (200 g/m2, 250 g/m2, 350 g/m2).

Even for a print job whose number of pages is within the limit, staple faults can occur depending on the following 
conditions: 

• Type of paper, such as Gloss Coated Paper

• Environment where the press is installed, such as room temperature, humidity, and others

• Print data, even if you use recommended paper types

• The job is made of a mixture of paper type or paper weight

Important: In an environment at a low temperature and low humidity, stapling of 40 sheets or more can 
cause paper jams.
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Note: The press determines paper type and paper weight based on paper information set for the job, not 
based on paper actually loaded in the tray. The press determines the number of sheets per job based on job 
information. Therefore, when multifeeds occur, stapling can be performed even if the number of sheets 
being fed exceeds the limit. However, this can cause staple faults.

PLOCKMATIC MPS XL (MULTI-PURPOSE STACKER)

The Plockmatic Multi-Purpose Stacker XL is a flexible stacking solution that assists operators with paper stacking and 
handling during the finishing process. The stacker offers a unique combination of features with a printer in a single 
product.

The stacker can stack a wide variety of media such as A4 or Letter trifold or gatefold, A4 or Letter Landscape 
brochures, leaflets, menus, business cards, postcards, and so on.

The stacker is fully integrated into the Xerox® Digital Presses.

The stacker provides the following features: 

• Provides the link between printing and the finishing device that will help to create the complete application.

• Offers a unique combination of features such as stacking, lifting, transporting, and integration with a printer in a 
single product.

• The stacker has multiple sensors that can detect jams and stack capacity limits, which triggers a soft stop within 
the printer.

• Integration and communication with the printer conveniently allows the operator to pause and resume jobs 
directly from the stacker control panel.

• Simple docking mechanism and large casters allow frequent docking or undocking and easy transportation of 
paper from the printer to finishing system. 

Note: When docked, the stacker is powered through the docking bracket that is attached to the 
upstream device.

• Capable of stacking a wide range of media, sheets as large as 330 x 1200 mm (13 x 47.2 in.) and as thick as 
400 g/m2.
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• The stacking table has a default length of 715 mm (28 in.) for longer sheets, and the table can be extended all 
the way up to 1200 mm (47.2 in.). The upstream print engine determines the maximum sheet size.

• Supports a maximum stacking load of 40 kg (88.2 lbs.) and a maximum stacking height of 330 mm (13 in.) for 
sheets within 715 mm (28 in.) in length and 140 mm (5.5 in.) for the sheets over 715 mm (28 in.) in length. 

Note: Maximum stack height can vary between -10 mm (-0.4 in.) and +5 mm (+0.2 in.) depending on 
media type and weight.

• An active Infeeder Unit receives paper from the upstream device and drives each sheet into the stacker. It also 
contains a fan which helps to cool media down and prevents sheets from sticking to each other.

• An active side jogger on the Infeeder Unit helps to align sheets and produce high quality stacks.

• The Motorized Stacking Table eliminates the need to manually lift heavy paper stacks.

For detailed information and instructions to use the Plockmatic Multi-Purpose Stacker XL, go to https://www.support. 
xerox.com, then search for your Press and Plockmatic MPS XL.

SQUAREFOLD ®  TRIMMER DEVICE

Note: This optional finishing device requires the Interface Decurler Module. 

Tip: SquareFold® Trimmer device is available only with a booklet maker finisher. 

The SquareFold® Trimmer device is an optional finishing device that flattens the spine of a booklet and performs 
face trim of the booklet.

The SquareFold Trimmer device:

• Receives the booklet from the booklet maker area of the finisher

• Flattens the booklet spine which reduces the booklet thickness and gives it the appearance of a perfect-bound 
book

• Trims and cuts away the face edge of the booklet, resulting in a neat finished edge

The booklet area of the finisher assembly and staples booklet. The booklet enters the SquareFold® Trimmer device 

Xerox® Versant® 280 Press User Documentation 209

Working With

https://www.support.xerox.com
https://www.support.xerox.com


already assembled. Any adjustments to the image of the original and its placement on the booklet page must be 
set at the print server.

SquareFold® Trimmer Components

NUMBER COMPONENT DESCRIPTION 

1 Left Cover * Open this cover to remove paper jams.  

2 Right Cover * Open this cover to remove paper jams.  

3 Circuit Breaker Switch on the rear of 
device 

Automatically shuts off electricity in the event of 
an electrical fault or a short circuit. 

4 Booklet Tray This tray receives square-fold booklet output from 
the finisher. 

5 Square-fold Adjustment Button Press this button to adjust the thickness of 
printed booklets. 

6 Paper Jam and Error Indicator Lights when a paper jam occurs. 

7 Trimmer Waste Container Collects waste from the trimmer area of the 
device. 

* The covers cannot be opened during normal operation or when the press is idle. The covers can be 
opened only when an indicator is lit and a jam or fault occurs within the SquareFold® Trimmer device.  
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SquareFold® Trimmer Circuit Breaker

The circuit breaker is located on the rear of the device. The circuit breaker is normally in the ON position. 

Note: When an electrical interruption is detected, the circuit breaker automatically switches off to 
discontinue the electrical flow to the device. For electrical information, refer to Safety.

Under normal operating conditions, this switch should not be touched. If the press is moved, press this button to 
switch off power to the device.

Output Trays

1. Finisher Output Tray: Unused sheets that are purged by the press are ejected to this output tray.

2. Booklet Tray: Saddle Stitch/Bi-fold and Trim/Square-fold jobs are delivered only to this tray.
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Control Panel

NUMBER DESCRIPTION 

1 Fault indicators: These indicators light when a fault or jam occurs in a particular 
area of the SquareFold® Trimmer device. The lower indicator (with the lock icon) 
lights when the trimmer waste container is pulled out or when it is full. 

Note: If El, E2, or E3 is lit, the left and right covers can be opened and the 
jam or fault cleared. Otherwise, during normal operation or when the press is 
idle, the covers cannot be opened.

2 Select the desired square-fold setting; for more information refer to the Square Fold 
Adjustment Settings. 

3 Press this button to adjust the square-fold, book thickness setting. 

SquareFold® Trimmer Paper Path

NUMBER DESCRIPTION 

1 The booklet leaves the booklet area of the finisher and enters the SquareFold® 

Trimmer device. The booklet exit sensor, in the SquareFold® Trimmer device, detects 
the lead-edge spine of the booklet and moves the booklet to the square-fold area. 

2 Once the booklet spine reaches the square-fold area, the booklet is clamped and 
the square-folding operation begins. 
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NUMBER DESCRIPTION 

3 The booklet is flattened and the spine squared according to the square-fold setting 
indicated on the control panel. 

4 After the booklet is flattened and the spine squared, it is moved to the trimmer 
area. 
• Based on the finished booklet size, the booklet is moved until the trail edge 

reaches the trimmer cutter. 
• The trail edge is trimmed (cut); this is based on the finished booklet size entered 

for the trimmer mode setting. 

5 The booklet is then moved to the exit area where it is transported to the booklet 
tray. 

Note: Booklets exiting the SquareFold® Trimmer device may contain trim remnants or scraps from the 
previously trimmed booklet. This is due to static electricity build-up and is normal. If booklets contain trim 
remnants or scraps, simply remove and discard them.

Square Fold and Trim Features

Square Fold Feature

The Square Fold feature is available only when the press is connected to both a finisher with a booklet maker and 
the SquareFold Trimmer Module.

The Square Fold feature can be selected or accessed from your computer print driver, the press User Interface (UI), 
or the print server.

Note: The term Book Pressing is used synonymously with the terms Square Fold or Square Folding.

SSqquuaarree FFoolldd AAddjjuussttmmeenntt SSeettttiinnggss

The square fold feature can be switched on or off based on user preference. When the feature is switched on, you 
can select one of five options depending on your requirements for the finished booklet job.

Note: Run one or more test prints before running large jobs.
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NUMBER DESCRIPTION 

1 Select this setting (-2 / Lower / Low 2) when your finished booklet is five pages or 
less and on lightweight paper (100 g/m2 or lower). The least amount of pressure 
that can be applied to the booklet is -2. 

2 Select this setting (-1 / Low / Low 1) when you want less pressure applied to the 
spine of the booklet. The less pressure applied to the booklet, the more rounded the 
booklet spine will be. 

3 Auto / Normal is the default setting and is used for most jobs. 

4 Select this setting (+1 / High / High 1) when you want a greater amount of 
pressure applied to the spine of the booklet, but not as much as the +2 setting uses.  

5 Select this setting (+2 / Higher / High 2) when you want the most amount of 
pressure applied to the spine of the booklet. The more pressure applied, the more 
square the booklet spine will be. The greatest amount of pressure that can be 
applied to the booklet is +2. 

BBooookklleett EExxaammppllee

The following illustration shows two different booklet types:

1. This booklet is not square-folded; it has a rounded, thicker appearance to the spine.

2. This booklet is square-folded; the booklet spine is flattened and squared, giving a perfect-bound book 
appearance.

Trim Feature

Access the trim feature from your computer print driver, the press UI, or the print server.

TTrriimm OOppttiioonnss

When using the trim options, always consider the following:
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• Booklets exiting the SquareFold® Trimmer device can contain trim remnants or scraps from the previously 
trimmed booklet. Static electricity causes this build-up and it is normal. If booklets contain trim remnants, simply 
remove and discard them.

• The trim feature can be switched on or off. When the feature is on, you can adjust the trim setting in 0.1 mm 
(0.0039 in.) increments depending on your requirements for the finished booklet job.

The trim options include the following:

• Trimming On/Off: Switch On/Off the Trimming feature. The default setting is Off.

• Cut to Size: Use the Left/Right Arrow buttons to decrease or increase the trimmer setting. Adjustments are 
made in 0.1 mm (0.0039 in.) increments.

The trim setting is based on:

• The number of sheets in the finished booklet

• The finished booklet width size

• The media type (coated or uncoated)

• The media weight

Note: Experiment with various settings to determine the best selections for your job. You may want to run 
one or more test prints before running larger jobs for best booklet output.

Note: Trim settings cannot be adjusted to remove less than 2 mm (0.078 in.) or more than 20 mm (0.787 
in.) of edge material from the booklet. Adjustments less than 2 mm may produce poor trim quality. 
Adjustments greater than 20 mm result in no trimming to the booklet edge.

TTrriimm GGuuiiddeelliinneess

The following table shows various scenarios using different paper weights, media types, and trim setting selections. 
Use this table as a guideline when selecting a trim setting for your specific job.

Note: The settings shown in the following table are provided as examples and are not meant to represent 
every possible job scenario; again, use this table as a guideline only.

SCE
NARIO 
NUM
BER 

PAPER SIZE 
FINISHED 
BOOKLET SIZE 

PAPER WEIGHT 
(LBS./ G/M2) 

APPROXIMATE 
TRIM SETTING 
(MM) 

NUMBER OF 
PAGES IN 
FINISHED 
BOOKLET 

1 
210 x 298 mm (8.5 
x 11 in.), A4 

149 x 210 mm 
(5.5 x 8.5 in.) 

20 lbs./ 75 g/m2 130 20 

2 
210 x 298 mm (8.5 
x 11 in.), A4 

149 x 210 mm 
(5.5 x 8.5 in.) 

24 lbs./ 90 g/m2 125 14 

3 
210 x 298 mm (8.5 
x 11 in.), A4 

149 x 210 mm 
(5.5 x 8.5 in.) 

32 lbs./ 120 g/m2 135 10 

4 
210 x 298 mm (8.5 
x 11 in.), A4 

149 x 210 mm 
(5.5 x 8.5 in.) 

20 lbs./ 75 g/m2 125 10 

5 
210 x 298 mm (8.5 
x 11 in.), A4 

149 x 210 mm 
(5.5 x 8.5 in.) 

80 lbs./ 120 g/m2 135 12 
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SCE-
NARIO 
NUM-
BER 

PAPER SIZE 
FINISHED 
BOOKLET SIZE 

PAPER WEIGHT 
(LBS./ G/M2) 

APPROXIMATE 
TRIM SETTING 
(MM) 

NUMBER OF 
PAGES IN 
FINISHED 
BOOKLET 

6 
250 x 353 mm (8.5 
x 14 in.), B4 

250 x 176.5 mm 
(8.5 x 7 in.) 

20 lbs./ 75 g/m2 172 6 

7 
250 x 353 mm (8.5 
x 14 in.), B4 

250 x 176.5 mm 
(8.5 x 7 in.) 

24 lbs./ 90 g/m2 170 6 

8 
297 x 420 mm (11 
x 17 in.), A3 

210 x 297 mm 
(8.5 x 11 in.), A4 

24 lbs./ 90 g/m2 200 14 

9 
297 x 420 mm (11 
x 17 in.), A3 

210 x 297 mm 
(8.5 x 11 in.), A4 

80 lbs./ 216 g/m2 205 5 

10 
297 x 420 mm (11 
x 17 in.), A3 

210 x 297 mm 
(8.5 x 11 in.), A4 

20 lbs./ 80 g/m2 210 22 

11 
297 x 420 mm (11 
x 17 in.), A3 

210 x 297 mm 
(8.5 x 11 in.), A4 

24 lbs./ 90 g/m2 210 8 

12 
297 x 420 mm (11 
x 17 in.), A3 

210 x 297 mm 
(8.5 x 11 in.), A4 

80 lbs./ 120 g/m2 205 10 

13 
305 x 458 mm (12 
x 18 in.) 

152 x 229 mm 
(6 x 9 in.) 

80 lbs./ 120 g/m2 220 6 

14 
305 x 458 mm (12 
x 18 in.) 

152 x 229 mm 
(6 x 9 in.) 

80 lbs./ 120 g/m2 215 5 

15 
305 x 458 mm (12 
x 18 in.) 

152 x 229 mm 
(6 x 9 in.) 

80 lbs./ 120 g/m2 210 4 

16 
305 x 458 mm (12 
x 18 in.) 

152 x 229 mm 
(6 x 9 in.) 

28 lbs./ 105 g/m2 220 16 

17 
305 x 458 mm (12 
x 18 in.) 

152 x 229 mm 
(6 x 9 in.) 

80 lbs./ 120 g/m2 210 14 

SquareFold® Trimmer Specifications

ITEM SPECIFICATIONS 

Paper size • Maximum: 330 x 457 mm (13 x 18 in.) 
• Minimum: 216 x 270 mm (8.5 x 11 in.), A4 SEF 

Trim capacity • 5–20 sheet booklet (up to 80 imaged sides) at 90 g/m2, 24 lb. 
• 5–25 sheet booklet (up to 100 imaged sides) at 80 g/m2, 200 lb. 
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ITEM SPECIFICATIONS 

Trim size 2–20 mm, adjustable in 0.1 mm increments 

Paper weights 16 lb. bond to 90 lb. cover 

60–350 g/m2 uncoated and coated
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Job Workflows

PRINTING EXTRA-LONG SHEETS

Printing Extra-Long Sheets (XLS) with the EX Print Servers

You can print on long sheets of paper up to 330 x 660 mm (26 in.) using the standard XLS feature. This process 
allows you to create banners, advertisements, A4 landscape book covers, calendars, and long sheet prints. XLS 
specifications include:

• Print Speed: Up to 9 ppm, 1-sided mode only

• Paper Weights: For uncoated, 52–220 g/m2 and coated, 72–220 g/m2

• Maximum Paper Size: 330 x 660 mm

• Maximum Printable Area: 323 x 654 mm

To use this feature, feed sheets from Tray 5, then for output destination, specify an option: 

• Offset Catch Tray

• Top Tray of the desired finishing device

Note: A GBC® AdvancedPunch™ Pro cannot be configured with the system.
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To print extra-long sheets:

1. To support the long paper, use the Top Tray Extension Rolls. If the rails are inserted in the Finisher Tray, pull 
them out to their full extension. If the rails are stored in the back of the finisher, retrieve them and insert them 
into the holes at the end of the Tray.

2. Load the paper into the Bypass Tray 5, on top of the 2-Tray Advanced Oversized High Capacity Feeder, or 
directly on the side of the press when no optional feeders are configured with the system.  

a. To insert the paper easily, spread the Tray 5 paper guides wider than the paper.

b. Hold the center of the paper guides, then squeeze them until they touch the edges of the stack of paper.

3. Specify the paper size and type at the press touchscreen.  

a. After you load the paper, the Paper Tray Settings window opens on the User Interface.  

On this window, touch CChhaannggee SSeettttiinnggss.

b. Touch PPaappeerr ssiizzee.

c. Touch CCuussttoomm ssiizzee.

d. Enter the length (x) and height (y) of the paper that you loaded.  

For example: 26 in. x 13 in.

e. Touch SSaavvee.

f. Change other parameters as needed.

g. Touch SSaavvee.

4. Touch CCoonnffiirrmm. 

5. Submit the job file to the Hold Queue for the print server. To send the job, use File > Print from a PC on the 
network or use the Import function at the server. To use Import, follow these steps:  

a. On the Fiery® print server, click the Import shortcut.

b. Click Add.

c. Navigate to the file, then select it.

d. Click Hold.  

The job is sent to the Hold queue.

6. At the print server, set the Job Properties. 

a. To open the job properties, double-click the job in the Hold area. 

b. On the Quick Access tab, set Copies to the number of prints that you want to make.

c. On the Quick Access tab, under Paper size, click Custom.

d. Set the Width and Height of the paper, as you did at the press User Interface. 

Note: The terms for the paper dimensions are different on the server. Width corresponds to the 
measurement in the cross-process direction. Height corresponds to the length of the paper in the 
process direction. Process direction means the direction that the paper moves in the press.

e. Click OK.

Xerox® Versant® 280 Press User Documentation 219

Working With



f. On the Media tab, set Paper source to Tray 5 (bypass).

g. On the Finishing tab, for Delivery options, select the Offset Catch Tray or specific Top Tray that you want to 
use to collect the prints. Specify delivery of the output to the Offset Catch Tray or a Top Tray.

7. Click Print, then monitor the printing.

PRINTING SADDLE-STITCHED BOOKLETS WITH FULL BLEED,  TRIMMED EDGES,  AND 

INSERTING PREPRINTED COVERS

Important: The following print job workflows require you to have an Inserter device, a Production Ready 
Booklet Maker Finisher, a Crease and 2-Sided Trimmer, and a SquareFold Trimmer. 

This workflow produces an appealing look on the printed output because:

• The booklet maker creates saddle-stitched booklets

• The two trimmers cut off the edges on three sides of the booklets so that the images extend to the edge of the 
pages

• Preprinted cover pages are inserted into the workflow with the Inserter device

There is one workflow scenario for the Xerox® EX 280 and EX-i 280 Print Servers, Powered by Fiery®.

Creating Booklets with Full Bleed with the EX Print Servers 

This procedure requires the following finishing devices:

• A Production Ready Booklet Maker Finisher

• A Crease and Two-Sided Trimmer device 

• Inserter device

• SquareFold® Trimmer device

The booklet maker creates saddle-stitched booklets, while the two trimmers cut the edges off three sides of the 
booklets so that the images extend to the edge of the pages. With the Inserter device, you can insert preprinted 
cover pages in this workflow. This full-bleed output produces an appealing look for some documents.

The setup for this type of workflow includes:

• Loading the paper and programming it at the press UI

• Submitting the job and opening Job Properties

• Setting Properties for the media, layout, folding and trimming

• Selecting the settings to insert preprinted covers

• Releasing the job for a Proof copy

• Checking the output and making any adjustments to the trim settings or imposition

• Printing the job

Print the file first with no trim to see how much trim is needed to achieve a full bleed of page images.
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1. If needed, load the paper into a press tray. If you want the finished size to be 8.5 x 11 in., A4, you can load 12 
x 18 in., A3 paper and impose two 8.5 x 11 in. images onto each side of the sheets. This provides an edge 
around the images for trimming. If you load 11 x 17 in. paper, you can still impose two 8.5 x 11 in. images 
onto each side of sheets, but after the edges are trimmed the resulting size will be less than 8.5 x 11 in.

2. If you loaded paper in a tray, the Tray window opens on the press UI. If you loaded the same size paper, touch 
CCoonnffiirrmm on this window. If you loaded a different size paper, touch CChhaannggee SSeettttiinnggss and enter the new stock 
properties - Size, Type, and Weight.

3. Submit the job file to the print server Hold queue.

4. At the print server, double-click the job to open its Properties.

5. On the Quick Access tab, enter the Paper size and Paper source (where you loaded the paper) and enter the 
number of Copies.

6. On the Media tab, for 2-sided, select Top-top if printing on 2 sides of the paper. For 1-sided printing, leave the 
setting Off.

7. On the Finishing tab, under Fold, set Fold style to Booklet-fold.

8. On the Finishing tab, under Stapler, set Stapler mode to Center. 

9. On the Finishing tab, under Trim, select the box for Head and foot trim.

10. Use the up and down arrows to set the Finish Size of pages. This is the distance from the top of the page to 
the bottom.

11. For Spine printing, select Normal.

12. Select the box for Engage fore (face trim).

13. Use the up and down arrows to set the face trim. You can set the Finish Size, which is the distance from the 
spine to the right side of the page for a right-bound booklet, or the amount of the face to be trimmed.

14. If your file is pre-imposed, the settings are now complete and you can release the job to print. However, if the 
file is not preimposed, access the Layout tab and select Booklet to set the imposition you want for the job.

15. If you are not inserting pre-printed covers, proof the job, check the output, then release the job to print.

16. For optionally inserting covers when the job is pre-imposed: 

a. Load the pre-printed cover stock into the Inserter Tray T1.

b. Program the stock at the Control Panel.

c. Select the Media tab, then scroll down to select Define Cover.

d. Click the check box for Front Cover, then select Insert from the drop-down menu.

e. For Paper source, select T1.

f. Set any other unique paper properties for the cover stock, if they are different from the body stock. For 
example, the g/m2 weight may be heavier.

g. Click OK on the Cover Media window. 

h. Click Print on the Media tab to release the job.

Note: If you have an Inserter configured with your press, you can optionally insert pre-printed cover sheets 
for the booklets. The size of the cover sheets should be the same as the body sheets. The Booklet Maker will 
wrap the pre-printed cover sheet around the body pages to form a front and a back cover.
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17. For optionally inserting covers when the job is not pre-imposed:  

a. Load the pre-printed cover stock into the Inserter Tray T1.

b. Program the stock at the Control Panel.

c. Select the Layout tab.

d. Select the Booklet radio button.

e. Scroll down to the Cover area.

f. For Content input, select Pre-Printed.

g. Click Define Cover.

h. For Cover source select T1.

i. For Media Weight, select the g/m2 for the cover stock and set any other unique cover stock properties.

j. Click OK.

k. Click Print on the Layout tab to release the job.

Note: If you have an Inserter device with your press, you can optionally insert preprinted cover sheets for the 
booklets. The size of the cover sheets should be the same as the body sheets. The Booklet Maker will wrap 
the preprinted cover sheet around the body pages to form a front and a back cover.

ADJUSTING BOOKLET FOLD AND STAPLE POSITIONS

Use this procedure:

• To adjust the staple position horizontally on the paper

• To ensure that the booklet staples lay precisely on the fold, not off the fold

Note: This procedure does not enable you to move the staples up or down on the fold. A Customer Service 
Engineer must make vertical adjustments for staple positions on the fold.

To adjust the fold and staple positions for booklets, log in as Administrator and use the Tools menu. Create a profile 
for a specific size booklet in terms of the number of sheets or create a profile for booklets that vary in length.

If printing booklets that use the same number of sheets, enter that number. If printing booklets that differ in the 
number of sheets used, perform adjustments separately for a small set of sheets (Set 1) and again for a large set of 
sheets (Set 2). The system calculates and automatically uses the required adjustments for booklets that vary in size 
between Set 1 and Set 2.

The paper weight for the booklet media is important when creating the profile. The number of sheets used in the 
sets vary based on the selected weight. The system automatically determines the size of the sets based on the 
selected paper weight.

Creating a Profile for Adjusting the Fold and Staple Positions

1. For the booklet job, load the paper, short-edge feed (SEF) in the tray.

2. From the press UI, confirm or change the media settings.

3. Log in as Administrator.

4. Press the Machine Status button.
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5. Select Tools > Setup & Adjustment > Finisher – Adjust Fold Position.

6. Perform one of the following: 

• To edit an existing profile, select the profile name and touch Change Settings. Go to .

• To create a new profile, continue to the next step.

7. To create a new profile: 

a. From the Adjust Fold Position window, select one of the <Available> rows.

b. Touch Change Settings.

c. To enter a unique name, touch Change Settings again.

d. For the profile you are creating, enter a unique name .

e. Touch Save.

8. Select the Booklet fold type.

9. Touch Change Settings. 

The Booklet window opens.

10. Touch the Paper Type button.

11. Select the Paper Type and Paper Weight you are using to print the booklets.

12. Touch Save.

13. For Adjustment Method, select Standard or Variable Sheet. 

• Standard provides a profile with the most flexibility for booklets with a range of pages. When you select 
Standard, you must print and check two sample prints. One sample print is for a small page set. The other 
sample print is for a large page set. The system interpolates the settings from these two adjustments to 
match a range of pages between them.

• Variable Sheet provides the best accuracy if you always print booklets with the same number of pages. 
When you select Variable Sheet, you enter a fixed number of pages in your booklets, then make just one 
set of adjustments.

14. If you selected Variable Sheet, in the field, enter the number of sheets.

15. Touch the Sample Printout button.

16. Touch Paper Supply.

17. Select the tray that contains the paper for the booklets.  
The booklet paper must be loaded short-edge feed (SEF) in the tray.

18. Touch Save.

19. On the press UI, press the Print button.

20. When the printing completes, touch Close.

21. Touch Close again.

22. From the press output area, collect the print sample.

23. Touch Next. 

The Booklet Fold State window opens.
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24. Hold the sample booklet in front of the Booklet Fold State window with the fold on top as shown on the 
window. 

25. Place the line on the back cover of the booklet, to the left of the fold.

26. On the Booklet Fold State window, review the four staple and fold position buttons for the following 
information: 

a. Identify the staple offset position: left or right of the fold.  
The staple offset position indicates eliminates two of the four buttons and indicates one of the two 
buttons on the left or one of the two buttons on the right.

b. Of the two buttons remaining, record one of the two buttons to use. 
If the staple is not offset, but is correctly positioned, skip this step.

27. Fold the booklet closed to determine if one side, left or right, is longer than the other side.

28. Touch the button that best describes the position of both the staple and the fold.  

The Booklet Fold State window displays an illustration showing how to measure the offsets.

29. Record the following measurements: 

a. The distance the fold is off (A). 

b. How far the staple position is off (B). 
Measure the B value from the current position of the fold.

30. Use the arrows to enter the A distance and the B distance.

31. Touch Sample Printout.

32. Select Paper Supply, then select the tray that contains the paper for the booklets.

33. Touch Save.

34. Press the green Print button on the Control Panel.

35. When printing completes, touch Close.

36. Collect the sample print and check the staple and fold positions. If the fold and staple positions are not correct, 
repeat to . Go to the next step when you are satisfied with the results.

37. If you selected Variable Sheet, you are done and the profile is now complete. Touch Save and Close the 
windows.

38. If you selected Standard in , touch Next to make adjustments for Set 2. Repeat to .

39. When the second set of adjustments are complete, touch Save.

40. Touch Close.

41. Touch Close again.

42. Log out as Administrator.

Applying the Fold and Staple Position Profile to a Tray

1. Open and close the paper tray that you want to associate with the custom fold profile.

2. On the Tray Properties window that opens on the Touch Screen, select Change Settings.

3. Touch Adjust Fold Position.
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4. Select the specific profile that you want to use. You need to use the up or down arrows to locate it.

5. Touch Save.

6. Touch Save again.

7. Touch Confirm. 

The custom fold profile is now associated with the tray and is used for any paper in the tray. 

Note: You can assign the profile to a Custom Paper, then assign the Custom Paper to the tray. It is useful if 
there are other adjustments, such as paper curl, alignment, or print engine adjustments that you want to 
apply to the paper you are using for the booklets, in addition to the fold adjustment settings. 

PRODUCING SIMPLE FOLDED SHEETS AND INSERTING FOLDED SHEETS INTO A DOCUMENT

Use the Production Ready (PR) Finisher, Basic Punch, and C/Z Folder to produce simple folded sheets or insert folded 
sheets into a document.

With the optional C/Z Folder, you can produce C and Z folds on 8.5 x 11 in. or A4 sheets. You also can create 
engineering Z-folds on 11 x 17 in. or A3/B4 media. These Z-folds are called Half Z-folds. The engineering Z-fold or 
Half Z-fold folds the 11 x 17 in. or A3/B4 paper and reduces the sheet to 8.5 x 11 in. or A4 paper, respectively. This 
process allows you to insert the folded sheet into an 8.5 x 11 in. or A4 document so that the reader can pull out the 
folded portion to see an extra-large image.

C-Fold or Trifold Z-fold Half Z-fold or Engineering Z-fold 

Important: When you load or select media for folding, position the paper Short Edge Feed (SEF).

Note: Each Z-Fold Half Sheet added to a stapled set counts as 10 sheets. It reduces the total number of 
sheets for any given specified weight range.

Producing Simple Folded Sheets with the EX Print Servers

1. For the job, load the paper short-edge feed (SEF) into a tray and program the media at the press User 
Interface (UI).

2. Submit the job to the print server Hold queue.

3. From the print server, to open the job, double-click the Properties.

4. Set all required properties for the job such as quantity, paper size, source tray, and 1-sided or 2-sided.

5. Select one of the following: 

• For C and Z-folds, use 8.5 x 11 in. or A4 sheets.

• For Engineering Z-fold or Half Z-fold, use 11 x 17 in. or A3/B4 paper.
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6. Select the Finishing tab, then scroll down to the Fold area.

7. For Fold, set the style to the fold you want:  

• Trifold

• Z-fold

• Half Z-fold

• Half fold

8. Set the fold to Inside or Outside.  
When you select Inside, Page 1 is within the fold. For Outside, Page 1 is on the back of the fold.

9. If a message opens stating that the Output delivery is Face down - normal order and should be 
Face down - reverse order, select OK to correct the setting.

10. If you want the sheets hole-punched, under Punch: 

a. Set Punch edge to Left, Right, or Top. 

b. Set Punch to 2 hole punch or 3 hole punch.

11. Select Print.

12. Collect the folded output from the Top Tray of the finisher or the bottom drawer of the C/Z-folder. 

13. To open the bottom drawer of the C/Z Folder, push the button on the top left-front of the folder unit.

Inserting Folded Sheets into a Document with the EX Print Servers

You can insert printed and folded sheets into documents as long as they are not booklets created by imposing and 
folding large sheets. For example, if they are stapled, or hole-punched, but not booklets, document sets can receive 
folded sheets. Engineering Z-folds or Half Z-folds can create a useful and attractive fold-out sheet for large images 
in technical manuals or advertising pieces. The folded sheet is printed as a regular sheet in the document, but is 
programmed as an exception page for folding.

1. If needed, load the paper for the job and program it at the press User Interface (UI).

2. Submit the job to the Hold queue for the print server.

3. From the print server, double-click the job to open its Properties.

4. Set all required properties for the job such as Copies, Paper size, Source tray, and 1-sided or 2-sided.  

Usually, you print the document on 8.5 x 11 in. or A4 paper and print 2-sided, Top-to-top.

5. Select the Finishing tab, then scroll down to the Fold area.

6. Under Fold, set Fold style to Half Z-fold.  
Even though you do not apply the fold to all pages in the document, make this setting here so that it displays 
as a selection in the Mixed Media definition that you set.

7. If you want the document stapled, under Stapler, set Stapler mode to the location of the staples. 

8. If you want the document hole-punched, under Punch, set the Punch style to your preference.

9. Scroll down to the Mixed Media area and select the New Page Range button.

10. Under Define Media for Page(s), enter the page or pages that you want to be folded.  
If you are printing 2-sided, select 2 pages, which are the front and back of the folded page.
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11. For Paper size, select 11 x 17 in. (A3).

12. For Fold style, select Half Z-fold.

13. Select Add Definition.

14. Select Close. 

15. Select Print.

USING THE INSERTER DEVICE TO INCLUDE SHEETS OR TABS IN THE PRINTED OUTPUT

When you insert covers, sheets, or tabs into printed documents using the Inserter device, the insertion occurs after 
documents exit the press and before they are finished. For the inserted media, use preprinted media or blank 
media.

Note: If you want to print on the inserted sheets, use Tray 5 (Bypass) or another tray.

You can use the Exception Pages feature to specify the tray to use for the inserts. For this workflow, select the 
Inserter device, Tray T1.

Inserting Sheets and Tabs into the Printed Output with the EX Print Servers

With the EX Print Servers, you can use the Inserter device, Tray T1, or Tray 5 to insert covers and sheets into 
documents.  

Note: To insert tabs, use Tray 5.

1. If needed, load the main media for the document into a feeder tray with a long-edge feed orientation.

2. Load the sheets into the Inserter Tray T1 with a long-edge feed (LEF) orientation.  
If you load tabs in Tray 5, place the tabs face up and out, at the trailing edge of the media. When you insert 
preprinted or blank tabs, the system does not know how many tabs are in a set. It simply inserts the tabs, one 
at a time, in the same order they are placed in the tray. Check the tab sets and make sure that there are no 
partial sets. Also, if you have a jam and lose some tabs, you have to restart the job on a full tab set in Tray 5.

3. Program the media to insert at the press UI:  

Note: For Special Paper, ensure that you select the specific paper source where the media is loaded. It is 
recommended that you run tabs from Tray 5.

a. From the press UI, configure the Tray settings. 

• A Size of 8.5 x 11 in. (A4), long-edge feed

• The Weight of the tab media. This weight is usually about 164 g/m2, but it depends on your media.

• For Type, select the type of media to be inserted, for example, Precut tab - Plain.

4. To close the Tray Properties window, select Confirm .

5. Submit the job file to the Hold queue on the print server.

6. To open its Properties, double-click on the job.

7. Set all the Properties for the job such as Paper size, 1-sided or 2-sided, and number of Copies.

8. Select the Media tab, then scroll down to the Mixed Media section.

9. Select New Insert.
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10. With Page Number selected, enter the page numbers after which you want to insert preprinted or blank sheets 
or tabs. Use a comma to separate the numbers.

11. For Paper Size, select the size of your tabs, 8.5 x 11 in. Tab LEF or A4 Tab LEF.

12. For Media Type, select Tab stock (uncoated) or Tab stock (emboss).

13. Select Insert.

14. Select Close.

15. Select Print.

USING THE GBC ®  ADVANCEDPUNCH ®  PRO

Using the AdvancedPunch® Pro with the EX Print Servers

1. Load the paper for the job.

2. Confirm or change the media settings at the press UI.

3. Submit the job to the print server Hold queue.

4. At the print server, open the job Properties by double-clicking the held job. 

a. Set all required properties for the job such as Copies, Paper size, Source tray, and 1-sided or 2-sided.

b. Select the Finishing tab.

c. Scroll down to the Punch area.

d. For Punch edge, select the location of the punch on the paper: Left, Right, or Top.

e. For Punch, select Advanced Pro-ANSI or Advanced Pro-ISO. 

The name of the unit depends on your geographic region.

f. To release the job, on the finishing tab, select Print.
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Maintenance

CLEANING THE PRESS OVERVIEW

• Before you start to clean the press, be sure to switch off the power using the rear breaker switch and unplug the 
press. Cleaning the press without switching off the power may cause an electric shock.

• Always use a dry lint-free cloth for all cleaning actions unless otherwise directed.

• Do not use benzene, paint thinner, other volatile liquids, or spray insect repellent on the press as doing so may 
discolor, deform, or crack covers.

• If a moistened cloth is used, wipe afterwards with a dry lint-free cloth. Cleaning the press with an excessive 
amount of water may cause the press to malfunction and/or damage documents during printing.

Cleaning the Exterior

1. Wipe the exterior with a soft cloth moistened with water. If dirt is difficult to remove, try gently wiping with a 
soft cloth moistened with a small amount of neutral detergent. 

2. Wipe off any excess water from the exterior with a soft cloth. 

Cleaning the Document Cover and Glass

1. Cleaning the document cover 

a. Raise the document feeder. 
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b. To remove dirt, wipe the document cover with a soft cloth moistened with water and then wipe it dry with 
a soft cloth. If dirt is difficult to remove, try gently wiping with a soft cloth moistened with a small amount 
of neutral detergent. 

2. Cleaning the document (platen) glass 

a. To remove dirt, wipe the document glass with a soft cloth moistened with water and then wipe it dry with a 
soft cloth. If dirt is difficult to remove, try gently wiping with a soft cloth moistened with a small amount of 
neutral detergent.  

Caution: Do not press heavily on the document glass to avoid damaging the glass surface.

3. Cleaning the second-side scanning lens assembly 

a. The second-side scanning lens assembly is located along the left side of the document cover. The 
assembly consists of the mirrored-glass strip, a metal strip, a white-plastic strip, and rollers. All parts of the 
assembly must be cleaned to ensure the best image quality when making copies.
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b. With the document feeder open, pull the lever that is located at the top of the document cover. 

Part of the document cover pulls away from the assembly, which allows better access to the second-side 
scanning lens assembly.

c. To remove dirt, wipe the mirrored glass, metal strip, both sides of the white-plastic strip, and the rollers with 
a soft cloth moistened with water, then wipe it dry with a soft cloth. 

Caution: Do not press heavily on the mirrored glass as this will result in damage to the film around the 
glass surface.

Note: If dirt is difficult to remove, try gently wiping with a soft cloth moistened with a small amount of 
neutral detergent.

4. Once the second-side scanning assembly is clean, return the document cover to its original position and ensure 
that the lever is locked in place. 

If you touch the document cover with your bare hands, wipe it clean before closing the document feeder.

5. Gently close the document feeder.
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Cleaning the Document Feeder Rollers

1. Gently lift the latch of the document feeder top cover until it is open completely in a fixed position.  

2. While turning the rollers, gently clean them with a soft cloth moistened with water.  

Caution: Use a cloth that has been thoroughly wrung to prevent drops of water falling into the press. 
Drops of water on internal components may cause a malfunction.

If dirt is difficult to remove, try gently wiping with a soft cloth moistened with a small amount of neutral 
detergent. 

3. Close the top cover of the document feeder until you hear it click into place.

4. Close the left cover of the document feeder until you hear it click into place.

Cleaning the Drum Drawer Area

When you are replacing a drum cartridge, before inserting the new cartridge, perform these steps to clean under 
the drum cartridge area:

1. With the Drum Cartridge Drawer open, look for dry ink/toner waste on the bottom of the catch pan under the 
drum cartridges. 

2. Use a clean cloth to wipe down the catch pan.

3. Continue following the instructions on how to insert the new cartridge. 

Cleaning the ROS Windows

Unfused dry ink/toner collects on the 4 color ROS window areas located just above the Drum Cartridge Drawer 
within the press. Contaminated ROS windows can cause a white streak defect on your printed output.

Perform this procedure to clean the ROS window of the affected color whenever:

• You replace the drum cartridge

• A white streak (no image captured) shows in the same position on every print
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Note: Use only the wand and cloth pad provided when performing this cleaning procedure. Do not use any 
other cleaning device, liquid solutions, or cloths.

1. Open the Left Front Door of the press.

2. Locate the Cleaning Wand tool stored on the side panel of the open front door and remove. 

Make sure the pad at the tip of the wand is clean. Replace the pad after 4 uses. Several pads are provided in 
the Nationalization Kit. To acquire additional pads, contact your Service representative. 

3. With the pad facing upward, insert the wand fully into the ROS color window opening and then bring the wand 
fully out towards you. Complete this in/out action 3 or 4 times in each ROS window. 

4. Replace the Cleaning Wand tool into the storage area on the side panel of the open front door.

5. Close the Front Door of the press.

Cleaning the Fuser Assembly Routine

When you have an image quality issue caused by contaminants in the fuser, run the Clean Fuser Assembly routine 
from the Tools menu. For example, use this feature when you see dry ink/toner debris on the back side of prints.

The press automatically runs this routine periodically. However, if you see image quality problems with dry ink/toner 
on the back of prints, you can initiate this procedure manually.

Note: If you still notice contaminants on the back of the prints after running this procedure, contact Xerox 
Service. Dry ink/toner debris can originate from either of two areas in the press: the Transfer Roll or the Fuser 
Assembly Roll.

Cleaning the Fuser Assembly with Paper

1. Press the Machine Status button on the press User Interface.

2. Select the Tools tab.

3. Select Clean Fuser Assembly.

4. For Paper Supply, select the paper tray to use. 

Note: Although you can use any type and size of paper, the smooth surface of coated paper has more 
contact area to the pressure roll.

5. From Number of Sheets, select the number of blank sheets to run (1 — 5). 

Note: For best results, run fewer sheets for more times. It is more effective to run one or two sheets for 
multiple times than to run five sheets for one time only. This is especially important when running larger 
sheets, in the short-edge-feed (SEF) direction, such as 11 x 17 in. or A4 paper. 

6. Select Save.

7. Press the Start button. 

Note: When running five sheets of paper, the process takes approximately one minute.

The system begins the cleaning process. When the cleaning process finishes, a Completed Successfully 
message displays.

8. Select OK.
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REPLACING CONSUMABLE SUPPLIES

The following items are the Customer Replaceable Units (CRU) for the press. It is recommended that you have a 
supply of these items available to eliminate down time when they need to be replaced.

• Dry Ink/Toner cartridges (C, M, Y, K)

• Drum cartridges (C, M, Y, K)

• An empty Waste Dry Ink/Toner bottle

• Suction Filter

Refer to www.xerox.com for the latest consumable part numbers.

Note: The Fuser Module may be replaced by the customer only if directed to do so by Service.

Note: Store supply items and Xerox parts in their original packages in a convenient location. Always recycle/ 
dispose the used CRU according to the disposal instructions supplied with the new CRU.

Ordering Supplies

Xerox supplies, paper, and throughput material can be ordered from the web site www.xerox.com and clicking on 
the Supplies link. For any item that is not orderable from the web site, contact your Xerox Service Representative.

Note: The cleaning pads used with the ROS Window cleaning wand are not orderable. Contact your Xerox 
representative for any additional cleaning pads. 

CRUS (SUPPLY ITEM) REORDER QUANTITY 

APPROXIMATE PRINT YIELD 
(FULL COLOR 8.5X11/A4 
PRINTS) 

Black Dry Ink/Toner Cartridge 1 per box, 2 per press 50,000 

Cyan Dry Ink/Toner Cartridge 1 per box 55,000 

Magenta Dry Ink/Toner Cartridge 1 per box 51,000 

Yellow Dry Ink/Toner Cartridge 1 per box 51,000 

Waste Dry Ink/Toner Bottle 1 45,000 

Suction Filter 1 200,000 

Drum Cartridge (R1) 1 per box 348,000 

Drum Cartridge (R2) 1 per box 348,000 

Drum Cartridge (R3) 1 per box 348,000 

Drum Cartridge (R4) 1 per box 348,000 

OHCF Feed Roll Kit 1 kit 500,000 

Standard Finisher Staple Cartridge and 
Staple Waste Container 

4 Staple Cartridges (5,000 
staples per cartridge) and 1 
Staple Waste Container per 

5,000 staples each cartridge 
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CRUS (SUPPLY ITEM) REORDER QUANTITY 

APPROXIMATE PRINT YIELD 
(FULL COLOR 8.5X11/A4 
PRINTS) 

carton 

Booklet Maker Finisher Staple Cartridge 4 pack: 5,000 staple refills 
each 

5,000 staples each cartridge 

Business Ready (BR) Finisher Staple 
Cartridge 

1 Staple Cartridge 5,000 staples per cartridge 

Business Ready (BR) Finisher with Booklet 
Maker Staple Cartridge 

4 pack: 5,000 staple refills 
each 

5,000 staples per cartridge 

Staple Refills for the Business Ready 
Finisher and Business Ready Finisher with 
Booklet Maker 

3 refills per carton 5,000 each refill for a total of 
15,000 

Checking the Status of Consumables

When a consumable is reaching the time it should be replaced, a message is displayed on the press UI. This 
indicates when it is time to order and/or install a new consumable item. With some CRUs, the screen indicates that 
the press may continue to run print jobs without immediately replacing the item. Otherwise, when it is time to 
replace it, a message appears and the press stops running.

1. Press the Home button on the UI.

2. Press Machine Status and select the Supplies tab. 

The Supplies area shows a 1 to 100% indicator bar of the remaining amount of dry ink/toner. Remaining dry 
ink/toner is updated in 10% increments.

3. From the Supplies pull-down menu, select Other Consumables to view the status of other consumables, such 
as the drum cartridges the Dry Ink/Toner Waste Bottle, and any applicable optional devices (such as the OHCF 
feed rolls). 

Note: The status of the Fuser and Suction Filter are not shown, but a message displays when these items 
require replacing.
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Replacing a Dry Ink/Toner Cartridge

Note: Refer to the following information:

• The dry ink/toner cartridge can be replaced while a job is printing.

• If the press is installed with Xerox® Adaptive CMYK+ Kit, ensure to install the correct color configuration.

• After you replace a dry ink/toner cartridge, the system automatically resets the usage counter to zero (0) for this 
CRU. Check the Consumables Supplies screen to verify the reset and new status.

1. Open the Dry Ink/Toner cover, located just above the press front door. 

2. Lay paper on the floor before removing the cartridge. This will allow any excess dry ink/toner to fall on the 
paper.

3. Grasp the handle of the dry ink/toner cartridge matching the color indicated in the message. 

4. Remove the dry ink/toner cartridge by slowly and gently pulling it straight out. While pulling out, hold the 
bottom of the cartridge with your other hand to give it support. 

5. Dispose of or recycle the cartridge per your local authorities and regulations. 
In the United States, also refer to the Electronic Industries Alliance website: www.eiae.org. For more information 
about Xerox environmental programs, go to www.xerox.com/environment.

6. Remove the new dry ink/toner cartridge from its packaging.

7. With one hand on either side of the cartridge, vigorously shake and rotate the new cartridge up and down and 
left and right for 30 seconds to redistribute the dry ink/toner.

8. Install the new dry ink/toner cartridge by gently and evenly sliding the cartridge into the press until it stops.

9. Close the dry ink/toner cover. If the cover does not close completely, make sure the cartridge is in the lock 
position and is installed into the appropriate dry ink / toner location.
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Replacing the Dry Ink/Toner Waste Bottle

The Dry Ink/Toner Waste Bottle collects dry ink/toner that accumulates during the printing process. When the bottle 
is full, a message displays on the press UI informing you to exchange the full bottle with an empty one. 

The press contains one waste bottle located at the front of the press behind the Dry Ink/Toner Waste Bottle Door. 
When removing a full Dry Ink/Toner Waste bottle, SLOWLY pull it out of the press. This will prevent any dry ink/toner 
from spilling out of the bottle.

Note: After you replace the Dry Ink/Toner Waste Bottle, the system automatically resets the usage counter 
to zero (0) for this CRU component. Check the Consumables Supply screen to verify the reset.

1. Ensure that the press is stopped (not running any jobs).

2. Open the front door of the press.

3. Open the Dry Ink/Toner Waste Bottle Door. 

4. Grasp the handle of the Dry Ink/Toner Waste bottle and pull it halfway out of the press.

5. Support the underside of the bottle with your other hand and continue pulling it out from the press. 

Caution: Never use a vacuum cleaner when cleaning up spilled dry ink/toner. Use a broom or a cloth 
moistened with a neutral detergent.

6. Use both hands to place the old used Dry Ink/Toner Waste Bottle into the provided plastic bag.

7. Remove a new, empty waste bottle from the packaging.

8. Hold the center part on the top of a new bottle and insert it evenly and gently into the press until it comes to a 
stop.

9. Close the waste bottle door.

10. Close the press front door.
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Replacing a Drum Cartridge

You need to replace a drum cartridge if it has reached the end of its component life, if it is damaged by light, or if 
you are experiencing spots and streaks on your output.

Note: All four Drum cartridges are interchangeable.

Note: After replacing the drum cartridge, the system automatically resets the usuage counter of this CRU 
component to zero (0). Check the Consumables screen for the reset and new status. 

Caution: Drums are light sensitive. Do not leave the Drum Cartridge Drawer open for more than one 
minute. Exposing the drum cartridges to direct sunlight or strong light from indoor fluorescent lighting for 
more than one minute can cause image quality defects.

Caution: Replace drum cartridges while the press is powered ON.

1. Ensure that the press is stopped and is not currently printing jobs.

2. Open the press Front Door. 
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3. Rotate and turn the R1-R4 Drum Drawer Handle to the unlock position. 

4. Open the bag containing the new drum cartridge. Place the new drum cartridge near the press. 

Caution: Do not touch or scratch the surface of the drum when you take it out from the bag.

5. Unwrap the sheet covering the new drum cartridge and place it under the cartridge. Some drum cartridges may 
include a protective film. Remove the film on the drum cartridge, if the film is present. 
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6. Grab the Release Handle and pull the Drum Drawer straight out. 

7. Remove the old drum cartridge by holding the finger rings provided at both ends of the drum cartridge and 
gently lifting up. 

Caution: Drums are light sensitive. Do not leave the Drum Cartridge Drawer open for more than one 
minute when replacing cartridges. Exposing the drum cartridges to direct sunlight or strong light from 
indoor fluorescent lighting for more than one minute can cause image quality defects.

8. Install the new drum cartridge into the press following the guides with the side marked front facing the front. 
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9. Press both ends of the drum cartridge to place it in a horizontal position. 

10. Immediately close the drum cartridge drawer to protect the other drums from light.

11. Return the Release Handle to its original position.

12. Return the R1-R4 handle to the original position and close the front door.

13. Insert the used drum cartridge into an empty container for recycling.

Replacing the Suction Filter

You will need the T10 Torx driver tool for this procedure.

After you replace the filter, you will need to contact the system administrator who will log into administrator mode 
and reset the counter to zero (0) for this CRU.

Caution: Make sure the press is powered off before performing this procedure.

1. At the back of the press, locate the Suction filter cover on the lower panel.

2. Use the Torx driver to remove the screw on the right side of the cover by turning the screw counterclockwise.  

3. Pull out and remove the Suction Filter Cover.
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4. Grasp the handle of the filter box and pull straight out. 

5. Remove the Suction filter out of the box.

6. Place the new Suction filter into the box and push the tray back in until it stops and is flush with the press.

7. Place the cover back onto the filter box area. Make sure to first insert the left two tabs of the cover into the left 
side of the box area. Then push the entire cover flush to the press. 

8. Insert the Torx driver with the screw attached into the cover and turn clockwise to tighten.

9. Log in as the Administrator or ask the Administrator to perform the following steps to reset the counter to zero 
(0): 

a. At the UI, press the Machine Status button.

b. From the screen that displays, select the Tools tab.

c. Select System Settings > Common Service Settings > Maintenance. 

d. Use the arrow buttons to access the next Maintenance screens. 

Note: After selecting the icon in following step, there is a 4 second delay before the Technical Key Operator 
feature displays.

e. Select the Technical Key Operator (TKO) icon.  

The Technical Key Operator feature displays.

f. Log in to the Technical Key Operator mode. 

AAtttteennttiioonn

If you cannot log in as TKO, or do not have the TKO password, call your Customer Service Engineer.

g. In the Part Number list, select Suction Filter.

h. Select Reset Current Value. The system resets the HFSI to 0.

10. Exit administrator mode. 

a. To return to Tools tab, select Close twice. 

The main Tools screen displays.

b. Select the Log In / Out button on the User Interface.
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c. When prompted, select Logout.

TRAYS 6  AND 7 MAINTENANCE

Consumable Supplies for Tray 5-9

CRUS (SUPPLY ITEM) REORDER QUANTITY 

APPROXIMATE PRINT YIELD 
(FULL COLOR 8.5X11/A4 
PRINTS) 

Feed Roll Kit (Trays 5–9) 1 kit 300,000 

**Each tray requires its own feed roll kit. Each kit contains all the required items for replacing the feed rolls.

Important: Three feed roll kits are available: 

• Reorder number: 000088RR1133119966 for Tray 5 
• Reorder number: 000088RR1133119955 for Tray 6, 1-Tray Oversized High Capacity Feeder 
• Reorder number: 000088RR1133116699 for Trays 6-9, 2-Tray Advanced Oversized High Capacity Feeder or Dual 

Advanced Oversized High Capacity Feeder; 1 roll kit is required for each tray. 

For more information, contact the Customer Support Center.

Replacing Tray 5 Feed Rolls

Use this procedure by Tray 5 is installed on top of Trays 6 and 7.

Tip: Replace the bypass tray feed rolls when experiencing frequent multifeeds, single feeds, or blank prints in the 
stack of the output prints.

Use this procedure to replace the Bypass tray feed rolls, which includes:

• Feed Roll

• Nudger Roll

• Separator Roll

Note: After you replace all of the feed rolls, contact your system administrator who will reset the HFSI 
counter for these CRU components to zero (0).

1. Locate and access the Bypass Tray on top of Trays 6 and 7.
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2. Lift up and open the Bypass Tray cover to access the feed roll components. 

3. Remove and replace the feed roll by squeezing the metal shaft and lifting out. 

4. Remove and replace the nudger roll using the same technique. 
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5. Remove and replace the separator roll using the same technique. 

6. Close the bypass tray cover.

7. Verify that the tray is operating correctly by feeding paper from the bypass tray.

8. Log in as the administrator or ask the administrator to perform the following steps to reset the HFSI count to 
zero (0): 

a. At the UI press the Machine Status button.

b. Select the Tools tab.

c. Select System Settings > Common Service Settings > Maintenance.

d. Use the arrow buttons to access the next Maintenance screens.

e. Select the Technical Key Operator (TKO) icon.  

The Technical Key Operator feature displays.

f. Log in to the Technical Key Operator mode. 

AAtttteennttiioonn

If you cannot log in as TKO, or do not have the TKO password, call your Customer Service Engineer.

g. Select the bypass rolls item that corresponds with the newly-replaced components.

h. Select Reset Current Value. The system resets the HFSI to 0.

9. Exit the administrator mode by pressing the Log In/Out button on the UI.  

When prompted, select Logout.

Replacing Trays 6 and 7 Feed Rolls

Replace the feed rolls every 300,000 prints or when experiencing frequent multifeeds, single feeds, or blank prints in 
the stack of the output prints.  

Use this procedure to replace the feed rolls, which includes:

• Feed Roll

• Nudger Roll
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• Separator Roll

Note: After you replace all of the feed rolls, contact your system administrator who will reset the HFSI 
counter for these CRU components to zero (0). 

1. Pull open the top tray to access the feed components. 

2. On the right-side panel of the tray is the feed roll compartment.  

3. Remove the nudger roll by pushing down on the black tab with one hand (which raises the roll upward) and 
then squeezing the metal shaft on both ends with your other hand. Lift out the nudger roll. 

4. Replace the new roll by squeezing both ends of the metal shaft, and pushing down on the black tab, insert and 
release the roll ends into the notches. 
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5. Next, remove the separator roll assembly at the side of the feeder tray to access the separator roll. Unscrew the 
3 thumbscrews. 

6. Slide the separator assembly all the way to the left so it is out of the slots. Pull the assembly out towards you 
until completely removed from the tray. Set aside. 

7. With the separator assembly out, access and remove the feed roll. To remove, squeeze both ends of the metal 
shaft and lift out. To replace, squeeze both ends of the new roll shaft, then insert and release the roll ends into 
the notches. 
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8. Finally, replace the separator roll. Squeeze the orange shafts of the separator roll and lift out of the assembly.  

9. Replace a new separator roll into the black notches of the assembly using the same technique. 

10. Reinstall the separator assembly into the tray. Align the cutout holes of the assembly with the frame of the tray 
so the pin holes match up. Insert the assembly into the frame. Slide the assembly all the way to the right using 
the pin as a guideline. Ensure the device is all the way into the slots and the 3 screw areas align.  

11. Screw in the 3 thumbscrews to attach the assembly. Do not overtighten. 

12. Close the tray and verify that the tray is operating successfully by feeding paper using that tray.

13. Log in as the administrator or ask the administrator to perform the following steps to reset the HFSI count to 
zero (0). 

a. At the UI press the Machine Status button.

b. Select the Tools tab.
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c. Select System Settings > Common Service Settings > Maintenance. 

d. Use the arrow buttons to access the next Maintenance screens.

e. Select the Technical Key Operator icon. 

The Technical Key Operator feature displays.

f. Log in to the Technical Key Operator mode. 

AAtttteennttiioonn

If you cannot log in as TKO, or do not have the TKO password, call your Customer Service Engineer.

g. Select the item (HCF) that corresponds with the newly-replaced components.

h. Select Reset Current Value. The system resets the HFSI to 0.

14. Exit administrator mode by pressing the Log In/Out button on the UI. 

When prompted, select Logout.

TRAYS 8  AND 9 MAINTENANCE

Replacing Tray 5 Feed Rolls

Use this procedure by Tray 5 is installed on top of Trays 8 and 9.

Tip: The feed rolls for Tray 5 (Bypass) should be replaced when experiencing frequent multifeeds, single feeds, or 
blank prints in the stack of the output prints.

Use this procedure to replace the following feed rolls for Tray 5:

• Feed Roll

• Nudger Roll

• Separator Roll

Note: After you replace all of the feed rolls, contact your system administrator who will reset the High 
Frequency Service Item (HFSI) usage counter for these CRU components to zero (0).

1. Locate and access Tray 5 (Bypass) on top of Trays 8 and 9.

2. Lift up and open the Bypass Tray cover to access the feed roll components. 
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3. Remove and replace the feed roll by squeezing the metal shaft and lifting out. 

4. Remove and replace the nudger roll using the same technique. 

5. Remove and replace the separator roll using the same technique. 

6. Close the bypass tray cover.

7. Verify that the tray is operating correctly by feeding paper from the bypass tray.

8. Log in as the administrator or ask the administrator to perform the following steps to reset the High Frequency 
Service Item (HFSI) count to zero (0): 
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a. At the Control Panel, press the Machine Status button.

b. Select the Tools tab.

c. Select System Settings > Common Service Settings > Maintenance.

d. Use the arrow buttons to access the next Maintenance screens.

e. Select the Technical Key Operator (TKO) icon.  

The Technical Key Operator feature displays.

f. Log in to the Technical Key Operator mode. 

AAtttteennttiioonn

If you cannot log in as TKO, or do not have the TKO password, call your Customer Service Engineer.

g. Select the bypass roll items that corresponds with the newly-replaced components.

h. Select Reset Current Value. The system resets the High Frequency Service Item (HFSI) to 0.

9. Exit the administrator mode by pressing the Log In / Out button on the UI.  

When prompted, select Logout.

Replacing Trays 8 and 9 Feed Rolls

Replace the feed rolls every 300,000 prints or when experiencing frequent multifeeds, single feeds, or blank prints in 
the stack of the output prints.  

Use this procedure to replace the feed rolls, which includes:

• Feed Roll

• Nudger Roll

• Separator Roll

Note: After you replace all of the feed rolls, contact your system administrator who will reset the High 
Frequency Service Item (HFSI) usage counter for these CRU components to zero (0). 

1. Pull open the top tray to access the feed components. 
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2. Notice the feed roll compartment on the right-side panel of the drawer.  

3. Remove the nudger roll by pushing down on the black tab with one hand (which raises the roll upward) and 
then squeezing the metal shaft on both ends with your other hand. Lift out the nudger roll. 

4. Replace the new roll by squeezing both ends of the metal shaft, and pushing down on the black tab, insert and 
release the roll ends into the notches. 

5. Next, remove the separator roll assembly at the side of the feeder tray to access the separator roll. Unscrew the 
3 thumbscrews. 
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6. Slide the separator assembly all the way to the left so it is out of the slots. Pull the assembly out towards you 
until completely removed from the tray. Set aside. 

7. With the separator assembly out, access and remove the feed roll. To remove, squeeze both ends of the metal 
shaft and lift out. To replace, squeeze both ends of the new roll shaft, and insert and release the roll ends into 
the notches. 

8. Finally, replace the separator roll. Squeeze the orange shafts of the separator roll and lift out of the assembly.  

Xerox® Versant® 280 Press User Documentation 253

Working With



9. Replace a new separator roll into the black notches of the assembly using the same technique. 

10. Reinstall the separator assembly into the tray. Align the cutout holes of the assembly with the frame of the tray 
so the pin holes match up. Insert the assembly into the frame. Slide the assembly all the way to the right using 
the pin as a guideline. Ensure the device is all the way into the slots and the 3 screw areas align.  

11. Screw in the 3 thumbscrews to attach the assembly. Do not over tighten. 

12. Close the tray and verify that the tray is operating successfully by feeding paper using that tray.

13. Log in as the administrator or ask the administrator to perform the following steps to reset the High Frequency 
Service Item (HFSI) count to zero (0). 

a. At the Control Panel, press the Machine Status button.

b. Select the Tools tab.

c. Select System Settings > Common Service Settings > Maintenance. 

d. Use the arrow buttons to access the next Maintenance screens.

e. Select the Technical Key Operator (TKO) icon.  

The Technical Key Operator feature displays.

f. Log in to the Technical Key Operator mode. 

AAtttteennttiioonn

If you cannot log in as T

g. Select the item that corresponds with the newly-replaced components.

h. Select Reset Current Value. The system resets the High Frequency Service Item (HFSI) to 0.
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14. Exit administrator mode by pressing the Log In / Out button on the Control Panel. 

When prompted, select Logout.

FINISHING DEVICES MAINTENANCE

Business Ready (BR) Finisher and Optional Booklet Maker Maintenance

Consumable Supplies for the BR Finisher

CRUS (SUPPLY ITEM) REORDER QUANTITY 

APPROXIMATE PRINT YIELD 
(FULL COLOR 8.5X11/A4 
PRINTS) 

Business Ready (BR) Finisher Staple 
Cartridge 

1 Staple Cartridge 5,000 staples per cartridge 

Business Ready (BR) Finisher with Booklet 
Maker Staple Cartridge 

4 pack: 5,000 staple refills 
each 

5,000 staples per cartridge 

Staple Refills for the Business Ready 
Finisher and Business Ready Finisher with 
Booklet Maker 

3 refills per carton 5,000 each refill for a total of 
15,000 

Replacing Staples in the Main Stapler Unit

1. Open the front door of the Business Ready Finisher.

2. Hold the stapler assembly by the orange lever R1 and push it to the right. 

3. Grip the staple cartridge by the orange handle and pull it firmly toward you to remove it. 
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4. Pinch both sides of the staple refill (1) and remove it from the cartridge (2). 

5. Insert the front side of the new staple refill into the staple cartridge (1), then push the rear side into the 
cartridge (2). 

6. Close the front door of the Business Ready Finisher.

Replacing Staples in the Booklet Maker

1. Open the front door of the Business Ready Finisher.

2. Grasp the booklet maker handle and pull the unit toward you until the staple cartridges appear on the top edge 
of the device. 

3. To remove the staple cartridge from the booklet maker, push down on the staple cartridge handle as shown, 
then pull the cartridge out and up. 

4. Turn the staple cartridge over.
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5. To permit the staple cartridge handle to open out and away from the staple refill, press in the green tabs, then 
pull back the handle. 

6. To remove the staple refill, press the rear of the refill container as shown. 

7. Replace the staple refill, then return the staple cartridge to the booklet maker.

8. Close the front door of the Business Ready Finisher.

Emptying the Hole Punch Waste Container

A message appears on the press User Interface (UI) when the hole punch waste container is full.

WARNING: Do not perform this procedure while the printer is copying or printing.

1. Open the front door of the Business Ready Finisher.

2. Remove the hole punch waste container from its slot near the top left of the finisher. 

• Wait 10 seconds before reinserting the container into the printer. The hole punch counter resets after 10 
seconds.

• If you remove the hole punch waste container before the device instructs you to, empty the container 
before you reinsert it into the finisher.
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3. Empty the container. 

4. Insert the container all the way into the finisher. 

5. Close the front door of the Business Ready Finisher.
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Crease and Two-Sided Trimmer Maintenance

Emptying the Crease and Two-Sided Trimmer Waste Container

When the trimmer waste container is nearing the full condition, an indicator lights on the top of the Crease and 
Two-Sided Trimmer. 

Note: The waste container can be emptied before it is full and also while the printer is running.

When the waste container reaches the full condition, the following changes occurs: 

• The indicator changes from a steady lighted condition to blinking.

• A message appears on the press indicating that the waste container is full.

Perform the following steps to empty the trimmer waste container.

1. Open the lower cover of the Crease and Two-Sided Trimmer. 
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2. Pull out and remove the waste container. 

3. Discard all waste.  

Important: Ensure that the waste container is empty. If waste or debris remains in the container, the 
trimmer may malfunction.

4. To ensure that you remove all waste and debris, especially beneath the frame that is located behind the 
container, use the cleaning rod to remove any remaining waste from inside the trimmer. 

5. Return the cleaning rod to its original position on the inside of the lower cover.

6. Reinsert the waste container and push it in fully. 

7. Close the lower cover.
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Production Ready Finishers Maintenance

Finisher Consumable Supplies

Xerox supplies, including staples, staple cartridges, and staple waste containers can be ordered from Xerox by going 
to www.xerox.com and clicking on the Contact Us link for specific contact information and telephone numbers in 
your area or by clicking on the Supplies and entering/selecting your specific machine information (product family 
and model type).

Note: Always refer to www.xerox.com for the latest Customer Replaceable Units (CRUs) part numbers.

Store supply items and Xerox parts in their original packages in a convenient location.

SUPPLY ITEM 
SUPPLY UNIT SHIPPED WITH FINISHER/REORDER 
QUANTITY 

Staple Cartridge and Staple Waste Container 
(for the PR Finisher, the PR Booklet Maker 
Finisher, and the PR Finisher Plus) 

4 staple cartridges (5,000 staples per cartridge) and 1 staple 
waste container per carton 

PR Booklet Maker Finisher Staple Cartridge 4 pack: 5,000 staple refills each 

Checking the Status of Finisher Consumables

When a consumable is nearing the time for replacement, a message is displayed on the control panel touch screen. 
This indicates when it is time to order and install a new consumable item. With some Customer Replaceable Units 
(CRUs), the screen indicates that the press may continue to run print jobs without immediately replacing the item. 
Otherwise, when it is time to replace it, a message appears and the press stops running.

To check the status of your consumables:

1. Press the Home button on the press control panel.  

2. Press Machine Status and select the Supplies tab. 

The Supplies area shows a 1 to 100% indicator bar of the remaining amount of dry ink/toner. Remaining dry 
ink/toner is updated in 10% increments.
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3. From the menu, select Other Consumables to view the status of other consumables, such as the drum 
cartridges the Dry Ink/Toner Waste Bottle, and any applicable optional devices, such as the OHCF feed rolls. 

The Other Consumables window appears and provides information about the percentage of remaining life for 
each consumable. 

4. Use the up and down arrows to see additional consumables, such as the finisher staples, the staple waste 
container, and other consumables for any additional optional devices that are configured with the press.

Replacing the Basic Staple Cartridge for Side Stitching

Note: Ensure that the press is not running before performing this procedure.
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1. Open the finisher front cover. 

2. Pull out R1.  

3. Holding the staple cartridge at the position indicated by the arrow, remove it from the unit. 
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4. Insert a new staple cartridge into the unit. 

5. Insert the unit to its original position. 

6. Close the finisher front cover.

Replacing the Booklet Staple Cartridge for Saddle Stitching

Note: Ensure that the press is not running before performing this procedure.

Note: This procedure is applicable only or the PR Booklet Maker Finisher.

1. Open the finisher front cover. 
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2. Pull out the Saddle Stitch Unit 3 toward you until it stops.  

3. While holding the tabs on the staple cartridge, pull out the cartridge to remove it. 

Note: There are two booklet staple cartridges provided. Check the message to see which cartridge needs 
replacing.

4. While holding the tabs on the new staple cartridge, push in the cartridge until it seats. 

Note: Make sure that the marks are aligned.
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5. Push the Saddle Stitch Unit 3 gently into the finisher until it stops. 

6. Close the finisher front cover.

Replacing the Finisher Staple Waste Container

WARNING: To avoid personal injury, use care when removing staple waste container.

The press displays a message when staple waste container is full. When the message appears, replace the container 
with a new one.

Important: 

• Before you perform this procedure, ensure that the press is not running.

• When you replace the staple waste container, keep the press powered on. If the press is powered off, it does not 
recognize that the waste container was replaced, and the full message remains displayed.

• To ensure that the press continues running after you replace the waste container, close the finisher front cover.

Note: A staple waste container comes with the basic staple cartridge.

1. Open the finisher front cover. 
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2. Move the lock lever under R5 toward the left to the opened-lock mark. 

3. Pull out R5. 

4. Place the used staple waste container into the supplied plastic bag. 

Note: Do not disassemble the used waste containers. Return the used staple waste containers to the 
Customer Support Center. 
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5. Insert the new staple waste container by lowering it into position and gently pushing it into place. 

WARNING: To prevent injury, do not put your fingers on top of the container.

6. Move the lock lever under R5 toward the right to the closed-lock mark. 

7. Close the finisher front cover.

Emptying the Hole Punch Waste Container

The press displays a message when hole punch waste container is full. When the message appears, empty the 
container of all paper scraps.

Important: 

• Before you perform this procedure, ensure that the press is not running.

• When you empty the container, keep the press powered on. If the press is powered off, it does not recognize 
that the container was emptied, and the full message remains displayed.

• To ensure that the press continues running after you empty the container, close the finisher front cover.
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1. Open the finisher front cover. 

2. Pull out the R4. 

3. Discard all waste from the container. 

Important: Be sure to completely empty the container. If any waste or scraps remain, the container 
becomes full before a full message displays causing a fault to occur.

4. Return R4 to its original position.

5. Close the finisher front cover.

PR Finisher Plus Maintenance

For information on consumable supplies and maintenance procedures for the PR Finisher Plus, refer to the following:
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• Finisher Consumable Supplies

• Checking the Status of Finisher Consumables

• Replacing the Basic Staple Cartridge (for Side Stitching)

• Replacing the Finisher Staple Waste Container

• Emptying the Hole Punch Waste Container

SquareFold® Trimmer Device Maintenance

Emptying the SquareFold® Trimmer Waste Container

When the waste container reaches the full condition, an indicator lights on the top of the SquareFold® Trimmer 
device. A message also appears on the press indicating that it is full. When the message appears, dispose of the 
paper scraps.

Note: Keep the press powered on when disposing of the waste. If powered off, the press does not recognize 
that the container was emptied. 

Perform the following steps to empty the trimmer waste container.

1. Ensure that the press is not running, then slowly pull out the Trimmer Waste Container. 
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2. Hold the belt on the waste container, then remove the container with both hands.  

3. Discard all waste and scraps. 

Note: Ensure that the container is completely emptied. If any waste or scraps remain, the container will 
become full before a message appears causing the press to malfunction.

4. Reinsert the empty waste container and slowly push it in completely. 
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General Troubleshooting

Check the press status for system troubleshooting.

Warning: Precision components and high-voltage power supplies are used on the press. Never open or 
remove covers that are screwed shut unless specifically instructed in this guide. A high-voltage component 
can cause electric shocks. When opening the panels and covers that are screwed shut to install or detach 
optional accessories, be sure to follow instructions in this guide. Do not try to alter the press configuration 
or modify any parts. Doing so might cause press malfunction or fire.

The information in this section helps you resolve some basic problems you can encounter with the press. If the 
problem persists after following the instructions, contact your Xerox Representative or the Xerox Technical Customer 
Support.

Note: If your print server indicates that the press has a fault and the User Interface (UI) does not readily 
display a message, refer to the Print Reports > Job Status > Error History Report.

PRESS DOES NOT POWER ON

PPrroobblleemm

The press does not power on.

SSoolluuttiioonnss

1. Ensure the power cord from the press is plugged into the power outlet or receptacle. If the problem persists, 
perform the following steps: 

a. From inside the front door, press off the main power switch.

b. Firmly plug in the power cord.

c. Press the power switch on.

2. From inside the front door, ensure the power switch is set to the ON position, the press the power button ON. 

Note: The power button is located on top of the press near the user interface (UI).

3. Ensure the power supply is 200–240V (volts) and 30A (amperes).

4. Ensure that the supplied power capacity is compatible with the specified maximum power consumption of the 
press which is 2.8–3.1 kVA (kilo-volt-ampere).

5. Check the ground fault interrupter (GFI) circuit breakers.

6. If the power in your location is working properly and you have tried the suggested solutions, but the press does 
not power on, contact the Customer Support Center for assistance.

CANNOT OBTAIN THE PRESS SERIAL NUMBER FROM THE MACHINE STATUS SCREEN

PPrroobblleemm

There is no power to the press, and you cannot access the Machine Status screen to get the press serial number.
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SSoolluuttiioonnss

Open paper tray 1. On the left frame, near tray 1, locate the serial number. Refer to Locating the Press Serial 
Number.

USER INTERFACE IS  NOT WORKING

PPrroobblleemm

The user interface (UI) is not working. It is locked up or completely dark.

SSoolluuttiioonnss

• If the UI buttons or keyboard do not work, press the power button Off. Wait 30 seconds, then reboot the 
system by pressing the power button On.

• If the Power Saver button light is on, the press is in the Power Saver Mode. To cancel the Power Saver mode, 
press the Power Saver button.

PRESS DOES NOT COMPLETE A PRINT JOB

PPrroobblleemm

The press does not successfully complete a print job.

SSoolluuttiioonnss

• To verify that your press connected to the network, from the print server, print a test page.

• Verify that the power cable is connected to the press and to a suitable power outlet.

• Verify that the network cables are attached securely to the press and seated properly.

• Clear out the print job from the print queue, and resend the print job.

• To restart the press, power off the press, then power it on.

• Your press may not be configured on the network. To connect the press to the network, contact the system 
administrator.

TIME INTERVAL BETWEEN PRINT JOBS IS  LONGER THAN 1 MINUTE

PPrroobblleemm

The press is taking longer than one minute before printing the next job.

SSoolluuttiioonnss

The system requires approximately 2 minutes when switching print modes in order to make any necessary 
adjustments for the next print job, including color-to-color registration, density, charge levels, bias levels, or other 
adjustments. 

• The system has two print modes selectable at the print server: 
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– 4 Color Mode (CMYK: Cyan, Magenta, Yellow, Black) 

– Black and White Mode Only 

• If the next print job is switching print modes, for example from black-only to 4-color, the system requires 
approximately 2 minutes to make any necessary adjustments.

• During this time, the touch screen displays the Adjusting Image Quality message.

• The next job begins printing once the system completes its adjustments.

Other information to remember includes: 

• From a cold start (power on or power saver), system takes less than 5 minutes to start printing.

• From standby mode, system usually takes less than 1 minute to start printing.

PRINT OUTPUT CONTAINS CORRUPTED TEXT

PPrroobblleemm

The printed output contains corrupted text, or the text prints incorrectly.

SSoolluuttiioonnss

Check the application or print driver settings on whether non-standard fonts are used for printing.

TRAYS DO NOT RECOGNIZE THE MEDIA

PPrroobblleemm

Trays do not recognize the media.

SSoolluuttiioonnss

• At the user interface (UI), check the paper settings for the tray. To check the paper settings for a tray, select 
Machine Status > Device Information > Paper Tray Status.

• Check the print server settings.

• Check that the paper is loaded correctly in either the short-edge-feed (SEF) or long-edge-feed (LEF) direction, 
and at the print server, ensure that the settings match the programmed paper settings.

PRINTS ARE NOT ON THE DESIRED PAPER SIZE

PPrroobblleemm

Prints are not on desired paper size.

SSoolluuttiioonnss

• Ensure that the correct paper size and type is loaded in the paper trays.

• Set the paper guides to the correct positions.
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• At the print server, select the paper size, tray and weight, and from the Tray Properties window, ensure the paper 
attributes match.

• From the print driver, ensure the Fit to Paper or an equivalent selection is not selected.

REPEATED PAPER MISFEEDS,  JAMS,  OR WRINKLES

PPrroobblleemm

Paper repeatedly misfeeds, jams often, or wrinkles.

SSoolluuttiioonnss

• If a message appears on the press touch screen, follow the instructions displayed.

• Ensure that the paper and paper tray selected match the paper size settings. Refer to the Tested Substrate List 
from www.xerox.com/rmlna or www.xerox.com/rmleu.

• Ensure that the trays are loaded properly with acceptable media, and do not exceed the MAX fill line.

• Ensure that the paper tray edge guides are in the correct position. To ensure tray closure, firmly push it in as far 
as possible. 

• In the selected tray, flip the paper stack around or over.

• Remove a few sheets from the top and the bottom of the stack in the paper tray.

• Fan all four edges of the paper in the selected paper tray. 

• Replace the paper in the selected paper tray with paper from a new package.

• Remove any partially fed paper from the trays. Make sure to remove any torn pieces of paper still remaining 
inside the press.

• Ensure that the paper you are using had been stored properly.

• If the problem is from trays 6-9 only, refer to Multifeeds, Misfeeds and Paper Jams in Trays 6-9.

MULTIPLE SHEETS FED FROM THE PAPER TRAYS

PPrroobblleemm

Multiple sheets feed from the paper trays.

SSoolluuttiioonnss

• Do not fill the paper trays above the MAX fill line indicator.

• Remove the paper from the tray and fan the sheets to separate the joined sheets. 

• If hole–punch paper sticks together at the holes, remove the paper from the tray, and fan the sheets to 
separate the joined sheets.

• If environmental conditions are too dry and cause excessive static, paper and transparencies may stick together. 
Increase the humidity level in the room to minimize static. 

• Before you load transparencies, gently fan them to separate the sheets.
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• If the problem is from trays 6-9 only, refer to Multifeeds, Misfeeds and Paper Jams in Trays 6-9.

PAPER JAMS IN OPTIONAL TRAYS 6–9

PPrroobblleemm

Paper jams occur in the optional Trays 6, 7, 8, or 9.

SSoolluuttiioonnss

• Visually check to see if the feed, separator, or nudger rolls are worn or damaged.

• For the tray rolls, check the high frequency service item (HFSI) interval status. If required, replace the rolls.

For information, refer to Trays 6 and 7 Maintenance or Trays 8 and 9 Maintenance.

PAPER JAMS WHEN EXITING THE PAPER TRAYS

PPrroobblleemm

When exiting the trays, paper jams occur.

SSoolluuttiioonnss

• Ensure that the edge guides of the paper tray fit snugly against the paper stack.

• Do not fill the paper trays above the MAX fill line indicator.

• Close the tray slowly to avoid shifting the paper stack.

PRINTED OUTPUT JAMS WHEN EXITING PRESS TO OFFSET CATCH TRAY (OCT)

PPrroobblleemm

When exiting the press to the offset catch tray (OCT), the printed output jams.

SSoolluuttiioonn

• When using the OCT for printed output, to ensure continuous production, empty the tray before it 
approaches the maximum capacity. The OCT maximum capacity is 500 sheets for 24 lb. or 90 g/m2 paper.

• For 11 x 17 in. or A3 output, ensure the first output sheet is not blocking the paper exit.

EXCESSIVE PAPER CURL

PPrroobblleemm

The printed output contains excessive paper curl.

SSoolluuttiioonnss

Potential impacts: 
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• Ensure that the correct paper weight and paper type are selected.

• The printed output contains a mass of dry ink/toner coverage. On the printed output, the amount of paper curl 
depends on the size of the dry ink/toner mass.

• The paper weight and whether or not it is coated or uncoated.

• The humidity conditions at the press.

• You can sometimes minimize curl problems by flipping the paper over in the tray. If excessive curl is still present, 
use a heavier paper. 

• To ensure continuous production, empty the output device when the output approaches the maximum amount 
that the device can hold; refer to the specifications for that output device for output limit amount.

• An attempt to print on thicker paper or on paper stock that is less sensitive to moisture.

Paper curl can be adjusted in the following ways: 

• If the Interface Decurler Module or Interface Decurler Module with Inline Spectrophotometer (ILS) is attached, 
use the manual decurl buttons on the control panel for the module. For information, refer to Interface Decurler 
Module and Interface Decurler Module with Inline Spectrophotometer (ILS).

• Refer to Paper Curl.

• Use the Adjust Paper Curl feature. For information, refer to the System Administrator Guide.

CANNOT PRINT BECAUSE OUTPUT PAPER WIDTH DOES NOT MATCH INSTALLED FUSER 

ASSEMBLY

PPrroobblleemm

Unable to print with current fuser assembly because the output paper width does not match the installed fuser.

SSoolluuttiioonnss

• Replace the fuser assembly with one that supports the specific paper width for the current print job. For more 
information, refer to Fuser Hints and Tips.

• Cancel the current print job and continue with the print job by resubmitting from the print server. 

Warning: When resubmitting the job from the print server, do not override the current fuser 
maximum width. Overriding the fuser width causes a mismatch, and can damage the fuser.

MESSAGE ON THE USER INTERFACE DOES NOT CLEAR

PPrroobblleemm

The message on user interface does not clear.

Xerox® Versant® 280 Press User Documentation 279

Troubleshooting



SSoolluuttiioonnss

• If the fault is a paper jam, ensure that any paper is removed from the area and that there are no hidden or 
small pieces of paper left behind.

• Reboot the press by pressing off the power, and then pressing it on again. The power button is located on top 
of the press near the user interface (UI).

TRANSPARENCY OUTPUT IS  DAMAGED

PPrroobblleemm

After you exit from the press, the transparency output is damaged.

SSoolluuttiioonnss

For copy or print job, for the paper type, ensure that Transparencies is selected. The press temperature adjusts for 
different types of media, and paper tolerates more heat than transparencies.

PRINTED OUTPUT IS  NOT STACKED CORRECTLY

PPrroobblleemm

The output is not stacked correctly.

SSoolluuttiioonn

Check paper curl, and ensure that the paper tray guides are locked into position against the paper. 

Note: Mixed media sizes may not stack well.

PAGES IN THE PRINTED OUTPUT ARE NOT STAPLED OR PUNCHED

The following information is applicable when one of the following finishing devices is attached to your press:

• Business Ready (BR) Finisher without or with the optional Booklet Maker

• Production Ready (PR) Finisher

• Production Read (PR) Booklet Maker Finisher

For information on these finishing devices, refer to:

• Business Ready (BR) Finisher and Optional Booklet Maker

• Production Ready (PR) Finishers

PPrroobblleemm

Pages in the output set are not stapled or punched.
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SSoolluuttiioonnss

• Select the option on the press touch screen.

• Check that there are staples in the staple cartridge.

• Check that the punch scrap container is not full.

HOLE-PUNCH OUTPUT HAS HOLES ON THE WRONG SIDE

PPrroobblleemm

The hole-punch output has the paper holes are on the wrong side.

SSoolluuttiioonnss

Ensure that the hole-punch paper is loaded correctly in the paper tray, and that the holes are positioned as shown 
on the tray label.

PRINTING TAKES TOO LONG FOR FIRST PRINT OR FIRST COPY OUT

CCooppyy oorr PPrriinntt JJoobbss WWiitthh aa CCoommbbiinnaattiioonn ooff CCoolloorr aanndd BBllaacckk--aanndd--WWhhiittee OOuuttppuutt

PPrroobblleemm

For jobs that are a combination of color and black and white, the first copy or print output takes longer than the 
expected 10 seconds.

JJoobb WWoorrkkfflloowwss aanndd FFiirrsstt CCooppyy oorr PPrriinntt OOuuttppuutt TTiimmee FFaaccttoorrss

The following workflow scenarios affect the extended wait-time for the first copy or print output: 

• Copy or print jobs that are 1–2 pages only versus copy or print jobs that are more than 2 pages

• The number of users in the print queue

• Copy or print jobs that use the same type of media versus copy or print jobs that contain mixed media types

• Copy or print jobs that use a mixture of color and black-and-white output

If you do not use one of these workflows, the implementation of this solution can result in color stability issues.

SSoolluuttiioonn

To decrease the wait-time for first copy or print out, perform the following: 

1. Increase the Power Saver time to 30 minutes. 

If the wait time remains too long, continue to the next step.

2. For this user requirement, to change the NVM values for 752–175 and 740–437, contact Xerox Technical 
Customer Support. For more information, refer to the Xerox® Versant® 280 Press System Administrator 
Guide.

3. For Copy mode, on the press UI, set Output Color to Auto Detect.  

The default setting is Auto Detect.
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CCoolloorr CCooppyy oorr CCoolloorr PPrriinntt JJoobbss 

PPrroobblleemm

For copy or print jobs that are color only, for the first copy or print output, the printing takes longer than the 
expected 10 seconds.

CCoolloorr JJoobb WWoorrkkfflloowwss aanndd FFiirrsstt CCooppyy oorr PPrriinntt OOuuttppuutt TTiimmee FFaaccttoorrss

The following workflow scenarios affect the extended wait-time for the first color copy or print output: 

• Copy or print jobs that are 1–2 pages only versus copy or print jobs that are more than 2 pages

• The number of users in the print queue

• Color copy or print jobs that use the same type of media versus copy or print jobs that contain mixed media 
types

• Copy or print jobs that use only a color output

If you do not use one of these workflows, the implementation of this solution can result in color stability issues.

SSoolluuttiioonn

To decrease the wait-time for first copy or print out, perform the following: 

1. Increase the Power Saver time to 30 minutes. 

If the wait time remains too long, continue to the next step.

2. For this user requirement, to change the NVM values for 752–175 and 740–437, contact your Xerox 
Technical Customer Support. For more information, refer to the Xerox® Versant® 280 Press System 
Administrator Guide.

3. For Copy mode, on the press UI, set Output Color to Auto Detect. 

The default setting is Auto Detect.

REDUCING DRY INK/TONER CONSUMPTION

PPrroobblleemm

In order to maintain image quality (IQ), the press enters Adjust Image Quality mode. In this mode, dry ink/ 
toner is consumed in the form of dry ink/toner bands and process control patches being laid down. Frequency of 
image quality adjustment is dependent on many factors including area coverage. While printing jobs of low 
area coverage or low image density, the frequency of image quality adjustment can be greater.

SSoolluuttiioonn

Three NVM values can be adjusted to reduce dry ink/toner consumption based on user requirements. Refer to 
the following table. From the first column of the table, select the solution which best fits user requirements. To 
implement the appropriate outcome for your environment, contact Xerox Technical Customer Support.  

Important: NVM values must be set or changed only by the customer support representative.
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USER REQUIREMENT SOLUTION 

1. Image Quality (IQ) Priority 

These are the press default settings which provide 
optimum IQ output, but increase dry ink/toner 
consumption and can reduce productivity. 

For this user requirement, to change the NVM values 
for 762–075, 752–175 and 762–098, contact Xerox 
Technical Customer Support. 

2. Middle Setting 

This is the recommended setting.

These settings configure the press for less dry ink/toner 
usage if image quality is not the highest priority. IQ can 
be reduced slightly.

For this user requirement, to change the NVM values 
for 762-075, 752–175 and 762–098, contact Xerox 
Technical Customer Support. 

3. Lower Toner Consumption Priority 

These settings decrease dry ink/toner usage and increase 
productivity, but can result in degraded IQ.

For this user requirement, to change the NVM values 
for 762–075, contact Xerox Technical Customer 
Support. For the NVM values 752–175 and 762– 
098, no change is required. 
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Image Quality Troubleshooting

Perform these actions first to improve image quality: 

• Manage the stock in use. Ensure that the media used is approved, within press specifications and is clean. 

• Ensure the correct media is properly loaded in the paper tray. 

• Run print samples and evaluate the defect. From the following table, determine which problem description 
matches the IQ defect and perform the appropriate corrective actions.

CONTAMINATION ON THE BACK SIDE OF PRINTS

PPrroobblleemm

The back side of the printed output contains contamination. The contamination is a specific toner defect of 10–15 
mm wide running from long-edge (LE) or trail-edge (TE), and is near the outboard (OB) side of the print.

SSoolluuttiioonnss

• Contamination can be media related.  

– Look for paper damage, paper dust, or environmental conditions that may contribute.  

– Ensure the media is fresh and properly loaded in the trays. 

• Defects occur on heavyweight stock with lightweight stock settings. Ensure the proper Custom Paper Settings 
are configured for the media in use. For information and procedures, refer to the System Administrator Guide, 
Paper Tray Settings.
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• If the defect is the specific streak on the back of prints, there may be a secondary-bias transfer roll (2nd BTR) 
failure. Perform the Cleaning the Fuser Assembly with Paper procedure. If the problem continues, contact the 
customer support center.

BANDING ON PRINTS

PPrroobblleemm

The print shows lines or bands running from the inboard-to-outboard (IB/OB) direction (side-to-side direction).

For defects running Lead Edge to Trail Edge (LE/TE), refer to Streaks or Lines on Prints.

SSoolluuttiioonnss

Acquire the measuring tool from either www.xerox.com/VERSANT_280docs or the Nationalization Kit. Check the 
frequency of the defect at interval.

• If the defect is at the interval of 37.5 mm or 147 mm, replace the appropriate drum cartridge. Refer to 
Replacing a Drum Cartridge.

• If the defect is defect at the interval of 154 mm, the problem may be with the Pressure Roll Assembly (fuser 
assembly). For more details, contact the customer support center.

• If the defect is 375 mm, the problem may be Fuser Belt failures. For more details, contact the customer support 
center.

COLOR NON-UNIFORMITY ON PRINTS

PPrroobblleemm

The print has variations in color uniformity, such as:
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• Uneven density

• Light or dark areas running from the side-to-side direction (inboard-to-outboard)

• Color shift or inconsistent color throughout the page

SSoolluuttiioonnss

• Perform the Cleaning the ROS Windows procedure. 

• Perform the Density Uniformity Adjustment procedure. For refer to the System Administrator Guide, Simple 
Image Quality (SIQA).

• For other suggested solutions, refer to Custom Paper Settings Troubleshooting.

RANDOM WHITE OR DARK SPOTS ON PRINTS

PPrroobblleemm

The prints show random spots, but they do not repeat at regular intervals.
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SSoolluuttiioonnss

• Ensure that the media used is approved, within press specifications and is clean.

• Check that the press is within environmental specifications and humidity levels.

• Load a new ream of paper or different type of media.

• Run the Clean Toner procedure. For instructions, refer to the the System Administrator Guide, Maintenance > 
Common Service Settings.

• Check for Drum failure or damage. Acquire your measuring tool from either www.xerox.com/VERSANT_280docs
or the Nationalization Kit. 

– Check the frequency of the spot intervals. If spots occur every 147 mm on the prints, determine which color 
drum is affected. 

– To determine which color drum is affected, go to www.xerox.com/VERSANT_280docs, to download, and 
then print the Halftone Test Pattern PDF. 

• To replace or swap the drum; refer to Drum Cartridge.

REPEATING DEFECTS AT REGULAR INTERVALS ON PRINTS

PPrroobblleemm

The prints show any defect type that repeats at intervals that can be measured.
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SSoolluuttiioonnss

Acquire the measuring tool either from www.xerox.com/VERSANT_280docs or the Nationalization Kit. Check the 
frequency of the defect interval.

• If the defect occurs every 44 mm on the prints, do not replace the drum. This interval is caused by a damaged 
or defective developer housing. For more details, contact the Customer Support Center.

• If spots or bands occur every 147 mm on the prints, a drum is damaged or light shocked. Replace or swap the 
appropriate drum cartridge; refer to Replacing a Drum Cartridge. 

• If the defect occurs every 374 mm on the prints, replace the fuser belt assembly. For details, contact the 
Customer Support Center.

STREAKS OR LINES ON PRINTS

PPrroobblleemm

The prints show solid color streaks or lines running from Lead Edge to Trail Edge (LE or TE) of prints.
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For IQ defects that run Inboard to Outboard (IB or OB); refer to Banding on Prints.

SSoolluuttiioonnss

• Perform the Cleaning the ROS Windows procedure.

• Measure and check the frequency of the defect intervals: 
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– Acquire the measuring tool either from www.xerox.com/VERSANT_280docs or the Nationalization Kit. 

– If spots or bands occur every 147 mm on the prints, a drum is damaged or light shocked. 

– Replace or swap the appropriate drum cartridge. Refer to Replacing a Drum Cartridge. 

EDGEWEAR ON PRINTS

PPrroobblleemm

The IB and OB edges of the output prints shows dry ink/ toner deletions, density inconsistency, or is lacking in color 
depth; occurs mainly when using heavier or lighter weight stock.

SSoolluuttiioonnss

If you run multiple width papers, for more information, refer to Fuser Hints and Tips and Extended Fuser Life.

HALO OR SMUDGES ON PRINTS

PPrroobblleemm

The printed output contains halo or smudges on them. 
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SSoolluuttiioonn

Perform the Density Uniformity Adjustment procedure. For instructions, refer to the System Administrator Guide, 
Simple Image Quality (SIQA).
For other suggested solutions, refer to Custom Paper Settings Troubleshooting.

IMAGE DENSITY

PPrroobblleemm

Print output is too light, faint, or washed out; solid areas not black or inconsistent shading; part of image 
missing. 
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SSoolluuttiioonn

• On the User Interface, press the Home button, and check the status of the CRUs/Supplies. Shake or replace 
the affected dry ink/toner cartridge. Refer to Replacing a Dry Ink/Toner Cartridge.

• For suggested solutions, refer to Custom Paper Settings Troubleshooting.

• Determine if a drum cartridge is contaminated or light-shocked by running a set of halftone test patterns to 
identify which color is affected: 

– Go to www.xerox.com/VERSANT_280docs and download the Halftone Test Pattern PDF. 

– Print several sets of the Halftone Test Pattern. PDF. 

– Identify which color is affected. 

– Replace or swap the appropriate drum. Refer to Drum Cartridge. 

• For other suggested solutions, refer to Custom Paper Settings Troubleshooting.

IMAGE-ON-PAPER REGISTRATION

PPrroobblleemm

The entire image on the printed output is misregistered, shifted, skewed or crooked. 
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SSoolluuttiioonn

• Ensure the paper tray guides are against the edges of the loaded paper.

• Create or use an existing Alignment Profile.

• Perform the Auto Alignment Adjustment procedure. For instructions, refer to the System Administrator Guide, 
Simple Image Quality (SIQA).

• Refer to the Image Registration, Perpendicularity, Skew, and Magnification.

UNFUSED PRINTS OR FUSER OFFSET

PPrroobblleemm

The image is not properly fused. Dry ink/toner on print is not permanent, smears, flakes, or rubs off. 
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SSoolluuttiioonn

• Check that the paper weight settings at the print server match the actual paper loaded in the tray.

• Ensure that the paper loaded is within press specifications. For information on paper and storage, refer to 
Paper and Media. 

• Load a new ream of paper into the selected paper tray.

• For other suggested solutions, refer to Custom Paper Settings Troubleshooting.

• Perform the Cleaning the Fuser Assembly routine. If the problem continues, contact the Customer Support 
Center for service.

TRAIL-EDGE DELETIONS

PPrroobblleemm

Trail edge of output contains dry ink/toner deletions, density inconsistency, or is lacking in color depth; this occurs 
mainly when using heavier or lighter weight stock.
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For inboard or outboard (IB or OB) edge deletions, refer to Edgewear.

SSoolluuttiioonnss

• Create a custom stock and use it. 

• Refer to Trail Edge Deletions
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Custom Paper Settings Troubleshooting

This section helps you locate and resolve specific problems through the use of the Custom Paper Settings. For more 
information, refer to the System Administrator Guide.

To improve print quality, ensure that the used page is: 

• Compatible with the press

• Within supported specifications

• In good condition

• Assigned to the correct Press Tray

If problem continues, contact the customer support center.

MULTIFEEDS,  MISFEEDS,  AND PAPER JAMS IN TRAYS 6–9

PPrroobblleemm

Multifeed or misfeed paper jams occur in Tray 6, 7, 8, or 9.

SSoolluuttiioonnss

1. Change the Adjust Air Assist Values setting: 

• Use this feature to adjust the amount of air volume generated by the tray blowers which assist in separating 
sheets when feeding paper. When using light-weight or heavy-weight paper, which stick together easily, 
select a stronger air flow setting in order to better separate sheets and prevent paper jams or multifeeds.

• This feature can be found in Machine Status > Tools > Setup & Adjustment > Custom Paper Settings. 
Select the desired Custom Paper > Change Settings > Adjust Air Assist Values > Change Settings.
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• The settings available for this feature are: 

– System Default: The air volume is set to the appropriate amount based on the Stock and 
environmental conditions. 

– Multifeed Support Table: Select this option if you use paper that tends to trigger multifeeds. This 
setting increases the air volume to a level higher than System Default. 

– Mis-Feed Support Table: Select this option if you use paper that tends to trigger paper jams. This 
setting increases the air volume to a level higher than Multifeed Support Table. 

– Forced Off: Select this option when working with special media that tends to jam as a result of the air 
flow that is introduced by Adjust Air Assist Values. This setting turns off Adjust Air Assist Values. 

2. Change the Tray Heater setting. 

• Use this feature to Enable (checked) or Disable (unchecked) the tray heater. The tray heater warms the air 
that is blown into the tray by Adjust Air Assist Values to help prevent paper jams and multifeeds by 
loosening contact between sheets. 

• The tray heater may partially dry paper and affect print quality. If print quality is affected by dry paper, 
Disable the tray heater. 

Note: Disabling the tray heater may result in an increase of multifeeds.

• This feature can be found in Machine Status > Tools > Setup & Adjustment > Custom Paper Settings. 
Select the desired Custom Paper > Change Settings > Tray Heater > Change Settings.

• To Disable (unchecked) the tray heater:

a. Remove any paper loaded in the tray. 

b. In Adjust Air Assist Values select any option except Forced Off . 

c. Disable (unchecked ) the tray heater and register the stock. 

The printer performs a forced exhaust action for approximately one minute. During the forced exhaust 
action, do not change any settings or open a tray.

Important: A forced exhaust with paper loaded in tray can lead to image quality problems.

d. After the forced exhaust is complete, load paper in tray.

3. Change the Multifeed Detection setting. 

• Use this feature to Enable (checked) or Disable (unchecked) multifeed notifications; this feature does not 
make any other adjustments.

• The Multifeed Detection feature is accessed from Machine Status > Tools > Setup & Adjustment > 
Custom Paper Settings. Select the desired Custom Paper > Change Settings > Multifeed Detection > 
Change Settings.
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• The settings available for the Multifeed Detection option include: 

– Enabled (checked): Multifeed notifications are switched On. 

– Disabled (unchecked): Multifeed notifications are switched Off. 

Note: To prevent the system from reporting faults due to multifeeds, tteemmppoorraarriillyy disable notifications. 
This allows the user to continue their workflow until the cause of the problem is resolved. Be aware that 
disabling this feature has no impact on the occurrence rate of actual multifeeds and, if disabled, 
multifeed sheets may cause jams elsewhere in the system and/or result in additional blank sheets in the 
final output.

PAPER CURL

PPrroobblleemm

The output contains paper curl.

SSoolluuttiioonnss

1. If your press configuration includes the Interface Decurler Module (IDM)s, confirm that the IDM Curl 
Correction option on the IDM control panel is set to Auto. 

Note: For more information, refer to Interface Decurler Module and Interface Decurler Module with 
Inline Spectrophotometer (ILS)

2. Change the Adjust Paper Curl setting. 

Tip: Changing the default setting is considered a temporary solution because environmental 
conditions vary from day to day. It is recommended that upon completion of the print job you 
return the option to its default setting.

• Use the Adjust Paper Curl feature to correct paper curl caused by heat and pressure and to apply fine 
adjustments based on the characteristics of each paper type. Paper curl may cause paper jams and wrinkled 
output.

• This feature can be found in Machine Status > Tools > Setup & Adjustment > Adjust Paper Curl. It can 
also be found in Machine Status > Tools > Setup & Adjustment > Custom Paper Settings. Select the 
desired Custom Paper > Change Settings > Adjust Paper Curl > Change Settings.

• From the Adjust Paper Curl screen, make the change by moving up or down the selections available one at 
a time.
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• Use the following sequential order when making changes to the paper curl. This ensures that the desired 
output is achieved:  

Tip: Paper jams and wrinkled output may occur if the change is not performed in the 
recommended sequential order; for example, using Default and then skipping to Type C. 

Note: Always run test prints every time a setting is changed / selected; this allows you to evaluate the 
output and determine if additional changes are necessary. 

a. Default

b. Type A

c. Type B

d. Type C

e. Custom Curl Correction: Slight (Very Small) Upward or Slight (Very Small) Downward

f. Custom Curl Correction: Moderate (Small) Upward or Moderate (Small) Downward

g. Custom Curl Correction: Medium Upward or Medium Downward

h. Custom Curl Correction: Severe (Large) Upward or Severe (Large) Downward

• If paper curl continues to persist after trying several or all of these settings, try decreasing the image density 
on the print job or use a different type of paper.

• If paper curl is still a problem after you decrease the image density and after you use a different type of 
paper, for more information, contact the customer support center.

UNEVEN DENSITY OR MOTTLE

PPrroobblleemm

Uneven Density or Mottle

SSoolluuttiioonnss

1. Perform Adjust Image Transfer. 

• Use this feature to adjust the voltage ratio on the secondary bias transfer roll (2nd BTR). For heavy-weight 
paper, such as 220 g/m2 or greater, the 2nd BTR is where the image is transferred from the belt to the paper. 
However, there are times when it is also used with lightweight paper.

• This feature is accessed from Machine Status > Tools > Setup & Adjustment > Custom Paper Settings. 
Select the desired Custom Paper > Change Settings > Adjust Image Transfer > Change Settings.
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• The Adjust Image Transfer procedure can be performed by selecting Auto or Manual. 

Note: An automatic adjustment fixes most image quality issues. Always perform the Auto procedure 
before performing the Manual adjustment.

– Auto: The adjustment is done automatically by the press. It eliminates the need for you to interpret 
printed targets and manually enter adjustment values. This saves time and avoids errors. 

– Manual: The user must manually perform the adjustment, including printing test patterns, interpreting 
the printed targets on those patterns, then manually entering the adjustment values. 

Tip: Use the Manual adjustment option only when the Auto adjustment does not 
provide the desired output.

– For detailed information and instructions on how to use the Auto and Manual adjustment options, 
refer to the System Administrator Guide.  

2. If the issue is observed on the tail edge of the printed output and is not corrected by performing a Adjust 
Image Transfer, change the Adjust Image Transfer for Trail Edge setting. 

• Use this feature to adjust the voltage ratio on the secondary bias transfer roll (2nd BTR); this is where the 
image is transferred from the belt to the paper.

• This feature is accessed from Machine Status > Tools > Setup & Adjustment > Custom Paper Settings. 
Select the desired Custom Paper > Change Settings > Adjust Image Transfer for Trail Edge > Change 
Settings.

• Decrease the Adjust Image Transfer for Trail Edge in increments of 10%. After every incremental 
adjustment, run test prints and evaluate the output to determine if additional adjustment is necessary.

3. Perform an Automatic Density Uniformity Adjustment. 

Note: This is a press feature and is not a Custom Paper Settings feature.

• Use this feature to correct image quality issues on the output when that image quality is not consistent 
throughout the entire output. For example, the image quality is lighter (faded) or heavier (thicker) on the left 
or right sides of the output (inboard / outboard).

• For information and instructions on how to use this feature, refer to the System Administrator Guide.

IMAGE REGISTRATION,  PERPENDICULARITY,  SKEW,  AND MAGNIFICATION

PPrroobblleemm

The image on the printed output is misregistered, or is perpendicular, skewed, or magnified.

SSoolluuttiioonnss

1. If you use trays 1, 2, or 3, switch the optional trays 6, 7, 8, or 9 (if available).  

Note: Trays 6-9 have better registration and skew performance.

2. Create and/or use an existing Alignment Profile. 

Note: Before creating a new and/or using an existing manual alignment, read all the information in the 
Alignment Adjustment of System Administrator Guide. 
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• Use CCeenntteerr LLiinnee SSttoocckk for Alignment Profiles. If the problem occurs when using this stock, call the 
Customer Support Center.

• The following steps are required for each procedure; for complete instructions, refer to the Alignment 
Adjustment section in the System Administrator Guide.

• To create a New Alignment Profile, perform the following:  

Note: This option can be found in Machine Status > Tools > Setup & Adjustment > Alignment 
Adjustment Setup. 

a. From the Alignment tab, select the New button. 

A New Profile Properties window displays. 

b. Enter the Name you want to assign to the profile.

c. Perform the Auto Alignment procedure.

d. Run a set of test prints to evaluate the output and evaluate the results.

e. If necessary, depending on the results, perform a Manual Adjustment.

f. When making manual adjustments to multiple items, use the following guidelines: 

• Adjust the image in the following order: Registration, Perpendicularity, Skew, and Magnification.

• Choose oonnllyy oonnee ooppttiioonn at a time (such as Registration), then run a set of test prints to evaluate the 
output. Determine if the printed output for the selected option is acceptable and if it is acceptable, then 
select and adjust the next alignment option.

• After each option is selected, always run a set of test prints and evaluate the output. Determine if the 
output for the selected feature is acceptable. If it is, continue to adjust another alignment option as 
required.

• To use an existing Alignment Profile, perform the following: 

Note: The option may be found by selecting Machine Status > Tools > Setup & Adjustment > 
Alignment Adjustment Setup. Select the desired Custom Paper > Change Settings > Alignment 
Adjustment Setup > Change Settings.

a. Select the Alignment Adjustment button.

b. Select Use Default or Select from List.  

If using Select from List, make a selection from the list of saved Alignment Profiles.

3. Change the Adjust Regi-Loop setting. 

Note: Use Adjust Regi-Loop only if Alignment Adjustment did not correct registration and/or skew 
problems.

• Use this feature to adjust Regi-Loop. 

• When paper feeds through the press, it stops once and pressure is applied in order to correct registration 
and skew. The loop is created when paper is stopped and pressured is Regi-Loop. 
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– To correct for registration and skew when the degree of skew varies from sheet to sheet, increase the 
Regi-Loop value to increase pressure on the Lead Edge (LE) of the paper. Increasing the value too 
much may cause unintended folds or scratches on the Lead Edge paper. 

– In hot and humid environments, decrease the Regi-Loop value to lower the pressure on the Lead Edge 
of light weight paper to avoid ripping the paper. 

• This feature is accessed from Machine Status > Tools > Setup & Adjustment > Custom Paper Settings. 
Select the desired Custom Paper > Change Settings > Adjust Regi-Loop > Change Settings.

• Based on the output, increase or decrease the Regi-Loop in increments of 0.3 mm. After each incremental 
adjustment, run test prints and evaluate the output to determine if additional adjustments are required.

• If feeding paper from tray 1, 2 or 3 and repeated Adjust Regi-Loop adjustments do not make any 
improvements in a registration problem, return the Adjust Regi-Loop value to its default setting. 

4. Change the Adjust Fuser Speed setting. 

• This feature is used to adjust the fusing speed to improve print quality when the image is distorted 
(stretched or shrunk). 

– If the image is shrunk, increase the fuser speed. If the fuser speed is set too high, it may cause paper 
jams. 

– If the image is stretched, decrease the fuser speed. 

• This feature is accessed from Machine Status > Tools > Setup & Adjustment > Custom Paper Settings. 
Select the desired Custom Paper > Change Settings > Adjust Fuser Speed > Change Settings.

• Increase or decrease the fuser speed in increments of 0.1%. 

• After each incremental adjustment, run test prints and evaluate the output to determine if additional 
adjustments are required.

UNFUSED DRY INK OR TONER ON OUTPUT

PPrroobblleemm

The output contains unfused dry ink or toner.
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SSoolluuttiioonnss

1. Change the Adjust Fuser Temperature setting. 

Tip: Changing the default setting of 0 (zero) is a temporary solution because environmental 
conditions vary from day to day. Upon completion of the print job, the recommendation is to 
return the option to its default setting.

• Use this feature to adjust the fuser temperature.

• If dry ink/toner comes off the paper, especially with special media, resolve the problem by increasing the 
fusing temperature.

• If the fuser temperature is too high when printing on lightweight paper, it may cause blocking, media 
damage, or paper jams at the peeling unit in the fusing module.

• If the fuser temperature is too low, it may cause poor fusing on higher-density image areas and dry ink/ 
toner may peel off the printed output. 

• This feature is accessed from Machine Status > Tools > Setup & Adjustment > Custom Paper Settings. 
Select the desired Custom Paper > Change Settings > Adjust Fuser Temperature > Change Settings.

• Based on the printed output, increase or decrease the Adjust Fuser Temperature in increments of 1° or 2°.

• After each incremental adjustment, run test prints and evaluate the output to determine if additional 
adjustments are required.

2. If feeding paper from trays 6-9 and if the paper is damp, confirm that the Tray Heater feature is Enabled 
(checked). 

Note: Tray Heater is available only for trays 6-9.

• Use this feature to Enable (checked) or Disable (unchecked) the tray heater. 

• The tray heater warms the air that is blown into the tray by Adjust Air Assist Values and helps prevent 
paper jams and multifeeds by loosening contact between sheets.

• The tray heater may partially dry paper and affect print quality. If print quality is affected by dry paper, 
disable the tray heater.  

Note: Disabling the tray heater may result in an increase of multifeeds.

• This feature is accessed from Machine Status > Tools > Setup & Adjustment > Custom Paper Settings. 
Select the desired Custom Paper > Change Settings > Tray Heater > Change Settings to Enable (check) 
the box for Tray Heater.

FOLD ADJUSTMENT

PPrroobblleemm

The fold on the output is not correct or as desired.

SSoolluuttiioonnss

• The Finisher - Fold Adjust Position is available only when the system configuration includes one of the 
following: 
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– Production Ready (PR) Booklet Maker Finisher (for Bi-Fold or Single-Fold) 

– Optional C/Z Folder with one of the following optional finishers: 

– PR Finisher 

– PR Booklet Maker Finisher 

– PR Finisher Plus 

• For detailed information about these finishing devices, refer to the C/Z Folder.

• Create or use an existing Finisher - Fold Adjust Position 

Note: Before you create a new or use an existing profile or performing any alignment adjustments, read 
or review the Fold Adjustment Profile section in the System Administrator Guide.

• Depending on your system configuration, the following fold adjustments are available: 

– Bi-Fold Single Sheet (available only with the PR Booklet Maker Finisher) 

– Bi-Fold Multiple Sheets (available only with the PR Booklet Maker Finisher) 

– Bi-Fold Multiple Sheets Stapled (available only with the PR Booklet Maker Finisher) 

– C-Fold (available with the optional C/Z Folder) 

– Z-Fold (available with the optional C/Z Folder) 

– Z-Fold Half-Sheet (available with the optional C/Z Folder) 

• Create a new or use an existing Finisher - Fold Adjust Position. The following steps are required for creating a 
new or using an existing procedure. 

Note: This option is accessed from Machine Status > Tools > Setup & Adjustment > Finisher - Fold 
Adjust Position. 

1. From the Fold Adjustment tab, select the New or Edit button. 

If you edit an existing fold adjustment, select Machine Status > Tools > Setup & Adjustment > Custom 
Paper Settings. Select the desired Custom Paper > Change Settings > Adjust Fold Position > Change 
Settings.

2. Type in a new name or, if desired, edit the existing name.

3. To complete the procedure, refer to the Fold Adjustment Profile section in the System Administrator Guide.

SMEAR AT 208 MM FROM THE LEAD EDGE

PPrroobblleemm

On the printed output, a smear occurs at 208 mm from the lead edge of the paper.
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SSoolluuttiioonnss

1. Confirm that the media being used is compatible with the press, is within supported specifications, and is in 
good condition.

2. Change the Adjust Paper Speed at Transfer Module setting. 

• Use this feature to adjust the paper speed in the transfer unit.

• The option can be found in Machine Status > Tools > Setup & Adjustment > Custom Paper Settings. 
Select the desired Custom Paper > Change Settings > Adjust Paper Speed at Transfer Module > 
Change Settings.

• Based on the output, decrease Adjust Paper Speed at Transfer Module in increments of 0.05%. After 
every increment adjustment run test prints and evaluate the output to determine if additional adjustment is 
necessary.

• Transfer defects may occur when paper speed is too fast or too slow.

3. Change the Adjust Fusing Speed setting. 

• This feature can be used to correct the issue of a smear at 208 mm from the Lead Edge (LE). Increase the 
fuser speed to correct the issue.

• This feature also impacts print quality. 

– Increasing fuser speed extends the image. If fuser speed is set too high, paper jams can occur. 

– Decreasing fuser speed shrinks the image. 

• The option can be found in Machine Status > Tools > Setup & Adjustment > Custom Paper Settings. 
Select the desired Custom Paper > Change Settings > Adjust Fusing Speed > Change Settings.

• Increase fuser speed in increments of 0.5%. After every increment adjustment run test prints and evaluate 
the output to determine if additional adjustment is necessary.

TRAIL EDGE DELETIONS

PPrroobblleemm

The printed output contains trail edge deletions.

SSoolluuttiioonnss

Change the Adjust Image Transfer for Trail Edge setting. 

• This feature is used to adjust the voltage ratio on the Secondary Bias Transfer Roll (BTR), where the image is 
transferred from the belt to the paper.

• This feature can be found in Machine Status > Tools > Setup & Adjustment > Custom Paper Settings. Select 
the desired Custom Paper > Change Settings > Adjust Image Transfer for Trail Edge > Change Settings.

• Decrease the Adjust Image Transfer for Trail Edge in increments of 5%–10%. After every increment 
adjustment run test prints and evaluate the output to determine if additional adjustment is necessary.
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CUSTOM PAPER SETTINGS -  DEFAULT SETTINGS

The information provides the default values, ranges, and recommended incremental adjustments for the various 
Custom Paper Settings features, options, and settings.

Alignment Profile

TTaabbllee 33..11 RReeggiissttrraattiioonn

OPTION OR 
SETTING 

DEFAULT 
VALUE 

ADJUST
MENT 
STEP 
INCRE
MENTS 

AVAILABLE 
RANGE 

RECOMMENDED INCREMENTAL 
ADJUSTMENT 

Side 1, Side 0.0 0.1 -2.0 to 2.0 mm Determined by test print output 

Side 1, Lead 0.0 0.1 -2.0 to 2.0 mm Determined by test print output 

Side 2, Side 0.0 0.1 -2.0 to 2.0 mm Determined by test print output 

Side 2, Lead 0.0 0.1 -2.0 to 2.0 mm Determined by test print output 

TTaabbllee 33..22 PPeerrppeennddiiccuullaarriittyy

OPTION OR 
SETTING 

DEFAULT 
VALUE 

ADJUST
MENT 
STEP 
INCRE
MENTS 

AVAILABLE 
RANGE 

RECOMMENDED INCREMENTAL 
ADJUSTMENT 

Side 1 0.0 0.1 -1.0 to 1.0 mm Determined by test print output 

Side 2 0.0 0.1 -1.0 to 1.0 mm Determined by test print output 

TTaabbllee 33..33 SSkkeeww

OPTION OR 
SETTING 

DEFAULT 
VALUE 

ADJUST
MENT 
STEP 
INCRE
MENTS 

AVAILABLE 
RANGE 

RECOMMENDED INCREMENTAL 
ADJUSTMENT 

Side 1 0.0 0.1 -1.0 to 1.0 mm Determined by test print output 

Side 2 0.0 0.1 -1.0 to 1.0 mm Determined by test print output 
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TTaabbllee 33..44 MMaaggnniiffiiccaattiioonn

OPTION OR 
SETTING 

DEFAULT 
VALUE 

ADJUST
MENT 
STEP 
INCRE
MENTS 

AVAILABLE 
RANGE 

RECOMMENDED INCREMENTAL 
ADJUSTMENT 

Side 1, Height 0.000 0.025 -0.200 to 0.200 
% 

Determined by test print output 

Side 1, Width 0.000 0.025 -0.200 to 0.200 
% 

Determined by test print output 

Side 2, Height 0.000 0.025 -0.200 to 0.200 
% 

Determined by test print output 

Side 2, Width 0.000 0.025 -0.200 to 0.200 
% 

Determined by test print output 

Fold Adjustment Profile

TTaabbllee 33..55 BBii--FFoolldd -- SSiinnggllee SShheeeett

OPTION OR 
SETTING 

DEFAULT 
VALUE 

ADJUST
MENT 
STEP 
INCRE
MENTS 

AVAILABLE 
RANGE 

RECOMMENDED INCREMENTAL 
ADJUSTMENT 

Left and Right 
Sides Equal 

N/A N/A N/A N/A 

Left Side of Fold 
is Longer 

0.0 0.1 0.0 – 20.0 mm Determined by test print output 

Right Side of Fold 
is Longer 

0.0 0.1 0.0 – 20.0 mm Determined by test print output 
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TTaabbllee 33..66 BBii--FFoolldd –– MMuullttiippllee SShheeeettss SSttaapplleedd

OPTION OR 
SETTING 

DEFAULT 
VALUE 

ADJUST
MENT 
STEP 
INCRE
MENTS 

AVAILABLE 
RANGE 

RECOMMENDED INCREMENTAL 
ADJUSTMENT 

Left and Right 
Sides Equal 

N/A N/A N/A N/A 

Left Side of Fold 
is Longer 

0.0 0.1 0.0 – 20.0 mm Determined by test print output 

Right Side of Fold 
is Longer 

0.0 0.1 0.0 – 20.0 mm Determined by test print output 

TTaabbllee 33..77 BBii--FFoolldd –– MMuullttiippllee SShheeeettss SSttaapplleedd

OPTION OR 
SETTING 

DEFAULT 
VALUE 

ADJUST
MENT 
STEP 
INCRE
MENTS 

AVAILABLE 
RANGE 

RECOMMENDED INCREMENTAL 
ADJUSTMENT 

SShheeeettss iinn SSeett 11 

Left and Right 
Sides Equal 

N/A N/A N/A N/A 

Left Side of Fold 
is Longer 

0.0 0.1 0.0 – 20.0 mm Determined by test print output 

Right Side of Fold 
is Longer 

0.0 0.1 0.0 – 20.0 mm Determined by test print output 

On the Fold N/A N/A N/A N/A 

Left of Fold 0.0 0.1 0.0 – 20.0 mm Determined by test print output 

Right of Fold 0.0 0.1 0.0 – 20.0 mm Determined by test print output 

SShheeeettss iinn SSeett 22 

Left and Right 
Sides Equal 

N/A N/A N/A N/A 

Left Side of Fold 
is Longer 

0.0 0.1 0.0 – 20.0 mm Determined by test print output 

Right Side of Fold 
is Longer 

0.0 0.1 0.0 – 20.0 mm Determined by test print output 

On the Fold N/A N/A N/A N/A 
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OPTION OR 
SETTING 

DEFAULT 
VALUE 

ADJUST-
MENT 
STEP 
INCRE-
MENTS 

AVAILABLE 
RANGE 

RECOMMENDED INCREMENTAL 
ADJUSTMENT 

Left of Fold 0.0 0.1 0.0 – 20.0 mm Determined by test print output 

Right of Fold 0.0 0.1 0.0 – 20.0 mm Determined by test print output 

TTaabbllee 33..88 CC--FFoolldd

OPTION OR 
SETTING 

DEFAULT 
VALUE 

ADJUST
MENT 
STEP 
INCRE
MENTS 

AVAILABLE 
RANGE 

RECOMMENDED INCREMENTAL 
ADJUSTMENT 

“A” Length 0.0 0.1 0.0 – 20.0 mm Determined by test print output 

“B” Length 0.0 0.1 0.0 – 20.0 mm Determined by test print output 

TTaabbllee 33..99 ZZ--FFoolldd

OPTION OR 
SETTING 

DEFAULT 
VALUE 

ADJUST
MENT 
STEP 
INCRE
MENTS 

AVAILABLE 
RANGE 

RECOMMENDED INCREMENTAL 
ADJUSTMENT 

“A” Length 0.0 0.1 0.0 – 20.0 mm Determined by test print output 

“B” Length 0.0 0.1 0.0 – 20.0 mm Determined by test print output 

TTaabbllee 33..1100 ZZ--FFoolldd HHaallff SShheeeett

OPTION OR 
SETTING 

DEFAULT 
VALUE 

ADJUST
MENT 
STEP 
INCRE
MENTS 

AVAILABLE 
RANGE 

RECOMMENDED INCREMENTAL 
ADJUSTMENT 

“A” Length 0.0 0.1 0.0 – 20.0 mm Determined by test print output 

“B” Length 0.0 0.1 0.0 – 20.0 mm Determined by test print output 
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Stock Properties Custom Paper Settings

TTaabbllee 33..1111 SSttoocckk BByy NNaammee aanndd MMuullttiiffeeeedd DDeetteeccttiioonn

OPTION OR 
SETTING 

DEFAULT 
VALUE 

ADJUST
MENT 
STEP 
INCRE
MENTS 

AVAILABLE 
RANGE 

RECOMMENDED INCREMENTAL 
ADJUSTMENT 

Stock By Name 
Only 

Checked Box — — — 

Multi Feed 
Detection 

Checked Box — — — 

TTaabbllee 33..1122 PPrriimmaarryy TTrraannssffeerr CCuurrrreenntt AAddjjuussttmmeenntt

OPTION OR 
SETTING 

DEFAULT 
VALUE 

ADJUST
MENT 
STEP 
INCRE
MENTS 

AVAILABLE 
RANGE 

RECOMMENDED INCREMENTAL 
ADJUSTMENT 

Yellow 100 1 10%–200 % Determined by test print output 

Magenta 100 1 10%–200 % Determined by test print output 

Cyan 100 1 10%–200 % Determined by test print output 

Black 100 1 10%–200 % Determined by test print output 

TTaabbllee 33..1133 IImmaaggee TTrraannssffeerr AAddjjuussttmmeenntt

OPTION OR 
SETTING 

DEFAULT 
VALUE 

ADJUST
MENT 
STEP 
INCRE
MENTS 

AVAILABLE 
RANGE 

RECOMMENDED INCREMENTAL 
ADJUSTMENT 

Side 1 150 1 10%–300 % Perform Auto Adjustment 

Side 2 150 1 10%–300 % Perform Auto Adjustment 

Adjust Air Assist 
Values 

System 
Default 

Distinct 
Selections 
Available 

System Default

Multi Feed 
Support Table

Mis-Feed 
Support Table

Forced Off

Determined by test print output 
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OPTION OR 
SETTING 

DEFAULT 
VALUE 

ADJUST-
MENT 
STEP 
INCRE-
MENTS 

AVAILABLE 
RANGE 

RECOMMENDED INCREMENTAL 
ADJUSTMENT 

Custom 1 
through 8

Tray Heater Checked Box — — — 

Adjustment of 
Image Transfer 
Trail Edge 

100 1 0%–100 % 10% 

Adjustment of 
Paper Speed at 
Transfer 

0.00 0.01 -0.50%–0.50 % 0.05% 

Fuser 
Temperature 
Adjustment 

0 1 -10–10° C 1° or 2 ° 

Fuser Speed 
Adjustment 

0.0 0.1 -0.50%–0.50 % 0.1% 

Adjustment of 
Regi-Loop 

0 0.3 -3.0–3.0 mm 0.3 mm 

Alignment 
Adjustment 

Default Distinct 
Selections 
Available 

Available 
selections will 
be based on the 
Profiles created 
by the user 

Determined by test print output 

Fold Adjustment 
Profile 

Default Distinct 
Selections 
Available 

Available 
selections will 
be based on the 
Profiles created 
by the user 

Determined by test print output 
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TTaabbllee 33..1144 PPaappeerr CCuurrll AAddjjuussttmmeenntt

OPTION OR 
SETTING 

DEFAULT 
VALUE 

ADJUST
MENT 
STEP 
INCRE
MENTS 

AVAILABLE 
RANGE 

RECOMMENDED INCREMENTAL 
ADJUSTMENT 

1 Sided- Face Up Default Distinct 
Selections 
Available 

Default

Type A

Type B

Type C

Custom

Severe Upward

Medium 
Upward

Moderate 
Upward

Slight Upward

No Curl

Slight 
Downward

Moderate 
Downward

Medium 
Downward

Severe 
Downward

Follow recommended sequential order:
• Default 
• Type A 
• Type B 
• Type C 
• Custom Curl Correction: Slight (Very 

Small) Upward or Slight (Very Small) 
Downward 

• Custom Curl Correction: Moderate 
(Small) Upward or Moderate (Small) 
Downward 

• Custom Curl Correction: Medium 
Upward or Medium Downward 

• Custom Curl Correction: Severe (Large) 
Upward or Severe (Large) Downward 

1 Sided- Face 
Down 

Default Distinct 
Selections 
Available 

Default

Type A

Type B

Type C

Custom

Severe Upward

Medium 
Upward

Moderate 
Upward

Follow recommended sequential order:
• Default 
• Type A 
• Type B 
• Type C 
• Custom Curl Correction: Slight (Very 

Small) Upward or Slight (Very Small) 
Downward 

• Custom Curl Correction: Moderate 
(Small) Upward or Moderate (Small) 
Downward 

• Custom Curl Correction: Medium 
Upward or Medium Downward 
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OPTION OR 
SETTING 

DEFAULT 
VALUE 

ADJUST-
MENT 
STEP 
INCRE-
MENTS 

AVAILABLE 
RANGE 

RECOMMENDED INCREMENTAL 
ADJUSTMENT 

Slight Upward

No Curl

Slight 
Downward

Moderate 
Downward

Medium 
Downward

Severe 
Downward

• Custom Curl Correction: Severe (Large) 
Upward or Severe (Large) Downward 

2 Sided Default Distinct 
Selections 
Available 

Default

Type A

Type B

Type C

Custom

Severe Upward

Medium 
Upward

Moderate 
Upward

Slight Upward

No Curl

Slight 
Downward

Moderate 
Downward

Medium 
Downward

Severe 
Downward

Follow recommended sequential order:
• Default 
• Type A 
• Type B 
• Type C 
• Custom Curl Correction: Slight (Very 

Small) Upward or Slight (Very Small) 
Downward 

• Custom Curl Correction: Moderate 
(Small) Upward or Moderate (Small) 
Downward 

• Custom Curl Correction: Medium 
Upward or Medium Downward 

• Custom Curl Correction: Severe (Large) 
Upward or Severe (Large) Downward 
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Paper Jams

PAPER JAMS OVERVIEW

If a paper jam occurs, a fault screen displays a message on the press UI indicating in which area the jam is 
situated. Follow the instructions provided for clearing the jam and resuming press operation.

INFORMATION ABOUT PAPER JAMS

Review the following list to address paper jams:

• When paper jams inside the press, the press stops and a fault message displays.

• Follow the instructions displayed on the User Interface to remove the jammed paper.

• Gently remove the paper taking care not to tear it. If paper is torn, be sure to remove all torn pieces.

• If a piece of jammed paper remains inside the press, the paper jam message will remain on the display.

• Paper jams can be removed with the press still powered on. When the power is turned off, all information stored 
to the system memory will be erased.

• Do not touch components inside the press. This can cause print defects.

• After clearing a paper jam, printing is automatically resumed from the state before the paper jam occurred.

• If a paper jam occurred during printing, press the Start button. Printing is resumed from the state before the 
paper jam occurred.

Warning: When removing jammed paper, make sure that no pieces of jammed paper are left in the 
press. A piece of paper remaining in the press can cause fire. If a piece of paper is stuck in a hidden area 
or paper is wrapped around the fuser unit or rollers, do not remove it forcefully. You can get injured or 
burned. Switch off the press immediately and contact the Customer Support Center.

JAM RECOVERY OFFSET FEATURE

The Jam Recovery Offset Feature helps users verify and / or monitor job integrity when a jam occurs while printing 
offset output.

The following two conditions are required in order for this feature to work:

• When an Offset mode is available with the finishing device, such as the Offset Catch Tray (OCT), High Capacity 
Stacker (HCS), Business Ready (BR) Finisher, Standard or Booklet Maker Finisher, or Standard Finisher Plus

• When the printed offset output is not stapled

If your system meets these two requirements, then the Jam Recovery Offset Feature can be set up and used.

Important: Before this feature can be set up and used, the associated NVM value is required to be changed 
by a Service Representative. To enable the feature, contact the Customer Support Center to schedule an 
appointment with a Service Representative.
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HHooww tthhee JJaamm RReeccoovveerryy OOffffsseett FFeeaattuurree WWoorrkkss

When a jam occurs while printing offset output, the first sheet after recovery (jam clearance) is an insert that is 
pulled from a tray that is selected by the user. For example:

1. While setting up the Jam Recovery Offset Feature, the user selected Tray T1 (Post-Process Inserter) as the tray to 
use for offset jam recovery.

2. Tray T1 is loaded with colored stock, such as yellow paper.

3. A jam occurs while printing offset output.

4. The user removes the sheets in the paper path per the User Interface (UI) screens.

5. The press recovers by feeding first a yellow sheet from T1, then the offset in the set.

6. At that point, it is easy for the user to verify if all pages are present in the job by accessing the set with the 
Yellow insert.

CCoonnddiittiioonnss RReeqquuiirreedd ffoorr tthhee JJaamm RReeccoovveerryy OOffffsseett FFeeaattuurree ttoo WWoorrkk

For the insert paper to work correctly, the following conditions needs to be met:

• A specific paper tray must be selected for the jam recovery insert sheet.

• The selected paper tray must be operational; the selected tray cannot be broken.

• The selected paper tray must be installed with your system.  

In other words, you cannot assign the jam recovery insert sheet to the Top Tray of the Standard Finisher 
because your system only has a High Capacity Stacker (HCS) attached. Therefore, you must select the HCS for 
the insert sheet.

• The selected paper tray must support the desired paper size for the insert sheet. For example: 

– You want the jam recovery sheet to be 11 x 17 in., A3 size. 

– You try to assign it to the 1-Tray High Capacity Feeder (8.5 x 11 in., A4). 

– The 1-Tray HCF does not support 11 x 17 in., A3 size. 

SSeettttiinngg UUpp tthhee JJaamm RReeccoovveerryy OOffffsseett FFeeaattuurree

1. Press the Log In/Out button on the UI.

2. Enter the system administrator Login ID with the numeric keypad, then select Enter. Enter the password. 

To log in as system administrator with Login ID and password, refer to System Administrator Guide. 

Note: By default, the password prompt is not enabled.

3. Press the Machine Status button on the UI.

4. Select the Tools tab.

5. Select System Settings > Common Service Settings.

6. Select Other Settings.

7. Select the item Jam Recovery Separator Tray.

8. Select Change Settings.
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9. Select the desired tray to use for the jam recovery insert sheet.  

Note: Ensure that the selected tray meets all the required conditions for using that tray; refer to 
Conditions Required for the Jam Recovery Offset Feature to Work.

10. Select Save.

11. Select Close.  

The main Tools screen displays.

12. Exit the administrator mode.  

a. Press the Log In/Out button. 

b. When the Logout screen appears, select Logout.

PAPER JAMS IN THE DOCUMENT FEEDER

Document Feeder Jams

1. Gently lift the latch of the document feeder top cover until it is completely open. 

2. Open the left cover until it comes to a stop.  

3. If the document is not caught in the entry of the document feeder, then remove it. 
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4. If instructed to open the inner cover, lift up the lever, then open the inner cover. Remove the jammed 
document. 

Note: If the document is stuck, do not pull on it forcefully, as this could damage the document.

5. If the jam is inside of the left cover, remove the jammed document. 

6. Close the following open covers until they click into place. Close them in the following order: 

• Inner cover

• Top cover

• Left cover

7. If a document jam cannot be found, slowly raise the document feeder and, if the document is there, remove it. 

8. Close the document feeder.

9. If indicated, raise the feeder tray area and remove the document. 

10. Gently return the feeder tray to its original position.
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11. After removing the jammed document, follow the instructions to reload the entire document set into the 
document feeder.  

Note: Ensure that there are not any torn, wrinkled, or folded documents in the document set. To scan torn, 
wrinkled or folded documents, use the Document Glass, only. The already scanned document sheets are 
automatically skipped and scanning resumes from the document sheet last scanned prior to the jam.

Document Jams Under the Document Feeder Belt

1. Open the document feeder. 

2. Open the belt of the document cover while gripping the lever and remove the jammed document. 

3. Gently return the belt to the original position. 

4. Close the document feeder.

5. Follow the instructions to reload the entire document set into the document feeder.  

Note: Ensure that there are not any torn, wrinkled, or folded documents in the document set. To scan torn, 
wrinkled or folded documents, use the Document Glass, only. The already scanned document sheets are 
automatically skipped and scanning resumes from the document sheet last scanned prior to the jam.
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PRESS PAPER JAMS

Paper Jams Inside the Press

Warning: Never touch a labeled area, found on the fuser unit or nearby, indicating High Temperature 
and Caution. Contact can lead to burns.

1. Open the Press Front Door. 

2. Rotate Handle 2 to the right until it is in the horizontal position, then pull out the transfer module. 

3. Remove the visible jammed paper.

4. After clearing the jammed sheets, ensure that no torn paper pieces are left in the press.
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5. Move Handle 2b and remove any jammed paper. 

6. Return Handle 2b to its original position.

7. Move Handle 2e and remove any jammed paper. 

8. Return Handle 2e to its original position.

9. Pull down Handle 2f and remove the jammed paper. 

10. Return Handle 2f to its original position.

11. Push in the transfer module completely and rotate Handle 2 to the left.
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12. Close the press Front Door.

13. Run five blank sheets to clean left-over toner from the fuser roll and resume the copying/printing process.

Paper Jams in Trays 1-3

Note: Paper is sometimes torn and remains inside the press if you open a tray without checking the paper 
jam position. This may cause a malfunction. Check where the paper jam occurred before clearing the 
problem.

1. Open the tray where the paper jam occurred. 

2. Remove the jammed paper. 
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3. Push the tray in gently until it comes to a stop. 

PAPER JAMS IN THE BYPASS (TRAY 5)

Paper Jams in the Standalone Bypass (Tray 5)

Important: Use this procedure to clear paper jams in the Bypass (Tray 5) when it is a standalone feeding 
device and is not installed on any optional feeder (such as the Advanced Oversized High Capacity Feeder).

Tip: Always ensure that all paper jams, including any small, ripped pieces of paper, are cleared before proceeding 
with any copy/print jobs.

1. Remove the jammed paper and any paper that is loaded from the Bypass tray. 

Note: If paper is torn, check inside the press and remove it.

2. Open the Bypass Top Cover and remove jammed paper. 
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3. Close the cover. 

4. Reload paper into the tray and resume copying / printing.
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Tray 6 Troubleshooting

TRAY 6  PAPER JAMS

Clearing Paper Jams in the HCF (Tray 6)

1. Open Tray 6 and remove any jammed paper. 

Note: If paper is torn, check for any torn pieces of paper inside the machine.

2. Gently close the tray.

3. Gently move Tray 6 to the left until it stops. 

4. Grasp the top cover handle and open the top cover. 

5. Remove any jammed paper from the top cover area of Tray 6.

6. Close the Tray 6 top cover.

7. Return Tray 6 to its original position. 
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Clearing HCF Paper Jams in the Lower Left Cover

1. Gently move Tray 6 to the left until it stops. 

2. Gently open the lower left cover while gripping the release handle. 

3. Remove the jammed paper. 

Note: If paper is torn, check for any torn pieces of paper inside the machine.

4. Gently close the lower left cover.

5. Gently move Tray 6 back into position. 

TRAY 6  FAULT MESSAGES

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and 
a message appears on the press UI. A graphical illustration shows the location of the fault with a brief explanation 
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of corrective actions for clearing the fault. If a fault occurs in more than one location, the illustration changes to 
indicate the multiple locations and the required corrective actions.

Tray 6 Fault Code Information

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and 
a message appears on the press UI. 

The UI also displays a Faults button which provides information about the fault and detailed instructions for 
correcting the fault. 

Tip: Tray 6 faults are identified by the codes which start with the three-digit numbers 002244 and 007788. 
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Trays 6 and 7 Troubleshooting

TRAYS 6  AND 7 PAPER JAMS

Paper Jams When the Bypass is Installed on Trays 6 and 7

Tip: Always ensure that all paper jams, including any small, ripped pieces of paper, are cleared before proceeding 
with any print jobs.

1. Remove the paper currently loaded in the Bypass (Tray 5). 

2. Lift and open the Top Cover of the Bypass (Tray 5). 

3. Remove any jammed paper. 

Note: If paper is torn, check inside the press and remove it.
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4. Close the Top Cover of the Bypass (Tray 5). 

5. Reload paper into the tray and resume printing.

Paper Jams Inside Trays 6 and 7

1. Pull out the tray where the paper jam occurred. 

2. Remove the jammed paper. 

Note: If paper is torn, check inside the machine and remove it.

3. Gently push in the tray until it comes to a stop.
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Trays 6 and 7 Paper Jams at Lever 1a and Knob 1c

1. Open the front cover of the OHCF. 

2. Move the lever 1a to the right and turn the knob 1c to the right. Remove the jammed paper. 

Note: If paper is torn, check inside the machine and remove it.

3. Return the lever 1a to the original position. 

4. Close the front cover of the OHCF. 

Note: If the front cover of the OHCF is not completely closed, a message will appear and the machine will 
not operate.
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Trays 6 and 7 Paper Jams at Lever 1b and Knob 1c

1. Open the front cover of the OHCF. 

2. Move the lever 1b to the right and turn the knob 1c to the right. Remove the jammed paper. 

Note: If paper is torn, check inside the machine and remove it.

3. Return the lever 1b to the original position. 
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4. Close the front cover of the OHCF. 

Note: If the front cover of the OHCF is not completely closed, a message will appear and the machine will 
not operate.

Trays 6 and 7 Paper Jams at Lever 1d and Knob 1c

1. Open the front cover of the OHCF. 

2. Move the lever 1d upward and remove the jammed paper. 

Note: If paper is torn, check inside the machine and remove it.
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3. If the paper cannot be removed, turn the knob 1c clockwise, then remove the jammed paper. 

Note: If paper is torn, check inside the machine and remove it.

4. Return the lever 1d to the original position. 

5. Close the front cover of the OHCF. 

Note: If the front cover of the OHCF is not completely closed, a message will appear and the machine will 
not operate.

TRAYS 6  AND 7 FAULT MESSAGES

When an fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and 
a message appears on the press UI. A graphical illustration shows the location of the fault with a brief explanation 
of corrective actions for clearing the fault. If a fault occurs in more than one location, the illustration changes to 
indicate the multiple locations and the required corrective actions. 

Trays 6 and 7 Fault Code Information

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and 
a message appears on the press UI. 

The UI also displays a Faults button which provides information about the fault and detailed instructions for 
correcting the fault. 
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Tip: Trays 6 and 7 faults are identified by the codes which start with the three-digit number 007788. 
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Trays 8 and 9 Troubleshooting

TRAYS 8  AND 9 PAPER JAMS

Clearing Trays 8 and 9 Jams

Nip Release levers inside of the Transport area of the Feeder hold back large size sheets (such as A3, 11 x 17 inches, 
12 x 18 inches) to reduce the chance of jamming as paper enters the print engine.

Note: Follow the jam clearance instructions displayed on the touch screen. Always ensure that all paper 
jams, including any small ripped pieces of paper, are cleared before proceeding with your print jobs. 

Paper Jams When the Bypass is Installed on Trays 8 and 9

Tip: Always ensure that all paper jams, including any small, ripped pieces of paper, are cleared before proceeding 
with any print jobs.

1. Remove the paper currently loaded in the Bypass (Tray 5). 

2. Lift and open the Top Cover of the Bypass (Tray 5). 

3. Remove any jammed paper. 

Note: If paper is torn, check inside the press and remove it.
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4. Close the Top Cover of the Bypass (Tray 5). 

5. Pull open the Top Drawer (located at the top of Trays 6 and 7). 

6. Lift levers 2a and 2b, then remove any paper jams. 

7. Close levers 2a and 2b.

8. Close the Top Drawer.
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9. Reload paper into the tray and resume printing.

Paper Jams Inside Trays 8 and 9

1. Pull out the tray where the paper jam occurred. 

2. Remove the jammed paper. 

Note: If paper is torn, check inside the machine and remove it.

3. Gently push in the tray until it comes to a stop.

Trays 8 and 9 Paper Jams at Lever 1a and Knob 1c

1. Open the front cover of the feeder module. 
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2. Move the lever 1a to the right and turn the knob 1c to the right. Remove the jammed paper. 

Note: If paper is torn, check inside the machine and remove it.

3. Return the lever 1a to the original position.

4. Close the front cover of the feeder module. 

Note: If the front cover of the feeder module is not completely closed, a message will appear and the press 
will not operate.

Trays 8 and 9 Paper Jams at Lever 1b and Knob 1c

1. Open the front cover of the feeder module. 
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2. Move the lever 1b to the right and turn the knob 1c to the right. Remove the jammed paper. 

Note: If paper is torn, check inside the machine and remove it.

3. Return the lever 1b to the original position.

4. Close the front cover of the feeder module. 

Note: If the front cover of the feeder module is not completely closed, a message will appear and the press 
will not operate.

Trays 8 and 9 Paper Jams at Lever 1d and Knob 1c

1. Open the front cover of the feeder module. 
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2. Move the lever 1d upward and remove the jammed paper. 

Note: If paper is torn, check inside the machine and remove it.

3. If the paper cannot be removed, turn the knob 1c clockwise, then remove the jammed paper.

4. Return the lever 1d to the original position.

5. Close the front door of the feeder module. 

Note: If the front cover of the feeder module is not completely closed, a message will appear and the press 
will not operate.

TRAYS 8  AND 9 FAULT MESSAGES

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and 
a message appears on the press UI. A graphical illustration shows the location of the fault with a brief explanation 
of corrective actions for clearing the fault. If a fault occurs in more than one location, the illustration changes to 
indicate the multiple locations and the required corrective actions. 

Trays 8 and 9 Fault Code Information

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and 
a message appears on the press UI. 

The UI also displays a Faults button which provides information about the fault and detailed instructions for 
correcting the fault. 

Tip: Trays 8 and 9 faults are identified by the codes which start with the three-digit number 117788.
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High Capacity XLS Vacuum Feeder (HCVF) Troubleshooting

For a printable flowchart of the HCVF Troubleshooting, that is described in the following section, refer to 
Troubleshooting Feed Errors in the Xerox® High Capacity XLS Vacuum Feeder in www.xerox.com. In the Customer 
Support > All Support and Drivers section of the web page, search for your Product. In the Documentation web 
page of your printer, you can find the HCVF Troubleshooting flowchart.

TROUBLESHOOTING MISFEEDS AND MULTIFEEDS IN THE HIGH CAPACITY XLS VACUUM 

FEEDER (HCVF)

When using the optional High Capacity Vacuum XLS Feeder (HCVF) and a misfeed or multifeed condition occurs, 
check the press user interface for one of the following fault codes.

MISFEED FAULT CODES MULTIFEED FAULT CODES 

• 078–101 
• 078–131 
• 078–132 
• 078–151 

• 178–101 
• 178–131 
• 178–132 
• 178–151 

• 077–131 
• 077–132 

• 078–125 
• 078–126 
• 078–127 

To resolve misfeed or multifeed conditions, adjust the Air Assist Values setting to a recommended value. For 
instructions on adjusting Air Assist Values, refer to Adjusting Air Assist Values.

To troubleshoot misfeeds, refer to Troubleshooting Misfeeds in the HCVF.

To troubleshoot multifeeds, refer to Troubleshooting Multifeeds in the HCVF.

Adjusting Air Assist Values

The Air Assist Values setting corresponds to a specific configuration of blower settings in the High Capacity XLS 
Vacuum Feeder (HCVF). An adjustment to the Air Assist Values setting results in a different configuration of blower 
settings.

To optimize blower settings in the HCVF, adjust the Air Assist Values setting. Make adjustments according to the 
recommended troubleshooting instructions only. 

Note: Before you adjust the Air Assist Values setting, ensure that the media loaded in the HCVF adheres to 
the Paper and Media Guidelines for the HCVF.

To adjust the Air Assist Values setting, do the following:

1. At the press user interface, log in as an administrator.

2. Select Machine Status > Tools > System Settings > Common Service Settings > Paper Tray Settings.

3. At the Paper Tray Settings window, select Custom Paper Settings.

4. At the Custom Paper Settings window, a list of profiles is displayed. Each profile corresponds to a set of custom 
settings. Do one of the following: 

• To use an existing profile, select a named profile.

• To create a new profile, select an unused profile, then type a name for the profile.
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5. Select Change Settings.

6. At the Settings window, select Adjust Air Assist Values > Change Settings.

7. At the Adjust Air-Assist Values window, select Custom Table. 

Note: The Custom Table contains a set of numerical settings. Each numerical value in the Custom Table 
maps to a specific blower configuration in the HCVF.

8. To change the Custom Table setting, type the required number. Alternatively, use the up and down arrows to 
select the number.

9. To save the Custom Table setting, select Save.

10. To save the profile, select Save.

11. To close the Custom Paper Settings window, select Close.

12. To close the Paper Tray Settings window, select Close.

Troubleshooting Misfeeds in the HCVF

When using the optional High Capacity XLS Vacuum Feeder (HCVF), the following fault codes indicate a misfeed 
condition:

• 078–101, 078–131, 078–132, 078–151

• 178–101, 178–131, 178–132, 178–151

For fault codes relating to multifeeds, refer to Troubleshooting Multifeeds in the HCVF.

To resolve a misfeed, follow the steps in the appropriate section.

Misfeeds when using paper weight 177 g/m² or heavier

When using paper of weights 177 g/m² or heavier, misfeed problems can occur.

1. Make the following adjustments: 

a. Change the Custom Table setting to 5. Save the setting.

b. Run a test print. If no misfeed occurs, the problem is resolved.

c. Increase the Custom Table value by one setting. Save the setting.

d. Run a test print. If no misfeed occurs, the problem is resolved.

e. If misfeeds continue, repeat steps 1c and 1d until the Custom Table setting reaches 8.

2. If the problem is not resolved, contact your Xerox representative.

Misfeeds when using paper weight less than 177 g/m² and printing five or fewer sheets
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When using paper of weights less than 177 g/m² and printing five or fewer sheets, misfeed problems can 
occur.

Make the following adjustments:

1. Change the Custom Table setting to 32. Save the setting.

2. Run a test print. If no misfeed occurs, the problem is resolved.

3. If a misfeed occurs again, change the Custom Table setting to 33. Save the setting.

4. Run another test print. If the problem is not resolved, contact your Xerox representative.

Misfeeds when using paper weight less than 177 g/m² and printing more than five sheets

When using paper of weights less than 177 g/m² and printing more than five sheets, misfeed problems 
can occur.

1. Make the following adjustments: 

a. Change the Custom Table setting to 5. Save the setting.

b. Run a test print. If no misfeed occurs, the problem is resolved.

c. Increase the Custom Table value by one setting. Save the setting.

d. Run a test print. If no misfeed occurs, the problem is resolved.

e. If misfeeds continue, repeat steps 1c and 1d until the Custom Table setting reaches 8.

2. If a misfeed occurs again, change the Custom Table setting to 32. Save the setting.

3. Run a test print. If no misfeed occurs, the problem is resolved.

4. If a misfeed occurs again, change the Custom Table setting to 33. Save the setting.

5. Run another test print. If the problem is not resolved, contact your Xerox representative.

Troubleshooting Multifeeds in the HCVF

When using the optional High Capacity XLS Vacuum Feeder (HCVF), the following fault codes indicate a multifeed 
condtion:

• 077–131, 077–132.

• 078–125, 078–126, 078–127.

For fault codes relating to misfeeds, refer to Troubleshooting Misfeeds in the HCVF.

To resolve a multifeed, follow the steps in the appropriate section.

Multifeeds when using coated paper weight 177 g/m² or heavier
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Humidity levels of 50 percent or higher

When using coated paper of weight 177 g/m² or heavier in humidity levels of 50 percent or 
higher, multifeed problems can occur.

Make the following adjustments:

1. If the paper is coated on one side only, go to step 3.

2. If the paper is coated on both sides, do the following: 

a. Change the Custom Table setting to 5. Save the setting.

b. Run a test print. If no multifeed occurs, the problem is resolved.

c. Increase the Custom Table value by one setting. Save the setting.

d. Run a test print. If no multifeed occurs, the problem is resolved.

e. If multifeeds continue, repeat steps 2c and 2d until the Custom Table value reaches 8.

3. If using paper that is coated on one side only, or if multifeeds continue, do the following: 

a. Change the Custom Table setting to 9. Save the setting.

b. Run a test print. If no multifeed occurs, the problem is resolved.

c. Increase the Custom Table value by one setting. Save the setting.

d. Run a test print. If no multifeed occurs, the problem is resolved.

e. If multifeeds continue, repeat steps 3c and 3d until the Custom Table value reaches 12.

4. If the problem is not resolved, contact your Xerox representative.
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Humidity levels below 50 percent

When using coated paper of weight 177 g/m² or heavier in humidity levels below 50 percent, 
multifeed problems can occur.

1. Make the following adjustments: 

a. Change the Custom Table setting to 9. Save the setting.

b. Run a test print. If no multifeed occurs, the problem is resolved.

c. Increase the Custom Table value by one setting. Save the setting.

d. Run a test print. If no multifeed occurs, the problem is resolved.

e. If multifeeds continue, repeat steps 1c and 1d until the Custom Table value reaches 12.

2. If multifeeds continue, do the following 

a. Change the Custom Table setting to 35. Save the setting.

b. Run a test print. If no multifeed occurs, the problem is resolved.

c. Increase the Custom Table value by one setting. Save the setting.

d. Run a test print. If no multifeed occurs, the problem is resolved.

e. If multifeeds continue, repeat steps 2c and 2d until the Custom Table value reaches 38.

3. If the problem is not resolved, contact your Xerox representative.
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Multifeeds when using uncoated paper weight 177 g/m² or heavier

When using uncoated paper of weight 177 g/m² or heavier, multifeed problems can occur.

1. Make the following adjustments: 

a. Change the Custom Table setting to 9. Save the setting.

b. Run a test print. If no multifeed occurs, the problem is resolved.

c. Increase the Custom Table value by one setting. Save the setting.

d. Run a test print. If no multifeed occurs, the problem is resolved.

e. If multifeeds continue, repeat steps 1c and 1d until the Custom Table setting reaches 12.

2. If the problem is not resolved, contact your Xerox representative.
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Multifeeds when using paper weight less than 177 g/m²

Humidity levels of 50 percent or higher

When using paper of weight less than 177 g/m² in humidity levels of 50 percent or higher, 
multifeed problems can occur.

1. Make the following adjustments: 

a. Change the Custom Table setting to 9. Save the setting.

b. Run a test print. If no multifeed occurs, the problem is resolved.

c. Increase the Custom Table value by one setting. Save the setting.

d. Run a test print. If no multifeed occurs, the problem is resolved.

e. If multifeeds continue, repeat steps 1c and 1d until the Custom Table value reaches 12.

2. If multifeeds continue, do the following: 

a. Change the Custom Table setting to 5. Save the setting.

b. Run a test print. If no multifeed occurs, the problem is resolved.

c. Increase the Custom Table value by one setting. Save the setting.

d. Run a test print. If no multifeed occurs, the problem is resolved.

e. If multifeeds continue, repeat steps 2c and 2d until the Custom Table value reaches 8.

3. If a multifeed occurs again, change the Custom Table setting to 32. Save the setting.

4. Run a test print. If no multifeed occurs, the problem is resolved.

5. If a multifeed occurs again, change the Custom Table setting to 33. Save the setting.

6. Run another test print. If the problem is not resolved, contact your Xerox representative.
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Humidity levels below 50 percent

When using paper of weight less than 177 g/m² in humidity levels below 50 percent, multifeed 
problems can occur.

1. Make the following adjustments: 

a. Change the Custom Table setting to 5.

b. Run a test print. If no multifeed occurs, the problem is resolved.

c. Increase the Custom Table value by one setting. Save the setting.

d. Run a test print. If no multifeed occurs, the problem is resolved.

e. If multifeeds continue, repeat steps 1c and 1d until the Custom Table value reaches 8.

2. If a multifeed occurs again, change the Custom Table setting to 32. Save the setting.

3. Run a test print. If no multifeed occurs, the problem is resolved.

4. If a multifeed occurs again, change the Custom Table setting to 33. Save the setting.

5. Run a test print. If no multifeed occurs, the problem is resolved.

6. If multifeeds continue, do the following: 

a. Change the Custom Table setting to 9. Save the setting.

b. Run a test print. If no multifeed occurs, the problem is resolved.

c. Increase the Custom Table value by one setting. Save the setting.

d. Run a test print. If no multifeed occurs, the problem is resolved.

e. If multifeeds continue, repeat steps 6c and 6d until the Custom Table value reaches 12.

7. If the problem is not resolved, contact your Xerox representative.
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Finishing Devices Troubleshooting

BUSINESS READY FINISHER TROUBLESHOOTING

BR Finisher Paper Jams

Clearing Jams in the BR Finisher at Position 3a

1. If the paper is visible at the output tray exit, remove the paper by pulling it gently in the direction shown. 

2. Open the front door of the Business Ready Finisher.

3. Lift green handle 3a. 

4. Carefully remove the paper. 

• If the paper is torn, remove all torn pieces from the finisher.

• If the paper is inaccessible, or if the press User Interface (UI) prompts you to release the paper, turn green 
handle knob 3b in the direction shown.
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5. Return green handle 3a to its original position. 

6. Close the front door of the Business Ready Finisher.

Clearing Jams in the BR Finisher at Position 3c

1. Open the front door of the Business Ready Finisher.

2. Move green lever 3c to the left. 

3. Carefully remove the paper. 

• If the paper is torn, remove all torn pieces from the finisher.

• If the paper is inaccessible, or if the press User Interface (UI) prompts you to release the paper, turn green 
handle knob 3b in the direction shown.

4. Return green lever 3c to its original position. 

5. Close the front door of the Business Ready Finisher.
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Clearing Jams in the BR Finisher at Position 3d

1. Open the front door of the finisher and locate green lever 3d. 

2. Move green lever 3d to the right. 

3. Carefully remove the paper. 

Note: If the paper is torn, remove all pieces from the finisher.

4. Return green lever 3d to its original position. 

5. Close the front door of the Business Ready Finisher.

Clearing Jams in the BR Finisher at Position 4

1. Open the front door of the Business Ready Finisher.
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2. Using the green handle, pull out unit 4 until it stops. 

3. To remove the jammed paper, turn green knob 4 in either direction as shown. 

Note: If the paper is torn, remove all torn pieces from the finisher.

4. Return unit 4 to its original position. 

5. Close the front door of the Business Ready Finisher.

Clearing Jams in the Booklet Tray

1. Open the front door of the Business Ready Finisher.

2. To release the jammed paper, turn green knob 4 in the direction shown. 
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3. To remove the paper, pull it in the direction shown. 

Note: If the paper is torn, remove all torn pieces from the finisher.

4. Close the front door of the Business Ready Finisher.

BR Finisher Fault Messages and Fault Codes

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and 
a message appears on the press UI. A graphical illustration shows the location of the fault with a brief explanation 
of corrective actions for clearing the fault. If a fault occurs in more than one location, the illustration changes to 
indicate the multiple locations and the required corrective actions. 

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and 
a message appears on the press UI. 

The UI also displays a Faults button which provides information about the fault and detailed instructions for 
correcting the fault. 

Tip: BR Finisher and Booklet Maker faults are identified by the codes which start with the three-digit number 001122.
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INTERFACE DECURLER MODULE TROUBLESHOOTING

Paper Jams on the Interface Decurler Module

The following occurs when there is a fault, such as paper jams, open doors or covers, or a press malfunction:

• The press stops running and a fault message displays on the press touch screen.

• The message includes a graphical illustration showing the location of the fault along with a brief explanation of 
corrective actions for clearing the fault.

• Paper jams may occur in multiple areas of the press and any optional devices connected to the press. When this 
happens, the graphical illustration changes to show the multiple locations and the required corrective actions. 

• Additionally, if a fault occurs with an optional device, an indicator lights on that device control panel and shows 
the corresponding area on the device where the fault occurred.

Always refer to the following information when clearing paper jams:

• Do not power off the press when removing paper jams.

• Paper jams can be removed with the press still powered on. When the power is turned off, all information stored 
to the system memory will be erased.

• Clear all paper jams before resuming print jobs.

• Do not touch components inside the press. This can cause print defects.

• Ensure that all paper jams, including any small ripped pieces of paper, are cleared before proceeding with print 
jobs.

• Gently remove the paper taking care not to tear it. If paper is torn, be sure to remove all torn pieces.

• After removing paper jams, close all doors and covers. The press cannot print when doors or covers are open.

• After clearing a paper jam, printing automatically resumes from the state before the paper jam occurred.

• If all paper jams are not cleared, an error message continues to display on the press touch screen. To clear any 
remaining jams, refer to the press touch screen for instructions and information.
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Clearing Paper Jams on the Interface Decurler Module

1. Open the front cover on the Interface Decurler Module (IDM). 

2. Remove jammed paper: 

a. Open lever 1a downward.

b. Turn knob 1b counterclockwise. 

Important: To ensure the jammed paper exits the area, turn the knob a minimum of ten (10) times 
or more.

c. Remove the jammed paper. 

Important: Remove the jammed paper by carefully pulling it out of the area.

Xerox® Versant® 280 Press User Documentation 355

Troubleshooting



3. Return lever 1a to its original position. 

4. If you encounter difficulty when removing jammed paper, open lever 1c upward and carefully remove jammed 
paper. 

5. Return lever 1c to its original position. 

6. Close the IDM front cover.

7. If required, follow the instructions on the press touch screen to clear other areas of the system.
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Fault Messages on the Interface Decurler Module

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and 
a message appears on the press touch screen. A graphical illustration shows the location of the fault with a brief 
explanation of corrective actions for clearing the fault. If a fault occurs in more than one location, the illustration 
changes to indicate the multiple locations and the required corrective actions.

The touch screen also displays a Faults button which provides information about the fault and detailed instructions 
for correcting the fault.

Fault Code Information on the Interface Decurler Module

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and 
a message appears on the press touch screen. 

The touch screen also displays a Faults button which provides information about the fault and detailed instructions 
for correcting the fault. 

Tip: Interface Decurler Module faults are identified by the codes which start with the three-digit number 004488.  

INSERTER DEVICE TROUBLESHOOTING

Inserter Paper Jams

The following occurs when there is a fault, such as paper jams, open doors or covers, or a press malfunction:

• The press stops running and a fault message displays on the press touch screen.

• The message includes a graphical illustration showing the location of the fault along with a brief explanation of 
corrective actions for clearing the fault.
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• Paper jams may occur in multiple areas of the press and any optional devices connected to the press. When this 
happens, the graphical illustration changes to show the multiple locations and the required corrective actions. 

• Additionally, if a fault occurs with an optional device, an indicator lights on that device control panel and shows 
the corresponding area on the device where the fault occurred.

Always refer to the following information when clearing paper jams:

• Do not power off the press when removing paper jams.

• Paper jams can be removed with the press still powered on. When the power is turned off, all information stored 
to the system memory will be erased.

• Clear all paper jams before resuming print jobs.

• Do not touch components inside the press. This can cause print defects.

• Ensure that all paper jams, including any small ripped pieces of paper, are cleared before proceeding with print 
jobs.

• Gently remove the paper taking care not to tear it. If paper is torn, be sure to remove all torn pieces.

• After removing paper jams, close all doors and covers. The press cannot print when doors or covers are open.

• After clearing a paper jam, printing automatically resumes from the state before the paper jam occurred.

• If all paper jams are not cleared, an error message continues to display on the press touch screen. To clear any 
remaining jams, refer to the press touch screen for instructions and information.

Clearing Paper Jams from Inserter E1 Area

1. Open the T1 cover (1), then remove the jammed papers (2) as well as all of the paper loaded in the tray (3). 

Note: When two or more sheets of paper are loaded, remove all sheets.

Fan the paper you removed and make sure all four corners are aligned correctly. 

2. Reload the paper into the tray.

3. Close the T1 cover.
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Clearing Paper Jams from Inserter E2 Area

1. Open the Inserter front cover. 

2. Open lever 1a upward (1) and turn knob 1b counterclockwise (2). Remove jammed paper (3). 

3. Return lever 1a to its original position. 
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4. If you have difficulty when removing jammed paper, open lever 1c to the right (1) and turn knob 1b 
counterclockwise (2). Remove jammed paper (3). 

5. Return lever 1c to its original position. 

6. Close the Inserter front cover.

Clearing Paper Jams from Inserter E3 Area

1. Open the Inserter front cover. 
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2. Open lever 1d downward (1) and turn knob 1e counterclockwise (2). Remove the jammed paper (3). 

Note: The jammed paper may be hidden behind the upper-left cover area.

3. Return lever 1d to its original position. 

4. If you have difficulty when removing jammed paper, open lever 1a upward (1) and turn knob 1e 
counterclockwise (2). Remove the jammed paper (3). 
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5. Return lever 1a to its original position. 

6. Close the Inserter front cover.

Inserter Fault Messages

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and 
a message appears on the press touch screen. A graphical illustration shows the location of the fault with a brief 
explanation of corrective actions for clearing the fault. If a fault occurs in more than one location, the illustration 
changes to indicate the multiple locations and the required corrective actions. 

The touch screen also displays a Faults button which provides information about the fault and detailed instructions 
for correcting the fault. The (EE) code on the upper-left part of the Fault message displays which error indicator is lit 
on the Inserter control panel (E1, E2, E3).

Inserter Fault Code Information

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and 
a message appears on the press touch screen.

The touch screen also displays a Faults button which provides information about the fault and detailed instructions 
for correcting the fault.

Tip: Inserter faults are identified by the codes which start with the three-digit numbers 001122, 001133, and 002244. 
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HIGH CAPACITY STACKER TROUBLESHOOTING

HCS Paper Jams

The following occurs when there is a fault, such as paper jams, open doors or covers, or a press malfunction:

• The press stops running and a fault message displays on the press touch screen.

• The message includes a graphical illustration showing the location of the fault along with a brief explanation of 
corrective actions for clearing the fault.

• Paper jams may occur in multiple areas of the press and any optional devices connected to the press. When this 
happens, the graphical illustration changes to show the multiple locations and the required corrective actions. 

• Additionally, if a fault occurs with an optional device, an indicator lights on that device control panel and shows 
the corresponding area on the device where the fault occurred.

Always refer to the following information when clearing paper jams:

• Do not power off the press when removing paper jams.

• Paper jams can be removed with the press still powered on. When the power is turned off, all information stored 
to the system memory will be erased.

• Clear all paper jams before resuming print jobs.

• Do not touch components inside the press. This can cause print defects.

• Ensure that all paper jams, including any small ripped pieces of paper, are cleared before proceeding with print 
jobs.

• Gently remove the paper taking care not to tear it. If paper is torn, be sure to remove all torn pieces.

• After removing paper jams, close all doors and covers. The press cannot print when doors or covers are open.

• After clearing a paper jam, printing automatically resumes from the state before the paper jam occurred.

• If all paper jams are not cleared, an error message continues to display on the press touch screen. To clear any 
remaining jams, refer to the press touch screen for instructions and information.
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Clearing Paper Jams from HCS Area E1

1. Open the HCS top cover. 

2. Open lever 1b upward (1) and remove jammed papers (2). 

3. Return lever 1b to its original position. 

4. Close the HCS top cover.

5. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume 
printing.
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Clearing Paper Jams from HCS Area E2

1. Open the HCS top cover. 

2. Open lever 1b upward (1) and rotate knob 1a counterclockwise (2) and remove jammed papers (3). 

3. Return lever 1b to its original position. 

4. Close the HCS top cover.

5. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume 
printing.
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Clearing Paper Jams from HCS Area E3

1. Open the HCS top cover. 

2. Open lever 1b upward (1) and rotate knob 1a counterclockwise (2) and remove jammed papers (3). 

3. Return lever 1b to its original position. 

4. Open lever 2b upward (1) and turn knob 2c counterclockwise (2) and remove jammed papers (3). 
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5. Return lever 2b to its original position. 

6. Close the HCS top cover.

7. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume 
printing.

Clearing Paper Jams from HCS Area E4

1. Open the HCS top cover. 

2. Open lever 2a downward (1) and remove jammed papers(2). 

3. Return lever 2a to its original position. 
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4. Close the HCS top cover.

5. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume 
printing.

Clearing Paper Jams from HCS Area E5

1. Open the HCS top cover. 

2. Open lever 2b upward (1) and turn knob 2c counterclockwise (2) and remove jammed papers (3). 

3. Return lever 2b to its original position. 

4. Close the HCS top cover.

5. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume 
printing.
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Clearing Paper Jams from HCS Area E6

1. Press the Unload button. 

2. Make sure the HCS front door is unlocked and then open it.  

3. Pull out the stacker cart slowly and remove any jammed paper. 
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4. Push the stacker cart back into its original position. 

5. Close the HCS front door.

6. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume 
printing.

Clearing Paper Jams from HCS Area E7

1. Remove any output delivered to the top tray. 

2. Open the HCS top cover. 

3. Open lever 1b upward (1) and remove jammed papers (2). 
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4. Return lever 1b to its original position. 

5. Open lever 2a downward (1) and remove jammed paper (2). 

6. Return lever 2a to its original position. 

7. Close the HCS top cover.

8. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume 
printing.

HCS Fault Messages

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and 
a message appears on the press touch screen. A graphical illustration shows the location of the fault with a brief 
explanation of corrective actions for clearing the fault. If a fault occurs in more than one location, the illustration 
changes to indicate the multiple locations and the required corrective actions. 

The touch screen also displays a Faults button which provides information about the fault and detailed instructions 
for correcting the fault. The (EE) code on the upper-left part of the Fault message displays which error indicator is lit 
on the HCS control panel (E1–E8).

HCS Fault Code Information

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and 
a message appears on the press touch screen. 

The touch screen also displays a Faults button which provides information about the fault and detailed instructions 
for correcting the fault. 
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Tip: HCS faults are identified by the codes which start with the three-digit numbers 004499. 

Additional HCS Troubleshooting Information

Hints and Tips for Using the High Capacity Stacker (HCS)

Refer to the following hints and tips when using the HCS:

1. Check the paper in the applicable HCS tray for curl. 

a. If no curl is present and if the output is acceptable and meets customer satisfaction, you are finished.

b. If no curl is present and if the output is not acceptable, call for service.

c. If curl is present, continue to the next step.

2. To correct the paper curl, use the paper curl correction controls on the top of the Interface Decurler Module 
(IDM).

3. If the output has not improved, adjust the paper curl again.

4. If the output still has not improved, call the Customer Support Center.
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CREASE AND TWO-SIDED TRIMMER TROUBLESHOOTING

Crease and Two-Sided Trimmer Paper Jams

The following occurs when there is a fault, such as paper jams, open doors or covers, or a press malfunction:

• The press stops running and a fault message displays on the press touch screen.

• The message includes a graphical illustration showing the location of the fault along with a brief explanation of 
corrective actions for clearing the fault.

• Paper jams may occur in multiple areas of the press and any optional devices connected to the press. When this 
happens, the graphical illustration changes to show the multiple locations and the required corrective actions. 

• Additionally, if a fault occurs with an optional device, an indicator lights on that device control panel and shows 
the corresponding area on the device where the fault occurred.

Always refer to the following information when clearing paper jams:

• Do not power off the press when removing paper jams.

• Paper jams can be removed with the press still powered on. When the power is turned off, all information stored 
to the system memory will be erased.

• Clear all paper jams before resuming print jobs.

• Do not touch components inside the press. This can cause print defects.

• Ensure that all paper jams, including any small ripped pieces of paper, are cleared before proceeding with print 
jobs.

• Gently remove the paper taking care not to tear it. If paper is torn, be sure to remove all torn pieces.

• After removing paper jams, close all doors and covers. The press cannot print when doors or covers are open.

• After clearing a paper jam, printing automatically resumes from the state before the paper jam occurred.

• If all paper jams are not cleared, an error message continues to display on the press touch screen. To clear any 
remaining jams, refer to the press touch screen for instructions and information.
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Clearing Paper Jams from Trimmer Area E1

1. Open the trimmer upper cover. 

2. Open lever 1a downward (1), lever 1b downward (2) and lever 1d upward (3). Remove jammed paper (4). 

Note: Check behind the upper cover for any hidden jammed paper.

3. If you have difficulty removing any paper jams, rotate knob 1c clockwise (1), then remove the jammed paper 
(2). 
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4. Return levers 1a, 1b and 1d to their original positions. 

5. Close the trimmer upper cover.

6. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume 
printing.

Clearing Paper Jams from Trimmer Area E2

1. Open the trimmer upper cover. 

2. Rotate knob 2 counterclockwise to align the mark on the knob with the unlock position (a mark resembling an 
open padlock). 
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3. Open lever 1a downward (1) and lever 1b downward (2). 

4. Turn knob 1c clockwise (1) and remove jammed papers (2). 

5. Return levers 1a and 1b to their original positions.  
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6. If you have difficulty removing any paper jams, open lever 1d upward (1) and lever 2a to the left (2). 

7. Rotate knob 2b counterclockwise (1) and remove jammed papers (2). 

8. Return levers 1d and 2a to their original positions. 

9. Close the trimmer upper cover.

10. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume 
printing.
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Clearing Paper Jams from Trimmer Area E3

1. Open the trimmer upper cover. 

2. Rotate knob 2 counterclockwise to align the mark on the knob with the unlock position (a mark resembling an 
open padlock). 

3. Open lever 2c downward (1) and remove jammed paper (2). 

Note: Check behind the upper cover for any hidden jammed paper.

378 Xerox® Versant® 280 Press User Documentation 

Troubleshooting



4. Return lever 2c to its original position. 

5. Close the trimmer upper cover.

6. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume 
printing.

Clearing Paper Jams from Trimmer Area E4

1. Open the trimmer upper cover. 

2. Open lever 2c downward (1), lever 2d upward (2) and lever 2e to the right (3). 
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3. Rotate knob 2f clockwise (1) and remove jammed paper (2).  

Note: Grasp the lead edge of the jammed sheet and gently pull out the sheet to remove it.

4. If you have difficulty removing the jammed sheet, grasp the top edge at the inner-right side of the sheet and 
gently pull out the sheet to remove it. 

5. Return levers 2e (1), 2d (2) and 2c (3) to their original positions. 

6. Close the trimmer upper cover.

7. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume 
printing.
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Clearing Paper Jams from Trimmer Area E5

1. Open the trimmer upper cover. 

2. Open lever 3a to the right (1), lever 3b to the left (2). 

3. Rotate knob 3c clockwise (1) and remove jammed paper (2). 
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4. Rotate knob 2f counterclockwise (1) and remove jammed paper (2). 

5. Return levers 3a and 3b to their original positions. 

6. Close the trimmer upper cover.

7. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume 
printing.

Clearing Paper Jams from Trimmer Area E6

1. Open the trimmer upper cover. 
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2. Open lever 3a to the right (1), lever 4b downward (2) and lever 4c to the right (3). Remove jammed paper (4). 

3. Rotate knob 4d counterclockwise (1) and remove jammed paper (2). 

4. Open lever 4a to the right (1) and rotate knob 2f counterclockwise (2). Remove jammed paper (3). 

Note: Hold lever 4a while rotating knob 2f.
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5. Rotate knob 3c clockwise (1) and remove jammed paper (2). 

6. Return levers 3a, 4b and 4c to their original positions. 

7. Close the trimmer upper cover.

8. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume 
printing.

Clearing Paper Jams from Trimmer Area E7

1. Open the trimmer upper cover. 
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2. Open lever 3a to the right (1) and rotate knob 2f counterclockwise (2). 

Note: Rotate the knob five times or more.

3. Pull out and push in the trimmer waste container continuously for three times or more.  

4. Return lever 3a to its original position. 

5. If indicator E7 remains lit, perform the following steps: 
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a. Open the lower cover. 

b. Remove the supplied cleaning rod from its location inside the lower cover. 

c. Open lever 3a to the right (1) and open lever 3d to the right (2). 
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d. Use the cleaning rod to sweep any remaining waste or debris from inside the trimmer into the trimmer 
waste container. 

e. If you have difficulty sweeping waste into the trimmer waste container, use the cleaning rod to gather 
waste, then remove the waste by hand. 

f. Return levers 3a and 3d to their original positions.

6. To ensure that all waste and debris is removed, especially beneath the frame that is located behind the 
container, use the cleaning rod to remove any remaining waste from inside the trimmer.  
For information, refer to Emptying the Crease and Two-Sided Trimmer Waste Container.

7. Close the trimmer upper and lower covers.

8. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume 
printing.

Crease and Two-Sided Trimmer Fault Messages

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and 
a message appears on the press touch screen. A graphical illustration shows the location of the fault with a brief 
explanation of corrective actions for clearing the fault. If a fault occurs in more than one location, the illustration 
changes to indicate the multiple locations and the required corrective actions. 

The touch screen also displays a Faults button which provides information about the fault and detailed instructions 
for correcting the fault. The (EE) code on the upper-left part of the Fault message displays which error indicator is lit 
on the Crease and Two-Sided Trimmer indicator panel (E1–E7).
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Crease and Two-Sided Trimmer Fault Code Information

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and 
a message appears on the press touch screen. 

The touch screen also displays a Faults button which provides information about the fault and detailed instructions 
for correcting the fault. 

Tip: Crease and Two-Sided Trimmer faults are identified by the codes which start with the three-digit numbers 001122, 
001133, 001144, 002244, and 002288.

C/Z FOLDER TROUBLESHOOTING

C/Z Folder Paper Jams

• The press stops running and a fault message displays on the press touch screen.

• The message includes a graphical illustration showing the location of the fault along with a brief explanation of 
corrective actions for clearing the fault.

• Paper jams may occur in multiple areas of the press and any optional devices connected to the press. When this 
happens, the graphical illustration changes to show the multiple locations and the required corrective actions. 

• Additionally, if a fault occurs with the C/Z Folder, an indicator lights on the PR Finisher control panel and shows 
the corresponding area on the C/Z Folder where the fault occurred.
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Always refer to the following information when clearing paper jams: 

• Do not power off the press when removing paper jams.

• Paper jams can be removed with the press still powered on. When the power is turned off, all information stored 
to the system memory is erased.

• Clear all paper jams before resuming print jobs.

• Do not touch components inside the press. This can cause print defects.

• Ensure that all paper jams, including any small ripped pieces of paper, are cleared before proceeding with print 
jobs.

• Gently remove the paper taking care not to tear it. If paper is torn, be sure to remove all torn pieces.

• After removing paper jams, close all doors and covers. The press cannot print when doors or covers are open.

• After clearing a paper jam, printing automatically resumes from the state before the paper jam occurred.

• If all paper jams are not cleared, an error message continues to display on the press touch screen. To clear any 
remaining jams, refer to the press touch screen for instructions and information.

Clearing Paper Jams from Folder Area E10

1. Open the folder front cover. 

2. Open lever 2a upward (1) and lever 2b to the left (2). Remove jammed paper (3). 
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3. Return levers 2a and 2b to their original positions.  

4. Close the folder front cover.

5. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume 
printing.

Clearing Paper Jams from Folder Area E11

1. Open the folder front cover. 

2. Open lever 2g to the right (1) and rotate knob 2c counterclockwise (2). Remove jammed paper (3).  
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3. Return lever 2g to its original position.  

4. Close the folder front cover.

5. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume 
printing.

Clearing Paper Jams from Folder Area E12

1. Open the folder front cover. 

2. Pull open the C/Z fold output tray 2d.  
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3. Open lever 2e to the right (1) and rotate knob 2c counterclockwise (2). Remove jammed paper (3). 

4. Return lever 2e to its original position.  

5. If you have difficulty removing any paper jams, open lever 2f to the right (1) and rotate knob 2c 
counterclockwise (2). Remove jammed paper (3). 

392 Xerox® Versant® 280 Press User Documentation 

Troubleshooting



6. Return lever 2f to its original position. 

7. Close the C/Z fold output tray 2d by pushing it in completely. 

8. Close the folder front cover.

9. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume 
printing.

C/Z Folder Fault Messages

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and 
a message appears on the press touch screen. A graphical illustration shows the location of the fault with a brief 
explanation of corrective actions for clearing the fault. If a fault occurs in more than one location, the illustration 
changes to indicate the multiple locations and the required corrective actions. 

The touch screen also displays a Faults button which provides information about the fault and detailed instructions 
for correcting the fault. The (EE) code on the upper-left part of the Fault message displays which error indicator is lit 
on the C/Z Folder indicator panel (E1–E7).

C/Z Folder Fault Code Information

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and 
a message appears on the press touch screen.

The touch screen also displays a Faults button which provides information about the fault and detailed instructions 
for correcting the fault.
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Tip: C/Z Folder faults are identified by the codes which start with the three-digit numbers 001122 and 001133.

PRODUCTION READY FINISHERS TROUBLESHOOTING

PR Finisher Paper Jams

PR FINISHER AND PR BOOKLET MAKER 
FINISHER PR FINISHER PLUS 

The following occurs when there is a fault, such as paper jams, open doors or covers, or a press malfunction:

• The press stops running and a fault message displays on the press touch screen.

• The message includes a graphical illustration showing the location of the fault along with a brief explanation of 
corrective actions for clearing the fault.

• Paper jams may occur in multiple areas of the press and any optional devices connected to the press. When this 
happens, the graphical illustration changes to show the multiple locations and the required corrective actions.

• Additionally, if a fault occurs with an optional device, an indicator lights on that device control panel and shows 
the corresponding area on the device where the fault occurred.

Always refer to the following information when clearing paper jams:

• Do not power off the press when removing paper jams.

• Paper jams can be removed with the press still powered on. When the power is turned off, all information stored 
to the system memory will be erased.

• Clear all paper jams before resuming print jobs.
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• Do not touch components inside the press. This can cause print defects.

• Ensure that all paper jams, including any small ripped pieces of paper, are cleared before proceeding with print 
jobs.

• Gently remove the paper taking care not to tear it. If paper is torn, be sure to remove all torn pieces.

• After removing paper jams, close all doors and covers. The press cannot print when doors or covers are open.

• After clearing a paper jam, printing automatically resumes from the state before the paper jam occurred.

• If all paper jams are not cleared, an error message continues to display on the press touch screen. To clear any 
remaining jams, refer to the press touch screen for instructions and information.

Clearing Paper Jams from Finisher Area E1

1. Open the finisher front cover. 

2. Open lever 1a to the left (1) and remove the jammed paper (2). 

Note: Grasp the leading edge of the jammed sheet and pull out the sheet to remove it.
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3. If you have difficulty removing any paper jams, rotate knob 1b clockwise (1) and remove the jammed paper 
(2). 

4. Return lever 1a to its original position. 

5. Close the finisher front cover.

Clearing Paper Jams from Finisher Area E2

1. Open the finisher front cover. 
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2. Open lever 1c to the right (1) and rotate knob 1e clockwise (2). Remove the jammed paper (3). 

Note: The jammed paper may be hidden behind the upper cover.

3. Return lever 1c to its original position.  

4. Close the finisher front cover.

Clearing Paper Jams from Finisher Area E3

1. Pull out the jammed paper from the finisher top tray.  
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2. Open and close the finisher front cover.  

Clearing Paper Jams from Finisher Area E4

1. Open the finisher front cover. 

2. Open lever 1d to the right (1) and rotate knob 1e clockwise (2). Remove the jammed paper (3).  
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3. Return lever 1d to its original position.  

4. Close the finisher front cover.

Clearing Paper Jams from Finisher Area E5

1. Open the finisher front cover. 

2. Open lever 1d to the right (1) and rotate knob 1f counterclockwise (2). Remove the jammed paper (3). 
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3. Return lever 1d to its original position.  

4. Close the finisher front cover.

Clearing Paper Jams from Finisher Area E6

1. Pull out the jammed paper from the finisher stacker tray.  

2. Open and close the finisher front cover. 
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Clearing Paper Jams from Finisher Booklet Area E7

1. Open the finisher front cover. 

2. Open lever 3a to the left (1) and remove the jammed paper (2). 

3. If you have difficulty to remove the paper jam, pull out the Saddle Stitch Unit 3 (1) and remove the jammed 
paper (2). 
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4. Return lever 3a to its original position.  

5. Gently push in the Saddle Stitch Unit 3 until it stops.  

6. Close the finisher front cover.

Clearing Paper Jams from Finisher Booklet Area E8

1. Open the finisher front cover. 
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2. Pull out the Saddle Stitch Unit 3 toward you until it stops.  

Note: Check lever 3a for paper jam before pulling out the unit.

3. Rotate knob 3b counterclockwise (1) and remove the jammed paper (2). 

4. Gently push in the Saddle Stitch Unit 3 until it stops.  

5. Close the finisher front cover.
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Clearing Paper Jams from Finisher Booklet Area E9

1. Open the finisher front cover. 

2. Rotate knob 3b clockwise (1) and remove the jammed paper from the booklet tray area (2). 

3. Close the finisher front cover.

Production Ready Finisher Plus Troubleshooting

Clearing Paper Jams in PR Finisher Plus, Areas E1-E6

Refer to the following procedures for clearing paper jams the PR Finisher Plus, Finisher Module areas E1–E6:

• Clearing Paper Jams from Finisher Area E1

• Clearing Paper Jams from Finisher Area E2

• Clearing Paper Jams from Finisher Area E3

• Clearing Paper Jams from Finisher Area E4

• Clearing Paper Jams from Finisher Area E5

• Clearing Paper Jams from Finisher Area E6
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Clearing Paper Jams in the PR Finisher Plus, Area E7

1. Open the finisher front cover. 

2. Remove any jammed paper.

3. To clear paper jams from Area E7, perform the following: 

a. Open lever 3a to the left (1) and lever 3b to the left (2). 

b. Rotate knob 1b clockwise (1) and remove the jammed paper (2). 
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c. Return levers 3a and lever 3b to their original positions.  

4. Close the finisher front cover.

Clearing Paper Jams in the PR Finisher Plus, Finishing Transport

Refer to the following procedures for clearing paper jams the PR Finisher Plus, Finisher Module areas 1-4:

• Clearing Paper Jams in Finishing Transport Area 1

• Clearing Paper Jams in Finishing Transport Area 2

• Clearing Paper Jams in Finishing Transport Area 3

• Clearing Paper Jams in Finishing Transport Area 4

CClleeaarriinngg PPaappeerr JJaammss iinn FFiinniisshhiinngg TTrraannssppoorrtt AArreeaa 11

1. Open the Finishing Transport front cover. 
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2. Open lever 1 downward and remove the jammed paper.  

3. Return lever 1 to its original position.  

4. Close the Finishing Transport front cover.

CClleeaarriinngg PPaappeerr JJaammss iinn FFiinniisshhiinngg TTrraannssppoorrtt AArreeaa 22

1. Open the Finishing Transport front cover. 

Xerox® Versant® 280 Press User Documentation 407

Troubleshooting



2. Open lever 2 to the right (1) and rotate the knob counterclockwise (2). Remove the jammed paper.  

3. Return lever 2 to its original position.  

4. Close the Finishing Transport front cover.
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1. Open the Finishing Transport front cover. 
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2. Open lever 3 to the left (1) and rotate the knob clockwise (2). Remove the jammed paper. 

3. Return lever 3 to its original position.  

4. Close the Finishing Transport front cover.
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1. Open the Finishing Transport front cover. 
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2. Open lever 4 downward (1) and rotate the knob clockwise (2). Remove jammed papers. 

3. Return lever 4 to its original position. 

4. Close the Finishing Transport front cover.

Finisher Staple Faults

Use the following procedures when stapling issues occur with the printed output, such as when the sheets are not 
stapled or the staples are bent. Contact the service representative if the problems continue after you have tried the 
following solutions.

Not stapled Bent staple 

If printed sheets are stapled as shown in the following figures, contact your service representative. 

One side of staple raised up Staple bent in reverse direction Flattened staple 
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Entire staple raised up Staple raised up with center pressed inward 

Important: 

• Depending on the type of paper being stapled, the staple nails may be bent. If the bent nails are stuck inside 
the finisher, they may eventually cause paper jams.

• When you open the cover of the staple cartridge, remove any bent staples; otherwise staple jams may occur. 
Use the cover of the staple cartridge only when removing jammed staples.

Clearing Staple Jams in the Basic Stapler

If the staple cartridge accidentally detaches from its holder, refer to Reinserting the Basic Staple Cartridge.

Note: Ensure that the press is not running before performing this procedure.

1. Open the finisher front cover. 
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2. Pull out R1. 

Note: After removing the staple cartridge, check the inside of the finisher for any remaining staples.

3. Open the unit cover and remove the jammed staples. 

WARNING: To avoid personal injury, use care when removing jammed staples.

4. Reinsert the unit to its original position. 

5. Close the finisher front cover.
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Reinserting the Basic Staple Cartridge

If a staple cartridge has been inserted incorrectly or accidentally removed, perform the following procedure to 
correctly reinsert the staple cartridge into the cartridge unit.

1. Open the finisher front cover. 

2. Pull out R1.  

3. Open the unit cover and remove the jammed staples. 

WARNING: To avoid personal injury, use care when removing jammed staples.
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4. Locate the lever on the back of the unit. 

WARNING: When moving the lever, be careful not to hurt your fingers and nails.

5. Turn the unit up while holding the lever, then take out the staple cartridge from the unit. 

6. Remove the outside staples along the line. 

WARNING: When removing staples, be careful not to hurt your fingers.
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7. Insert the staple cartridge into the unit. 

8. Reinsert the unit to its original position. 

9. Close the finisher front cover.

Clearing Staple Jams in the Booklet Stapler

Note: Ensure that the press is not running before performing this procedure.

1. Open the finisher front cover. 
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2. Pull out the Saddle Stitch Unit 3 toward you until it stops. 

3. While holding the tabs on the staple cartridge, pull out the cartridge to remove it. 

4. Remove any jammed staples. 

WARNING: To avoid personal injury, use care when removing jammed staples.

5. While holding the tabs on the new staple cartridge, push in the cartridge until it seats. 

Note: Make sure that the marks are aligned.
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6. Push the Saddle Stitch Unit 3 gently into the finisher until it stops. 

7. Close the finisher front cover.

Stapler Faults in the PR Finisher Plus

Refer to the following procedures for clearing staple jams the PR Finisher Plus, Basic Staple Cartridge:

• Finisher Staple Faults

• Clearing Staple Jams in the Basic Stapler

• Reinserting the Basic Staple Cartridge

Finisher Fault Messages

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and 
a message appears on the press touch screen. A graphical illustration shows the location of the fault with a brief 
explanation of corrective actions for clearing the fault. If a fault occurs in more than one location, the illustration 
changes to indicate the multiple locations and the required corrective actions. 

The touch screen also displays a Faults button which provides information about the fault and detailed instructions 
for correcting the fault. The (EE) code on the upper-left part of the Fault message displays which error indicator is lit 
on the Finisher indicator panel (E1–E9).

Finisher Fault Code Information

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and 
a message appears on the press touch screen. 

The touch screen also displays a Faults button which provides information about the fault and detailed instructions 
for correcting the fault. 

Tip: Finisher faults are identified by the codes which start with the three-digit numbers 001122, 001133, 002244, 004411, 111122, 
and 112244.

Xerox® Versant® 280 Press User Documentation 417

Troubleshooting



PR Finisher Plus Fault Code Information

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and 
a message appears on the press touch screen.

The touch screen also displays a Faults button which provides information about the fault and detailed instructions 
for correcting the fault.

Tip: PR Finisher Plus faults are identified by the codes which start with the three-digit numbers 001133 and 005511.

SQUAREFOLD ®  TRIMMER TROUBLESHOOTING

SquareFold® Trimmer Paper Jams
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The following occurs when there is a fault, such as paper jams, open doors or covers, or a press malfunction:

• The press stops running and a fault message displays on the press touch screen.

• The message includes a graphical illustration showing the location of the fault along with a brief explanation of 
corrective actions for clearing the fault.

• Paper jams may occur in multiple areas of the press and any optional devices connected to the press. When this 
happens, the graphical illustration changes to show the multiple locations and the required corrective actions. 

• Additionally, if a fault occurs with an optional device, an indicator lights on that device control panel and shows 
the corresponding area on the device where the fault occurred.

Always refer to the following information when clearing paper jams:

• Do not power off the press when removing paper jams.

• Paper jams can be removed with the press still powered on. When the power is turned off, all information stored 
to the system memory will be erased.

• Clear all paper jams before resuming print jobs.

• Do not touch components inside the press. This can cause print defects.

• Ensure that all paper jams, including any small ripped pieces of paper, are cleared before proceeding with print 
jobs.

• Gently remove the paper taking care not to tear it. If paper is torn, be sure to remove all torn pieces.

• After removing paper jams, close all doors and covers. The press cannot print when doors or covers are open.

• After clearing a paper jam, printing automatically resumes from the state before the paper jam occurred.

• If all paper jams are not cleared, an error message continues to display on the press touch screen. To clear any 
remaining jams, refer to the press touch screen for instructions and information.

Clearing Paper Jams from SquareFold® Trimmer Areas E1 and E2

Note: Ensure that the press is not running before performing this procedure.

1. Open the left cover of trimmer device by pressing the button on the cover. 
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2. Remove the jammed paper. 

3. If you have difficulty removing the jammed paper, open the front cover of the finisher. 

4. Rotate the knob 3b to the right, then remove the jammed paper. 

5. If necessary, close the front cover of the finisher.

6. Close the left cover of the trimmer device.

7. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume 
printing.
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Clearing Paper Jams from SquareFold® Trimmer Area E3

Note: Ensure that the press is not running before performing this procedure.

1. Open the right cover of trimmer device by pressing the button on the cover. 

2. Remove the jammed paper. 

3. Close the right cover of the trimmer device.

4. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume 
printing.

SquareFold® Trimmer Fault Messages

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and 
a message appears on the press touch screen. A graphical illustration shows the location of the fault with a brief 
explanation of corrective actions for clearing the fault. If a fault occurs in more than one location, the illustration 
changes to indicate the multiple locations and the required corrective actions. 

The touch screen also displays a Faults button which provides information about the fault and detailed instructions 
for correcting the fault. The (EE) code on the upper-left part of the Fault message displays which error indicator is lit 
on the SquareFold® Trimmer control panel (E1–E3).
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SquareFold® Trimmer Fault Code Information

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and 
a message appears on the press touch screen. 

The touch screen also displays a Faults button which provides information about the fault and detailed instructions 
for correcting the fault. 

Tip: SquareFold® Trimmer faults are identified by the codes which start with the three-digit number 001133.

Guidelines for Using the SquareFold® Trimmer Device

Full-Page Images on Booklets

When using full-page images, ensure that the finished booklet size accommodates any full-page images and that 
when the booklet is trimmed, these images are not truncated.

The following are examples of a booklet with preprinted front/back covers with a full-page image but different sizes:

1. Booklet 1 is printed on 8.5 x 14 in./B4 paper: The front cover, which was trimmed, displays the entire image.

2. Booklet 2 is printed on 8.5 x 11 in./A4 paper: The image on the front cover is truncated after trimming it.
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Booklet Considerations

Before you print any booklet, consider the following:

• Image location on the original as it will no longer be centered. Do you need to shift images in order to ensure 
they fit on the finished booklet?

• What is the desired size of the finished booklet?

• Does the booklet contain full-page images?

• Are you using preprinted covers with full-page images?

• Are you trimming the booklet?

Considerations for Obtaining Desired Booklet Output

Follow these tips to ensure you get your desired output:

• Always run one or more test prints of your job before running a larger output quantity.

• Review your test prints for truncated images/text.

• If any images or text need shifting, use the various selections from the print driver for your application. Refer to 
the Help information for your print driver.

Note: It may take one or more test prints before you achieve your desired output.
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Troubleshooting Help

LOCATING THE PRESS SERIAL NUMBER

The press serial number can be accessed from the User Interface (UI) or from the serial number plate which is 
located on the inside frame of Tray 1.

1. Press the Machine Status button on the UI.

2. From the Machine Status screen, ensure that the Device Information tab is displayed. 

The press serial number is displayed under Device Serial Number near the bottom of the screen.

3. If there is a loss of power and it is not possible to access the Machine Status screen, the press serial number 
can also be found on the inside frame of the press near the Paper Tray 1 drawer: 

a. At the press, fully open Tray 1.

b. At the left of the tray, on the press frame, locate the plate with the serial number (SSEERR##). 

CALLING FOR SERVICE

1. Record any displayed fault codes.

2. Record the press serial number. 

a. Select the Machine Status button at the press UI. 

b. From the Machine Status screen, select the Device Information tab to view the serial number listed. 
If the serial number is not displayed, open the press Paper Tray 1 drawer and locate the serial number plate 
on the left side of the frame (SER #). 

3. If output quality is a problem, take a sample as a reference to assist you in describing the problem over the 
telephone when answering the questions from the customer support operator about the defects.

4. If possible, use a phone near the press when calling for assistance. Follow the instructions provided by the 
operator.

5. For system support, user help, and service support, call the appropriate number. For the specific number in your 
area, go to www.xerox.com and select the Support link.
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Fuser Hints and Tips

EXTENDING FUSER LIFE

To extend the life of your fuser, discuss the usage of multiple fusers with your Service Representative. Multiple fusers 
provide maximum print output for longer periods of time and ensure image defects on output are avoided. 
Depending on the types of jobs run and their frequency, you may want more than one fuser available, such as the 
following for example:

• One fuser roll for narrower paper

• One fuser for wider paper

Note: The additional fuser can be stored in its original packaging if a fuser stand is not available.

PREVENTING FUSER DAMAGE

1. To reduce 11 in./279.4 mm lines and wear marks, you may require the use of two fusers - one when running 8. 
5x 11 in./A4 stock and the other when running 12 x 18 in./304.8 x 457.2 mm or larger stock. This is especially 
true for the graphic arts people.

2. Image quality defects such as marks or spots will occur every 110 mm/4.3 in. on the prints if the fuser roll is 
damaged. Defects which occur every 98 mm/3.89 in. indicate a damaged fuser belt.

FUSER PAPER WIDTH INFORMATION

The press is delivered and installed with a standard type fuser that accommodates all paper width sizes. However, 
the press allows for the installation of other fuser assemblies and paper width types for printing specific paper width 
ranges. When installing a new fuser, the customer can indicate that the fuser be used for certain paper widths only. 
Identifying the fuser width type is performed by connecting the appropriate fuser jumpers provided in the 
nationalization kit as well as attaching a colored fuser width clip. 

Before using the new fuser, the system administrator must update the NVM width setting values to match the 
specific width used for this fuser.

The following table defines the media sizes and width ranges that can be set for the fuser.

TTaabbllee 33..1155 BByyppaassss CCoonnnneeccttoorr uusseedd ffoorr DDeeffaauulltt PPaappeerr WWiiddtthh NNVVMM SSeettttiinnggss

RANGE NO. 
BYPASS 
CONNECTOR MEDIA SIZE WIDTH RANGE 

1 None All paper widths 98.0 - 330.2 mm (3.858 - 13.0 in.) 

2 Black Resistor Type A4/Letter SEF A3 SEF 

A4/Letter LEF

11 x 17 in.

270.4 - 298.0 mm (9.84 - 11.69 in.) 
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RANGE NO. 
BYPASS 
CONNECTOR MEDIA SIZE WIDTH RANGE 

3 Blue Type SRA3 

12 in.

13 in.

300.0 - 330.2 mm (12.09 - 13.00 in.) 

4 See Note  Custom 100.0 - 330.2 mm (3.937 - 13.0 in.) 

Note: Refer to the System Administrator Guide on how to set the NVM width.
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For Administrators
From the press, you can log into the Administrator mode. From the select Administrator mode, you can do the 
following:

• Customize the press screen

• Select the power saver mode settings

• Run the Clean the Fuser Assembly with Felt procedure

• Reset a High Frequency Service Item (HFSI) counter

• Select and edit Copy and Scan setting

• Select and edit other System Settings

• Perform Simple Image Quality Adjustment (SIQA) procedures

• Connect to Xerox® CentreWare® Internet Services

• Setup and use the Accounting features and functions

• Setup and use the Authentication/Security Settings

For more information, refer to the System Administrator Guide.
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